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1. General Information

1.1. Short Description

This document describes the Graphical User Interface of the InScript Software.

Here is the main Window:

1.2. Concept

This is a description of the basic concepts of InScript and ARGES Laser Controllers.

1.2.1. InScript - Controllers

InScript is a Front-End for ARGES controller hardware. InScript is used to organize internal structures
on the controllers. For instance it is possible to handle Devices (see 3 Devices) like scan heads, laser,
axis, IOs or other hardware devices. Additionally InScript is used to create so-called Jobs, which con-
sist of execution units - so-called Job Nodes (see 5 Job Nodes) - that are created, parameterized and
put-together in InScript. These Job Nodes are organized in a hierarchical tree structure.

The fundamental configuration components are variables which are arranged hierarchically in a tree
structure that is stored on the ARGES controller. All components like Devices, Job Nodes or Jobs consist
basically of a collection of these variables. But normally a user will only deal withNodes that integrate
these variables.
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1. General Information

These Nodes are created directly on the controller hardware. The controller hardware then renders
DSP (digital signal processor) data for real-time execution of these jobs on the connected hardware
(e.g. scan heads), gives interfaces to external IO etc.. The InScript Vector Editor has two modes. One
is Edit mode, where line data is calculated to some extent at PC side and can be modified. The other
mode is the Preview mode, where line data is taken directly from the controller's DSP. This gives a
clear view of the data that will actually be processed.

InScript
↓↑

Controller
↓↑

Hardware

1.2.2. Summary

Here you can find a summary and deepening of the InScript concepts:

• InScript is a Front-End for ARGES controller hardware

• InScript manages and configures hardware devices on the controllers

• All operations of InScript are Job based

• Jobs are hierarchical tree structures that are executed from their root node to the last node in
the last branch

• Each node is an execution, steering or processing element

• Each node consists of variables created on the controller

• These jobs can be created in the Job Configuration editor

• The Vector Editor of InScript shows the visual output of your work in progress

• All of the visual output that InScript provides in preview mode is calculated directly by the
controller

1.2.3. Remarks

If you use an NCC controller, you have to be aware that normally the controller is built into the PC
(host PC) on which InScript is running. This means that if the PC is shut down, put into stand by
or hibernation mode, the NCC controller is powered-off with most PC hardware and looses unsaved
settings and jobs. If InScript is running, automatic power state changes (e.g. to stand by or hiberna-
tion) are prevented but the user is still allowed to actively put the machine to sleep mode, with all
the implications that are stated above. The NCC PCI card is connected to the host PC via an internal
PCI slot.

In opposite to this, ASC controllers are stand-alone external appliances, that are independent from
your PC. ASC controllers are connected via ethernet to the host PC.
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1.3. Overview of Changes

1.3. Overview of Changes

2009-02-11 Remaining Job nodes added (ar)

2009-01-20 Job node added: ARL P3D

2008-02-14 Job nodes added: Raw Lines; RawLines, Tiling and Tile nodes translated to de-DE

2008-01-17 Job nodes added: Tiling, Tile

2007-11-29 Document created

2. Devices Window

Devices are the hardware connected to the controller or present on the controller. The controller
uses device specific drivers to control them. Devices and their drivers can be accessed via the Devices
window.

At the first start of InScript there are already some devices and their drivers present in the Devices
window. The presence of these devices depends on the controller hardware and the assumption that
at least one scan head is installed. These devices cover basic functions of controller and scan head.

You may want to add further devices and their drivers respectively for the devices connected to the
controller, but at least one for the laser. How this is done and how to manage devices you will learn
in the following sections.

But first let us describe how to open the Devices window, see section 2.2 How to Open the Window,
and what can be seen in the Devices window, see section 2.3 Description of the Window.

Then manage all device related issues in the Devices window via the context menu, see section 2.5
Context Menu in the Devices Window and section 2.6 Manage Devices.

2.1. Settings in Devices vs. Settings in Pens

The entries in theDeviceswindow represent basicically driver for connected devices andnormally you
cannot (and should not) change parameters here unless you unlock the parameter by deactivating the
red square below a value (see 2.6.5 Edit (Parametrize) for more information). The red square shows
that this parameter is controlled by the corresponding pen.

If you want to do special settings, while a job is executed, use Pens (4.9 Manage Pens). These pens can
be used in the Job tree by dragging and dropping them (see 4.9.1 Control Device Parameters During
Job Execution). Another big advantage is that you can save Pens for different purposes in *.pen files
to reuse them (see 4.9.6 Save Pen).

TIP

Normally device parameters should be used as a kind of basic settings. If you want to
change device parameters dynamically while you execute a Job, we highly recommend
to use the Pen mechanism!
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2. Devices Window

2.2. How to Open the Window

� In the menu, click View→ Devices.
— or —
In the toolbar, click .
The Devices window opens.

2.3. Description of the Window

Figure 1: The Devices window

Column Device shows which devices are present by a device "category" icon, a status LED (see
Column Status) and the device's name. Possible device categories are

generic device

scan head device

device on the controller

motion axis device

laser device

Column Driver shows the driver's name for the respective device

Column Status shows the driver's status. The driver's status is also shown by a LED next to the
device's name. Possible statuses are

inactive the device is inactive

activating the device is being activated

not ready the device is not ready

ready the device is ready to use

failure the device is ready to use

deactivating the device is being deactivated

22 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



2.4. Devices Tree Structure

2.4. Devices Tree Structure

See also figure 1 The Devices window.

Devices this is the root of the tree structure. If you want to add a device then create it via the
context menu of this root node

sas some devices are located in the sas device's subtree, see section 3.3 sas - System Ac-
tivity State.
Active devicesmaybe arranged in the sasdevice's subtree. Whenactivating a device this is
done automatically in most cases. The sas device controls the error state of all connected
and activated devices, that are in the sas device's subtree. The sas device synchronizes
the devices in its subtree, see section 2.6.6 Synchronize with Other Devices

2.5. Context Menu in the Devices Window

Use the context menu to manage devices in the Devices window. Whether a menu item is enabled or
not, depends on the device and its status. The context menu:

Create Device This menu item is only available on the Devices root node and opens the New Device
window to add a device and its driver to the devices tree structure, see section 2.6.2 Create
Device

Edit opens the device drivers's editor to parametrize the driver, see section 2.6.5 Edit (Parametrize).
Only active device driver's can be edited (parametrized)

Configure opens the device drivers's editor to configure the driver, see section 2.6.3 Configure. Only
inactive device driver's can be configured

View Configuration opens the active device drivers's configuration editor. Only inactive device
driver's can be configured

Activate activates an inactive device driver, see section 2.6.4 Activate
Deactivate deactivates an active device driver, see section 2.6.8 Deactivate
Delete deletes an incative device driver, see section 2.6.9 Delete. Only inactive device drivers can

be deleted
Show Status on Fail if this menu item is selected and if the device falls to a failure state, then its

editor window will automatically be opened. If the device is in the sas device's subtree, see
section 3.3 sas - System Activity State, and if the menu item is selected, then the sas device's
editor window will be opened additionally
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2. Devices Window

Xplore opens the Xplorer window at the selected device driver's variables, see section 8.5 Xplorer

Info opens the Node Info window at the selected device driver's variables

Dump opens a Dump window of the selected device driver's variables

Add to Inspector opens the Inspector window to add variables, see section 8.9 Node Inspector

Name to Clipboard copies the device driver's name to the clipboard

2.6. Manage Devices

2.6.1. Basic Steps

How to add a device

Step 1 Connect the device to the controller, see the documentation for the controller and the
device.

Step 2 Create a device in the Devices window, see section 2.6.2 Create Device.

Step 3 Configure the device, see section 2.6.3 Configure.

Step 4 Activate the device, see section 2.6.4 Activate.

Step 5 Edit (parametrize) the device, see section 2.6.5 Edit (Parametrize).

How to use a device

Step 1 Synchronize the device with other devices, see section 2.6.6 Synchronize with Other De-
vices.

Step 2 Control the device's parameters during job execution, see section 2.6.7 Control Device
Parameters During Job Execution.

How to remove a device

Step 1 Deactivate the device, see section 2.6.8 Deactivate.

Step 2 Delete a device, see section 2.6.9 Delete.

2.6.2. Create Device

Step 1 On the Devices node context menu, right click Devices and choose Create Device.
The New Device window opens.
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2.6. Manage Devices

Step 2 You may type a customized Name for the device.
This name will be used in the Devices window in column Device.

Step 3 Select a device from the Driver list.

Step 4 Find a description of supported devices in section 3 Devices.
If you do not find a compatible device, contact ARGES.

Step 5 Click OK.
The device appears in the Devices window, but is still inactive. This status is symbolized
by a gray LED .

Step 6 Configure the device, see next section.

2.6.3. Configure

The configuration is a basic step for the operation of a device, e.g. select and configure a COM port.
Such basic settings can only be modified, if a device is inactive, which is symbolized by a gray LED .

Step 1 Double click the created device.
— or —
Click Configure in the device context menu.

Step 2 The configuration window of the corresponding device opens.

Step 3 Configure the device as needed.
Find a description of supported devices in section 3 Devices.

Step 4 To apply the configuration, click OK.
The configuration window closes. The device is configured now, but still inactive.

Step 5 Activate the device, see next section.
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2. Devices Window

2.6.4. Activate

CAUTION

Wrong device configuration

Material damage

� Activate the device only if you are sure that it is configured correctly.

Step 1 In the device context menu, click Activate.
After a short time the device will be active and ready. This status is symbolized by a
green LED . A red LED would symbolize an error, e.g. if no communication could be
established with the device.
At the same time a pen section will be created in the Job Configurationwindow in the tree
structure under Pens→ default, which belongs to this device, see section 4.9Manage Pens.

Step 2 Parametrize the device, see next section.

2.6.5. Edit (Parametrize)

To set a device it has to be active. This status is symbolized by a green LED .

Only set parameters, which are constant during a job, e.g. Settle Time of the laser power. Settings that
may be changed, while executing a job, are labeled with a red checkbox and locked, i.e. they should
not be changed here. Set these parameters within the pen section belonging to the device, refer to
section 4.9 Manage Pens for more information.

NOTE

If you clear the red checkbox to a gray checkbox then the corresponding setting can be
changed in the device and the setting in the corresponding pen section will be ignored.
But this may lead to unwanted results.

Step 1 Double click the device.
— or —
Click Edit in the device context menu.
The settings dialog of the corresponding device opens.

TIP

To let every input immediately take effect, clear the Suspend checkbox. To
input all settings first and let them take effect together, select the Suspend
checkbox. This may be necessary to prevent the device from going into an
undefinded state by the temporary input of incompatible settings.

Step 2 Set the device.
Find a description of supported devices in section 3 Devices.

Step 3 Click OK.
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2.6. Manage Devices

Step 4 CAUTION

Data loss
Settings will be lost by re-starting the controller.
� In themenu, click Controller→ Save Devices and Default Pen (NVRam) to pre-

vent data loss.

2.6.6. Synchronize with Other Devices

CAUTION

Loss of synchronization to other devices
Material damage
If you remove the device from the sas device subtree then the device will not be synchro-
nized with the devices remaining in the sas device subtree.
� Make sure that the lack of synchronizationdoesnot result inmaterial damage (e.g. collision

of linear axes, process outside the intended area).

� In the Devices window, Drag&Drop the device into the sas device's subtree.

TIP

A device reporting an error, symbolized by a red LED , can be deactivated or removed
from the sas device's subtree. This may be useful for testing purposes, e.g. when working
with a switched off laser where the laser device is reporting an error.

2.6.7. Control Device Parameters During Job Execution

Find more information about, how to control device parameters during job execution, in section 4.9
Manage Pens.

2.6.8. Deactivate

CAUTION

Loss of synchronization to other devices
Material damage
If you deactivate the device then it will be removed from the sas device subtree and the
device will not be synchronized with the devices remaining in the sas device subtree.
� Make sure that the lack of synchronizationdoesnot result inmaterial damage (e.g. collision

of linear axes, process outside the intended area).

� Click Deactivate in the device context menu.
The device will be set inactive. This status is symbolized by a gray LED .
At the same time this device's pen section is removed from the Job Configurationwindow under
the tree structure Pens→ default, see section 4.9 Manage Pens.
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2.6.9. Delete

To delete a device it has to be inactive. A gray LED symbolizes this status.

Step 1 In the device context menu, click Delete.
The Confirm window opens.

Step 2 Click Yes.
The device will be deleted from the tree structure.
At the same time this device's pen section is removed from the Job Configuration window
under the tree structure Pens→ default, see section 4.9 Manage Pens.

2.7. Store Configuration

NOTE

If you do not store the settings to the controller NVRam then the settings will be lost
after rebooting or restarting the controller.

� In the main menu, click Controller→ Save Devices and Default Pen (NVRam) — or — Choose Save
Devices and Default Pen (NVRam) in the context menu of the controller in the Job Configuration
window

3. Devices

3.1. Shared GUI Elements

Some graphical user interface elements are shared by all devices. These elements are summarized
here.

3.1.1. When Configuring Inactive Devices

Activate activates the device

OK applies changes made and closes the window

Cancel cancels changes made and closes the window

Restore restores the values as they were before opening the window

3.1.2. When Editing (Parametrizing) Active Devices

(Controlled) If the checkbox is selected (red ) then the parameter above the checkbox can not
be changed in the device. The parameter is controlled by the pen section which belongs to the
corresponding device then. Such a parameter can be changed during job execution, see section
4.9.1 Control Device Parameters During Job Execution).
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3.2. pio - Parallel Inputs and Outputs

If the checkbox is cleared (gray ) then the parameter above the checkbox can be changed in
the device.

NOTE

If you try to set such parameters, where the checkbox is cleared (gray ), in the
corresponding pen section then the settings in the pen section will be ignored.

Suspend If the checkbox is selected then changes take effect not until clicking OK. This is useful, if
changes are temporarily not compatible to each other and an error condition would be caused
that way.
If this checkbox is cleared then changes will take effect immediately when pressing the Enter
key

Status shows the device's status
Power State shows the laser's power state (only for laser devices; see the Power Saver tab)
Reset acknowledges error conditions and restarts the device
OK applies changes made and closes the window
Cancel cancels changes made and closes the window
Restore restores the values as they were before opening the window

opens the DefaultPen's pen section that belongs to this device

3.2. pio - Parallel Inputs and Outputs

for controller NCC
device type controller
driver version 1.0

For instance the NCC controller has 2 connectors called parallel interface inputs and parallel interface
outputs. The pio device drives these connectors. Find more information about both connectors in
Manual -- NCC System Controller.

3.2.1. Configure

NOTE

The pio device can not be configured. The device covers basic functions of the controller.
It is always active, and available even on an ASC controller, but there the ASE USER IO
device (see 3.36 ase user io - USER Inputs and Outputs) has replaced the pio device.

3.2.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.
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3. Devices

3.2.3. Parametrize - General

Out shows and sets the digital outputs

1 .. 11 If the checkbox is selected then the digital output is set to active

NOTE

To be able communicating with an external super ordinated machine control
InScript provides several input and output signals. In the System Activity State
device, see section 3.3 sas - System Activity State, some of these signals are al-
ready assigned to digital outputs. This is why some checkboxes are disabled.

In shows the digital inputs

1 .. 11 If the checkbox is selected then the digital input is set to active

3.2.4. Reading and Setting Parallel Inputs and Outputs

� If you want to readout or set parallel inputs and outputs on the NCC controller manually then
open the pio device.
— or —
If you want to readout or set parallel inputs and outputs while executing a job then use e.g. 5.44
Script (by setting e.g. dev.pio.o1 output variable, reading e.g. dev.pio.i1 input variable or
similar variables of the pio device) or 5.65 ExtSelect.

3.3. sas - System Activity State

for controller NCC, ASC
device type controller
driver version 1.0
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3.3. sas - System Activity State

The sas (or sasp) device controls the error state of all connected and activated devices, that are in the
sas device's subtree. The sas device synchronizes the devices in its subtree.

The sas device also serves as an interface, when InScript is controlled by an external super ordinate
machine control. To start processing by such a machine control it is necessary to apply a Start signal
to an input of the controller (see Manual -- NCC System Controller -- parallel interface inputs). To enable
themachine control tomonitor the state of the processing system and to request the next program as
soon as possible the controller provides the 2 status signals Ready and Active at an output (seeManual
-- System Controller -- parallel interface outputs).

It is possible to create a second SASP device but normally this is only practical for e.g. testing purposes.

At an NCC controller these signals are located at 2 connectors called parallel inputs and parallel outputs,
see also section 3.2 pio - Parallel Inputs and Outputs and the documentation of the NCC controller.

At the ASC controller these signals are located at 2 connectors called PLC and PLC AUX, for more in-
formation, please see the documentation of the ASC controller.

Timing Diagram

Description Timing Diagram
Digital inputs can be configured to be either high-active or low-active. Therefore they are only ad-
dressed as active or inactive signals in the following.

No. 1 When the controller board shows its readiness by an active Ready signal you may request
the execution of a program by setting the Start signal to active.

No. 2a The controller board acknowledges the Start signal by setting the Ready signal to inac-
tive.

No. 2b The controller board shows the beginning of program execution by activating the Active
signal.

No. 3 When the programends the controller board sets the Active signal to inactive and the Ready
signal to active.

No. 4 Once the Ready signal is active again you may request the execution of the next program.

No. 5a see No. 2a

No. 5b see No. 2b
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3. Devices

State Transition Diagram

Description State Transition Diagram

A=0 inactive state

A=1 active state

R=0 controller board not ready

R=1 controller board ready

/ condition is not fulfilled

&& both conditions are fulfilled

|| either one or the other condition is fulfilled

3.3.1. Configure
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3.3. sas - System Activity State

NOTE

Parameters on this tab are only relevant for the NCC controller.

Inputs

NOTE

A positive value stands for a high-active digital input. A negative value stands for a
low-active digital input. The value 0 (zero) means that no digital input will be used.

Start sets the digital input for the Start signal

Stop sets the digital input for the Stop signal

Abort sets the digital input for the Abort signal

Speed this setting is deprecated. It has to be 0

Allow spurious start if this checkbox is unselected, an external Start signal always gives
back an error, while a Job is being executed. If this checkbox is selected, a Job is not
interrupted by an external Start signal but repeated Starts do not return any error con-
dition (e.g. for an external pushbutton that gives unwanted repeated signals that cause
repeated Start signals).

NOTE

Under normal circumstances an undesired second Start signal has to be seen as
a serious error condition!

Outputs

NOTE

A positive value stands for a high-active digital input. A negative value stands for a
low-active digital input. The value 0 (zero) means that no digital input will be used.

Active sets the digital input for the Abort signal

Failure sets the digital output for the Failure signal

Ready sets the digital output for the Ready signal

3.3.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.
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3. Devices

3.3.3. Parametrize - General

NOTE

Parameters on this tab are only relevant for NCC controller.

Outputs shows the assignment of digital outputs to the signals Ready, Active and Failure. The status
is shown by representations of LEDs

NOTE

A positive value stands for a high-active digital output. A negative value stands for
a low-active digital output. The value 0 (zero) means that no digital output will be
used. See also the Manual -- NCC System Controller -- parallel interface outputs.

Preload To reduce time from Start signal to execution of a job, the data can be loaded and the line
vectors can be calculated in advance
always jobs will be pre-loaded

NOTE

If you select always and change an already selected job then you have to update
the job on the controller board manually. For this de-select the job and then
select the job again — or — click Job Abort.

never jobs will not be loaded until the Start signal
Dependencies lists monitored and controlled devices. When external devices are created by Create

Device they are automatically added to the list of monitored and controlled devices. In case a
critical error occurs at one of these devices the program will be interrupted and the error dis-
played. If the listed devices are in a standby state then theywill be reactivated before beginning
the job
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3.3. sas - System Activity State

Add adds a device to the list. This is necessary, if for testing purposes a device was previously
deleted from the list by Delete

Delete deletes a device from the list. If you delete a device from the list then the device will
not be monitored and controlled. That way it is possible e.g. to ignore error messages
from a connected laser system

Inputs shows the assignment of digital inputs to the signals Start, Stop andAbort. The status is shown
by representations of LEDs.

NOTE

A positive value stands for a high-active digital input. A negative value stands for a
low-active digital input. The value 0 (zero) means that no digital input will be used,
see the documentation of the NCC controller.

Manual Start If the checkbox is selected then the Start signal is set to active

Stop If the checkbox is selected then the Stop signal is set to active

Abort If the checkbox is selected then the Abort signal is set to active

3.3.4. Parametrize - Teach-In

This tab and its settings are normally needed in a sas Pen Section for pens that are used for Teach-In
(see also 4.9.12 Teach-in pilot Pen).

Use Teach-In if this checkbox is selected, theTeach-In function is active, i.e. Teach-In canbe started
by clicking Start Teach-In (F8) in the Job Control window (see also 4.9.12 Teach-in pilot Pen and
3.1.2 When Editing (Parametrizing) Active Devices)
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3. Devices

Pointer Options sets how a pointer device will react

Sensitivity X/Y sets the sensitivity to mouse movement. A higher sensitivity increases the
pointer speed on the target and a lower sensitivity decreases the speed

Invert X If the checkbox is selected then the X-axis of the teach-in mouse will be inverted.
This does not affect any coordinate system in InScript but assists the teach-in function

Invert Y If the checkbox is selected then the Y-axis of the teach-in mouse will be inverted.
This does not affect any coordinate system in InScript but assists the teach-in function

Sensitivity Z sets the sensitivity to mouse wheel movement. A higher sensitivity increases
the pointer speed on the target and a lower sensitivity decreases the speed

Display Options sets how the nodes are displayed

Current Node sets how the current node is displayed

Draw shape completely draws the shape completely as defined in the job

Teach-In-enabled Nodes sets how teach-in-enabled nodes are displayed

Draw shape completely draws the shapes completely as defined in the job

Draw nothing ignores these nodes and draws nothing instead

Other Nodes set how other nodes are displayed

Draw shape completely draws the shapes completely as defined in the job

Draw nothing ignores these nodes and draws nothing instead

Contrast sets the contrast of the selected node compared to other nodes when all nodes are
shown
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3.3. sas - System Activity State

3.3.5. Parametrize - Inputs/Outputs

NOTE

Parameters on this tab are only relevant for the ASC controller.

This tab shows the signal names assigned to the IO numbers at the connectors PLC and PLC AUX.

TIP

Inputs and outputs can be addressed by their name when using a Script node in a job.
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3. Devices

3.3.6. Parametrize - Breakout Pinout

NOTE

Parameters on this tab are only relevant for the ASC controller.

This tab shows the actual breackout pinout of the PCC breakout box that is connected to the connec-
tors PLC and PLC AUX.

TIP

You can print this tab using the Print button and keep this hardcopy near the PLC break-
out box.
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3.4. flash - Flash Memory

3.3.7. Parametrize - Connector Pinout

NOTE

Parameters on this tab are only relevant for the ASC controller.

This tab shows the actual PLC and PLC AUX connector pinout.

3.3.8. Parametrize - Job Duration Measurement

The feature job duration measurement is controlled via the variable dev.sas.jobDurationMeasurement.
If the variable is set to activated the feature is activated and job cycles after the activation will bemea-
sured. If the variable is set to deactivated the feature is deactivated and job cycles after the activation
will not be measured. See also 5.1 Shared GUI Elements.

3.4. flash - Flash Memory

for controller NCC, ASC
device type controller
driver version 1.0

The flash device manages the controller's memory.
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3. Devices

3.4.1. Configure

NOTE

The flash device can not be configured. The device covers a basic function of the con-
troller. The device is always active.

3.4.2. Parametrize

The flash device has no graphical user interface.

CAUTION

You have to know exactly how to set the variables here

Loss of data, jobs and other settings

� Do not edit any variables.

3.5. dac_a/b - Digital Analog Converter a and b

for controller NCC
device type controller
driver version 1.0

Each dac device (a or b) controls 2 analog outputs for external devices of the NCC controller.

3.5.1. Configure

NOTE

The dac device cannot be configured. The device covers a basic function of the controller.
The device is always active.

3.5.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

40 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



3.6. dist_xy - Distortion

3.5.3. Parametrize - General

Value sets the nominal voltage

Slew Rate sets the slew rate by which the voltage rises or drops

Settle Time sets the settling time waited after the nominal voltage stabilizes

Scale sets the voltage scale factor

Actual shows the actual voltage of the analog output. The value is calculated like this:
(Value + Offset) × Scale = Actual
If the Slew Rate is very small then the development of the actual voltage can be seen here

Offset sets the voltage offset

3.6. dist_xy - Distortion

for controller NCC, ASC
device type controller
driver version 1.0

The dist_xy device is used to correct scanfield distortions (see the Manual -- Scan Head).

NOTE

We strongly recommend you to use the wizard and follow the step by step instructions
in the Manual -- Scan Head -- Commissioning

.
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3.6.1. Configure

NOTE

The dist_xy device can not be configured. The device covers a basic function of the con-
troller. The device is always active.

3.6.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

If you do not use the dist_xy wizard(s) , see the Manual -- Scan Head , expert settings can be accessed
by double clicking the dist_xy device in the Devices window (see 2 Devices Window) and clicking on
the Expert Mode button. Be aware that these settings are difficult and we recommend you to use the
wizard(s)!

File name shows the name of the distortion file in use

Load

CAUTION

Pay attention to the sequence of steps.

A wrong sequence results in a wrong distortion correction.

Before loading a distortion *.dst file do the following: In the dist_xy2 device set the
Mode to Correction 65x65 except when using a dual scan head. Only in the latter case
set Mode to Distortion.

opens the Open dialog to open a distortion *.dst file
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3.6. dist_xy - Distortion

Save opens the Save As dialog to save a distortion *.dst file

Mode selects the mode of correction

Distortion for scan heads with flat field lens

Correction 65x65 for scan heads with focus translator

LH-Scale

CAUTION

Damage of the mirrors possible, if factor exceeds the value of 0.96

If factor exceeds the value of 0.96 then the mirrors can collide at high speeds in one
of the corners of the scan field, since the area for line handling is too small then.

We urgently recommend to leave the default value.

sets the factor for themaximal usable area of thewhole scan field. The not usable area is needed
for line handling

Rotation sets the rotation of the scan field counterclockwise regarding the scan head. For the de-
fault orientation of the scan field regarding the scan head at 0° (see 7.8 Coordinate System).
The values 0, 90, 180 and 270° with a range of ±3° are allowed. Note that the coordinate system
as seen in window Vector Edit is not affected by this. We recommend the default value

Aperture the aperture is only relevant whenMode is set to Correction 65x65. Specifies the aperture of
your scan head. For the aperture of 50mm two settings are possible. Please consult the order
confirmation to select the right one

List item Description
6mm, 11mm, 16mm, 21mm, 31mm, possible Apertures
50mm(066), 50mm(104)

Target Distance the target distance is only relevant if Mode is set to Correction 65x65. It specifies
the distance between the target and the bottom side of the scan head

3.6.3. Parametrize - Distortion

These tabs are only relevant if Mode is set to Distortion, i.e. for scan heads with flat field lens. The
settings in these tabs also specify the Testmark 2 for scan heads with focus translator

3.6.4. Parametrize - Distortion - Testmark

This tab is only relevant if Mode is set to Distortion, i.e. for scan heads with flat field lens. The settings
in this tab also specify the Testmark 2 for scan heads with focus translator
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3. Devices

Testmark

Type selects the type o fthe testmark

default available testmark (see figure and parameters below)

Corrected if this check box is selected then the testmark will be output corrected

Autostart if this check box is selected then the testmark will autostart. If it is unchecked,
the testmark will only be seleceted and can be previewed in Vector Editor (see 7.2 Preview
mode)

Activate starts the testmark

Mark Abort aborts the testmark

Test pattern

Squares sets the number of squares the scan field is divided in
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3.6. dist_xy - Distortion

Mark Squares sets how many of these squares will really be marked in case your target is
smaller than the scan field

3.6.5. Parametrize - Distortion - Measured Values

This tab is only relevant if Mode is set to Distortion, i.e. for scan heads with flat field lens. The settings
in this tab also specify the Testmark 2 for scan heads with focus translator

Measure Square select the largest completelymarked square of your testmark and type its number
into the Measure Square box. Use the number of tick marks of the testmark to determine the
right number

Six measured value boxes in the graphic measure the square that you selected in field Measure
Square and enter the values to the corresponding boxes shown on the screen. Pay attention to
the right orientation of the testmark. The tick marks of the testmark have to be oriented as
shown on the dialog
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3. Devices

3.6.6. Parametrize - Correction

Correction Editor opens the Correction window of the Correction Editor

Field Scale sets the field size. This parameter is only relevant ifMode is set to Correction 65x65, i.e. for
scan heads with focus translator

3.6.7. Parametrize - Raytracing 8V

3.6.8. Parametrize - Raytracing 8V - Testmark 1

This tab is only relevant whenMode is set to Correction 65x65, i.e. for scan heads with focus translator.
Specify the parameters for the initial focus translator testmark here. The testmark divides the scan
field into 2 concentric circles. The diameter of the circles can be specified in % of the scan field size
in case your target is smaller than the scan field (see the figure under Test Pattern).
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3.6. dist_xy - Distortion

Test Pattern

Size sets the size of Testmark 1

Inner Circle sets the inner circle size

Outer Circle sets the outer circle size

Activate outputs the testpattern

Measured Values
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3. Devices

Radii

Inner Circle sets the inner circle radius

Outer Circle sets the outer circle radius

Best Results

Inner Circle sets the angle of the best result on the inner circle

Outer Circle sets the angle of the best result on the outer circle

Calculate starts the calculation for the initial correction

3.6.9. Parametrize - Raytracing 8V - Testmark 2

This tab is only relevant if Mode is set to Correction 65x65, i.e. for scan heads with focus translator.
Specify the parameters for the X/Y pincushion testmark (Testmark 2) in 3.6.4 Parametrize - Distortion
- Testmark.
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3.6. dist_xy - Distortion

Activate starts the testmark

3.6.10. Parametrize - Raytracing 8V - Raytracing NCC

This tab is only relevant if Mode is set to Correction 65x65, i.e. for scan heads with focus translator.
Specify additional parameters to calculate the X/Y pincushion correction here.

Angle Scale

x sets the maximum X angle

y sets the maximum Y angle
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3. Devices

Mirror Thickness

x sets the mirror thickness in X direction

y sets the mirror thickness in Y direction

Angle Offset

x sets the X angle offset

y sets the Y angle offset

Calculate starts the calculation for the X/Y pincushion correction

3.6.11. Parametrize - Raytracing 8V - Testmark 3

This tab is only relevant when Mode is set to Correction 65x65, i.e. for scan heads with focus translator.
Specify the parameters for the final focus translator testmark here. The testmark outputs several
smaller versions ofTestmark 1 along the diagonal of one scan field quadrant (see figure andparameters
below).

Z Range

Min sets the minimal Z position

Max sets the maximal Z position

Degree to DAC Calculator calculates percentage of an angle. Just type in an angle in degrees and
its percentage will be calculated and displayed

Layout
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3.6. dist_xy - Distortion

Quadrant sets the mathematical quadrant of the scan field the testmark is executed in

Number of Circles sets the number of circles that are distributed on the diagonal. The first
circle will be marked on the origin of the coordinate system, the last will be marked in
the corner. The rest of the circles will be distributed equidistantly on the diagonal

Number of Marks sets the number of circles that will be marked beginning from the origin

Size sets the diameter of the circles

Dots per Circle the number of dots that will be marked on each circle

Activate starts the testmark

z-Mapping opens the z-Mapping window

Calculate starts the calculation for the final correction

3.6.12. Parametrize - Clipping

In this tab parameters can be specified to clip the scan field. Thismeans that outputwill be disallowed
outside the specified field.
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3. Devices

Offset

X sets the X offset

Y sets the Y offset

Fieldsize

X sets the field size in X direction

Y sets the field size in Y direction

Max Field sets Fieldsize X and Y to the highest possible value

3.7. dist_xy2 - Distortion

for controller NCC, ASC
device type controller
driver version 1.0

The dist_xy2 device can be used to set independent distortion data for the second head of e.g. a dual
scan head or a second scanhead that is connected to the same lead as the first scanhead.
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3.8. head - Scan Head

All parameters are described in device driver dist_xy - Distortion (see 3.6 dist_xy - Distortion). The
settings are identical.

3.8. head - Scan Head

for controller NCC, ASC
device type scan head
driver version 1.0

At the digital signal processor level this device driver distributes the line buffer data (LBE, Line Buffer
Entry) to the vector processors VP0 and VP1, see figure. Using a wobble matrix, line data can be
superimposed based on an oscillating circular movement. To be able of processing moving objects
(process-on-the-fly) an additional speed vector can be accounted for. This, as well as the wobble
matrix, affects the vector processor output of VP0 and VP1. The device driver applies the matrices
COR0 and COR1 for scan field correction to the resulting line data and in that way forms the wanted
output geometry. After that the scan field position can be corrected by adding an offset to the output.
In special cases the x- and/or y-axis output value can be set to a constant value.
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3. Devices

3.8.1. Configure

NOTE

The head device can not be configured. The device covers a basic function of the scan
head(s). The device is always active.

3.8.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.8.3. Parametrize - Wobble

The line width created directly by the laser is too small for some applications. Thus it is possible to
superimpose the linear movement of the scan head with a rotational movement (wobble) to widen
the line with.

Radius sets the wobble radius

Frequ sets the wobble frequency

Phase sets the angle for parallel projection of the wobble circle

Angle sets the projection plane direction

Type selects whether the wobble function is switched on or off

circular wobble is switched on

disabled wobble is switched off
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3.8. head - Scan Head

Direction selects the direction of the wobble movement

clockwise clockwise

counter-clockwise counter-clockwise

3.8.4. Parametrize - Offset

In this tab an offset can be compensated resulting e.g. from contorted mirror axes.

Head 0 Galvo Offset

dx sets the offset (in galvanometer angle percent) for the x galvo of head 0

dy sets the offset (in galvanometer angle percent) for the y galvo of head 0

Head 1 Galvo Offset

dx sets the offset (in galvanometer angle percent) for the x galvo of head 1

dy sets the offset (in galvanometer angle percent) for the y galvo of head 1

3.8.5. Parametrize - Channels

In this tab you can control, how the device driver handles line data for the single axes (X and Y of
head 0 as well as X and Y of head 1).
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3. Devices

NOTE

The settings in groups Head 0 and Head 1 are depending on the type of scan head con-
nected. In the Manual -- Scan Head -- Configure default pen and device driver you will find
which settings you need for your scan head.

Head 0 settings for the first head

Mode x

Normal the line data is handed over and output without further transformation

Reverse the line data will be output mirrored at the x-axis origin

Zero the x-axis output value stays zero

Min the x-axis output value stays at the lowest possible value (position -100%)

Max the x-axis output value stays at the highest possible value (position +100%)

Specified the x-axis output value stays at the specified value in Pos x and Pos y respec-
tively

Mode y

Normal the line data is handed over and output without further transformation

Reverse the line data will be output mirrored at the y-axis origin

Zero the y-axis output value stays zero

Min the y-axis output value stays at the lowest possible value (position -100%)

Max the y-axis output value stays at the highest possible value (position +100%)

Specified the axis output value stays at the specified value in Pos x and Pos y respectively
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3.8. head - Scan Head

Pos x sets the relative positions [%] of maximal and minimal deflection of the x-axis. Values
in a range between -100% and +100% are allowed. This corresponds to settings Min and
Max respectively in Mode x

Pos y sets the relative positions [%] of maximal and minimal deflection of the y-axis. Values
in a range between -100% and +100% are allowed. This corresponds to settings Min and
Max respectively in Mode y

Head 1 settings for the second head

Vector Processing

Copy VP0 Data if only 1 scan head is used or a 2nd scan head shall use the line data
from the vector processor VP0 of the 1st scan head then select this setting. The vector
processor VP1 of the 2nd scan head is deactivated and its scan field distortion will not
be corrected

VP1 Enable if a 2nd scan head shall produce independent output then select this set-
ting. In addition you have to set Scan Field Correction to COR1 Enabled to correct the
scan field distortion of the 2nd scan head

Scan Field Correction

Copy COR0 Data if only 1 scan head is used or a 2nd scan head shall use the line data
from the vector processor VP0 of the 1st scan head then select this setting. The scan
field distortion of the 2nd scan head will not be corrected. You should select Copy VP0
Data in Vector Processing to prevent needless calculations in vector processor VP1

COR1 Enabled if the scan field distortion of the 2nd scan head shall be corrected in-
dependently then select this setting. If both scan heads shall output the same line
data then in addition select Copy VP0 Data in Vector Processing. If both scan heads shall
output different line data then in addition select VP1 Enabled in Vector Processing

Output Channel Modifiers selects whether the Output Channel Modifiers of Head 0 will be
inherited to Head 1 or own Output Channel Modifiers (Mode x,Mode y and Pos x, Pos y) will be
applied

Copy OCM0 Data the settings of Head 0 will be copied

OCM1 Enabled own settings will be applied

Mode x see Mode x in group Head 0

Mode y see Mode x in group Head 0

Pos x see Pos x in group Head 0

Pos y see Pos y in group Head 0

3.8.6. Parametrize - Target

In this tab processing of still ormoving objects or targets can be set, e.g. objectsmoving on a conveyor
belt.

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 57



3. Devices

Type selects whether a still or moving target is processed

Still if you want to process motionless objects then select this setting. in this case all other
settings on this tab will be ignored

Moving if you want to process objects moving in an x-y-plane then select this setting

NOTE

If you selectMoving then the Job Start signal has to be triggered by a sensor at the
e.g. conveyor belt to synchronize the processing with the object's movement.

Motion selects how the motion is given

Constant velocity sets the targets's motion velocity to a constant in mm per second. The
fields Velocity x and Velocity y (see below) are activated

Measured velocity sets the targets's motion to a distance in mm. The fields Distance x and
Distance y (see below) are activated

Incremental update sets the targets's motion update to increments in mm. The fields Incre-
ment x and Increment y (see below) are activated

Offset x, Offset y sets the x and y processing offset relative to the target

Velocity x, Velocity y active, ifMotion is set to Constant velocity, sets the x and y component of the
target's speed vector

Distance x, Distance y active, if Motion is set to Measured velocity, sets the x and y component of
the target's distance

Increment x, Increment y active, if Motion is set to Incremental update, sets the x and y increment
of the target's way
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3.8. head - Scan Head

3.8.7. Parametrize - Home

In this tab the home position (origin) for both scan heads (Head 0 and 1, if available) can be set.

Head 0

Type selects, how the home position is defined

Center the home position is in the scan field center

First Marking Position the home position is at the coordinates the output starts at

Specified Position the home position is at the coordinates specified in x and y

Floating (both heads) the home position of both heads is at the coordinates specified
in x and y

x sets the home position x coordinate, see also Type

y sets the home position y coordinate, see also Type

Head 1

Type selects, how the home position is defined

Center the home position is in the scan field center

First Marking Position the home position is at the coordinates the output starts at

Specified Position the home position is at the coordinates specified in x and y

x sets the home position x coordinate, see also Type

y sets the home position y coordinate, see also Type
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3. Devices

3.9. scanhead - Scan Head

This device is used for extended runtime information from the scan head and for the configuration
and supervision of the tracking delay feature of the scan head via the Local Peripheral Chain (LPC)
protocol.

for controller ASC
device type scan head
driver version 1.0

3.9.1. Prerequisites

There are serveral prerequisites to use this device.

ARG_ASC_SYS Version 1.2.22 or higher
ARG_Inscript_FW Version 2.7.0.839 or higher
ARG_AC2_FW Version 4.30.283 or higher
IDB416 PCB version V31 or higher
ASC PCB version V21 or higher

3.9.2. Prerequisites - Detection of the scan head over LPC

There are 2 cables connected to the scan head.

The first is an Ethernet CAT5 cable (with RJ45 connectors) connected to the system controller that
carries the scanner position data via the High Speed Serial Interface (HSSI) protocol and additional
out-of-band data via the Local Peripheral Chain (LPC) protocol.

The second is the power cable that is either connected to the system controller's SPD PCB or to an-
other power source.

Aworking LPC connection is essential to run the scanheaddevice. In order to establish the connection
properly follow the appropriate startup procedure:

Prerequisities:
System controller and scan head are properly connected and switched off.

� If the scan head is powered by the system controllers SPD PCB then switch on the system con-
troller.
- OR -
If the scan head is powered by a power source other than the system controller's SPD PCB then:

Step 1 Switch on the scan head.

Step 2 Switch on the system controller.
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3.9. scanhead - Scan Head

CAUTION

Scan head power cycle -- OR -- disconnected Ethernet CAT5 cable

interrupts LPC connection

� Recover the LPC connection by the startup procedure described above.

3.9.3. Configure

dev Shows the detected scan heads. There was no scan head detected if this is empty.

ascVersion The PCB version of the ASC board.

countOfAxis The number of axis of the scan head you want to use.

detect If set to TRUE: tries to detect additional scan heads and adds them to dev.

3.9.4. Parametrize

ac2FirmwareVersion This shows the firmware version of the AC2 PCB inside the scan head.

ac2HardwareVersion This shows the PCB version of the AC2 PCB inside the scan head.

idbFirmwareVersion This shows the firmware version on the IDB416 interface PCB inside the scan
head.

idbHardwareVersion This shows the PCB version of the IDB416 interface PCB inside the scan head.

upTime This shows the total runtime of the scan head in seconds.

numberOfStarts This shows the total number of starts of the scan head.

autorecover This variable controls the behaviour upon a rising edge on the attention signal.

• If TRUE: The device will try to recover from failure state if attention is signalled.

• If FALSE: The device will not recover from failure state.

updateScanHeadInfo

• If TRUE: Communication between scan head and system controller is running when there
is NO job running.

• If FALSE: Communication between scan head and system controller is disabled. The values
under voltages, temperatures and adcValues will not be updated anymore.

updateScanHeadInfoWhileMarking

• If TRUE: Communication between scan head and system controller is running anytime,
also when there IS a job running.

• If FALSE: Communiction between scan head and system controller is disabled. The values
under voltages, temperatures and adcValues are not updated anymore.
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3.9.5. Parametrize - status

This parameter variables show the current state of the scan head.
If a certain variable is TRUE, this means that a below described state was entered or an event ocurred.

atUpTime Shows the uptime of the scan head at which the last state change was detected.

soaX Safe operating area X-channel was violated.

soaY Safe operating area Y-channel was violated.

fuseX Polyswitch X-channel was triggered.

fuseY Polyswitch Y-channel was triggered.

errorAz Error on ISTAMPCBwhich couldmean polyswitch was triggered or safe operating area was
violated.

axisLimit Axis limit was exceeded.

ampUnknown Unknown amplifier error.

supplyVoltage Supply voltage error.

supplyTransient Supply voltage transient.

boardOvertemp Maximum allowed PCB temperature was exceeded.

ampOvertemp Maximum allowed amplifier temperature was exceeded.

ampXDisabled Amplifier on X-channel was disabled.

ampXShutdown Forced shutdown of X-channel amplifier.

ampYDisabled Amplifier on Y-channel was disabled.

ampYShutdown Forced shutdown of Y-channel amplifier.

auxAxisDeactivated Auxiliary axis disabled. This is normal if you have a dual axis system.

ampAuxDisabled Amplifier for auxiliary axis is disabled.

3.9.6. Parametrize - voltages

This subtree shows you the current values of the internal voltages of the scan head.

+Ub Nominal value +24V

vdd Nominal value +15V

+5V Nominal value +5V

-Ub Nominal value -24V

vee Nominal value -15V

+3V3 Nominal value +3.3V

vref Nomianl value +2.5V
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3.9. scanhead - Scan Head

3.9.7. Parametrize - adcValues

This subtree shows you the current values of the position and error signals of the scan head.

xErr Control error on X-axis.
yErr Control error on Y-axis.
xPos X-axis Position [-100%;+100%].
yPos Y-axis Position [-100%;+100%].

3.9.8. Parametrize - temperatures

This subtree shows you the current temperatures inside the scan head.

tx X-channel amplifier temperature.
ty Y-channel amplifier temperature.
tu U-channel amplifier temperature.
tv V-channel amplifier temperature.
tPcb scan head pcb temperature.

3.9.9. Parametrize - trackingError

doCalibrate If TRUE: The tracking delay calibration procedure is triggered. The values in the sub-
trees sfN will be updated for the configured number of axis after the procedure is completed.

recordCalibrationResult If TRUE: The result of the calibration is saved on the controller. This
data could be used to do diagnosis of the scan head. The data is located under \\<ASC IP ad-
dress>\Data

• trackingErrorCalibration_fromAscToScanHead.bin: The data that is sent from the system con-
troller to the scan head.

• trackingErrorCalibration_fromScanHeadToAsc.bin: The data that is sent from the scan head
to the system controller.

safetyValue An integer value in the range of [0;10]. Whereby 0 signifies the least safe setting and
10 signifies the safest setting. Changing this value in the direction of saferwill cause the system
to be more sensitive in regard to control errors inside the scan head. This could mean that you
are more likely to get an error from the tracking delay supervision when you run the system at
higher process speeds. The default value is choosen to fulfill most customer requirements and
will reliably detect a catastrophic failure of the scan head hardware. So you most likely will
NOT have to modify this value.

disableSafety
• If TRUE: Errors from the tracking delay supervision subsystem will NOT cause a running
job to be aborted and will only print warning messages.

• If FALSE: Errors from the tracking delay supervision subsystemwill cause a running job to
be aborted and will print error messages.
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3.9.10. Parametrize - trackingError - sfN

scale The scaling factor for this subframe as determined by the calibration procedure.

offset The offset value for this subframe as determined by the calibration procedure.

delay The delay between set and real value for this subframe as determined by the calibration pro-
cedure.

minDelay Lower threshold for the delay value. If the calibrated delay is lower than this value, an
error is reported.

maxDelay Higher threshold for the delay value. If the calibrated delay is higher than this value, an
error is reported.

currentAccumulator Last read value of the error accumulator. This is in the range of [0.0;1.0].

maxAccumulator Maximum read value of the error accumulator. This is in the range of [0.0;1.0].
This value will be reset to 0.0 when safetyValue or one of the advanced parameters for this sub-
frame is changed.

accumulatorErrorThreshold If currentAccumulator is higher than this value, an error will be re-
ported.

enableMonitoring

• If TRUE: The tracking errorwill be supervised for this subframe and errorswill be reported
if currentAccumulator is higher than accumulatorErrorThreshold.

• If FALSE: The tracking error will NOT be supervised for this subframe on no errors will be
reported.

3.9.11. Parametrize - trackingError - sfN - advanced

Internal settings for the tracking error supervision process. This should normally not be changed by
the customer.

weight Error weight.

decay Decay factor for value the error accumulator.

maxErrorLimit Maximum limit for the new error value that will be added to the error accumulator.

3.9.12. Messages

This section describes messages that are displayed by the device.

3.9.13. Messages - Failed to communicate with scan head

This is a fatal and non-recoverable error. To leave this state, you have to restart the system.
Possible causes are:
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• Failure during LPC read: LPC connection to the scan head was lost.

• Failure during LPC write: LPC connection to the scan head was lost.

• Failure during access to ring buffer: Error during access to the ring buffer that is used for commu-
cation between scan head and system controller.

3.9.14. Messages - Internal error in scan head

Possible causes are:

• Error was caused by AC2: Error states of the AC2 PCB are included in this message.

• Error was caused by IDB due to HSSI communication problem: Please check cabling to the scan head.

• Unknown error source: Source of this error could not be determined.

3.9.15. Messages - Timeout while communicating with scan head

This is a fatal and non-recoverable error. To leave this state, you have to restart the system.
A possible error source can be the AC2 PCB.

3.9.16. Messages - Error during access to scan head via LPC

This is a fatal and non-recoverable error. To leave this state, you have to restart the system.
A possible error source can be the IDB416 PCB.

3.9.17. Messages - Maximum allowed error limit exceeded for subframe N

• Value of the error accumulator is higher than the configured threshold.

• Control loop error / tracking delay error is too high.

• Processing speed could be too high for this scan head hardware.

• safetyValue is set too low.

• Possible damage of the scan head hardware.

3.9.18. Messages - Number of axis is higher than the number of configured channels

• Please check HSSI configuration: The number of configured HSSI channels must be greater or
equal to countOfAxis.

• Check that countOfAxis is set to the correct number of axis of the scan head.
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3.9.19. Messages - Tracking delay out of bounds for subframe N

• Ocurrs directly after running the calibration procedure.
• Please check that the configuration variable countOfAxis is set correctly.
• The calibration procedure yielded a delay value that is out of the configured thresholds.
• Possible damage of the scan head hardware.

3.9.20. Mapping of axis names to subframe number

Standard 2D head
Subframe number Axis name

SF0 X
SF1 Y
SF2 n/a
SF3 n/a

Twin head (Twin Squirrel)
Subframe number Axis name

SF0 X Head 0
SF1 Y Head 0
SF2 X Head 1
SF3 Y Head 1

Elephant 3D
Subframe number Axis name

SF0 X
SF1 Y
SF2 Z
SF3 unused or optional attenuator

Precession Elephant
Subframe number Axis name

SF0 X
SF1 Y
SF2 Z
SF3 unused or optional attenuator
SF4 Phi (Displacement parallel to X axis)
SF5 Theta (Displacement parallel to Y axis)

Pivot scanner
Subframe number Axis name

SF0 XX
SF1 Y
SF2 Z
SF3 X
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3.10. linepar - Line Parameters

for controller NCC, ASC
device type scan head
driver version 1.0

The linepar device summarizes parameters needed for handling different line types.

How InScript handles lines in general Galvanometers move the mirrors in the deflection sys-
tem. A nominal position is transmitted to the mirrors. An analog PID-regulator controls the nominal
position. Themirrors have an inertia. Therefore, at high speeds, the deflected laser beam lags behind
the nominal position with the value of the tracking error. Additional errors exist as the laser beam
can not be switched on and off free of inertia. These errors cause a result with inadequate quality.
ARGES deflection systems correct these errors using several special methods.

If a line is output between points A and B then InScript defines 2 additional points A' and B'. These
points lie on the extensions of the line in both directions. The distance between A' and A is called
Head. The distance between B and B' is called Tail. To draw a line from A to B, InScript needs the
distance between A' and B'.

If the distance between A' and A is long enough then the speed reaches the wanted value and the
difference between nominal and actual position is fixed on this distance. This difference is constant
for this speed, i.e. on the distance between A and B the tracking error is constant. But the laser beam
must not be switched on until point A is crossed by the nominal position by the value of the tracking
error. Therefore the laser beam has to be switched on with a delay that corresponds to the tracking
error. This delay is called the ON delay. Corresponding to this the laser beam must not be switched
off until point B is crossed by the nominal position by the value of the tracking error. This delay is
called the OFF delay. This means that ON and OFF delay should be positive and equal in value.

In practice the laser beam switch on and off delays (e.g. the shutter delay) have to be taken in account
in addition to this value. As these delays may differ, the optimal values for ON delay and OFF delay
do not have to be identical. With a long delay for switching the laser beam on an off, it may even be
necessary to switch on the laser beam while the nominal position is not even reached which would
then result in a negative value of the ON delay.

Line types To make optimal output of lines and polygons possible several line types have to be
set apart. Most of the outlines are approximated by polygons in practice, i.e. even simple shapes,
e.g. rectangles or circles, are represented by a sequence of lines, where the end point of the 1st line is
the start point of the 2nd line, the endpoint of the 2nd line is the start point of the 3rd line and so on.
Between lines that follow each other there is always an angle between 0° and 180°. Depending on this
angle the joint in the polygon will be output with 1 of 3 methods. These methods correspond to the
types Normal Joint, Joint 1 and Joint 2. In addition there are the types Open End and Dot. The following
list describes basic terms and methods of line output.
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Open End lines of type Open End are lines, where the start and end points do not fall on start or
end points of other lines. In the figure above can be seen that times for Head and Tail as well as
times for ON delay and OFF delay have to be set

Normal Joint lines of type Normal Joint are a sequence of lines, where the end point of one line falls
on the start point of the next line. As long as the angle between the lines is obtuse, it is not
necessary to correct the path by setting Head and Tail times. The laser beam is not switched off
during such paths

Joint 1 lines of type Joint 1 are a sequence of lines, where the end point of a line falls on the start
point of the next line. Atmiddle angles between the lines the path has to be corrected by setting
a Tail time. Thus the time is taken in account that is needed until the actual laser beam position
reaches the start point of the next line. After that, the nominal position jumps to that point
without taking additional time for Head in account. The laser beam is not switched off during
such paths

Joint 2 lines of type Joint 2 are a sequence of lines, where the end point of a line falls on the start
point of the next line. At pointed angles between the lines the path has to be corrected by
setting the time forHead and Tail. If the end point B' of the line is reached, the nominal position
is set to the start point A' of the next line. The laser beam is switched off, as soon as the point
is reached on OFF delay and switched on again, if the nominal position reaches the point at ON
delay. Joint 2 is a sequence of lines with type Open End.

Dot lines of type Dot are a special case of a line. Points A and B are at the same position. For the ON
time the laser beam stays on this position. The time for Head specifies the breaking distance.

3.10.1. Configure

NOTE

The linepar device can not be configured. The device covers a basic function of the scan
head(s). The device is always active.

3.10.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.10.3. Parametrize - Common

Processing speed and angles for line types can be set on this tab.
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Processing Speed sets the processing speed
Angles set the threshold angles between the joint types Normal Joint, Joint 1 and Joint 2

3.10.4. Parametrize - Open End

In this tab set parameters for output of the Open End line type.

Speed
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Jump sets the jump speed between points where no processing is performed, i.e. when the
laser beam is off

Head sets the speed on distance Head

Tail sets the speed on distance Tail

Select Speed Head in general it is useful for precise line output to select a speed for dis-
tances Head and Tail that equals to the Processing Speed. To optimize the line output in
rare cases or to create special effects, it may be necessary to set these speeds indepen-
dent of the processing speed. If you want to do so then select Specified in Sel. Speed Head
and/or Sel. Speed Tail

Specified specify the speed on distance Head independently in Speed Head

Processing Speed speed on distance Head equals to the Processing Speed

Select Speed Tail see Sel. Speed Head

Specified specify the speed on distance Tail independently in Speed Tail

Processing Speed speed on distance Tail equals to the Processing Speed

Time

Head sets an additional delay for Head

Tail sets an additional delay for Tail

ON Delay sets an additional delay for ON Delay

OFF Delay sets an additional delay for OFF Delay

Sample Points if this check box is selected then sample points are displayed in the simulation

Play animation plays the simulation with the set parameters. This way it is easier to understand
the effect of single parameters and to find the settings for an optimal result. If the speed is set
high you may not see the animated points anymore

3.10.5. Parametrize - Joint 1

In this tab parameters for output of the Joint 1 line type are set.
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Speed

Tail sets the speed on distance Tail

Select Speed Tail in general it is useful for precise line output to select a speed for distances
Head and Tail that equals to the Processing Speed. To optimize the line output in rare cases
or to create special effects, it may be necessary to set these speeds independently from
the processing speed. If you want to do so then select Specified in Sel. Speed Tail

Specified specify the speed independently on distance Tail in Speed Tail

Processing Speed speed on distance Tail equals to the Processing Speed

Time

Tail sets an additional delay for Tail

Sample Points if this check box is selected then the sample points are displayed in the simulation

Play animation plays the simulation with the set parameters. This way it is easier to understand
the effect of single parameters and to find the settings for an optimal result. If the speed is set
high you may not see the animated points anymore

3.10.6. Parametrize - Joint 2

In this tab parameters for output of the Joint 2 line type are set. As this type equals a sequence of lines
of type Open End, this tab contains the same settings as the Open End tab, see section 3.10.4 Parametrize
- Open End.
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3.10.7. Parametrize - Dot

In this tab parameters for output of the Dot line type are set. The output of dots is special as in this
case the processing speed is zero and the laser beam stays on one position for some time. A typical
application of this function is the drilling of holes.

Speed
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Jump sets the jump speed between points where no processing is performed, i.e. when the
laser beam is off

Time

Head sets the time waited after a jump. This is the mirror settling time plus the laser beam
ON delay. In general this time is longer than with other line types as the speed has to be
completely reduced to zero and not to processing speed

Tail sets the laser beam OFF delay. The tracking error with a stationary processing on a fixed
position is zero. This is why contrary to the other line types no negative values can be
used here

ON sets the exposure time ("ON-Time") for dots

3.10.8. Parametrize - Raster

In this tab parameters for converting lines to raster units in render server (see 5.13.2 Edit - Render
Server) are set.

Foreground Color using this button, you can set the foreground color and alpha channel (trans-
parency) of the lines that are used in render server. Although a laser can't output colors, these
settigns can be used to create greyscales on rendered bitmaps

Background Color using this button, you can set the background color and alpha channel (trans-
parency) of the background that are used in render server - this setting is only used, if you
render a bitmap into a bitmap in color. Although a laser can't output colors, these settigns can
be used to create greyscales on rendered bitmaps
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Char Alignment sets the alignment of characters using the render server. Depending on this set-
tings, either character sizes or the distances between characters are equally spaced in relation
to the available pixel resolution

Float the distance of the characters is calculated independent of the underlying pixel resolu-
tion

High res pixels the distance of the characters is calculated based on the oversampled pixel
resolution (a higher internal resolution to create anti-aliasing etc.). Thismeans that char-
acters may look different but the distances between characters are identical

Low res pixels the distance of the characters is calculated based on the original pixel reso-
lution. This means that characters look identical but the distances between characters
vary

Linewidth width of the render server lines

Linewidth unit

mm the width of the render server lines is given in mm

pixel the width of the render server lines is given in pixel

Line Caps also see the graphics on the Raster tab

Butt the line ends are cut-off

Round the line ends have a rounded end

Square the line ends have a square end

Line Joints also see the graphics on the Raster tab

Miter the joints between lines have no transition

Round the joints between lines are rounded

Bevel the joints between lines are pointed

Miter Limit here you can limit the extent of the tip formed by two lines to prevent excessively
pointed joints on very acute angles

3.10.9. Parametrize - Ramping

Ramping can be used mainly for overlapping laser markings to prevent e.g excessive material re-
moval, scorching etc. while cutting or welding.

In this tab parameters for ramping are set. Here you can set all aspects of a line's ramping geometry.
In former versions of InScript you had to choose a DAC (Digital to Analaog Converter) for ramping.
Now, if the set up laser uses a DAC for its power control, this DAC is automatically chosen by the
ramping interface.

NOTE

If the laser has no DAC for its power control, ramping has no effect!
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Ramping can be set over the time or over the length of a laser output. Please choose the Specification
of your up- and/or down-ramping according to your process.

Mode here you can choose Linear multiplying to use ramping or None to use the power setting of the
laser driver

Power Factor the power factor is the maximum of the ramp. The factor is a fraction of the power
that is set in the laser driver (e.g. if the Power in the laser driver is set to 90% and Start Power
Factor is set to 50%, the maximum of te ramp will be 45% power)

Rising Ramp

Start Power Factor sets the start power factor of the ramping. The factor is a fraction of the
power that is set in the laser driver

Rise Time sets the time in which the the power rises

Rise Length sets the length in which the the power rises
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Specification

Time the value in Rise Time is used. The up-ramping is carried out over a stretch of time

Length the value in Rise Length is used. The up-ramping is carried out over a specific
length

Falling Ramp

End Power Factor sets the end power factor of the ramping. The factor is a fraction of the
power that is set in the laser driver

Fall Time sets the time in which the the power falls

Fall Length sets the length in which the the power falls

Specification

Time the value in Fall Time is used. The down-ramping is carried out over a stretch of
time

Length the value in Fall Length is used. The down-ramping is carried out over a specific
length

Particularities On older Firmware versions you will only be able to set the ramping over time. Full
ramping over time and length is supported from firmware≥ v2.7.0.443.TP and InScript≥ v2.10.2.1938
on.
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3.11. Coherent Avia

for controller NCC, ASC
device type laser
driver version 1.13.18.2

This device driver makes functions and parameters available to control lasers of the AVIA family in
InScript via a serial interface. Lasers of the AVIA family are compact diode-pumped solid-state Q-
switched lasers providing ultraviolet or infrared output with pulse repetition rates from single shot
to 100 kHz.

NOTE

For details how to operate your laser type, consult the corresponding manual.

3.11.1. Configure

Laser type

List item Description
355-1500, 355-1800, 355-3000, 355-4500, 355-7000, 355-X, selects the laser type
266-3000, Ultra 350, Ultra 500, Ultra 1000, Ultra 1500,
Ultra2000,

Controller port
COM A NCC serial interface COM A
COM B NCC or ASC serial interface COM B
COM C ASC serial interface COM C

Baud rate

List item Description
1200, 4800, 9600, selects the serial interface baud rate. If the baud rate exceeds the
19200, 38400 capability of the selected laser type then the baud rate will

automatically be adjusted
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Command format

Short selects the short command format

Long selects the long command format

Has shutter if the selected laser type has an optional shutter then this check box is selectable and
you can use the shutter by selecting this checkbox. If the selected laser is equipped with a
shutter by default then the check box is automatically selected

Version shows the power supply firmware version of the laser

3.11.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.11.3. Parametrize - Power

Lock current/power sets whether to hold the diode current stable or the optical power and shows
the setting returned by the laser

Current lock holds the diode current stable

Power lock holds the optical power stable

Diode current

Nominal sets the nominal average diode current and shows the setting returned by the laser
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Actual shows the actual average diode current

Maximum shows the average diode currentmaximumcalculated from the average diode cur-
rent

Delta shows the difference between diode currents

Average delta shows the average difference between diode currents

Optical output

UV power shows the ultraviolet average power

IR power shows the infrared average power

Pulse energy on if this check box is selected then the pulse energy can be set manually

Pulse energy sets nominal pulse energy and shows the setting returned by the laser

Pulse UV energy shows the actual ultraviolet pulse energy

Pulse IR energy shows the infrared pulse energy

Diode if this check box is selected then the diodes will be switched on. If the LED is lit, the diodes
are on

Shutter

Shutter Open/Close opens or closes the shutter and shows the setting returned by the laser

Interlock shows the status of the shutter interlock

3.11.4. Parametrize - Q-Switch
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Trigger

Trigger mode sets the trigger mode and shows the setting returned by the laser

Internal uses the laser internal trigger with the parameters in group Trigger. The EX-
TERNAL ENABLE input on the power supply rear panel must be connected and active

External uses an external triggerwith the parameters in group External Trigger (here the
controller board oscillator). The EXTERNAL ENABLE input on the power supply rear
panel must be connected and active

Front panel uses the laser internal trigger with the parameters in group Trigger. The
EXTERNAL ENABLE input on the power supply rear panel does not need to be con-
nected. Gated operation is not possible

Pulse control sets the pulse control and shows the setting returned by the laser

Pulsing off switches the Q-switch pulsing off

Pulsing on switches the Q-switch pulsing on

Pulse mode sets the pulse mode and shows the setting returned by the laser

Continuous generates pulses continuously

Burst generates bursts of pulses

CW alignment generates continuous wave output at low power level for alignment
purposes

Repetition rate sets the repetition rate and shows the setting returned by the laser

Burst pulses sets the number of pulses in a burst and shows the setting returned by the laser

RF state shows whether the RF module is on or off

Burst mode sets the burst mode and shows the setting returned by the laser

Continuous sets burst mode to continuous

Pulsed sets burst mode to pulsed

External trigger summarizes parameters to specify the type of signal which will be generated by
the controller board oscillator at the Gate output

Gate control sets the gate control

Always off oscillator stays permanently off

Always on oscillator stays permanently on

Auto oscillator will be automatically switched on and off

Gate mode sets the type of signal at the controller board gate output

Gated osc pulses will be generated with the parameters Frequency and On time

Gate a single on/off signal will be generated

Frequency sets the frequency to trigger the Q-switch

On time sets the signal on time to trigger the Q-switch
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3.11.5. Parametrize - Pulse Control

Pulse control mode sets the pulse control mode and shows the setting returned by the laser. For
detailed information consult the corresponding laser manual

Pulse Delete prevents the first laser pulse in any burst from having significantly higher en-
ergy than following pulses

ThermEQ turns off the RF between pulses and provides a solution to the laser rod thermal
problem (thermal lens)

PulseEQ if Trigger mode is set to Internal then PulseEQ works exactly like ThermEQ. If Trigger
mode is set to External then the internal repetition rate determines the pulse energy for
external trigger frequencies smaller than the internal repetition rate

PulseTrack if Trigger mode is set to Internal then PulseTrack works exactly like ThermEQ. If
Trigger mode is set to External then the width of the trigger pulse determines the laser
pulse energy independent to the repetition rate

Pulse delete auto calc switches the delay time calculation to off or to automatic and shows the
setting returned by the laser

Manual the delay time has to be set manually

Automatic the delay time will be calculated automatically. The delay time will not change
until a change of the repetition rate is made

Delay Time sets the delay time and shows the setting returned by the laser. If the Pulse control mode
is set to Pulse Delete then this is the pulse delete re-pump time. If the Pulse control mode is set to
ThermEQ, PulseEQ or PulseTrack then this is the ThermEQ delay time
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Delay time offset shows the delay time offset. If the Pulse control mode is set to Pulse Delete then this
is the pulse delete time offset. If the Pulse control mode is set to ThermEQ, PulseEQ or PulseTrack
then this is the ThermEQ delay time offset

Ramp slope shows the ramp slope. If the Pulse control mode is set to Pulse Delete then this is the
ramp slope percentage for pulse delete. If the Pulse control mode is set to ThermEQ, PulseEQ or
PulseTrack then this is the ramp slope percentage for ThermEQ

Ramp time offset shows the ramp time offset

RF level shows the RF level

RF off time shows the RF off time

Minimum RF off time shows the minimum RF off time. If Pulse control mode is set to Pulse Delete or
ThermEQ then the RF has to be off that time at least while Q-switching

Maximum RF on time shows the maximum RF on time. If Pulse control mode is set to ThermEQ,
PulseEQ or PulseTrack then the RF may be on that time at most while Q-switching

Pulse Delete Parameters (Mode 1) summarizes all parameters if the Pulse control mode is set to
Pulse Delete

Delay time sets the re-pump time and shows the setting returned by the laser

Delay time offset shows the pulse delete offset time

Ramp slope shows the pulse delete ramp slope

ThermEQ/PulseEQ/PulseTrack Parameters (Mode 2) summarizes all parameters if the Pulse
control mode is set to ThermEQ, PulseEQ or PulseTrack

Delay time sets the ThermEQ delay time and shows the setting returned by the laser

Delay time offset shows the ThermEQ offset time

Ramp slope shows the ThermEQ ramp slope

82 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



3.11. Coherent Avia

3.11.6. Parametrize - Diodes

Diode 1, Diode 2 summarizes parameters regarding the diodes

Current A shows the current

Heat sink temp shows the heat sink temperature

Operating hours shows the operating hours

Optimizing Optimize starts the optimizing process. If the LED is lit the optimization is run-
ning

Photo cell shows the photo cell voltage, this is used to check if the diode is good

Rated current shows the set current maximum

Rated current factor value / 1000h. show the degeneration rate (a value of e.g. 0. 01 is a 1%
increase in maximum current per 1000 hours)

Rated current max. shows the calculated currentmaximum. This value results from the set
current maximum, the increase in rated current by the degeneration rate and operating
hours of the diode

Temp. nominal sets the nominal temperature and shows the setting returned by the laser

Temp. actual shows the actual temperature

Temp. drive shows the temperature drive

Servo status shows the servo status

Voltage shows the voltage

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 83



3. Devices

Current drive shows the current drive

Serial number shows the serial number

3.11.7. Parametrize - Power Saver

If the laser is not in use for a time then the device driver can automatically switch the laser to standby
and switch it completely off to save the diodes.

Laser Standby

Enable if this check box is selected then switching from power state On to Standby is enabled

Timeout sets the time that will be waited when the laser is not used, before switching it to
power state Standby

Power sets the power at which the laser is operated in power state Standby

Laser Off

Enable if this check box is selected then switching from power state Standby to Off is enabled

Timeout sets the time that will be waited when the laser is not used, before switching it to
power state Off
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3.11.8. Parametrize - Interlock

Table a green LED shows the status is OK. A red LED shows that there is or was an error.

The LEDs in column Current show the current status of the corresponding interlock.

The LEDs in columnHistory show the status of the corresponding interlock since the last active
acknowledge by the user. Because error conditionsmay automatically disappear, it is necessary
to store the interlock history.

Column Interlock show the interlock short names. For troubleshooting consult the laser man-
ual.

AutoReady if this check box is selected and a Job Start signal occurs then the driver gets the system
automatically ready and begins with processing. When the driver is e.g. in power state Standby
then it automatically switches to power state On and opens the laser shutter. As soon as the
system is ready processing begins automatically.

WARNING

Visible and invisible laser radiation

Serious injury or property damagemayoccurwhenprocessing is automatically started.

You are allowed to select this check box only if the optical path is completely encap-
sulated in a enclosed machine. Entries into the machine have to be equipped with
approved interlock switches. If an entry is opened then the interlock switch has to
shut the laser safety shutter by force with the highest priority. The machine has to
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comply with the laser safety regulations for manufacturing. The machine has to be
approved by an authorized representative for laser safety.

AutoRecover if this check box is selected and an error occurs then InScript executes a reset of the
laser and tries that way to fix the error. As result the system may automatically continue with
processing.

WARNING

Visible and invisible laser radiation

Serious injury or property damagemay occurwhen processing is automatically con-
tinued.

You are allowed to select this check box only if the optical path is completely encap-
sulated in a enclosed machine. Entries into the machine have to be equipped with
approved interlock switches. If an entry is opened then the interlock switch has to
shut the laser safety shutter by force with the highest priority. The machine has to
comply with the laser safety regulations for manufacturing. The machine has to be
approved by an authorized representative for laser safety.

3.11.9. Parametrize - Configuration

Crystal Position

Set spot position sets the spot position on the crystal and shows the setting returned by the
laser

Previous, Next moves the crystal to the previous or next spot position
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CAUTION

Laser beam on moving crystal

Crystal damage

� Set Diodes to off and Pulse control to Pulsing off prior to moving the crystal
to a new spot position.

Spot status number shows the spot status number

Spot status sets the spots status and shows the setting returned by the laser

good spot is still good and may be used

bad spot is bad and must not be used

used spot is or was in use and may be used

Motor position X shows the motor position for the X-direction

Motor position Y shows the motor position for the Y-direction

Spot in use for x h shows the operating hours the spot on the crystal is in use

Crystal warning elapsed x h shows the time elapsed since the last crystal warning

Crystal warning interval x h shows the interval between crystal warnings

ThermaTrack (TM)

Dioptric motor moving if the LED is lit then the dioptric motor is moving

Dioptric power optimizing Optimize power starts the power optimizing process. If the
LED is lit the optimization process is running

Motor position sets the motor position and shows the setting returned by the laser
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3.11.10. Parametrize - Temperature

Second (SHG), Third (THG) and Fourth Harmonic Generator (FHG)
Optimizing Optimize starts the optimizing process. If the LED is lit the optimization pro-

cess is running
Fine optimizing Fine optimize starts the fine optimizing process (only THG). If the LED is

lit the optimization process is running
Nominal sets the nominal temperature and shows the setting returned by the laser
Actual shows the actual temperature
Drive shows the drive
Servo status shows the servo status
Heater sets the status of the crystal heater and shows the setting returned by the laser (only

SHG and FHG)
Cooldown cools down the crystal for laser shutdown procedure
Heating heats the crystal for laser operation

Laser rod, Resonator
Nominal shows the nominal temperature returned by the laser
Actual shows the actual temperature
Drive shows the drive
Servo status shows the servo status
Servo tight lock if this LED is lit then the temperature servo tight lock is active
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3.11.11. Parametrize - Status

Power supply

Software version shows the power supply firmware version

Serial number shows the power supply serial number

Operating hours shows the power supply operating hours

Base plate temperature shows the power supply base plate temperature

Battery voltage shows the backup battery voltage. Parts in this laser need to be cooled down
after operation. In case the regular shutdown procedure is accidentally not executed the
backup battery ensures a controlled cool down

Operation Key switch shows whether the key switch is on or off

Operation mode shows the operation status the laser is in at the moment

Service switch shows whether the laser is in user or service mode

Lock out front panel if this check box is selected the power supply front panel is locked out
from operation control. The LED shows the setting returned by the laser. A lit LED means
that the front panel is locked out

Menu exit exits the actual menu to the next higher menu at the power supply front panel

Reset system resets the laser

Laser head

Software version shows the laser head firmware version
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Serial number shows the laser head serial number

Operating hours shows the laser head operating hours

3.12. BP Aion / Coherent Prisma

for controller NCC, ASC
device type laser
driver version 1.35.8.13

This device driver makes functions and parameters available to control lasers of the AION family in
InScript via a serial interface. The Coherent Prisma laser is identical in construction - so you can also
use this driver for Coherent Prisma (there is an instance of this driver for Coherent Prisma in InScript
driver butmomentarily it does not have an own user interface). Lasers of the AION/Prisma family are
diode-pumped solid-state lasers providing ultraviolet, visible or infrared outputwith pulse repetition
rates from CW, single shot to 100 kHz and short pulse width from 5 to 30 ns.

NOTE

For details how to operate your laser type, consult the corresponding manual.

3.12.1. Configure

Laser type selects the laser type

List item Description
Industrial-1064-8-Y, -1064-8-V, -1064-8-Y-LP, -1064-8-V-LP, supported laser types
-1064-16-Y, -1064-16-Y-Wafermark, -1064-16-V,
-1064-16-Y-LP, -1064-16-V-LP, -532-4-Y, -532-4-V, -532-8-Y,
-532-8-V, -355-1-Y, -355-1-V, -355-3-Y

Serial interface selects the serial interface on the controller board
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COM A NCC serial interface COM A

COM B NCC or ASC serial interface COM B

COM C ASC serial interface COM C

Baud rate selects the baud rate

List item Description
1200, 4800, 9600, possible baud rates. If the baud rate exceeds the capability of the
19200, 38400 selected laser type then the baud rate will automatically be adjusted

Information

Laser type shows the laser type returned by the laser

Laser serial shows the lasers serial number

Software version shows the lasers software version

Software date shows when the laser software was created

Particularities As long as the BP Aion driver is not activated, you can set the compatibility mode
of the laser driver using Xplorer (see 8.5 Xplorer). Open Xplorer () and enter path drv.BP Aion.bp
aion to the Xplorer. Then adjust the settings under Select variable Compatibility to BP Aion, Coherent
Prisma 2.0 or Coherent Prisma 2.0 with 1.034f emulation exactly to the value, that you set at your laser.

3.12.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

NOTE

Depending on the laser type set in the configuration some of the parameters may not be
available.
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3.12.3. Parametrize - General

Diode Current

Nominal sets the nominal diode current

Maximal shows the maximal diode current that can be set

Actual shows the actual diode current returned by the laser

Minimal indicates the minimal diode current that can be set

Shutter

Open opens the shutter

Close closes the shutter

Actual shows the actual shutter status

Laser Pointer

Nominal switches the laser pointer off or on and indicates its actual status

Off laser pointer off

On laser pointer on

Actual shows whether the laser pointer is on or off

Parameter Set
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Load sets the parameter set to be loaded.

Load Button click here to load the set

Actual shows the parameter set in use

Save sets the number under which the actual set parameters will be saved

Save Button click here to save the set under the name set under Save

Info

Comm. status shows the status of the communication between laser and controller board

Temperature shows the actual water temperature

Emission gate shows the emission gate status

Error shows the active error returned by the laser

Warning shows the active warnings returned by the laser

3.12.4. Parametrize - Q-Switch

Laser External Oscillator

Gate control sets the gate control

Always off oscillator stays permanently off

Always on oscillator stays permanently on
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Auto oscillator will be automatically switched on and off

Gate mode sets the type of signal at the controller board gate output

Gated Osc pulses will be generated with the parameters Frequency and On time

Gate a single on-/off-signal will be generated

Frequency sets the frequency to trigger the Q-switch

On time sets the signal On time to trigger theQ-switch

First Pulse Suppression

Nominal level sets the nominal first pulse level

Actual level indicates the actual first pulse level returned by the laser

Nominal ramp sets the nominal first pulse ramp

Actual ramp indicates the actual first pulse ramp returned by the laser

Laser Internal Oscillator

Pulse mode sets the pulse mode

CW generates CW laser output

Pulsed generates pulsed laser output

Nominal freq. sets the nominal frequency

Maximal shows the maximal frequency that can be set

Actual shows the actual frequency

Minimal shows the minimal frequency that can be set
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3.12.5. Parametrize - Configuration

Laser Control

Diode current sets bywhich interface the diode current is controlled and indicates the actual
interface returned by the laser

No change indicates the interface is actually not in change

Internal the parameter is controlled via the lasers front panel

User the parameter is controlled via the lasers user interface

RS 232 the parameter is controlled via the lasers serial interface

Pulse frequency sets by which interface the pulse frequency is controlled and indicates the
actual control returned by the laser. For possible settings see Diode current

First pulse level sets by which interface the first pulse level is controlled and indicates the
actual control returned by the laser. For possible settings see Diode current

First pulse ramp sets by which interface the first pulse ramp is controlled and indicates the
actual control returned by the laser. For possible settings see Diode current

Emission gate sets bywhich interface the emission gate is controlled and indicates the actual
control returned by the laser. For possible settings see Diode current

Trigger active sets the active signal level of the lasers trigger input

Active low the signal is low active
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Active high the signal is high active

Gate active sets the active signal level of the lasers gate input

Active low the signal is low active

Active high the signal is high active

Device Behavior

AutoReady if this check box is selected and a Job Start signal occurs then the driver gets the
system automatically ready and begins with processing. When the driver is e.g. in power
state Standby then it automatically switches to power state On and opens the laser shutter.
As soon as the system is ready processing begins automatically.

WARNING

Visible and invisible laser radiation

Serious injury or property damage may occur when processing is automatically
started.

You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

AutoRecover if this check box is selected and an error occurs then InScript executes a reset
of the laser and tries that way to fix the error. As result the system may automatically
continue with processing.

WARNING

Visible and invisible laser radiation

Serious injury or property damage may occur when processing is automatically
continued.

You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.
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3.12.6. Parametrize - Power Saver

Laser On → Standby

Enable if this check box is selected then switching from power state On to Standby is enabled

After sets the time that will be waited and the laser is not used, before switching it to power
state Standby

Diode current sets the diode current which will be used in power state Standby

Laser Standby → Off

Enable if this check box is selected then switching from power state Standby to Off is enabled

After sets the time that will be waited and the laser is not used, before switching it to power
state Off
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3.12.7. Parametrize - Power Meter

Input Values

Diode current sets the diode current that will be used for measurement

Pulse frequency sets the pulse frequency that will be used for measurement

First delay sets the delay between the command to measure and the first measurement
List item Description
60, 90, 120, 150, 180, 210, 240, 270 delays that can be set

Measure every sets the interval between measurements

Measurement

Power shows the power measured with the parameters in group Input Values
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3.12.8. Parametrize - Info

Laser type shows the laser type returned by the laser

Laser serial number shows the lasers serial number

Software version shows the lasers software version

Software date shows the date the laser software was created

System shows the lasers system status

Hours shows the lasers operating hours

3.13. configurable laser - Configurable Laser

for controller ASC
device type laser
driver version 1.10.2.19

The configurable laser device can be configured to control lasers that have no specific laser driver in
InScript. Please consult the documentation for each laser to configure the driver,

Here are some examples for signals that may occur while controlling a laser:
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FPS

GATED OSC SYNC CONT

GATED OSC SYNC CUTOFF

GATED OSC ASYNC CONT

GATED OSC ASYNC CUTOFF

GATE SYNC CONT

GATE SYNC CUTOFF

GATE ASYNC CONT

GATE (ASYNC CUTOFF)

OSC CONTINUOUS

Figure 2: Laser Timing Diagrams

In the description of the configurale laser driver these diagrams are referenced as examples.

List item Signal Description
GATE(ASYNC CUTOFF) gate Asynchroneous to oscillator.

GATED OSC ASYNC CUTOFF oscillator Cut off by asynchroneous gate signal
GATE ASYNC CONT gate Asynchroneous and continuous to oscillator
GATED OSC ASYNC CONT oscillator No cut-off by asynchroneous gate signal

GATE SYNC CONT gate Synchroneous to oscillator
GATED OSC SYNC CONT oscillator No cut-off by synchroneous gate signal
GATE SYNC CUTOFF gate Synchroneous and continuous to oscillator
GATED OSC SYNC CUTOFF oscillator Cut off by synchroneous gate signal

FPS first pulse suppression Offset by FPS duration and inversion time

OSC CONTINUOUS oscillator Continuous oscillator signal

3.13.1. Configure

See 3.1.1 When Configuring Inactive Devices for common gui elements while configuring the device.

AutoConfigure if this function is used, a set of standard values is set
Off no auto configuration is executed
When activating auto configuration is executed, when the configurable laser driver is acti-

vated
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Now auto configuration is executed instantaneous

3.13.2. Configure - Gate

Gate

Config

None mode is set to ungated

Gate mode is set to gated

Signal sets the Gate signal to one of the High Speed Outputs HSO0 to HSO7 (see the Manual --
NCC System Controller)

Polarity sets the polarity to Active=High or Active=Low

Sync sets the synchronisation to Asynchronous or Synchronous to Oscillator. See 2 Laser Timing
Diagrams for sync and async examples

3.13.3. Configure - Osc/Frequency

The Oscillator frequency is set in this tab.
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Frequency

Min. Frequency sets the minimum oscillator frequency

Max. Frequency sets the maximum oscillator frequency

3.13.4. Configure - Osc/Internal

Using this tab, controller-internal (or laser-external) oscillator settings of the ASC can be set.
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Internal

Min. Duty Cycle sets the minimum Duty Cycle. The duty cycle is the fraction of time that a
system is in an "active" state. It is the duration that the function is active high (normally
when the signal is greater than zero) divided by the period of the function

Max. Duty Cycle sets the maximum Duty Cycle

Min. Time On sets the minimum On time of the signal

Max. Time On sets the maximum On time of the signal

Min. Time Off sets the minimum Off time of the signal

Max. Time Off sets the maximum Off time of the signal

Continuous

Config

None no continuous signal

Continuous see 2 Laser Timing Diagrams OSC CONTINOUS

Gated see any of the GATED examples in 2 Laser Timing Diagrams

CO2 reserved for later use

Signal sets the signal to one of the High Speed Outputs HSO0 to HSO7 (see the Manual -- NCC
System Controller)

Polarity sets the polarity to Active=High or Active=Low

Substitution set None for no substitution and Osc if oscillation must not be completely inter-
rupted (e.g. for quicker response of fibre laser and bitmap modulation)
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Gated

Config

None no gated signal

GatedOsc see any of the GATED examples in 2 Laser Timing Diagrams

Signal sets the signal to one of the High Speed Outputs HSO0 to HSO7 (see the Manual -- NCC
System Controller)

Polarity sets the polarity to Active=High or Active=Low

Sync run Asynchronous or Synchronous to Gate. See 2 Laser Timing Diagrams for sync and async
examples

3.13.5. Configure - Osc/External

Using this tab, controller-external (or laser-internal) oscillator settings of the laser can be set.

External

DAC the oscillator source can be set to None for no external oscillator or to DAC A to DAC D to
use the DAC A FB to DAC D FB (digital-to-analog converter) pins of the DVI laser connector
(see the Manual -- NCC System Controller)

Scale oscillator scale from 0 V/kHz - 10 V/kHz. Control voltage of the selected DAC output,
depending on the used laser
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3.13.6. Configure - FPS

Q-switched lasers often have a first pulse in a string of pulses that contains a much greater energy
level than those that follow. To prevent this, First Pulse Supression settings can be made in this tab.

FPS

Config first pulse suppression can be set to None or it can be realized using a Delayed Gate
signal depending on the used laser

Signal sets the FPS signal to one of the High Speed Outputs HSO0 to HSO7 (see the Manual --
NCC System Controller)

Polarity sets the polarity to Active=High or Active=Low

3.13.7. Configure - Modulation

Modulation is normally used for grayscale pixel modulation.
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Digital

Config digital modulation can be set to None or it can be switched on using Digital

Signal sets the modulation signal to one of the High Speed Outputs HSO0 to HSO7 (see the
Manual -- NCC System Controller)

Polarity sets the polarity to Active=High or Active=Low

Min. Duty Cycle sets the minimum Duty Cycle. The duty cycle is the fraction of time that a
system is in an "active" state. It is the duration that the function is active high (normally
when the signal is greater than zero) divided by the period of the function

Max. Duty Cycle sets the maximum Duty Cycle

Min. Time On sets the minimum On time of the signal

Max. Time On sets the maximum On time of the signal

Min. Time Off sets the minimum Off time of the signal

Max. Time Off sets the maximum Off time of the signal

Analog these values set the modulation of the single pulse energy tha is normally used for bitmap
grayscale

DAC analogmodulation can be set toNone or it can be switched on using DACA through DAC D
to choose the digital-to-analog converter that shall be used

Min. Power At voltage for the pulse energy that does the minimum change (e.g. black, if
the material gets lighter the more energie is applied or white, if the material gets darker)
of the material for grayscale output
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Max. Power At voltage for the pulse energy that does the maximum change (e.g. white, if
the material gets lighter the more energie is applied or black, if the material gets darker)
of the material for greyscale output

3.13.8. Configure - Power

The settings in this tab set how the used voltage determines the laser power in percent.

The figure above shows how the sum of the settings of this tab influence the resulting power values.

Power
Range Lo sets the lower threshold in percent of the laser power set under Analog /Min. Power

At that will be used as 0% in all power settings in percent

Range Hi sets the upper threshold in percent of the laser power set underAnalog /Max. Power
At that will be used as 100% in all power settings in percent

Analog
DAC analog power can be set to None or it can be switched on using DAC A through DAC D to

choose the digital-to-analog converter that shall be used

Min. Power At set minimum laser power to this voltage

Max. Power At set maximum laser power to this voltage
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3.13.9. Configure - Pointing Laser

Pointing Laser

Port the port for the pointing laser can be set toNone or it can be set to theASEUser device (see
3.36 ase user io - USER Inputs and Outputs), to the High Speed IOs HSIO (see the Manual --
NCC System Controller) or 16 IOs of the the Generic Laser Adapter GLA (see 3.13.16 Configure
- GLA)

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to High->On or Low->On

108 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



3.13. configurable laser - Configurable Laser

3.13.10. Configure - Shutter/Safety

Output
Port the port for the safety shutter can be set to None or it can be set to the ASE User device

(see 3.36 ase user io - USER Inputs andOutputs), to theHigh Speed IOsHSIO (see theManual
-- NCC System Controller) or 16 IOs of the Generic Laser Adapter GLA (see 3.13.16 Configure
- GLA)

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to High->Open or Low->Open

Status Open
Port the port for the "safety shutter open" status can be set to None or it can be set to the ASE

User device (see 3.36 ase user io - USER Inputs and Outputs), to the High Speed IOs HSIO
(see the Manual -- NCC System Controller) or 16 IOs of the Generic Laser Adapter GLA (see
3.13.16 Configure - GLA)

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to High=Open or Low=Open

Status Closed
Port the port for the "safety shutter closed" status can be set to None or it can be set to the

ASE User device (see 3.36 ase user io - USER Inputs and Outputs), to the High Speed IOs
HSIO (see the Manual -- NCC System Controller) or 16 IOs of the Generic Laser Adapter GLA
(see 3.13.16 Configure - GLA)

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 109



3. Devices

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to High=Closed or Low=Closed

3.13.11. Configure - Shutter/Process

Output

Port the port for the process shutter can be set to None or it can be set to the ASE User device
(see 3.36 ase user io - USER Inputs andOutputs), to theHigh Speed IOsHSIO (see theManual
-- NCC System Controller) or 16 IOs of the Generic Laser Adapter GLA (see 3.13.16 Configure
- GLA)

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to High->Open or Low->Open

Status Open

Port the port for the "process shutter open" status can be set to None or it can be set to the
ASE User device (see 3.36 ase user io - USER Inputs and Outputs), to the High Speed IOs
HSIO (see the Manual -- NCC System Controller) or 16 IOs of the Generic Laser Adapter GLA
(see 3.13.16 Configure - GLA)

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to High=Open or Low=Open
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Status Closed

Port the port for the "process shutter closed" status can be set to None or it can be set to the
ASE User device (see 3.36 ase user io - USER Inputs and Outputs), to the High Speed IOs
HSIO (see the Manual -- NCC System Controller) or 16 IOs of the Generic Laser Adapter GLA
(see 3.13.16 Configure - GLA)

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to High=Closed or Low=Closed

3.13.12. Configure - Interlock - A-H

This tab configures interlock signals.

A - H

Port the port for the each Interlock (A-H) can be set to None or it can be set to the ASE User
device (see 3.36 ase user io - USER Inputs and Outputs), to the High Speed IOs HSIO (see
theManual -- NCC System Controller) or 16 IOs of the Generic Laser Adapter GLA (see 3.13.16
Configure - GLA)

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to Fault->High or Fault->Low

Name sets a human-readable name for each interlock
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3.13.13. Configure - Aux/DAC

Up to four auxiliary DAC outputs can be set in this tab.

DAC

Analog1 analog1 can be set to None if no DAC (digital-to-analog converter) is needed or to
DAC A to DAC D to use the DAC A FB to DAC D FB pins of the DVI laser connector (see the
Manual -- NCC System Controller)

Analog2 analog2 can be set to None if no DAC (digital-to-analog converter) is needed or to
DAC A to DAC D to use the DAC A FB to DAC D FB pins of the DVI laser connector (see the
Manual -- NCC System Controller)

Analog3 analog3 can be set to None if no DAC (digital-to-analog converter) is needed or to
DAC A to DAC D to use the DAC A FB to DAC D FB pins of the DVI laser connector (see the
Manual -- NCC System Controller)

Analog4 analog4 can be set to None if no DAC (digital-to-analog converter) is needed or to
DAC A to DAC D to use the DAC A FB to DAC D FB pins of the DVI laser connector (see the
Manual -- NCC System Controller)

3.13.14. Configure - Aux/OUT

Auxiliary outputs can be set in this tab.
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Out 0-3 up to four auxiliary outputs can be configured

Port the port for the auxiliary output can be set to None or it can be set to the ASE User device
(see 3.36 ase user io - USER Inputs andOutputs), to theHigh Speed IOsHSIO (see theManual
-- NCC System Controller) or 16 IOs of the Generic Laser Adapter GLA (see 3.13.16 Configure
- GLA)

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to Active high or Active low

Name sets a human-readable name for each output

3.13.15. Configure - Aux/IN

in this tab auxiliary inputs can be set.
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In 0-3 up to four auxiliary inputs can be configured

Port the port for the auxiliary input can be set to None or it can be set to the ASE User device
(see 3.36 ase user io - USER Inputs andOutputs), to theHigh Speed IOsHSIO (see theManual
-- NCC System Controller) or 16 IOs of the Generic Laser Adapter GLA (see 3.13.16 Configure
- GLA)

Signal determines which signal of the selected Port shall be used (e.g. HSIO and 6 wouldmean
HSIO6)

Polarity sets the polarity to Active high or Active low

Name sets a human-readable name for each input

3.13.16. Configure - GLA

These seetings are only effective, if a GLA or Generic Laser Adapter is connected. The GLA module is
able to distribute the interfaces that can be lead through the DVI-I adapter to generic interfaces. The
GLA provides 16 In, Out and High Current IOs. The high current IOs (HCOs/HCIOs) can be controlled
by the high speed IOs (HSIOs).
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GLA

Auto Detect if this check box is selected a Generic Laser Adapter will be auto detected

Device ID this field shows the ID of the detected GLA or -1 if no GLA was detected

3.13.17. Configure - Comm

To use a COM port for communication with a laser the COM port can be set up under this tab.
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RS232

Port

None no COM port

COM A, COM B, COM C selects a serial interface on the ASC controller (normally
COM A is not supported without additional hardware)

Baudrate selects the baudrate of the selected Port

List item Description
300, 600, 1200, selects the serial interface baud rate. If the baud rate exceeds the
2400, 4800, 9600, capability of the selected laser type then the baud rate will
19200, 38400 automatically be adjusted, if possible

Data Bits selects the data bits

List item Description
7, 8, 9 number of data bits

Parity

List item Description
None, Odd, Even parity bit that is added to ensure that the number of bits

with the value one in a set of bits is even or odd

Stop Bits selects the number of stop bits
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List item Description
1, 2 number of stop bits

Handshake selects the flow control mechanism

List item Description
none no handshake is used
XON/XOFF software flow control XON/XOFF is used
RTS/CTS hardware flow control RTS/CTS is used

System Safety Requirement if this check box is selected the system checks if there is still
communication over the port

3.13.18. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

These parameters will be accessible after the device is activated (see 2.6.4 Activate).

If resources (like ports) are multiply assigned or if there are other resource conflicts, then InScript
will display an error message while the device is activated (this is only working properly, if the I/O
that re-uses an already assigned port is fully implemented).
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3.13.19. Parametrize - Control

Power sets the laser power to % (see also 3.13.8 Configure - Power how power in % is defined)

Pointing Laser switches the pointing laser On or Off

Power

Power Int internal Power in % (specified value eventually modified by power saver etc.)

Power Act actual power in % (the last value given to the d/a converter)

Settle sets the power settle time, which is the time the laser needs to get to ready state after
a change occured

Shutter

Safety Shutter set safety shutter to Closed or Open (desired state)

Safety Shutter Int current state, the safety shutter is Closed or Open (e.g. the powersaver or
an interlock may force the shutter to stay closed)

Process Shutter set process shutter to Closed or Open (desired state)

Process Shutter Int currently, the process shutter is Closed or Open (e.g. the powersaver or
an interlock may force the shutter to stay closed)

3.13.20. Parametrize - Osc

Oscillator values can be set in this tab.
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Gate

Control

List item Description
Auto the oscillator is automatically switched on and off
Always on the oscillator is always on
Always off the oscillator is always off

Mode

List item Description
Gate a single on/off signal is generated
Gated Osc pulses are generated with the parameters Frequency and On-Time

(see 2 Laser Timing Diagrams for gated osc examples)

Osc

Settle settle time until the laser gets ready after control power was changed

Frequency sets the frequency the laser-internal Q-switch modulator is operated with. This setting
defines the laser frequency, when Gated Osc is selected in the Mode list

OnTime sets the oscillator ON-time

3.13.21. Parametrize - FPS

Q-switched lasers often have a first pulse in a string of pulses that contains a much greater energy
level than those that follow. To prevent this, a FPS or First Pulse Suppression can be activated.
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The following figure shows Duration and Inversion Time:

Duration sets the FPS duration

Inv Time sets the FPS inversion time

Control

List item Description
Auto the FPS is automatically switched on and off
Always on the FPS is always on
Always off the FPS is always off

3.13.22. Parametrize - Ageing

In this tab you can record data about the ageing of lamps or diodes and use this data to automatically
compensate the power loss resulting from this ageing. In addition the offset depending on power can
be recorded to minimize the influence of power on the pointing stability of the laser.
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Current current ageing values are displayed
Age shows the actual number of operating hours of the lamp or diode
Power shows the corrected pumping power
Offset X shows the corrected offset in X direction
Offset Y shows the corrected offset in Y direction

Ageing
Enable if this check box is selected then the specified characteristics are used to compensate

for power loss and offset
Selection

Selection dropdown Enter the values into the table beneath

List item Description
Power the pumping power is shown over the number of operating hours
Offset X the offset in X direction is shown over the pumping power
Offset Y the offset in Y direction is shown over the pumping power

Selection list the entries for Power, Offset X or Offset Y depending on what is currently se-
lected in the Selection dropdown are displayed in this list. You can add New entries, Rename
or Delete existing entries or Dump the parameters of an entry by right clicking on it and
selecting an action from the popupmenu. The entries are sorted by the value in the name
column

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 121



3. Devices

3.13.23. Parametrize - Stats

Current Time

Power expired time in power on state since last reset

Reset (Power) Clicking this button resets Power to 0 after a prompt for confirmation. If the
reset is caused by a Lamp change, you can enter an Automatic Service Database Entry in
the next dialog (see 3.24 Automatic Service Database Entry)

Standby expired time in standby since last reset

Reset (Standby) Clicking this button resets Standby to 0 after a prompt for confirmation

Total Time

Power total time in power on state

Standby total time in standby

3.13.24. Parametrize - Power Saver

This tab specifies the power saver abilities of the connected laser device. Full power saver sequence
would be Standby→ Down→ Off.
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Standby

Standby Enable if this check box is selected power state Standby is enabled

Standby Timeout Standby timeout until the laser goes to standbt in seconds

Standby Power laser power while the laser is in Standby

Down

Down Enable if this check box is selected power state Down is enabled

Down Timeout Down timeout until the laser goes down in seconds

Down Power laser power while the laser is down

Off

Off Enable if this check box is selected power state Off is enabled

Off Timeout Off timeout until the laser is switched off in seconds

Power Saver

State displays the current power saver state
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3.13.25. Parametrize - Start Conditions

Start Conditions settings for the Start Conditions
Power State settings for the Power State

Power if the power state is Power then the system starts
Ignored the power state is ignored

Safety Shutter settings for the safety shutter
Open if the safety shutter is Open then the system starts
Ignored the safety shutter is ignored

Process Shutter settings for the process shutter
Open if the process shutter is Open then the system starts
Ignored the process shutter is ignored

Autostart automatic re-start conditions

WARNING

Visible and invisible laser radiation
Serious injury or property damagemayoccurwhenprocessing is automatically started.
You are allowed to use Auto Recover and Auto Ready only if the optical path is com-
pletely encapsulated in a enclosed machine. Entries into the machine have to be
equipped with approved interlock switches. If an entry is opened then the interlock
switch has to shut the laser safety shutter by force with the highest priority. The
machine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.
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Auto Recover if this check box is selected and an error occurs then InScript executes a reset
of the laser and tries to fix the error. As result the system may automatically continue
with processing

Auto Ready if this check box is selected and a Job Start signal occurs then the driver gets
the system automatically ready and begins with processing. When the driver is e.g. in
power state Standby then it automatically switches to power state On and opens the laser
shutter. As soon as the system is ready processing begins automatically

3.13.26. Parametrize - Fail Conditions

Fail Conditions

Safety Shutter

Ignored condition is ignored

Open if the saftey shutter is open, processing is aborted

Process Shutter

Ignored condition is ignored

Open if the process shutter is open, processing is aborted

3.13.27. Parametrize - GLA Status

This tab shows the status of the ARGES GLA (ARGES Generic Laser Adapter) IOs and voltages.
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GLA functional groups:

Inputs status of the 5V TTL Inputs

0-15 if one of these check boxes is set, then an input signal is high

Outputs status of the 5V TTL Outputs

0-15 if one of these check boxes is set, then an output signal is high

Power

DVI Power OK
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3.14. ipg ylp - Pulsed Ytterbium Fiber Laser by IPG

List item Description
Unknown status of the DVI power is unknown
No DVI power is not OK
Yes DVI power is OK

5V Power OK

List item Description
Unknown status of the 5V power is unknown
No 5V power is not OK
Yes 5V power is OK

12V Power OK

List item Description
Unknown status of the 12V power is unknown
No 12V power is not OK
Yes 12V power is OK

HCO status of the HC-IOs

0-3 if one of these check boxes is selected, then a high current input of the HC-IOs is high

LVDS low-voltage differential signaling, or LVDS, is an electrical signaling system that can run at
very high speeds over twisted-pair copper cables

Ignore LVDS Errors if this check box is selected LVDS errors are ignored to be able to keep
the driver working even if a signal error occurs. This switch can be used for test purposes

3.14. ipg ylp - Pulsed Ytterbium Fiber Laser by IPG

for controller ASC
device type laser
driver version 1.10.2.19

NOTE

For details how to operate your laser type, consult the corresponding manual.
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3.14.1. Configure

Min.Pulse Repetition Rate sets the lower limit of the pulse repetition rate

Max.Pulse Repetition Rate sets the upper limit of the pulse repetition rate

3.14.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.14.3. Parametrize - Control

Power sets the pumping power. This is a relative value and not standardized to the optical output
power. Hence 100% are not the same as maximal optical output power. For example optical
laser activity may occur not until the pumping power reaches 35% and the maximal optical
output powermaybe already reached at a pumpingpower of 70%. Set the desired optical output
power at the power supply according to the characteristic diagram which accompanies your
laser. Pay attention to the lamp current

Pulse Repetition Rate sets the pulse repetition rate

Processing Laser selects how the processing laser is controlled
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Always off the processing laser beam will be always off

Always on the processing laser beam will be always on

Auto the processing laser beam will be automatically switched on and off by InScript

Pointing Laser Off switches the pointing laser off

On switches the pointing laser on

Error Text shows error text

3.15. Spectra-Physics Explorer

for controller ASC
device type laser
driver version 1.10.2.19

NOTE

For details how to operate your laser type, consult the corresponding manual.

3.15.1. Configure

There are no specific settings to configure the Spectra-Physics Explorer laser.

3.15.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.
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3.15.3. Parametrize - Control

Power laser power in %

Diode 1 Source Select selects the source for Diode 1's power

Source

Explorer the source for the power is provided by the laser

ASC the source for the power is provided by the ASC controller
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3.15.4. Parametrize - Osc

In this tab oscillator settings are done.

Gate settings for the Gate control

Control Gate control

Auto oscillator is automatically switched on/off

Always off oscillator is always off

Always on oscillator is always on

Mode Mode control

Gate single on/off signal is generated

Gated Osc pulses are generatedwith the parameters Frequency and On-Time to the right

PRF Source select settings for pulse repetition rate

Source choose the source for the pulse repetition rate

Explorer the pulse repetition rate is provided by the laser

ASC the pulse repetition rate is provided by the ASC controller

Frequency sets the frequency the laser internal Q-switch modulator is operated with. This setting
defines the laser frequency, when Gated Osc is selected in the Mode list

On-Time sets the oscillator ON-time, when Gated Osc is selected in the Mode list
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3.15.5. Parametrize - Power Saver

Power Saver settings for the Power Saver

State current Power Saver State

Standby Enable if this check box is selected then switching from state On to Standby is en-
abled. Standby mode lowers the current of the diode laser below the threshold for laser
output but keeps the diode laser in a state of readiness. All other Explorer components
are maintained at operating temperature.

Standby Timeout time to wait until the Laser is switched to Standby (if it is not used)

Standby Power power of the Laser in mode Standby

Down Enable if this check box is selected then switching from state Standby to Down is en-
abled (this functionality will be implemented later)

Down Timeout time to wait until the Laser is switched to Down (if it is not used) (this func-
tionality will be implemented later)

Down Power power of the Laser inmode Down (this functionality will be implemented later)

Off Enable if this check box is selected then switching from state Down to Off is enabled.
Off is equivalent to the laser’s “Sleep” mode. It turns off the Q-switch, the temperature
control of the diode and crystals, and the diode laser.

Off Timeout time to wait until the Laser is switched to Off (if it is not used)
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3.15.6. Parametrize - Start Conditions

Interlock Start Conditions settings for the Interlock Start Conditions

Emission

Ignored condition is ignored

OK if the state applies, Job Start is enabled (∼ Interlock A)

Ready

Ignored condition is ignored

OK if the state applies, Job Start is enabled (∼ Interlock B)

Interlock Fault

Ignored condition is ignored

OK the state applies, Job Start is enabled (∼ Interlock C)

Start Conditions settings for the Start Conditions

WARNING

Visible and invisible laser radiation

Serious injury or property damagemayoccurwhenprocessing is automatically started.

You are allowed to use Auto Recover and Auto Ready only if the optical path is com-
pletely encapsulated in a enclosed machine. Entries into the machine have to be
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equipped with approved interlock switches. If an entry is opened then the interlock
switch has to shut the laser safety shutter by force with the highest priority. The
machine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

Auto Recover if this check box is selected and an error occurs then InScript executes a reset
of the laser and tries to fix the error. As result the system may automatically continue
with processing

Auto Ready if this check box is selected and a Job Start signal occurs then the driver gets
the system automatically ready and begins with processing. When the driver is e.g. in
power state Standby then it automatically switches to power state On and opens the laser
shutter. As soon as the system is ready processing begins automatically

Power State settings for the Power State

Power if the power state is Power then the system starts

Ignored the power state is ignored

3.15.7. Parametrize - Fail Conditions

Interlock Fail Conditions settings for the Interlock Fail Conditions

Emission

Ignored condition is ignored
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Failure if the state applies, processing is aborted

Ready

Ignored condition is ignored

Failure if the state applies, processing is aborted

Interlock Fault

Ignored condition is ignored

Failure if the state applies, processing is aborted

3.15.8. Parametrize - Status

Interlock Status shows the Interlock Status

Emission current status of interlock fail condition Emission (possible are "OK", "Failure", "Un-
defined" and "Unused")

Ready current status of interlock fail condition Ready (possible are "OK", "Failure", "Unde-
fined" and "Unused")

Interlock Fault current status of interlock fail condition Interlock Fault (possible are "OK",
"Failure", "Undefined" and "Unused")
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3.15.9. Parametrize - Explorer/General

Explorer
Fault fault code. See Laser User’s Manual for more information
Fault Name string counterpart of the Fault Code
Baud current communication speed (baud rate)
Set WatchDog sets the software watchdog alert time in seconds (0 - 110; 0 = watchdog timer

off).
WatchDog current watchdog timer for RS-232 communication in seconds. If the Explorer

has not received commands within the specified time, the laser will turn off
Head Hours laser head hours of operation in h
Power Supply Hours power supply hours in h. Incremented every 6 minutes that power is

supplied
Current Config Param Set current config parameter set user set #n, n=1-4
Boot Config Param Set sets which parameter set is to activate the next time the system is

booted (user set #n, n=1-4)
Analog Port Signal status of a function available through the analog interface. See Laser

User’s Manual for more information
Analog Port Config polarity of the analog interface lines (0 - 255). See Laser User’s Manual

for more information
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Burst Counts number of Burst Counts (0 - 4000, 0 = exit burst mode)

First Pulse Delay FPS delay time in ms (0 - 2000, 0 = exit FPS mode)

Laser Emission status Byte bit0: Laser emission

Command Error status Byte bit2: Command error

System Error status Byte bit3: System error

Event Summary status Byte bit5: Event summary

Operational status Byte bit7: Operational

Set Auto On sets Auto-On mode for remote control if checked

Auto On current Auto-On mode

Set Standby sets Standby mode if checked

Standby current Standby mode

Remote Mode sets Remote if checked / Local mode if unchecked

Burst Sync is trigger output extended for burst duration

Laser On is laser ON or OFF

3.15.10. Parametrize - Explorer/Identification
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Identification

Manufacturer name of the Manufacturer in the product identification string

Model name of the Model in the product identification string

SN Laser Head serial number of the Laser Head in the product identification string

SN Power Supply serial number of the Power Supply in the product identification string

FW Laser Head firmware of the Laser Head in the product identification string

FW Power Supply firmware of the Power Supply in the product identification string

3.15.11. Parametrize - Explorer/Temperature

Temperature

Current Diode Temperature current temperature of the diode laser in °C

Current Diode Temperature Set temperature setting of the diode laser in °C

Current SHG Temperature current temperature of the SHG Crystal in counts (100 4000)

Current SHG Temperature Set last commanded temperature for the SHGCrystal in counts

Current THG Temperature current temperature of the THG Crystal in counts

Current THG Temperature Set last commanded temperature for theTHGCrystal in counts
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Laser Head Temperature temperature of the Laser Head in °C

Fan Control Mode current Fan control mode

Fan Control Speed percentage of the fan maximum voltage (13V) in %

Fan Control Mode Set sets Fan control mode (0=drive mode (percentage of the voltage),
1=Control mode (speed dependent on laser head temperature)) (this functionality will be
implemented later)

Fan Control Speed Set set the fan speed in % of the fan maximum voltage (13V) (this func-
tionality will be implemented later)

Laser Fan Control Temperature laser fan control temperature in °C (this functionalitywill
be implemented later)

3.15.12. Parametrize - Explorer/Diode 1

Diode 1 Set sets the diode laser current in A

Diode 1 Source Select sets the source of the Diode 1 current

Explorer the diode 1 current is provided by the laser

ASC the diode 1 current is provided by the ASC controller

Diode 1 shows parameters of Diode 1

Current Set last commanded diode laser current in A
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Current actual diode laser current in A
Current Power actual diode laser current in % of the diode current limit
Maximum diode laser current limit in A
Standby diode laser standby current in A
Hours diode laser operating hours in h

3.15.13. Parametrize - Explorer/Q-Switch

PRF Set sets the Pulse Repetition Rate in Hz (0 = change to an external Qswitch trigger source; no
emission will occur until a TTL signal is provided on pin 21 to trigger the laser)

PRF Source Select
Explorer the pulse repetition rate is provided by the laser
ASC the pulse repetition rate is provided by the ASC controller

Q-Switch
Q-Sw Pulse Repetition Frequency current value of the PRF in Hz
Q-Sw Pulse Repetition Frequency Set last commanded value for the PRF in Hz
Q-Sw Min. Pulse Repetition Frequency minimum pulse repetition frequency in Hz
Q-Sw Max. Pulse Repetition Frequency maximum pulse repetition frequency in Hz
Q-Sw Pulse Count pulse count
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3.15.14. Parametrize - Explorer/Pulse Energy

Pulse Energy

Energy actual pulse energy in µJ
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3.15.15. Parametrize - Explorer/Status

Compatibility

Hardware Mismatch “COMPATIBILITY” Register bit0: PCB versions of power supply and
laser head do not match

Laser Head Software Mismatch “COMPATIBILITY” Register bit2: power supply software
does not match the laser head software version

Temp. Controller A SW Mismatch “COMPATIBILITY” Register bit3: power supply soft-
ware does not match the software version of the temperature controller A

Temp. Controller B SW Mismatch “COMPATIBILITY” Register bit4: power supply soft-
ware does not match the software version of the temperature controller B

Head

Communication error “HEAD” Register bit0: an error occurred while communicating with
the laser head

Configuration error “HEAD” Register bit1: an error occurred while retrieving or updating
the configuration parameters of the laser head

PCB Overtemp Error “HEAD” Register bit2: maximum printed-circuit board temperature
was exceeded (laser off)

RF Power Error “HEAD” Register bit3: Q-switch does not work properly
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Heatsink Overtemp Error “HEAD” Register bit4: maximum heatsink temperature was ex-
ceeded (laser off)

Q-Switch Timing Error “HEAD” Register bit5: invalid Q-switch timing parameters (not las-
ing)

Heatsink Undertemp Error “HEAD” Register bit6: heatsink temperature is below the mini-
mum of 18°C (typical); the laser system remains fully operational

Invalid Model Error “HEAD” Register bit7: internal model setting does not match the in-
stalled software

Head Not Connected Error “HEAD” Register bit8: no laser head detected by the software

Events

User Interlock System Events Condition Register bit0: user interlock is activated

Key Interlock System Events Condition Register bit1: keyswitch is OFF

Keylock System Events Condition Register bit2: keyswitch reset is necessary (this condition
can only occur if Auto-On mode is disabled)

System Boot System Events Condition Register bit3: Notification: the laser system has been
booted

Software Watchdog System Events Condition Register bit4: software watchdog for commu-
nication between the laser system and the host computer is tripped

Hardware Watchdog System Events Condition Register bit5: system has rebooted because
the hardware watchdog was activated

Operational

Standby Active SystemOperational Condition Register bit0: Standbymode is active (by soft-
ware/external analog signal)

Burst Busy System Operational Condition Register bit1: Burst mode is activated and a burst
is being carried out

Sleep Mode System Operational Condition Register bit3: Sleep mode is activated (the Q-
switch and TECs are switched off). All serial commands besides status queries will be
rejected.

Gate System Operational Condition Register bit5: Gate signal is being applied to the analog
port

External Diode Current System Operational Condition Register bit6: external diode cur-
rent control is activated (pin 18 of the analog port)

Sync Over Burst System Operational Condition Register bit7: SYNC pulse duration is ex-
tended to include the whole burst sequence

External Trigger System Operational Condition Register bit10: external triggering mode is
activated

First Pulse Suppression SystemOperational Condition Register bit11: FPSmode is activated
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Laser Warmup System Operational Condition Register bit12: laser system is warming up

Pulse Energy Setting System Operational Condition Register bit13: automatic pulse energy
adjustment is taking place (typical duration is 2 - 5 seconds)

Burst Enabled SystemOperational ConditionRegister bit14: burstmode is enabled, i.e., burst
counts is set to <n> counts

Analog Enabled System Operational Condition Register bit15: Explorer laser system is in
analog mode

System

Parameter Set Error SystemConditionRegister bit0: a problemwith the configuration set(s)
occurred (communication error, invalid checksums)

Laser Head Error System Condition Register bit1: a problem with the laser head occurred
(communication error, temperature, etc.)

Temperature Controller Error SystemCondition Register bit2: temperature controller fail-
ure (crystals and/or diode laser)

Laser Diode Error System Condition Register bit3: a problem with the diode laser occurred
(e.g., cable, current control)

Analog Interface Error System Condition Register bit4: a problemwith the analog port pins
occurred

Power Supply Error System Condition Register bit5: a problem with the power supply oc-
curred

Hard-/Software Mismatch System Condition Register bit14: updated software does not
match the hardware found

3.16. sl4xx and sl8xx

for controller NCC→ legacy device: not included in the standard NCC firmware
device type laser
driver version 1.0

The lasers of series SL4xx and SL8xx are flash lamp pumped pulse lasers Q-switched by a pockels cell.
The laser types cover a range of 50 to 100Hz in repetition rate and emit laser radiation with pulse
lengths from 6 to 8ns and a wavelength of 1064nm. As an option the frequency doubled wavelength
of 532nm can be emitted.

NOTE

For details how to operate your laser type, consult the corresponding manual.
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3.16.1. Configure

Configure the device driver here to enable communication with your laser.

Port selects the serial interface on the controller board for communication

COM A, COM B available serial interfaces

Type selects the laser type

List item Description
SL 801-50, SL 801-100, SL 401-50, SL 454-100, laser types supported by the
SL 852-100, SL 852-100 (no dump), SL 650 device driver

Lamp Trigger selects at which signal edge the pump lamp is triggered

Normal rising edge

Inverted falling edge

Max Rep Rate sets the maximal repetition rate

Max Voltage sets the maximal voltage

Max Pulse Energy sets the maximal pulse energy

Shutter 2 Polarity

Command sets the command signal polarity to open the shutter. Security relevant shutters
are closed when without voltage

Normal Signal high = shutter open

Inverted Signal low = shutter open

Feedback sets the shutter feedback signal polarity
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Normal Signal high = shutter open
Inverted Signal low = shutter open
Ignored the signal will be ignored
Inverted & Ignored Signal low = shutter open & the signal will be ignored

SL 852 Shutter TLock selects at laser type SL 852 whether the internal shutter will automati-
cally opened after laser parameters were changed
Normal the internal shutter automatically opens after time Shutter TLock which can be

set in the Power Saver tab
Disabled the shutter stays closed and has to be opened manually. Before continuing

work, make sure the laser stabilizes thermally

3.16.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

Power Up switches to the next higher Power State
Power Down switches to the next lower Power State
Recover tries to leave the "Failure" state into the "not Ready" state
Timeout for next state shows the time remaining until the laser switches to the next Power State

3.16.3. Parametrize - Control

This tab unites the main controls.
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Pump Start switches the internal water cooling pump on and off. If the LED is on then the pump
is on

Shutter1 opens and closes the internal laser shutter. If the LED is on then the internal shutter is
open

Watchdog enables and disables the monitoring of communication with the controlling computer.
If the watchdog detects an interruption then the laser will be automatically switch off. If the
LED is on then the watchdog is on

Laser On switches the laser power components on and off. If the LED is on then the power compo-
nents are on

Shutter2 opens and closes the process shutter. If the LED is on then the process shutter is open

Single Shot triggers a single laser pulse. This function is useful when adjusting or servicing the
laser. Not all laser types support this function

3.16.4. Parametrize - Power

The high power versions of the laser series SL4xx/8xx contain an oscillator and an amplifier. Thus
they posses 2 charging units which can be set separately in this tab.

Enable if this check box is selected then the respective charger is activated

Charger1 (%), Charger2 (%) sets the charging voltage of charger 1 and charger 2

Current Charger1 (%), Current Charger2 (%) shows the nominal values taking in account the
correcting values given in the Ageing tab

Trigger selects the source of the trigger pulses
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External a laser internal trigger generator is used

Internal a laser external trigger generator is used. The trigger pulses are generated internally
on the controller board

3.16.5. Parametrize - Ageing

You can record data about the ageing of lamps in this tab and use this data to automatically compen-
sate the power loss resulting from this ageing. The Pockels delay can also be compensated depending
on the number of pulses. In addition the offset depending on power can be recorded to minimize the
influence of power on the pointing stability of the laser. As these laser are often used with 2 scan
heads, the offset can be compensated separately for the master and the slave scan head.

Enable if this check box is selected then the specified characteristic diagrams are used to compen-
sate for power loss and offset

Age shows the actual number of operating hours

Charger1 shows the corrected charging voltage 1

Charger2 shows the corrected charging voltage 1

Pockels Delay shows the corrected Pockels delay

Offset X, Offset Y - Master, Slave shows the corrected offset for master and slave scan head

Selection selects the parameter shown in the diagram below. Enter the values into the table below.
Add rows using the context menu.

Charger1 the charging voltage 1 is shown over the number of pulses as a characteristic dia-
gram

148 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



3.16. sl4xx and sl8xx

Charger2 the charging voltage 2 is shown over the number of pulses as a characteristic dia-
gram

Voltage the voltage is shown over the number of pulses as a characteristic diagram

PulseEnergy the pulse energy is shown over the number of pulses as a characteristic diagram

PockelsDelay The Pockels delay is shown over the number of pulses as a characteristic dia-
gram

OffsetX the offset in X direction for the master scan head is shown over the pumping power
as a characteristic diagram

OffsetY the offset in Y direction for the master scan head is shown over the pumping power
as a characteristic diagram

OffsetX_Slave the offset in X direction for the slave scan head is shown over the pumping
power as a characteristic diagram

OffsetY_Slave the offset in Y direction for the slave scan head is shown over the pumping
power as a characteristic diagram

3.16.6. Parametrize - Timing

Rep Rate (%) sets the repetition rate of the laser internal frequency generator. Internal has to be
selected in the Trigger list in the Power tab

Rep Rate (Hz) sets the repetition rate. Internalhas to be selected in the Trigger list in the Power tab.
The controller board provides the timing for pulse generation. The pulses can be positioned
more exactly on the target
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Pockels Delay Int (%) sets the pockels delay relative to ignition of the pump lamps. Internal has
to be selected in the Trigger list in the Power tab

Pockels Delay Ext (µs) sets the pockels delay relative to ignition of the pump lamps. External has
to be selected in the Trigger list in the Power tab

Pockels Delay (%) shows the pockels delay relative to ignition of the pump lamps. Internal has to
be selected in the Trigger list in the Power tab

Pockels Delay (µs) shows the pockels delay relative to ignition of the pump lamps. External has to
be selected in the Trigger list in the Power tab

Settle Time Charg1 (s) sets the settle time waited after the nominal value for charging voltage 1
has adjusted

Settle Time Charg2 (s) sets the settle time waited after the nominal value for charging voltage 2
has adjusted

Settle Time Rep (s) sets the settle time waited after the nominal value for repetition rate has
adjusted

Q-Switch Mode selects the Q-switch mode

Internal the laser automatically switches on and off the Q-switch

Off the Q-switch stays off, i.e. is optically transparent

Direct Access the controller board automatically switches on and off the Q-switch

On the Q-switch stays on

Divide Ratio sets the divide ratio the repetition rate is divided by. To hold the laser thermally
stable the pump lamp frequency is hold constant and the pockels cell switched each nth pulse

Sync Line Start if this check box is selected then each first pulse is set to the beginning of a line.
We recommend to select the check box, when the repetition rate is very low and the pulses on
a line have to be arranged reproducible

3.16.7. Parametrize - Power Saver

If the laser is not in use over a time then the device driver can automatically switch the laser to
standby state or switch it off completely to spare the lamps.
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Dump if the laser beam is not used for short periods only then it is desired to hold stable the thermal
balance in the laser and thus beam quality and pointing stability. Normally the laser runs with
unchanged parameters in the Dump Power State whereas the laser beam is directed by amirror
to an absorber.

Enable if this check box is selected then the Dump function is activated

Timeout (s) (Power → Dump) sets the time where after the laser switches to Dump state
if not used

Up Delay (s) sets the time where after the laser switches from Dump to Power state when
requested

Charger 1 (%) sets the charging voltage 1 while in Dump state

Charger 2 (%) sets the charging voltage 2 while in Dump state

Rep Rate (%) sets the repetition rate while in Dump state

Laser Standby

Enable if this check box is selected then the Standby function is activated

Timeout (s) (Dump → Standby) sets the time where after the laser switches to Standby
state if not used and already in Dump state

Charger 1 (%) sets the charging voltage 1 while in Standby state

Charger 2 (%) sets the charging voltage 2 while in Standby state

Rep Rate (Hz) sets the repetition rate while in Standby state

Shutter 1 TLock (s) sets the time to have pass before shutter 1 can be opened, when the
laser switches from Standby state to Power state
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Shutter 2 TLock (s) sets the time to have pass before shutter 2 can be opened, when the
laser switches from Standby state to Power state

Laser Down
Enable if this check box is selected then the Laser Down function is activated
Timeout (s) (Standby → Down) sets the time after that the laser is switched to Down state

if not used and already in Standby state
Laser On if this check box is selected then the Laser On control signal is active

Laser Off
Enable if this check box is selected then the Laser Off function is activated
Timeout (s) (Down → Off) sets the time after that the laser is switched off if not used and

already in Down state
System Shutdown

Countdown (s) sets the time after that the system is switched off
Close applications if this check box is selected then InScript closes the applications

3.16.8. Parametrize - Conditions

In this tab the InScript error handling can be configured and the conditions can be set which have to
apply for starting and aborting a job.

NOTE

Settings in this tab can not prevent the laser from shutting off when a fault occurs. The
settings only affect InScript’s behavior in reacting to faults.
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Laser, Shutter1, Shutter2, External, Water Flow,

Water Level, Water Temp, Thermistor, PSU1 Temp,

PSU2 Temp, Cubicle Temp, Cubical Doors, Laser Head,

Shutter, Simmer Column Start sets the conditions, which have to apply to enable Job Start

Ignored the program ignores the state of the corresponding component and enables Job
Start

On / Open / OK if the state of the corresponding component applies then the pro-
gram enables Job Start

Column Fail sets the conditions, which have to apply to abort processing

Ignored the program ignores the state of the corresponding component and continues
with processing

Off / Closed / Failure if the state of the corresponding component applies then the
program aborts processing

AutoReady if this check box is selected and a Job Start signal occurs then the driver gets the
system automatically ready and begins with processing. When the driver is e.g. in power
state Standby then it automatically switches to power state On and opens the laser shutter.
As soon as the system is ready processing begins automatically

WARNING

Visible and invisible laser radiation

Serious injury or property damage may occur when processing is automatically
started.

You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

3.16.9. Parametrize - Stats

This tab shows information about operating hours since the last lamp change as well as the accumu-
lated laser operating hours.
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Current

Charger1 Power, Charger2 Power, Charger1 Standby, Charger2 Standby

Pulse Count shows the number of pulses in Standby state and Power state since the last
counter reset

Time (h) shows the operating hours in Standby state and Power state since the last
counter reset

resets the counter and opens the Automatic Service Database Entry window (see 3.24
Automatic Service Database Entry)

Total

Charger1 Power, Charger2 Power, Charger1 Standby, Charger2 Standby

Pulse Count shows the accumulated number of pulses in Standby state and Power state

Time (h) shows the accumulated number of operating hours in Standby state and Power
state

Auto-Write (s) sets the interval by which the operating hours are written to the con-
troller board's flash memory

NOTE

If you switch the laser on only for short times then we recommend to set the
interval to 300 s to 900 s. Otherwise larger discrepancies may occur to real
operating hours.
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3.16.10. Parametrize - Status

In this tab you get information about the interlock state of your laser. A fault can be identified more
easily by indicators.

External, Water Flow, Water Level, Water Temp,

Thermistor, PSU1 Temp, PSU2 Temp, Cubicle Temp,

Cubical Doors, Laser Head, Shutter, Simmer

LED and status display shows the state of the corresponding component by a symbolized
LED and a text. If the LED is green then the component is OK. If the LED is red then an
error occurred at the component

Communication, Scan Cycle, Shutter1 Time,

Shutter2 Time, Version, Date

staus field shows the state of the corresponding component with a text

3.16.11. Parametrize - ADC

This tab shows information about the optical output power of the laser.
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ADC

0, 1, 2, 3 shows the optical output power as value for infrared and green laser radiation

ADC0 (%), ADC1 (%) shows the optical output power for infrared and green laser radiation in
form of a bar

3.17. haas laser - HL-Series Laser by Coherent

for controller NCC
device type laser
driver version 1.0

The haas laser device makes functions and parameters available to control lasers of Coherent's HL-
family.

NOTE

For details how to operate your laser type, consult the corresponding manual.
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3.17.1. Configure

Type sets the laser type

HL 304P only this type is supported at the time

Ext. Reset Input sets the parallel input at the controller by which messages can be acknowledged
resp. the laser can be resetted, see section 3.2 pio - Parallel Inputs and Outputs and the docu-
mentation of the NCC controller

None no digital input will be used

1 .. 5 the corresponding parallel input is high active

1 inverted .. 5 inverted the corresponding parallel input is low active

3.17.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.17.3. Parametrize - Control

Power
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Power sets the pumping power. This is a relative value and not standardized to the optical
output power. Hence 100% are not the same as maximal optical output power. For ex-
ample optical laser activity may occur not until the pumping power reaches 35% and the
maximal optical output powermay be already reached at a pumping power of 70%. Set the
desired optical output power at the power supply according to the characteristic diagram
which accompanies your laser. Pay attention to the lamp current

Power Corrected shows the corrected pumping power. During a pumping lamp’s span of life
different aging processes result in a slow power loss. If the laser is always working at the
same power level then this power loss can be recorded against operating hours and then
adjusted. For this purpose the lamp current will be increased

Actual shows the actual pumping power

Settle Time sets the settle time which will be waited after the nominal pumping power is
reached

Gate

Freq. F sets the frequency the Q-switch is triggered with

Gate Control sets the gate control

Auto oscillator will be automatically switched on and off

Always off oscillator stays permanently off

Always on oscillator stays permanently on

Gate Mode sets the type of signal at the controller board gate output

Gated Osc pulses will be generated with the parameters Freq F and Osc. On Time

Gate a single on-/off-signal will be generated

Pulse Duration sets the nominal pulse duration

Osc.On Time sets the On time for the oscillator

Settle Time sets the settle time which will be waited after the nominal frequency is reached

Pulse Sync. Ext. If the check box is selected then the controller board provides the synchro-
nization signal for the pulses

Pulse Sync. Int. If the check box is selected then the laser provides the synchronization sig-
nal for the pulses

Laser On sets the laser to state ready

Realtime Start starts lines of a laser program which are processed with the WRS (WaitRealtimeS-
tart) function. Select laser programs by placing a Laser Haas node within a job at the desired
position

Ext. Ctrl. routes the laser control functions to its external control interface. In this case the exter-
nal control is the controller and InScript

Prog. Start Dyn. starts a laser program dynamically. Select laser programs by placing a Laser Haas
node within a job at the desired position
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3.17.4. Parametrize - Interlock

In this tab you get information about the interlock state of your laser. A fault can be identified more
easily by indicators. You can set the conditions which have to apply for a job start with Job Start and
at which faults a job shall be canceled resp. which faults will be ignored. Further on you can set
InScript’s reaction to faults.

NOTE

Settings in this tab can not prevent the laser from shutting off when a fault occurs. The
settings only affect InScript’s behavior in reacting to faults.

Laser Ready, Ext. Ctrl., Power Limit, Safety, Failure, Pulse Ready, Power State and

Ext. Reset

Column Status shows the respective component state by a symbolic LED and text. If the LED
is green then the component works correctly. If the LED is red then a fault occurred at
the component

Column Start sets the conditions which have to apply so that the program enables Job Start

Ignored The program ignores the respective component state and enables Job Start

Ready, External, OK and Ready If the respective component state applies then the
program enables Job Start

Column Fail sets the conditions which have to apply so that the program cancels a running
process

Ignored The program ignores the respective component state and continues with pro-
cessing

Failure If the respective component state applies then the program cancels the process-
ing
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AutoReady If the check box is selected and a Job Start signal occurs then the driver gets the system
automatically ready and begins with processing. When the driver is e.g. in power state Standby
then it automatically switches to power state On and opens the laser shutter. As soon as the
system is ready processing begins automatically

WARNING

Visible and invisible laser radiation

Serious injury or property damagemayoccurwhenprocessing is automatically started

� You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

AutoRecover If the check box is selected and an error occurs then InScript executes a reset of the
laser and tries that way to fix the error. As result the system may automatically continue with
processing

WARNING

Visible and invisible laser radiation

Serious injury or property damagemay occurwhen processing is automatically con-
tinued

� You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

3.18. lasag laser 2 - RTPS and VCPS Controlled Lasers by LASAG

for controller NCC
device type laser
driver version 1.20.32.2

The lasag laser 2devicemakes functions andparameters available to control RTPS andVCPS controlled
LASAG lasers.

NOTE

For details how to operate your laser type, consult the corresponding manual.
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3.18.1. Configure

Port selects the controller's serial interface to communicate with the laser

Laser Control the LASER CONTROL connector interface will be used

Baud selects the baud rate

600, 1200, 2400, 4800, 9600, 19200 possible baud rates

Type selects the laser type

RTPS power controlled

VCPS voltage controlled

Autodetect tries to determine the laser type automatically

3.18.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.
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3.18.3. Parametrize - Control

Osc

Freq sets the frequency the Q-switch is triggered with

Osc On-Time sets sets the on-time for the oscillator

Gate

Gate Control selects the gate control

Auto oscillator will be automatically switched on and off

Always off oscillator stays permanently off

Always on oscillator stays permanently on

Gate Mode selects the type of signal at the controller gate output

Gated Osc pulses will be generated with the parameters Freq and Osc On-Time

Gate a single on-/off-signal will be generated
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3.18.4. Parametrize - Power Saver

Laser Standby

Enable if this check box is selected then switching from power state Power to Standby is en-
abled

Timeout (Pwr → Stby) sets the time that will be waited while the laser is not used, before
switching it to power state Standby

Remote Frequency if this check box is selected the parameter Remote Frequency is set (ex-
tern) to suppress the internal pulse generation

Scanner Down

Enable If the check box is selected then switching frompower state Standby toDown is enabled

Timeout (Stby → Down) sets the time thatwill bewaitedwhen the laser is not used, before
switching it to power state Down

Power

Up switches the laser into a higher power saver state

Down switches the laser into a lower power saver state

Time to next state shows the time remaining, before switching to the next power saver state

Change shows whether a transition from one to another state is in progress or not
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3.18.5. Parametrize - Messages

Interlock, Security, Hardware shows the state of laser messages (green LED = state OK; red LED =
state not OK)

Text boxes show the 8 latest messages

Clear Messages clears the 8 latest messages

Action Groups

A .. H shows the action group state

3.18.6. Parametrize - Interlock

This tab shows information about the interlock states in your laser. If an error occurs then it can be
localized easier. Furthermore the error handling by InScript can be configured and the conditions
can be set that have to be true for starting a job via Job Start. It can also be set which errors abort a
job and which shall be ignored.
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NOTE

Settings in this tab do not prevent the laser from shutting down, if an error occurs. These
settings just affect the behavior of InScript in case of an error.

Shutter Open, RCA, Laser OK, Fiber in Pos, RS232 Comm, Power State

Column Status shows the respective component state with a symbolic LED and a text. A green LED
shows the component is OK. A red LED shows an error at the component

Column Start selects conditions to be true to release Job Start

Ignored The program ignores the respective component state and releases Job Start

Open and OK and Power respectively If the respective component state is true then the
program releases Job Start

Column Fail selects conditions to be true to abort a running process

Ignored The program ignores the respective component state and proceeds with the process

Closed and OK respectively If the respective component state is true then the program
aborts the process

AutoReady If the check box is selected and a Job Start signal occurs then the driver gets the system
automatically ready and begins with processing. When the driver is e.g. in power state Standby
then it automatically switches to power state On and opens the laser shutter. As soon as the
system is ready processing begins automatically
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WARNING

Visible and invisible laser radiation

Serious injury or property damagemayoccurwhenprocessing is automatically started

� You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

AutoRecover If the check box is selected and an error occurs then InScript executes a reset of the
laser and tries that way to fix the error. As result the system may automatically continue with
processing

WARNING

Visible and invisible laser radiation

Serious injury or property damagemay occurwhen processing is automatically con-
tinued

� You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

3.19. cw200s

for controller NCC
device type laser
driver version 1.0

This device driver controls continuously (cw) lamp pumped or diode pumped solid state lasers via a
serial interface.

NOTE

For details how to operate your laser type, consult the corresponding manual.
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3.19.1. Configure

Port selects the serial interface on the controller board for communication
COM A serial interface A
COM B serial interface B

Type selects the type of power supply

List item Description
SL902, SL1308MA, SLD21xx, CW60-04 power supplies supported by the device driver

Aperture Control if this check box is selected then aperture control is activated

3.19.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.19.3. Parametrize - Control
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Shutter

Open opens the mechanical shutter. If the LED is on, the shutter is open

Close closes the mechanical shutter. If the LED is on, the shutter is closed

Shutter Time shows the shutter time

Power

Power sets the electrical pumping power. This setting is not a relative value and is not nor-
malized to the optical laser output. Therefor 100% are not equal to the maximal optical
output power. Optical laser activity may occur e.g. at an electrical pumping power of 35%
and the maximal optical output power may be reached at 70%. Set the wanted optical
output power by observing the lamp current at the power supply and according to the
characteristic diagram accompanying your laser

Power with Ageing shows the corrected electrical pumping power. Within the lifetime of
a lamp several ageing processes result in a slow power loss. If the laser is working at a
constant electrical pumping power then the power loss can be measured depending on
the operating hours and compensated later on by increasing the lamp current. In the
Ageing tab the ageing behavior can be recorded

Power Laser Cmd shows the actual electrical pumping power

Aperture selects the aperture

TEM00 for TEM00

MM for multi mode

Settle Time sets the settle time waited after the nominal value for pumping power has ad-
justed. The settle time can be set in ms/% or in ms

Enable Power Mapping if this check box is selected then the Power Mapping is activated
(see 3.19.9 Parametrize - Power Mapping)

Pump

Start starts the cooling water pump. If the LED is on, the pump runs

Water Valve if the LED is on, the water valve is open. In controlled state the water valve
opens and closes in cycles

Watchdog

Enable if this check box is selected then the laserwatchdog is activated. Then the laser checks
if the communication between controller board and laser is OK. If the communication
is interrupted, e.g. when the controlling computer crashed, then the laser automatically
switches off. If the check box is cleared then the laser continues working with the actual
parameters
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3.19.4. Parametrize - Q-Switch

Frequency

Freq P sets the frequency within the Range. The laser triggers the Q-switch with this fre-
quency. This setting defines the laser frequency, when Gated Q or Internal Q is selected in
the Q-Switch-Mode list

Range selects the frequency range

0 - 10kHz from 0 to 10kHz

0 - 100kHz from 0 to 100kHz

label shows 1 / Freq P

Osc

Freq F sets the oscillator frequency by which the controller board triggers the Q-switch

Osc On-Time sets the oscillator ON-time

label shows 1 / Freq F

Gate

Gate Control selects the gate control

Always off oscillator stays always off

Always on oscillator stays always on

Auto oscillator is automatically switched on and off

Gate mode selects the signal generated at the controller board Gate output

Gated Osc pulses are generated with the parameters Freq F and Osc On-Time

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 169



3. Devices

Gate a single on/off signal is generated

Q-Switch-Mode selects the Q-switch mode

Gated Q the laser triggers the Q-switch with frequency Freq P. The pulses are enabled
via the controller board Gate output

Internal Q the laser triggers the Q-switch with frequency Freq P. The level at the con-
troller board Gate output is irrelevant

Gated CW the Q-switch modulator enables the laser as long as there is a signal at the
controller board Gate output

Triggered Q the Q-switch modulator works similar to Gated CW, but uses edge trigger-
ing. The RF OFF time is set to 5 µs

RF-Off-Level Source selects the source of the RF-Off-Level. Please consult the manual of your
laser for possible settings

default laser

External controller board

RF-Off-Level sets the Q-switch modulator voltage in off state, i.e. if the laser is enabled. To
generate a laser pulse the q-switch modulator voltage is set to 0V

FPK (First Pulse Kill) in continuously pumped solid state laser with Q-switch the first laser pulse
is significantly high, when the Q-switch inhibited laser emission for a longer time and a pulse
burst was output later. The super pulse at the beginning of the burst decreases the process-
ing quality at many applications. Please find more detailed information about this subject in
section 3.23 Background to Modes of Operation et sqq. and in the manual of your laser.

Slope sets the FPK slope

Slope-Src selects the FPK slope source

default the laser provides the FPK slope

RS 232 the controller board provides the FPK slope (see Slope)

Duration sets the time during which the FPK slope takes effect

Inversion Time sets the time after which a super pulse occurs

Control selects the FPK control

Auto FPK is automatically switched on and off

Always off FPK stays always off

Always on FPK stays always on

3.19.5. Parametrize - Ageing

In this tab you can record data about the ageing of lamps or diodes and use this data to automatically
compensate the power loss resulting from this ageing. In addition the offset depending on power can
be recorded to minimize the influence of power on the pointing stability of the laser.
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Enable if the check box is selected then the specified characteristic diagrams are used to compen-
sate for power loss and offset

Age shows the actual number of operating hours of the lamp or diode

Power shows the corrected pumping power

Offset X, Offset Y shows the corrected offset in X and Y direction

Selection selects the parameter shown in the diagram below. Enter the values into the table be-
neath. Add rows via the list's context menu

Power the pumping power [%] is shown over the number of operating hours as a character-
istic diagram

OffsetX the offset in X direction [µm] is shown over the pumping power as a characteristic
diagram

OffsetY the offset in Y direction [µm] is shown over the pumping power as a characteristic
diagram

3.19.6. Parametrize - Stats

This tab shows information about operating hours since the last lamp or diode change as well as the
accumulated laser operating hours.
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Auto-Write sets the interval in which the operating hours are written to the controller board flash
memory.

NOTE

If you switch on the laser only for short times thenwe recommend to set the interval
to 300 to 900 s. Otherwise larger discrepancies may occur to real operating hours.

Current

Power shows lamp or diode operating hours in power state since the last counter reset

resets the counter and opens the Automatic Service Database Entry window (see 3.24 Auto-
matic Service Database Entry) item[Standby] shows the laser operating hours in standby
state since the last counter reset

resets the counter and opens the Automatic Service Database Entry window (see 3.24 Au-
tomatic Service Database Entry)

Total

Power shows the accumulated lamp or diode operating hours in power state

Standby shows the accumulated laser operating hours in standby state

3.19.7. Parametrize - Interlock

In this tab you get information about the interlock state of your laser. A fault can be identified more
easily by indicators. You can set the conditions which have to apply for a job start with Job Start and
at which faults a job shall be canceled resp. which faults will be ignored. You can also set InScript’s
reaction to faults, here.
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NOTE

Settings in this tab can not prevent the laser from shutting off when a fault occurs. The
settings only affect InScript’s behavior in reacting to faults.

Shutter Open, External, Lamp Fail, Water Level,

Pump, Thermistor, PSU Temp, Modulator, Cubicle Temp,

Cubicle Doors, Laser Head, Shutter, Communication,

Power State

Column Status shows the state of the corresponding component by a symbolized LED and a
text. If the LED is green then the component is OK. If the LED is red then an error occurred
at the component

Column Start sets the conditions, which have to apply to enable Job Start

Ignored the program ignores the state of the corresponding component and enables Job
Start

Open / OK / Power if the state of the corresponding component applies then the
program enables Job Start

Column Fail sets the conditions, which have to apply to abort processing

Ignored the program ignores the state of the corresponding component and continues
with processing

Closed / Failure if the state of the corresponding component applies then the program
aborts processing

AutoReady if this check box is selected and a Job Start signal occurs then the driver gets the
system automatically ready and begins with processing. When the driver is e.g. in power
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state Standby then it automatically switches to power state On and opens the laser shut-
ter. As soon as the system is ready processing begins automatically.

WARNING

Visible and invisible laser radiation

Serious injury or property damage may occur when processing is automatically
started.

You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

AutoRecover if this check box is selected and an error occurs then InScript executes a reset
of the laser and tries that way to fix the error. As result the system may automatically
continue with processing.

WARNING

Visible and invisible laser radiation

Serious injury or property damage may occur when processing is automatically
continued.

You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

3.19.8. Parametrize - Power Saver

If the laser is not in use over a time then the device driver can automatically switch the laser to
standby state or switch it off completely to spare the lamps or diodes.
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Laser Standby

Enable if this check box is selected then the standby function is activated

Timeout (Laser On → Laser Standby) sets the time where after the laser switches to
standby state if not used

Shutter Time Lock sets the time that has to pass before the shutter can be opened, when
the laser switches from Off to Standby state

Laser Off

Enable if this check box is selected then the laser off function is activated

Timeout (Laser Down → Laser Off) sets the time after that the laser is switched off if it
is not used and already in down state

Power

Up switches from one power state to next higher power state

Down switches from one power state to next lower power state

Timeout for next state shows the time remaining before switching from the actual power
state to the next
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3.19.9. Parametrize - Power Mapping

TEM00-Mode shows the power mapping in TEM00 mode
TEM00-Mode Editor opens the TEM00-Mode Mapping window
Multi-Mode shows the power mapping in Multi Mode
Multi-Mode Editor opens the Multi-Mode Mapping window

Figure 3: Power Mappings Editor
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3.20. idar

for controller NCC
device type laser
driver version 1.0

3.20.1. Configure

Configure the device driver here to enable communication with the laser.

The IDAR laser power supply is controlled via analog voltage, these settings are meant for experi-
mental operation via RS232.

Port selects the serial interface on the controller board for communication

COM A, COM B assigns the idar device to one of the serial interface connectors at the NCC
controller, see the documentation of the NCC controller

Configure DAC if this check box is selected then the analog outputs are set to defined start values.
The offset voltages are set to 0V and the voltage scale is set to 1 (see 3.5 dac_a/b - Digital Analog
Converter a and b)

NOTE

Select the check box only if the laser device driver shall control laser parameters.

3.20.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.
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3.20.3. Parametrize - Control

Power sets the electrical pumping power. This setting is not a relative value and is not normal-
ized to the optical laser output. Therefor 100% are not equal to the maximal optical output
power. Optical laser activity may occur e.g. at an electrical pumping power of 35% and the
maximal optical output power may be reached at 70%. Set the wanted optical output power by
observing the lamp current at the power supply and according to the characteristic diagram
accompanying your laser

Settle Time sets the settle time waited after the nominal value for pumping power has adjusted

Frequ. sets the laser repetition rate

Power shows the actual power. Within the lifetime of a lamp several ageing processes lead to a
slow power loss. If the laser is operated with constant power then this loss can be recorded
and compensated over the operating hours. For this purpose the lamp current is increased. In
the Ageing tab the ageing behavior can be recorded

Control Mode for details see the manual of your laser

Analog control mode is set to Analog

Serial control mode is set to Serial

drop down for Shutter for details see the manual of your laser

Open Shutter is open

Closed Shutter is closed

Power Ramp for details see the manual of your laser

Ramp use power ramping

No Ramp do not use power ramping
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3.20.4. Parametrize - Gate

Frequ sets the frequency the laser internal Q-switch modulator is operated with. This setting de-
fines the laser frequency, when Gated Osc is selected in the Gate Mode list

On-Time sets the oscillator ON-time

Control selects the gate control

Always off oscillator stays always off

Always on oscillator stays always on

Auto oscillator is automatically switched on and off

Gate Mode selects the signal generated at the controller board's Gate output

Gated Osc pulses are generated with the parameters Frequ and On-Time

Gate a single on/off signal is generated

3.20.5. Parametrize - Ageing

In this tab you can record data about the ageing of lamps or diodes and use this data to automatically
compensate the power loss resulting from this ageing. In addition the offset depending on power can
be recorded to minimize the influence of power on the pointing stability of the laser.
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Enable if this check box is selected then the specified characteristic diagrams are used to compen-
sate for power loss and offset

Age shows the actual number of operating hours of the lamp or diode

Power shows the corrected pumping power

Offset X, Offset Y shows the corrected offset in X and Y direction

Selection selects the parameter shown in the diagram below. Enter the values into the table be-
neath. Add rows via the context menu.

Power the pumping power [%] is shown over the number of operating hours as a character-
istic diagram

OffsetX the offset in X direction [µm] is shown over the pumping power as a characteristic
diagram

OffsetY the offset in Y direction [µm] is shown over the pumping power as a characteristic
diagram

3.20.6. Parametrize - FPK

In continuously pumped solid state lasers with Q-switch the first laser pulse is significantly high,
when the Q-switch inhibited laser emission for a longer time and a pulse burst was output thereafter.
The super pulse at the beginning of the burst decreases the processing quality at many applications.
Please find more detailed information about this subject in section 3.23 Background to Modes of Op-
eration et sqq. and in the manual of your laser.
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Duration sets the time during which the FPK takes effect

Inv Time sets the time after which a super pulse occurs

Control selects the FPK control

Auto FPK is automatically switched on and off

Always off FPK stays always off

Always on FPK stays always on

3.20.7. Parametrize - Power Save

If the laser is not in use over a time then the device driver can automatically switch the laser to
standby state or switch it off completely to spare the lamps or diodes.
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Laser Standby

Enable if this check box is selected then the standby function is activated

Timeout (Laser On → Laser Standby) sets the time where after the laser switches to
standby state if not used

Power sets the pumping power the laser is operated in standby state

System Shutdown

Countdown sets the time after that the system is switched off

Force application to close if this check box is selected then InScript closes the applications

3.20.8. Parametrize - Conditions

In this tab the InScript error handling can be configured and the conditions can be set which have to
apply for starting and aborting a job.
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NOTE

Settings in this tab can not prevent the laser from shutting off when a fault occurs. The
settings only affect InScript’s behavior in reacting to faults.

Interlock, Power State, Shutter
Column Start sets the conditions, which have to apply to enable Job Start

Ignored the program ignores the state of the corresponding component and enables Job
Start

OK / Power / Open if the state of the corresponding component applies then the
program enables Job Start

Column Fail sets the conditions, which have to apply to abort processing

Ignored the program ignores the state of the corresponding component and continues
with processing

Closed / Failure if the state of the corresponding component applies then the program
aborts processing

AutoRecover if this check box is selected and an error occurs then InScript executes a reset of the
laser and tries that way to fix the error. As result the system may automatically continue with
processing.

WARNING

Visible and invisible laser radiation

Serious injury or property damagemay occurwhen processing is automatically con-
tinued.

You are allowed to select this check box only if the optical path is completely encap-
sulated in a enclosed machine. Entries into the machine have to be equipped with
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approved interlock switches. If an entry is opened then the interlock switch has to
shut the laser safety shutter by force with the highest priority. The machine has to
comply with the laser safety regulations for manufacturing. The machine has to be
approved by an authorized representative for laser safety.

AutoReady if this check box is selected and a Job Start signal occurs then the driver gets the system
automatically ready and begins with processing. When the driver is e.g. in power state Standby
then it automatically switches to power state On and opens the laser shutter. As soon as the
system is ready processing begins automatically.

WARNING

Visible and invisible laser radiation

Serious injury or property damagemayoccurwhenprocessing is automatically started.

You are allowed to select this check box only if the optical path is completely encap-
sulated in a enclosed machine. Entries into the machine have to be equipped with
approved interlock switches. If an entry is opened then the interlock switch has to
shut the laser safety shutter by force with the highest priority. The machine has to
comply with the laser safety regulations for manufacturing. The machine has to be
approved by an authorized representative for laser safety.

3.20.9. Parametrize - Stats

This tab shows information about operating hours since the last lamp change as well as the accumu-
lated laser operating hours.

Current

Power shows the number of pulses in Power state since the last counter reset
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resets the counter and opens the Automatic Service Database Entry window (see 3.24 Au-
tomatic Service Database Entry)

Standby shows the number of pulses in Standby state since the last counter reset

resets the counter and opens the Automatic Service Database Entry window (see 3.24 Au-
tomatic Service Database Entry)

Total

Power shows the accumulated number of operating hours in Power state

Standby shows the accumulated number of operating hours in Standby state

Auto-Write sets the interval bywhich the operatinghours arewritten to the controller board's
flash memory

NOTE

If you switch the laser on only for short times then we recommend to set the in-
terval to 300 to 900 s. Otherwise larger discrepanciesmay occur to real operating
hours.

3.20.10. Parametrize - Status

In this tab you get information about the interlock state of your laser. A fault can be identified more
easily by indicators.

Laser

Status shows the laser status

Serial Number shows the laser serial number
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Hourmeter shows the laser operating hours
Lamp Current PS shows the lamp current PS
Temperature PS shows the temperature PS
Temperature RF shows the temperature RF
Comm Status shows the communication status
Interlock shows the interlock status
Shutter shows the shutter status

Software
Status shows the software status
Serial Number shows the software serial number
Hourmeter shows the software operating hours

Options
Status shows the options status
Serial Number shows the options serial number
Hourmeter shows the options operation hours

3.21. sl902

for controller NCC
device type laser
driver version 1.0

3.21.1. Configure

Configure the device driver here to enable communication with the laser.
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NOTE

If you use a connecting cable from ARGES then the default configuration must not be
changed.

Inputs assigns the named signals to the digital inputs on the controller board. A positive value
corresponds to a high active digital input. A negative value corresponds to a low active digital
input. The value 0 (zero) means that no input is used

Outputs assigns the named signals to the digital outputs on the controller board. A positive value
corresponds to a high active digital output. A negative value corresponds to a low active digital
output. The value 0 (zero) means that no output is used

3.21.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.21.3. Parametrize - Lamp

Power sets the electrical pumping power. This setting is not a relative value and is not normal-
ized to the optical laser output. Therefor 100% are not equal to the maximal optical output
power. Optical laser activity may occur e.g. at an electrical pumping power of 35% and the
maximal optical output power may be reached at 70%. Set the wanted optical output power by
observing the lamp current at the power supply and according to the characteristic diagram
accompanying your laser

Settle Time sets the settle time waited after the nominal value for pumping power has adjusted
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Slew Rate sets the rate the nominal value for pumping power is approached with

Power shows the corrected pumping power

3.21.4. Parametrize - OSC

In this tab Q-switch mode settings can be done.

Frequ (Hz) sets the oscillator frequency by which the controller board triggers the Q-switch

Settle Time (ms) sets the settle time waited after the nominal value for frequency has adjusted

Slew Rate (Hz/s) sets the rate the nominal value for frequency is approached with

On-Time (µs) sets the oscillator ON-time

RF Mode selects the RF mode

Gated Q the laser triggers the Q-switch with frequency Frequ. The pulses are enabled via the
controller board Gate output

Internal Q the laser triggers the Q-switch with frequency Frequ. The level at the controller
board Gate output is irrelevant

Gated CW the Q-switch modulator enables the laser as long as there is a signal at the con-
troller board Gate output

Triggered Q the Q-switchmodulatorworks similar to Gated CW, but uses edge triggering. The
RF OFF time is set to 5 µs

Gate Control selects the gate control

Always off oscillator stays always off
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Always on oscillator stays always on

Auto oscillator is automatically switched on and off

Gate Mode selects the signal generated at the controller board Gate output

Gated Osc pulses are generated with the parameters Freq F and Osc On-Time

Gate a single on/off signal is generated

3.21.5. Parametrize - FPK

In continuously pumped solid state lasers with Q-switch the first laser pulse is significantly high,
when the Q-switch inhibited laser emission for a longer time and a pulse burst was output thereafter.
The super pulse at the beginning of the burst decreases the processing quality at many applications.
Please find more detailed information about this subject in section 3.23 Background to Modes of Op-
eration et sqq. and in the manual of your laser.

Duration (µs) sets the time during which the FPK takes effect

Inv Time (µs) sets the time after which a super pulse occurs

Control selects the FPK control

Auto FPK is automatically switched on and off

Always off FPK stays always off

Always on FPK stays always on
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3.21.6. Parametrize - Ageing

In this tab you can record data about the ageing of lamps or diodes and use this data to automatically
compensate the power loss resulting from this ageing. In addition the offset depending on power can
be recorded to minimize the influence of power on the pointing stability of the laser.

Enable if this check box is selected then the specified characteristic diagrams are used to compen-
sate for power loss and offset

Age shows the actual number of operating hours of the lamp or diode

Power shows the corrected pumping power

Offset X, Offset Y shows the corrected offset in X and Y direction

Selection selects the parameter shown in the diagram below. Enter the values into the table be-
neath. Add rows via the context menu.

Power the pumping power [%] is shown over the number of operating hours as a character-
istic diagram

OffsetX the offset in X direction [µm] is shown over the pumping power as a characteristic
diagram

OffsetY the offset in Y direction [µm] is shown over the pumping power as a characteristic
diagram

3.21.7. Parametrize - Power Save

If the laser is not in use over a time then the device driver can automatically switch the laser to
standby state or switch it off completely to spare the lamps or diodes.
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Laser Standby

Enable if this check box is selected then the standby function is activated

Timeout (s) (Laser On → Laser Standby) sets the time where after the laser switches to
standby state if not used

Power sets the pumping power the laser is operated in standby state

System Shutdown

Countdown sets the time where after the system is switched off

Force application to close if this check box is selected then InScript closes the applications

3.21.8. Parametrize - Conditions

In this tab the InScript error handling can be configured and the conditions can be set which have to
apply for starting and aborting a job.
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NOTE

Settings in this tab can not prevent the laser from shutting off when a fault occurs. The
settings only affect InScript’s behavior in reacting to faults.

PS Remote, PS Shutter, PS Interlock, RF Remote,

RF HRP, RF LFP, RF XT Temp, RF DRV, Temp, Power State

Column Start sets the conditions, which have to apply to enable Job Start

Ignored the program ignores the state of the corresponding component and enables Job
Start

Remote / Open / OK / Power if the state of the corresponding component applies
then the program enables Job Start

Column Fail sets the conditions, which have to apply to abort processing

Ignored the program ignores the state of the corresponding component and continues
with processing

Local / Closed / Failure if the state of the corresponding component applies then the
program aborts processing

Auto Recover if this check box is selected and an error occurs then InScript executes a reset
of the laser and tries that way to fix the error. As result the system may automatically
continue with processing.

WARNING

Visible and invisible laser radiation

Serious injury or property damage may occur when processing is automatically
continued.
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You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

3.21.9. Parametrize - Stats

This tab shows information about operating hours since the last lamp change as well as the accumu-
lated laser operating hours.

Current

Power shows the number of pulses in Power state since the last counter reset

resets the counter and opens the Automatic Service Database Entry window (see 3.24 Au-
tomatic Service Database Entry)

Standby shows the number of pulses in Standby state since the last counter reset

resets the counter and opens the Automatic Service Database Entry window (see 3.24 Au-
tomatic Service Database Entry)

Total

Power shows the accumulated number of operating hours in Power state

Standby shows the accumulated number of operating hours in Standby state

Auto-Write sets the interval by which the operating hours are written to the controller board's
flash memory
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NOTE

If you switch the laser on only for short times thenwe recommend to set the interval
to 300 s to 900 s. Otherwise larger discrepancies may occur to real operating hours.

3.21.10. Parametrize - Status

In this tab you get information about the interlock state of your laser. A fault can be identified more
easily by indicators.

PS Remote, PS Shutter, PS Interlock, RF Remote,

RF HRP, RF LFP, RF XT Temp, RF DRV Temp

LED and status display shows the state of the corresponding component by a symbolized
LED and a text. If the LED is green then the component is OK. If the LED is red then an
error occurred at the component

3.22. generic laser - Generic Laser

for controller NCC, ASC
device type laser
driver version 1.38.2.2

The generic laser device is able to control most of the lasers lacking a specific laser driver.
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3.22.1. Configure

Interlock

NOTE

Anegative valuemeans that the parallel input is low active. A value of 0 (zero)means
that no input shall be used.

A sets the laser interlock A to a parallel input on the controller

B sets the laser interlock B to a parallel input on the controller

Shutter

Shutter input field sets the shutter control to a parallel output on the controller

NOTE

A negative value means that the parallel input is low active. A value of 0 (zero)
means that no input shall be used. On NCC based controllers the value 12 sets
the shutter control to the Aux output of the LASER CONTROL connector on the
controller. On ASC based controllers the value 17 sets the shutter control to the
Aux output of the LASER CONTROL connector on the controller.

Frequency

Control selects, by which analog output the oscillator frequency Freq F is controlled

None no output

DAC A analog output A

DAC B analog output B

Scale sets the scale of oscillator frequency Freq F on the analog output

Power

Control selects by which analog output the pumping power is controlled
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None no output

DAC A analog output A

DAC B analog output B

Parallel parallel output

Duty Cycle power is controlled by the duty cycle of a CO2 laser. The duty cycle is de-
fined as laser pulse duration divided by the whole period

Digital sets the pumping power control to parallel outputs. In the box the parallel output for
the most significant bit is on the left and the the parallel output for the least significant
bit is on the right. The parallel outputs are separated by commas

Range Lo sets the lower limit for pumping power

Range Hi sets the upper limit for pumping power

3.22.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.22.3. Parametrize - Control

Shutter

Open opens the mechanical laser shutter. If the LED is lit then the shutter is open

Close closes the mechanical laser shutter. If the LED is lit then the shutter is closed

Power
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Power sets the electrical pumping power. This setting is not a relative value and is not nor-
malized to the optical laser output. Therefor 100% are not equal to the maximal optical
output power. Optical laser activity may occur e.g. at an electrical pumping power of 35%
and the maximal optical output power may be reached at 70%. Set the wanted optical
output power by observing the lamp current at the power supply and according to the
characteristic diagram accompanying your laser

Power Corrected shows the corrected electrical pumping power. Within the lifetime of a
lamp several ageing processes result in a slow power loss. If the laser is working at a
constant electrical pumping power then the power loss can be measured depending on
the operating hours and compensated later on by increasing the lamp current. In the
Ageing tab the ageing behavior can be recorded

Actual shows the actual electrical pumping power. The upper and lower limit is set in the
device driver configuration in Range Hi and Range Lo

Settle Time sets the settle time waited after the nominal value for pumping power has ad-
justed

Slew Rate sets the rate the nominal value for pumping power is approached with

Aux if this check box is selected then the Aux output of the controller's LASER CONTROL is set to
active

3.22.4. Parametrize - Q-Switch

Osc

Freq F sets the oscillator frequency by which the controller triggers the Q-switch

Osc On-Time sets the oscillator ON-time

Settle Time sets the settle time waited after the nominal value for frequency has adjusted

Slew Rate sets the rate the nominal value for frequency is approached with
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Gate
Control selects the gate control

Always off oscillator stays always off
Always on oscillator stays always on
Auto oscillator is automatically switched on and off

Gate Mode selects the signal generated at the controller's Gate output
Gated Osc pulses are generated with the parameters Freq F and Osc On-Time
Gate a single on/off signal is generated

FPK (First Pulse Kill) In continuously pumped solid state laserswithQ-switch the first laser pulse
is significantly high, when the Q-switch inhibited laser emission for a longer time and a pulse
burst was output thereafter. The super pulse at the beginning of the burst decreases the pro-
cessing quality at many applications. Please find more detailed information about this subject
in section 32.3.6.3, page 287 et sqq. and in the manual of your laser.
Control selects the FPK control

Auto FPK is automatically switched on and off
Always off FPK stays always off
Always on FPK stays always on

Duration sets the time during which the FPK slope takes effect
Inversion Time sets the time after which a super pulse occurs

3.22.5. Parametrize - Ageing

In this tab you can record data about the ageing of lamps or diodes and use this data to automatically
compensate the power loss resulting from this ageing. In addition the offset depending on power can
be recorded to minimize the influence of power on the pointing stability of the laser.
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Enable if this check box is selected then the specified characteristic diagrams are used to compen-
sate for power loss and offset

Age shows the actual number of operating hours of the lamp or diode

Power shows the corrected pumping power

Offset X shows the corrected offset in X direction

Offset Y shows the corrected offset in Y direction

Selection Enter the values into the table beneath. Add rows via the context menu

Power The pumping power is shown over the number of operating hours as a characteristic
diagram

OffsetX The offset in X direction is shown over the pumping power as a characteristic dia-
gram

OffsetY The offset in Y direction is shown over the pumping power as a characteristic dia-
gram

3.22.6. Parametrize - Stats

This tab shows information about operating hours since the last lamp or diode change as well as the
accumulated laser operating hours.

Auto-Write sets the interval by which the operating hours are written to the controller's board
flash memory

NOTE

If you switch the laser on only for short times thenwe recommend to set the interval
to 300 to 900 s. Otherwise larger discrepancies may occur to real operating hours.

Current
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Power shows lamp or diode operating hours in power state since the last counter

reset resets the counter and opens the 3.24 Automatic Service Database Entry window

Standby shows the laser operating hours in standby state since the last counter

reset resets the counter and opens the 3.24 Automatic Service Database Entry window

Total

Power shows the accumulated lamp or diode operating hours in power state

Standby shows the accumulated laser operating hours in standby state

3.22.7. Parametrize - Power Saver

If the laser is not in use over a time then the device driver can automatically switch the laser to
standby state or switch it off completely to spare the lamps or diodes.

Laser Standby

Enable if this check box is selected then the standby function is activated

Timeout (Laser On → Laser Standby) sets the time where after the laser switches to
standby state if not used

Power sets the pumping power for standby state

Laser Off

Enable if this check box is selected then the lase off function is activated

Timeout (Laser Down → Laser Off) sets the time where after the laser is switched off if
not used and already in standby state
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3.22. generic laser - Generic Laser

3.22.8. Parametrize - Interlock

In this tab you get information about the interlock state of your laser. A fault can be identified more
easily by indicators. You can set the conditions which have to apply for a job start with Job Start and
at which faults a job shall be canceled resp. which faults will be ignored. Further on you can set
InScript’s reaction to faults.

NOTE

Settings in this tab can not prevent the laser from shutting off when a fault occurs. The
settings only affect InScript’s behavior in reacting to faults.

Shutter Open, Interlock A, Interlock B, Power State

Column Status shows the state of the corresponding component by a symbolized LED and a
text. If the LED is green then the component is OK. If the LED is red then an error occurred
at the component

Column Start sets the conditions, which have to apply to enable Job Start

Ignored The program ignores the state of the corresponding component and enables Job
Start

Open / OK / Power If the state of the corresponding component applies then the
program enables Job Start

Column Fail sets the conditions, which have to apply to abort processing

Ignored The program ignores the state of the corresponding component and continues
with processing

Closed / Failure If the state of the corresponding component applies then the program
aborts processing

AutoReady if this check box is selected and a Job Start signal occurs then the driver gets the system
automatically ready and begins with processing. When the driver is e.g. in power state Standby
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then it automatically switches to power state On and opens the laser shutter. As soon as the
system is ready processing begins automatically

WARNING

Visible and invisible laser radiation

Serious injury or property damagemayoccurwhenprocessing is automatically started

� You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

AutoRecover if this check box is selected and an error occurs then InScript executes a reset of the
laser and tries that way to fix the error. As result the system may automatically continue with
processing

WARNING

Visible and invisible laser radiation

Serious injury or property damagemay occurwhen processing is automatically con-
tinued

� You are allowed to select this check box only if the optical path is completely en-
capsulated in a enclosedmachine. Entries into themachine have to be equipped
with approved interlock switches. If an entry is opened then the interlock switch
has to shut the laser safety shutter by force with the highest priority. The ma-
chine has to comply with the laser safety regulations for manufacturing. The
machine has to be approved by an authorized representative for laser safety.

3.23. Background to Modes of Operation

Q Switching

Q-switching of a CW laser oscillator refers to a process whereby the usual CWoscillation of the laser
is modulated to provide short, high peak power pulses of laser radiation.

Q-switching is accomplished by temporarily reducing the quality factor (Q) of the laser resonator by
the addition of a loss. Because of the low Q, the laser is prohibited from oscillating; however pumping
of the laser rod continues allowing energy to be stored in the laser rod. When the Q is increased
(i.e. the loss removed) the field in the resonator grows rapidly utilizing the energy stored in the laser
rod. The consequence is the generation of a pulsewith peak powerwell in excess ofwhat is achievable
under normal CW operation.

Acoustooptic Modul
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3.24. Automatic Service Database Entry

The type of Q-switch employed in the Spectron DPSS laser is an acoustooptic modulator. An Acous-
tooptic modulator is a block of transparent quartz with an acoustic transducer bonded to one side. in
acoustooptic modulators an acoustic wave sets up a pattern of density variations in the quartz crys-
tal, the crystal then effectively functions as a diffraction grating changing the fraction of incident
light it transmits.

This change in the quartz crystal is in response to the application of an external RF control signal.

First Pulse Kill (FPK)

If the laser resonator has been blocked for a time period longer than the Q-switching period the first
laser pulse to be generated will be abnormally large in energy. This is often not desired and can lead
to problems duringmaterial processing (see 4 Typical "First Pulse" effect when the laser is processing
single characters).

Figure 4: Typical "First Pulse" effect when the laser is processing single characters

To eliminate this effect FPK control is included as a standard system feature. The FPK operates by
reducing the rate at which the RF control signal is removed from the modulator and so diminishing
the intensity of the first laser pulse. If required the FPK can be overridden. If the FPK is switched off
the FPK input must be enabled a minimum of 50µs before the Gate signal is applied and then each
subsequent pulse from the laser will be suppressed.

Safety Features

• Acoustooptic modulator over temperature

• RF modulator over temperature

The interlocks are combined to produce to a relay contact output which, when the RF unit is used
in conjunction with the CW200S system controller, is fed into the interlock chain. An additional
protection function is included which will not allowed the RF unit to move into any mode other than
RF Off when the pump is not switched on.

3.24. Automatic Service Database Entry

To support the management of your service documentation, an entry can be added to the service
database in this window.
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Date, Time shows the actual date and the actual time that will be written to the service database

Action selects the action performed during the service

Amp Lamp Change at the moment only Amp Lamp Change is implemented

User sets the engineer’s name who performed the service

Age of Item sets the age of the exchanged part since the last counter reset

regular/irregular selects, whether this is a regular or irregular service

Regular regular service

Irregular irregular service

Note sets an informative text that will be written to the service database

Add adds the entry to the service data base

Cancel discards the entry and closes the window

3.25. isel - Universal Control for Motion Axes by ISEL

for controller NCC, ASC
device type motion axes
driver version 1.23.2.4

The isel device can control miscellaneous ISEL motion controllers.
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3.25. isel - Universal Control for Motion Axes by ISEL

3.25.1. Configure - General

Port selects the serial interface on the controller board for communication

COM A, COM B available serial interfaces

Type selects the motion control type

C142 4 axes motion control C142-4.1

IMC_MP iMC-MP motion control

Baud selects the baud rate for the serial interface

9600, 19200 possible baud rates

Axis cfg selects, which axes has to be configured and controlled

X, XY, XZ, XYZ, XA, XYA, XZA, XYZA possible combinations of axes. Depending on
the combination the respective tabs are shown

3.25.2. Configure - X / Y / Z / A
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3. Devices

NOTE

Values making sense result from the properties of the servo motor connected and the
spindle slope. Type in the values from the axis data sheet here. Too high values may
result in positioning errors.

Scale sets the scale, i.e. the steps necessary to move 1 mm

Max sets the maximal traverse path

Max Speed sets the maximal speed

Ref Speed sets the speed used for finding the system home position

Direction selects the position of the reference point, see the ISEL control manual

normal normal direction

reverse reverse direction

Reference sets

normal normal direction

reverse reverse direction

3.25.3. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.25.4. Parametrize - X / Y / Z / A

Pos (mm) sets the absolute position in mm

Pos (steps) sets the absolute position in steps
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3.25. isel - Universal Control for Motion Axes by ISEL

Speed sets the speed

Settle Time sets the settle time. This additional time is waited for, when the control has finished
motion. This may be necessary, when e.g. a heavy mass is moved and the axis shows a damped
oscillation at the end of the move

Pos Error not implemented yet

3.25.5. Parametrize - I/O

Out

1 ..16 if the check box is selected then the output is set to active. The I/Os are situated on
the ISEL motion controller

In

1 (Ref X), 2 (Ref Y), 3 (Ref Z), .. 8 shows the state of the inputs. If the LED is lit then
the input is active. Please note that the inputs 1, 2 and 3 show the reference switch state
of the axes and can not be used for other purposes

Manual Action selects the action, see Manual Steps

none no action will be taken

X, Y, Z, A positive the respective axis will be moved in positive direction

X, Y, Z, A negative the respective axis will be moved in negative direction

Manual Steps sets the number of steps to move
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3.26. imc4 - IMC4 Motion Control

for controller ASC
device type motion axes
driver version 1.0

The imc4 device is a stepper motor driver that can control up to four stepper motors.

3.26.1. Configure - General

Port selects the serial interface on the controller board for communication

COM A, COM B available serial interfaces

Type selects the motion control type

C142 4 axes motion control C142-4.1

Baud selects the baud rate for the serial interface

9600, 19200 possible baud rates

Axis cfg selects, which axes has to be configured and controlled

X, XY, XZ, XYZ, XA, XYA, XZA, XYZA possible combinations of axes. Depending on
the combination the respective tabs are shown

208 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



3.26. imc4 - IMC4 Motion Control

3.26.2. Configure - X / Y / Z / A

NOTE

Values making sense result from the properties of the servo motor connected and the
spindle slope. Type in the values from the axis data sheet here. Too high values may
result in positioning errors.

Scale sets the scale, i.e. the steps necessary to move 1 mm

Max sets the maximal traverse path

Max Speed sets the maximal speed

Ref Speed sets the speed used for finding the system home position

Direction selects the position of the reference point, see the ISEL control manual

normal normal direction

reverse reverse direction

Reference selects the position of the reference point, see the IMC4 control manual

normal normal direction

reverse reverse direction

3.26.3. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.
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3.26.4. Parametrize - General

3D If the check box is selected then the motion control interpolates the axes motions in a way that
axes X, Y and Z start and stop at the same time. Please note that axis A can not be synchronized
with the other axes

Out sets

1 .. 5 If the check box is selected then the corresponding parallel output is set to active

In sets

1 .. 2 If the check box is selected then the corresponding parallel input is active

3.26.5. Parametrize - X / Y / Z / A
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3.27. it116 - Control for Motion Axis IT116 by ISEL

Pos (mm) sets the absolute position

Pos (step) sets the absolute position

Speed sets the speed

Settle Time sets the settle time. This additional time is waited for, when the control has finished
motion. This may be necessary, when e.g. a heavy mass is moved and the axis shows a damped
oscillation at the end of the move

Pos Error not implemented yet

3.27. it116 - Control for Motion Axis IT116 by ISEL

for controller NCC, ASC
device type motion axes
driver version 1.62.114.3

The it116 device is meant for 1 axis and simple positioning tasks. The axis is controlled via a serial
interface.

3.27.1. Configure - General

NOTE

Values making sense result from the properties of the servo motor connected and the
spindle slope. Type in the values from the axis data sheet here. Too high values may
result in positioning errors.

Port selects the serial interface on the controller for communication

COM A, COM B available serial interfaces

Type selects the controller type

IT116, IT116-Flash, IT116-Mini supported controller types
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NOTE

Setting IT116-Flash or IT116-Mini supports also the newer LES-4 axis as well as
its predecessor.

CAUTION

Limit switch 2 of a newer LES-4 axis is not recognized by a controller of type
IT116.

Material damage

� Do not use setting IT116 in combination with a newer LES-4 axis.

� In case you have to use the IT116 setting in combination with the newer
LES-4 axis, ISEL provides an instruction manual for downgrading the newer
LES-4 axis to its predecessor.

Scale sets the scale, i.e. the steps necessary to move 1 mm

Max (mm) sets the maximal traverse path

MAx (steps/s) sets the maximal speed

3.27.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.27.3. Parametrize - General

Pos sets the nominal position

Speed sets the speed
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3.28. ims - IMS Motion Control

Settle Time sets the settle time. This additional time is waited for, when the control has finished
motion. This may be necessary, when e.g. a heavy mass is moved and the axis shows a damped
oscillation at the end of the move

Position shows the current position
Position Error shows the position error
Out sets

1 .. 4 If the check box is selected then the corresponding parallel output is set to active
In sets

1 .. 4 If the check box is selected then the corresponding parallel input is active

3.28. ims - IMS Motion Control

for controller NCC, ASC
device type motion axes
driver version 1.0

The ims device controls IM483 servo motor modules by Intelligent Motion Systems Inc. Up to 8 of
these modules can be controlled via 1 serial interface in a bus connection.

NOTE

Before activating the device driver, the number ofmotion axes has to be entered in Chan-
nels, the motor configuration has to be entered for eachmotion axis and an unique name
has to be chosen in the respective tab in the Name list.

3.28.1. Configure - General
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NOTE

Values making sense result from the properties of the servo motor connected and the
spindle slope. Type in the values from the axis data sheet here. Too high values may
result in positioning errors.

Port selects the serial interface on the controller for communication

COM A, COM B available serial interfaces

Channels sets the number of IMS modules connected to the serial interface. Depending on the
number the respective tabs appear for configuration. Up to 8 modules can be configured

3.28.2. Configure - A1 .. A8

Name selects an unique character for the motion axis

A .. Z, a .. z available characters

Scale sets the scale

Max Pos sets the maximal traverse path

Max Speed sets the maximal speed

Ref Speed sets the speed used for finding the system home position

Acceleration sets the acceleration in arbitrary units from 0 to 255

Deceleration sets the deceleration in arbitrary units from 0 to 255

Init-Speed sets the initialization speed in arbitrary units from 0 to 255

Hold Current sets the hold current applied to the servomotor while holding position. This current
acts like a motor break. Please note, that a too high hold current applied over a longer time
results in motor overheating
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3.29. can0/1 - Controller Area Network

Run Current sets the current applied to move the motor
Ref Time sets the maximal allowed time for finding the home position
Initialisation dropdown selects the mode of initialization

G0 starts the customer specific initialization program from address 0
F normal initialization

3.28.3. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.28.4. Parametrize - A1 .. A8

Pos sets the nominal position
Speed sets the speed
Settle Time sets the settle time. This additional time is waited for, when the control has finished

motion. This may be necessary, when e.g. a heavy mass is moved and the axis shows a damped
oscillation at the end of the move

3.29. can0/1 - Controller Area Network

for controller ASC
device type misc.
driver version 1.0

The can0/1 device drives the CAN interface at the ASC controller. The can1 device is used for inter-
nal purposes. The can0 device is used for communication via can bus. See the Manual -- ASC System
Controller for the CAN connector's pinout.
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3.29.1. Configure

CAN Bus shows the CAN bus number
CAN Node Type selects the CAN node type

Master sets the bus as Master
Slave sets the bus as Slave

Node ID shows the node ID number
Bitrate sets the bitrate

3.29.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.29.3. Parametrize - Network Management
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3.29. can0/1 - Controller Area Network

Sync Cycle Period sets the Sync cycle time. Only a master device can send Sync signals to all
slaves. This Sync signal initiates all slaves to send responses at the same time (the returned
values are "synced"). This value should not be less than 4000 µs (4 ms)

Sync COB ID sets the ID for the Sync COB (communication object)
Enable Sync If the checkbox is selected then synchronization is enabled
Send Sync if this checkbox is selected then a Sync signal is sent to all slaves (see also Sync Cycle

Period). The checkbox is unchecked immediately after the Sync signal was sent

Particularities
Here is a short example sequence of events for starting up a CAN communication:

Step 1 Connect the can0 device to the CAN bus (can0 = ASC 9-pin connector) , see the Manual --
ASC System Controller

Step 2 Configure device can0

Step 3 Set CAN Node Type to Slave

Step 4 Configure Node ID and Bitrate the values of your CAN bus

Step 5 Activate the can0 device (see 2.6.4 Activate)

After the device is activated, the ASC should be visible by the CAN Master device and it will output
the name "ASC5200Slave" on the ObjectDictionary-Index 0x1008.

PLC States
The current PLC state can be queried over ObjectDictionary-Index 0x2003:0x01. The value is com-
posed by these bits:

Bit1 DEVICES_FAILURE 0x0002
Bit2 DEVICES_READY 0x0004
Bit4 JOB_READY 0x0010
Bit5 JOB_ACTIVE 0x0020

Job Control

Job Start write 1 to ObjectDictionary-Index 0x2000:0x00
Job Abort write 1 to ObjectDictionary-Index 0x2002:0x00
Load Job to load a job, you have to write its file name (e.g. "Jobfile.job") to ObjectDictionary-Index

0x2013:0x00. The job has to be saved on the filesystem of the ASC controller (e.g. \\<ASC ip-
number>\Data\jobs)

Select Job to select a job, write the job name (the name of the Job node, not the file name, which
may be different) to ObjectDictionary-Index 0x2014:0x00

Job variables and other variables can be modified via CAN.
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PDOs - Process Data Objects

Four PDOs or Process Data Objects with up to 64 bit can be defined. A possible use of this feature could
be to send a PDO every time the PLC state changes.

3.30. udp_server - User Datagram Protocol Server

for controller ASC
device type misc.
driver version 1.0

The udp_server device enables communication between an ASC controller and a client by transport of
UDP datagrams over ethernet, see documentation ARG_InScript – ARG_Req_UDP.

3.30.1. Configure

Port sets the UDP port for the server

Error handling selects how errors will be handled

Count only errors will only be counted

Device failure the device will fall in failure state

Send message a message will be sent on error

3.30.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.
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3.31. sew_movidrive

3.30.3. Parametrize - General

Next sequence number shows the next sequence number (the UDP protocol itself does not have
sequence numbers; this is the internal sequence number for UDP data packages or UDP data-
grams)

Sync errors shows the number of sync errors

Checksum errors shows the number of checksum errors

Command errors shows the number of command errors

Reset server if the checkbox is selcted then the server will be reset

im

3.31. sew_movidrive

for controller ASC
device type misc.
driver version 1.0

3.31.1. Configure

Port selects which CAN device will be used
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can0 CAN device 0 will be used

can1 CAN device 1 will be used

Node ID sets the node ID

Axis Type selects the axis type

Linear sets the type to linear axis

Rotation sets the type to rotation axis

Scale Position sets the factor the position will be scaled with

Scale Speed sets the factor the speed will be scaled with

3.31.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.31.3. Parametrize - General
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3.31. sew_movidrive

CAN Node Name shows the CAN node name

Target Pos sets the nominal position

Target Speed sets the nominal speed

Start Ramp sets the time for acceleration until the target speed is reached

Stop Ramp sets the time for deceleration until stop

Apply On Start if this checkbox is selected a CAN sync signal is sent out after successfully sending
the PDO (CAN Process Data Object). For instance you can use this mechanism if you have two
axis and want to apply the settings synchroneously. Uncheck Apply On Start for the first axis
then do the settings. Check Apply On Start for the second axis and do the settings. On start a
CAN sync signal is sent and all parameters in the BUS system are set simultaneously.

Start if this checkbox is selected then axis motion will be started. The checkbox is unchecked im-
mediately after pressing it

Abort if this checkbox is selected then axis motion will be aborted. The checkbox is unchecked
immediately after pressing it

Job Continuation selects when the job will be continued

while moving the jobwill be continuedwhile the axis ismoving. E.g. for processingwhile the
axis is moving

after target position reached the job will be continued if the target position is reached.
E.g. for processing after the axis reached a position

Current Position shows the current position
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3.31.4. Parametrize - Status

Motor Turning the green LED is lit when the motor is turning
Inverter Ready the green LED is lit when the inverter is ready
IPOS Reference the green LED is lit when the drive is referenced (reference travel has completed

successfully)
Target Reached the green LED is lit when the nominal position is reached
Break Released the green LED is lit when the break is released
Limit Switch Clockwise the green LED is lit when
Limit Switch Counterclockwise the green LED is lit when
Error the red LED is lit when an error occures

3.32. fume extraction - Fume Extraction

for controller ASC
device type misc.
driver version 1.0
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3.32. fume extraction - Fume Extraction

The fume extraction device drives a fume extraction by control and feedback signals. Parameters re-
garding these signals and which device (i.e. connector) they should be located at can be defined here.

3.32.1. Configure

Control The Control signal will be sent to the fume extraction device over a device, which usually is
a connector, e.g. the USER connector at the ARGES System Controller, see section 3.36 ase user
io - USER Inputs and Outputs
Over device sets the device
Signal sets the output, which will be used for the Control signal on the chosen device
Polarity sets the polarity of the Control signal, i.e. defineswhether the fume extraction device

needs a high or a low active signal
Voltage sets the output voltage for the Control signal

Internal 5V sets the output voltage to 5 V and fixes this voltage for the entire block
of outputs the signal belongs to, see e.g. section 3.36 ase user io - USER Inputs and
Outputs

External sets the output voltage to the external supply voltage and fixes this voltage
for the entire block of outputs the signal belongs to, see e.g. section 3.36 ase user io -
USER Inputs and Outputs

Any sets the output voltage to any voltage that is defined for the entire block of outputs
the signal belongs to, see e.g. section 3.36 ase user io - USER Inputs and Outputs

Feedback The Feedback signal will be received from the fume extraction device over a device,
which usually is a connector, e.g. the USER connector at the ARGES System Controller, see sec-
tion 3.36 ase user io - USER Inputs and Outputs
Over device sets the device
Signal sets the input, which will be used for the Feedback signal on the chosen device
Polarity sets the polarity of the Feedback signal, i.e. defines whether the fume extraction de-

vice supplies a high or a low active signal
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3.32.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.32.3. Parametrize - General

Control mode sets whether the fume extraction device is switched Off, On or Job controlled. To con-
trol the fume extraction device, while a job is being executed, use InScript's pen mechanism.
How to use pens and change parameters during a job, see section 4.9 Manage Pens

Status

Control signal shows the signal's level and the level's human readable name

Feedback signal shows the signal's level and the level's human readable name

Timing

Lead time sets the time needed to establish the air flow necessary for nominal operation

Lag time sets the time needed tomaintain the air flow necessary for nominal operation after
the processing has ended

3.33. crossjet - Crossjet

for controller ASC
device type misc.
driver version 1.3.2.2

The crossjet device drives a crossjet nozzle by control and feedback signals. Parameters regarding
these signals and which device (i.e. connector) they should be located on, can be defined here.
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3.33. crossjet - Crossjet

3.33.1. Configure

Control The Control signal will be sent to the crossjet device over a device, which usually is a con-
nector, e.g. the USER connector at the ARGES System Controller, see section 3.36 ase user io -
USER Inputs and Outputs

Over device sets the device

Signal sets the output, which will be used for the Control signal on the chosen device

Polarity sets the polarity of the Control signal, i.e. defines whether the crossjet device needs
a high or a low active signal

Voltage sets the output voltage for the Control signal

Internal 5V sets the output voltage to 5 V and fixes this voltage for the entire block
of outputs the signal belongs to, see e.g. section 3.36 ase user io - USER Inputs and
Outputs

External sets the output voltage to the external supply voltage and fixes this voltage
for the entire block of outputs the signal belongs to, see e.g. section 3.36 ase user io -
USER Inputs and Outputs

Any sets the output voltage to any voltage that is defined for the entire block of outputs
the signal belongs to, see e.g. section 3.36 ase user io - USER Inputs and Outputs

Feedback The Feedback signal will be received from the crossjet device over a device, which usually
is a connector, e.g. theUSER connector at theARGES SystemController, see section 3.36 ase user
io - USER Inputs and Outputs

Over device sets the device

Signal sets the input, which will be used for the Feedback signal on the chosen device

Polarity sets the polarity of the Feedback signal, i.e. defines whether the crossjet device sup-
plies a high or a low active signal
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3.33.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.33.3. Parametrize - General

Control mode sets whether the crossjet device is switched Off, On or Job controlled. To control the
crossjet device, while a job is being executed, use InScript's pen mechanism. How to use pens
and change parameters during a job, see section 4.9 Manage Pens

Status
Control signal shows the signal's level and the level's human readable name
Feedback signal shows the signal's level and the level's human readable name

Timing
Lead time sets the time needed to establish the air flow necessary for nominal operation
Lag time sets the time needed tomaintain the air flow necessary for nominal operation after

the processing has ended
Feedback on-timeout sets the time period inwhich the crossjet device has to send the Feed-

back signal when it was switched on
Feedback off-timeout sets the time period inwhich the crossjet device has to send the Feed-

back signal when it was switched off

3.34. hid - Human Interface Device

for controller ASC
device type misc.
driver version 1.0
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3.35. profibus - Process Field Bus

The hid device manages ASC displays using a can bus. It can be activated or deactivated. Normally
the device must not be configured or parameterized.

NOTE

The hid device has no graphical user interface.

CAUTION

You have to know exactly how to set the variables here

Loss of data, jobs and other settings

� Do not edit any variables unless explicitly told to do so by ARGES.

3.35. profibus - Process Field Bus

for controller ASC
device type misc.
driver version 1.0

The profibus device requires optional hardware. Find more information about the profibus device in
the documentation ARGES System Controller – Fieldbus Interface for PROFIBUS – Interface Description.

NOTE

The profibus device has no graphical user interface yet.

3.36. ase user io - USER Inputs and Outputs

for controller ASC
device type misc.
driver version 1.0

The ase user io device controls inputs and outputs located at the ASC controller's USER connector or
its respective breakout box.
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3. Devices

3.36.1. Configure

Backplane address sets the ASE PCB's backplane address in the ASC PCB stack

NOTE

Do not modify this setting without consulting ARGES.

3.36.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.36.3. Parametrize - Inputs/Outputs

Inputs/Outputs No. shows the input and output number
Name shows the signal's name that is linked from a device to the respective input or output.

Unused inputs and outputs are shown as Input n or Output n. Only unused inputs and
outputs can be renamed here. Such inputs and outputs are set to low level and are high
active by default
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3.36. ase user io - USER Inputs and Outputs

TIP

Inputs andoutputs canbe addressed by their variable namewhenusing the Script
node in a job. The signal's variable name appeares in the Name column, in the
context menu.

Low level shows the human readable name for the signal's low level

High level shows the human readable name for the signal's high level

Level
shows the input signal's level
shows and sets the output signal's level

Status shows the human readable name for the signal's actual level

Output voltage sets the output voltage for a group of 4 outputs each

Internal 5V sets the output voltage to 5 V

External sets the output voltage to 5— 28 V depending on the supply voltage connected
to the upper Vext/GNDext connector at the USER breakout box, see section 3.36.4
Parametrize - Breakout Pinout.

NOTE

With this setting the Vext0 .. ext3/GNDuserIO pair of the respective group has to
be hard-wired to the upper Vext/GNDext connector.
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3. Devices

3.36.4. Parametrize - Breakout Pinout

This tab shows the actual breackout pinout as defined in tab Inputs/Outputs and in the devices con-
nected to the USER Inputs/Outputs device.

TIP

Print this tab and keep the hardcopy near the USER breakout box.
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3.37. position encoder - Position Encoder

3.36.5. Parametrize - Connector Pinout

This tab shows the current connector pinout as defined in tab Inputs/Outputs and in the devices con-
nected to the ase user io device.

3.37. position encoder - Position Encoder

for controller ASC
device type misc.
driver version 1.4

The position encoder device enables the usage of a position encoder. The device is using 4-fold-gating.
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3. Devices

3.37.1. Configure

Channel sets the connector at the ASC controller the encoder is connected to. If the encoder is
connected to connector ENCODER 1 then select "0". If the encoder is connected to connector
ENCODER 2 then select "1"

Counts per Revolution sets the expected counts per revolution.

NOTE

Take account of 4-fold gating and possible gear boxes.

Example:
Encoder signals per encoder revolution × 4 × gear transmission ratio = counts per
revolution
e.g. 2048× 4× 216 = 1769472

Direction of Rotation selects the direction of rotation

+, − inverts whether the resulting signals are incremental or decremental. This actually
depends on the machine setup

Angle sets the angle between the object's motion vector and the scan field's X-axis. This angle is
measured counterclockwise (positive values)

Resolution sets the expected resolution.

Counts per revolution : object length or circumference = resolution
e.g. 1769472 : 1981 = 893.221

Resolution unit dropdown sets the unit for the value in Resolution

Counts/mm, mm/Count, Counts/degree, Degrees/Count possible units

3.37.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.
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3.37. position encoder - Position Encoder

3.37.3. Parametrize - General

Counter Constraints

Inhibit Quantity sets the number of steps that will be ignored for the C-signal when mea-
surement begins. Whatever comes last of Inhibit Quantity and Inhibit Duration

Inhibit Duration sets the time in ns, µs, ms or s for which the steps will be ignored for the
C-signal when measurement begins. Whatever comes last of Inhibit Quantity and Inhibit
Duration

Lock Positive selects whether incremental counts are counted or not

Free incremental counts are counted

Locked incremental counts are not counted

Lock Negative selects whether decremental counts are counted or not

Free decremental counts are counted

Locked decremental counts are not counted

Status

Connected shows whether the position encoder device is connected or not. See the docu-
mentation of the ASC controller: At the ENCODER connector pins 9 and 11 have to be
connected at the encoder side of the supply cable

Power Status shows whether the voltage is OK or not

Power Fault shows whether the current is OK or not
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3. Devices

3.37.4. Parametrize - Measurement

Measurement Duration sets the duration (× 10.17 ns) used for velocity measurement. The value
has to be high enough to get reliable results. This method is recommended in case the velocity
is high. For low velocity see Quantity

Quantity sets the quantity of steps used for velocity measurement. This method is recommended
in case the velocity is low. For high velocity see Measurement Duration

NOTE

At the moment this method is not implemented yet.

Measured Time shows the measured time in× 10.17 ns

NOTE

At the moment this function is not implemented yet.

Encoder Frequency shows the encoder frequency

Global Count shows the global counts. To reset the Global Count reset the ASC controller.

3.37.5. Processing-On-The-Fly

If you need more information concerning this topic, please contact ARGES.
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3.38. disto - Distance Measurement Module

3.38. disto - Distance Measurement Module

for controller ASC
device type misc.
driver version 1.0

The disto device enables communication with the Distance Measurement Module.

3.38.1. Configure

Port selects the port for communication with the distance measurement module

COM A, COM B assigns the disto device to one of the serial interface connectors of the
controller

Baud selects the baud rate

4800, 9600, 19200, 38400 possible baud rates

Flow Control selects, how the data flow is controlled

None not controlled

RTS/CTS controlled via hardware, i.e. via the RTS/CTS lines

3.38.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.38.3. Parametrize - General

The disto device enables the laser tomeasure distances in combinationwith an e.g. Leica rangefinder.
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3. Devices

Result
Distance shows the distance
Distance Age shows the time passed since the distance was measured last
Average # shows the number of averaged distance values
Distance s2 shows the standard deviation of themeasured values or averaged values respec-

tively, see also Mode
Acquired # shows the total number of measurements

Control
Mode selects the mode of measurement

Single the distance will be measured when clicking Acquire
Continuous the distance will be measured continuously

Average sets the number of measurements to average the value shown in Distance
Acquire click to start measuring, click once again to stop measuring

Power Saver
Auto Power Off If the checkbox is selected then the module will be switched off after the

time given in Idle Timeout
Idle Timeout sets the period after that distancemeasuringmodule will be switched off when

the module is idle

3.39. pwm - Pulse Width Modulation

for controller NCC (since NCC 1704A), ASC
device type misc.
driver version 1.17.2.2
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3.39. pwm - Pulse Width Modulation

The pwm device generates a signal for pulse width modulation.

3.39.1. Configure

Channel selects the channel where the pwm signal will be output

HSIO0 .. HSIO7 — or — 2, 4, 5
If an ASC controller is used then this assigns the pwm signal to one of the high speed I/Os
at the LASER CONTROL connector, see the documentation of the ASC controller

— or —

If an NCC controller is used then this assigns the pwm signal to one of the given outputs
at the parallel outputs connector, see the documentation of the NCC controller

3.39.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.39.3. Parametrize - Wobble

Frequ sets the frequency of the pwm signal

Duty Cycle sets the pwm signal's pulse length in percent of the frequency specified in Frequ

Settle sets the settle time for the pwm signal to stabilize its value
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3. Devices

3.40. serial access - Serial Interface

for controller NCC
device type misc.
driver version 1.0

The serial access device enables communication via one of the NCC controller's serial interfaces.

3.40.1. Configure

Serial Interface

Port selects the serial interface for communication

COM A, COM B assigns serial access device to one of the serial interface connectors
at the NCC controller, see the documentation of the NCC controller

Baud selects the baud rate

300 .. 38400 possible baud rates

Bits selects the transmission format length

7, 8, 9 possible lengths in bit

Parity selects the parity

None no parity

Odd odd parity

Even even parity

Stop selects the number of stop bits

1, 2 possible number of stop bits

Handshake selects, how the data flow is controlled
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3.40. serial access - Serial Interface

None not controlled

XON/XOFF controlled via software

RTS/CTS controlled via hardware, i.e. via the RTS/CTS lines

Protocol

Protocol selects the ASCII character interpreted as line end

ASCII (CR) carriage return

ASCII (LF) line feed

Echo If the checkbox is selected then the characters received will be send back as an echo

Time Out sets the allowed time between receiving the last character and receiving the line
end character. If this time is exceeded then the command will be discarded

ACK sets the acknowledge string sent on success. Type control characters like Ctrl-M (CR) as
^M

NAK sets the not-acknowledge string sent on failure. Type control characters like Ctrl-M
(CR) as ^M

Echo linefeed sets the string sent on line end. The characters interpreted as line end are
defined in Protocol. The Echo checkbox has to be selected. Type control characters like
Ctrl-M (CR) as ^M

3.40.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.

3.40.3. Parametrize - General

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 239



3. Devices

Communications Status shows the communication status between the controller and the con-
nected device

Command text box to type in a command line.
Scripting language commands will be accepted here, see section 5.44.2 Scripting Language. Use
Script nodes to access the serial interface during job execution, see section 5.44 Script. Similar
to the conventional scripting a row of different commands can be seperated by semicolons.
The command line end identifies the end of the script here. The command line length has to
be less than 4 kB

Last Command shows the last executed command line
Input Buffer shows the number of characters currently in the receive buffer while characters are

received

3.40.4. Communication Examples

The following examples show communication using the serial access device:
Set a Variable and Job Start
Protocol: ASCII (CR)
ACK: OK^M^J
sent: $myvar$ = 256; mark_start(); (CR)
received: OK (CR) (LF)

Here is a description of this communication:
• An external device sends a string to the controller via the specified serial port
• The controller gets the string "$myvar$ = 256; mark_start();"
• The string is followed by a (CR) Carriage Return caharacter. this ends the communication as
specified in Protocol

• Now the string is executed as scripting command(s):
1. $myvar$=256;→ Variable usr.var.myvar is set to 256 (if it does not exist it is created)
2. mark_start();→ processing of the laser is started (as if you would click on Start )

• After the controller received the string, it will send the sequence of bytes specified under ACK
(normally OK^M^J)

• If an error occurs (e.g. a timeout), the controller will answer with the sequence of bytes speci-
fied under NAK (normally Error^M^J)

Send a Variable via COM A
Any scripting command can be sent as a string. For instance, another possibility would be to use the
serial send() command of the InScript scripting language to return a variable:
Protocol: ASCII (CR)
ACK:
sent: send("COM A","$usr.var.myvar$"); (CR)
received:
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3.41. out1 - Address Parallel Output Via Pens

But in this case you will have to be sure that the ACK, NAK or Echo communication does not interfere.
So all these fields have to be blank and unchecked.

Here is a description of this communication (we assume that variable $myvar$ exists and has a value
of 256):

• An external device sends a string to the controller via the specified serial port

• The controller gets the string "send("COM A","$usr.var.myvar$");"

• The string is followed by a (CR) Carriage Return caharacter. this ends the communication as
specified in Protocol

• Now the string is executed as scripting command(s):

– send("COM A","$usr.var.myvar$"); → The controller returns the string "256" through
COM port A

3.41. out1 - Address Parallel Output Via Pens

for controller NCC
device type misc.
driver version 1.0

If you want to address one output at the NCC controller's parallel outputs connector via a pen then use
the out1 device.

3.41.1. Configure

Output sets the output to be addressed at the parallel outputs connector of the NCC controller, see
the documentation of the NCC controller

3.41.2. Parametrize

See 3.1.2When Editing (Parametrizing) Active Devices for common gui elements while parametrizing
the device.
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4. Job Configuration Window

3.41.3. Parametrize - General

Settle rise sets the settle time for the rising slope of the signal

Settle fall sets the settle time for the falling slope of the signal

Value If the checkbox is selected and if the pen is in use during job execution then the signal will
be output

4. Job Configuration Window

The term job can be understood as a program, that can be designed using InScript. This program
controlls the devices connected to the controller.

Jobs consist of nodes, which are hierarchically related to one each other and are displayed as a tree
structure. There are different types of nodes. Each type has its function and properties. Nodes con-
taining other nodes are called parent nodes of the latter ones which are called child nodes (with
reference to their parent node). Child nodes inherit properties of their parent nodes.

The job and thus the wanted output results from the arrangement of the nodes within the tree struc-
ture. This is summarized by the term Job Configuration. The tree structure is displayed in the Job
Configuration window.

This tree structure contains nodes, which generate graphical output and are called graphical objects.
In most cases these nodes are the leaves of the tree structure. The graphical objects of jobs also can
be created in the Vector Editorwindow, see section 7 Vector EditorWindow. But the job tree structure
(work flow) can only be edited in the Job Configuration window.

4.1. How to Open the Window

� In the menu, click View→ Job Configuration.
— or —
In the toolbar, click .
The Job Configuration window opens.
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4.2. Description of the Window

4.2. Description of the Window

Figure 5: The Job Configuration window

Toolbar Standard Nodes provides thenodes to be inserted into an executable
job. Build up jobs from these nodes in the Exec branch of the tree structure. How to manage
jobs, see section 4.6 Manage (Executable) Jobs

Column Node shows which job nodes are present by job node "type" icon and the node's name.
For information about the main job node "types" marking the branches of the tree structure,
see section 4.3 Job Configuration Tree Structure

shows that the node is selected for execution, see section 6.3 Select Job for Execution

if the cursor is on a node then the node is selected for the next action from context
menu or keyboard

Column Properties shows the properties of the node in column Node in the same line

shows that the node has a view in Vector Editor, see section 4.4.2 Exec

shows that the node is selected in the Vector Editor, see section 4.4.2 Exec

shows that the node has a backdrop image, see section 4.4.2 Exec

4.3. Job Configuration Tree Structure

See also figure 5.

<Address|IP> this is the root of the tree structure. It shows the controller that is attached to
this instance of InScript. Next to the symbol you find the name of the NCC controller or the IP
address of the ASC controller. How to manage controllers, see section 4.5 Manage Controllers

Exec contains executable jobs, i.e. programs that control the devices connected to the controller.
How to manage and design jobs, see section 4.6 Manage (Executable) Jobs

Macros can contain parts of jobs, which can be reused in different places of jobs, see sections
4.7 Manage Macros

DefaultJob can contain a link to user-defined job file. After booting the controller this job file
will automatically be loaded. How to manage the default job, see section 4.8 Manage Default
Job
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4. Job Configuration Window

Pens in the Pens subtree pens with different properties can be defined. Each pen contains pen-
sections. Each pen-section is assigned to an active device, see section 3 Devices. In the pen-
sections the parameters of the assigned devices can be set. A device may e.g. be the scan head
itself, a laser, a motion axis or else.

That way you can create a collection of pens, whose properties are tailored to different tasks.

By inserting a Pen Link node into the job you can activate the parameters defined in the pen. If
pens are used in a graphics file, e.g. in HPGL files, then you can assign them via a Pen Set node
to the pens you created.

How to work with pens, see section 4.9 Manage Pens. You will also find an example in section
4.9.1 Control Device Parameters During Job Execution

Files in the Files subtree vector and raster graphic formats can be imported. They remain as
objects in this subtree and are e.g. referenced to by symbolic links in the Exec subtree. How to
work with files, see section 4.10 Manage Files

Fonts in the Fonts subtree all additional fonts which are available in RAM of the controller can
be seen. If you use a font e.g. in a Text node and execute this node, the font is visible in the
Fonts subtree. How to work with fonts, see section 4.11 Manage Fonts

Status in the Status subtree important information about processing times of the last executed
jobs and the currently selected job node is stored

4.4. Context Menus for the Respective Branch in the Tree Structure

Use the context menu to manage the job configuration in the Job Configuration window. Each main
branch of the tree structure has its own context menu. Some branches have several types of context
menus depending on the level in the tree structure. Whether a menu item is enabled or not, depends
on the job node and its status. The context menu:

4.4.1. Controller (root node)

Find more information in section 4.5 Manage Controllers.

NOTE

The ASC controller is not administrated via InScript. It is administrated via a so called
Web Interface, see section 4.5.2 ASC Web Interface. The context menu of the Job Config-
uration root node, showing the IP address of the ASC controller and allows the actions
shown in the next figure, left side.

The NCC controller is administrated via InScript. The context menu of the Job Configuration root,
showing the ID of the controller and allows the actions shown in the next figure, right side.
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4.4. Context Menus for the Respective Branch in the Tree Structure

Figure 6: The controller (root node) context menu for the ASC (left) and for the NCC (right) controller

Configure shows the Board Configuration window for the NCC controller, see section 4.5 Board
Configuration Window

Save Devices and Default Pen (NVRam) saves all current settings to theNVRam (non-volatile
RAM) of the controller, see section 2.7 Store Configuration

Flash

CAUTION

Data loss
The firmware or the user data together with the firmware present on the NCC con-
troller will be lost in this procedure.
� Save the jobs, user data and/or firmware before continuing.

flashes a new firmware to the NCC controller, see also section 4.5 Board ConfigurationWindow
Backup backups the current NCC controller firmware. User data will not be saved, see also sec-

tion 4.5 Board Configuration Window
Delete

CAUTION

Data loss
The current NCC controller firmware and user data on the NCC controller will be
lost in this procedure.
� Save the user data and/or firmware before continuing.

User data or Jobs, Pens, Files and Fonts will be deleted if you select them and click Delete. You
can use Backup to save the data in advance, see also section 4.5 Board Configuration Window

Reconnect

CAUTION

Data loss
Your settings may be lost by reconnecting the ASC controller as it will be restarted
as well.
� Save your settings before reconnecting.
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4. Job Configuration Window

restarts and reconnects the ASC controller

Reset

CAUTION

Data loss

Unsaved User Data and Jobs will be lost.

� Save the user data and/or jobs before continuing.

resets the NCC controller

Rename renames the NCC contoller node

Xplore opens the Xplorer window at the selected node. Find information about the Xplorer in
section 8.5 Xplorer

Info opens the Node Info window. Information coming from the controller about the selected
node will be shown

Dump opens the ARGES InScript window. Information coming from the InScript software about
the selected node will be shown

Name to Clipboard copies the full path and name of the selected node to the clipboard

4.4.2. Exec

Find more information in section 4.6 Manage (Executable) Jobs.

Show VectorEditor View adds the view of the selected subtree to the Vector Editor, see section
4.6.27 Show VectorEditor View
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4.4. Context Menus for the Respective Branch in the Tree Structure

Remove VectorEditor View removes the view of the selected subtree from the Vector Editor,
see section 4.6.28 Remove VectorEditor View

Select in VectorEditor selects the selected node in the Vector Editor, see section 4.6.29 Select in
VectorEditor

Edit Backdrop Property opens the Edit backdrop property window of the selected node, see sec-
tion 4.6.30 Edit Backdrop Property

Edit Node opens the node editor of the selected node, see section 4.6.16 Edit Node

Rename renames the selected node, see section 4.6.17 Rename Node

Select selects the selected node for execution, see section 6.3 Select Job for Execution

Deselect deselects the selected node from execution, see section 6.3 Select Job for Execution

Variables to Inspector copies theVariables changable in OperatorMode from the selected Job node
to the Inspector, see section 8.9 Node Inspector

Full Expand expands all subtrees in the Job Configurationwindow, see section 4.6.21 Expand Exec
Tree

Full Collapse collapses all subtrees in the Job Configuration window, see section 4.6.22 Collapse
Exec Tree

Node Expand expands a subtrees in the Job Configurationwindow, see section 4.6.23 Expand Sub-
tree

Node Collapse collapses a subtrees in the Job Configuration window, see section 4.6.24 Collapse
Subtree

Arrange arranges the order of nodes on the selected tree hierarchy level, see sections 4.6.25 Ar-
range Subtree and 4.6.26 Arrange Node

Make First makes the selected node first in its subtree

Up moves the selected node one place up in its subtree

Down moves the selected node one place down in its subtree

Make Last makes the selected node last in its subtree

Open Job opens a *.job file, see section 4.6.3 Open Job

Load File loads a file, see section 4.6.4 Load File

Save Job saves a job, see section 4.6.5 Save Job

Copy puts a copy of the selected node and its subnodes to clipboard

Cut puts a copy of the selected node and its subnodes to clipboard and removes it from the tree
structure

Paste pastes a copied or cut node and its subnodes from clipboard into the tree structure. The
root node has to be able to contain subtrees

Delete Node deletes the selected node and leaves all subnodes untouched
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4. Job Configuration Window

Delete Subtree deletes the selected node and all its subnodes

Xplore opens the Xplorer window at the selected node. Find information about the Xplorer in
section 8.5 Xplorer

Info opens the Node Info window. Information coming from the controller about the selected
node will be shown

Dump opens the ARGES InScript window. Information coming from the InScript software about
the selected node will be shown

Name to Clipboard copies the full path and name of the selected node to the clipboard

4.4.3. Macros

Find more information in section 4.7 Manage Macros.

Edit Node opens the node editor of the selected node, see section 4.6.16 Edit Node

Rename renames the selected node, see section 4.6.17 Rename Node

Full Expand expands all subtrees in the Job Configurationwindow, see section 4.6.21 Expand Exec
Tree

Full Collapse collapses all subtrees in the Job Configuration window, see section 4.6.22 Collapse
Exec Tree

Node Expand expands a subtrees in the Job Configurationwindow, see section 4.6.23 Expand Sub-
tree

Node Collapse collapses a subtrees in the Job Configuration window, see section 4.6.24 Collapse
Subtree

Arrange arranges the order of nodes on the selected tree hierarchy level, see sections 4.6.25 Ar-
range Subtree and 4.6.26 Arrange Node
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4.4. Context Menus for the Respective Branch in the Tree Structure

Make First makes the selected node first in its subtree

Up moves the selected node one place up in its subtree

Down moves the selected node one place down in its subtree

Make Last makes the selected node last in its subtree

Load Macro loads a macro, see section 4.7.6 Load Macros

Save Macro saves a macro, see section 4.7.5 Save Macros

Load Subtree loads a *.tre file under a node that can contain subtrees, see section 4.6.12 Load
Subtree

Save Subtree as saves the selected node and its subnodes to a *.tre file, see section 4.6.13 Save
Subtree. The node must not be a Job node

New Group creates a new macro group, see section 4.7.4 Group Macros

Copy puts a copy of the selected node and its subnodes to clipboard

Cut puts a copy of the selected node and its subnodes to clipboard and removes it from the tree
structure

Paste pastes a copied or cut node and its subnodes from clipboard into the tree structure. The
root node has to be able to contain subtrees

Delete Node deletes the selected node and leaves all subnodes untouched

Delete Subtree deletes the selected node and all its subnodes

4.4.4. DefaultJob

Find more information in section 4.8 Manage Default Job.

Set Default Job sets a job as default, see section 4.8.1 Set Default Job

Reset Default Job sets no job as default, see section 4.8.2 Reset Default Job

Xplore opens the Xplorer window at the selected node. Find information about the Xplorer in
section 8.5 Xplorer

Info opens the Node Info window. Information coming from the controller about the selected
node will be shown

Dump opens the ARGES InScript window. Information coming from the InScript software about
the selected node will be shown

Name to Clipboard copies the full path and name of the selected node to the clipboard
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4. Job Configuration Window

4.4.5. Pens

Find more information in section 4.9 Manage Pens.

New Pen creates a new pen, see section 4.9.2 Create New Pen

Load Pen loads a pen, see section 4.9.4 Load Pen

Load Pen as loads a pen and provides the possibility to change the pen name, see section 4.9.5
Load Pen as

Save all user pens saves all pens created by the user, i.e. saves not the default pen

New Pen Section creates a pen section, see section 4.9.2 Create New Pen

Delete Pen deletes a pen, see section 4.9.8 Delete Pen

Save Pen saves a pen, see section 4.9.6 Save Pen

Save Pen as saves a pen and provides the possibility to change the file name, see section 4.9.7
Save Pen as

Edit Pen Section opens the pen section's editor, see section 4.9.3 Edit Pen Section

Delete Pen Section deletes a pen section, see section 4.9.9 Delete Pen Section

Xplore opens the Xplorer window at the selected node. Find information about the Xplorer in
section 8.5 Xplorer

Info opens the Node Info window. Information coming from the controller about the selected
node will be shown

Dump opens the ARGES InScript window. Information coming from the InScript software about
the selected node will be shown

Name to Clipboard copies the full path and name of the selected node to the clipboard

4.4.6. Files

Find more information in section 4.10 Manage Files.
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Load

HPGL loads a HPGL vector file to the Files subtree, see section 4.10.5 Load - Creating Nodes
Manually

LG1 loads a LG1 vector file to the Files subtree, see section 4.10.5 Load - Creating Nodes Man-
ually

Bitmaps loads a graphics file to the Files subtree, see section 4.10.5 Load - Creating Nodes
Manually

Delete deletes the selected node

Xplore opens the Xplorer window at the selected node. Find information about the Xplorer in
section 8.5 Xplorer

Info opens the Node Info window. Information coming from the controller about the selected
node will be shown

Dump opens the ARGES InScript window. Information coming from the InScript software about
the selected node will be shown

Name to Clipboard copies the full path and name of the selected node to the clipboard

Add to Inspector opens the Xplorer window at the selected node. Find information about the
Xplorer in section 8.5 Xplorer

4.4.7. Fonts

Find more information in section 4.11 Manage Fonts.

Load loads a *.fdt or *.sfh file, see section 4.11Manage Fonts formore information on font handling
and fonts

Delete removes the font from the Fonts folder in the Job Configuration window

Xplore opens the Xplorer window at the selected node. Find information about the Xplorer in
section 8.5 Xplorer
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Info opens the Node Info window. Information coming from the controller about the selected
node will be shown

Dump opens the ARGES InScript window. Information coming from the InScript software about
the selected node will be shown

Name to Clipboard copies the full path and name of the selected node to the clipboard

Add to Inspector opens the Xplorer window at the selected node. Find information about the
Xplorer in section 8.5 Xplorer

4.4.8. Status

Xplore opens the Xplorer window at the selected node. Find information about the Xplorer in
section 8.5 Xplorer

Info opens the Node Info window. Information coming from the controller about the selected
node will be shown

Dump opens the ARGES InScript window. Information coming from the InScript software about
the selected node will be shown

Name to Clipboard copies the full path and name of the selected node to the clipboard

Add to Inspector opens the Xplorer window at the selected node. Find information about the
Xplorer in section 8.5 Xplorer

4.5. Manage Controllers

NOTE

The ASC controller is not administrated via InScript. It is administrated via a so called
Web Interface, see section 4.5.2 ASC Web Interface.

The NCC controller is administrated via InScript.

The following topics refer to NCC.

Board Configuration Window

If you choose Configure from the context menu or double click the root of the Job Configuration tree,
you get the Board Configuration window:
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Among other things you can flash and backup the firmware and user data of the NCC controller in
this dialog. The firmware is the basic software that enables the NCC controller to work. The user data
is all settings you made on the controller. Please be aware that if you change the firmware or user
data of your controller also the functionality of the controller may change.

NOTE

It is always advisable to save the current firmware and user data before you change the
current configuration!

Type displays the sub-type of the ASC controller

Reset Board cautionData lossUnsaved User Data and Jobs will be lost.

� Save the user data and/or jobs before continuing (check this section for more informa-
tion)!

The controller board will be reset

Save/Restore

Save User-Data saves the NCC user data to a *.fdb file. This file can not be restored by the
user - you will have to contact ARGES to do be able to this. This function exists mainly for
debugging purposes

Save Firmware saves the current firmware to a *.ffb file

Restore Firmware

CAUTION

Data loss

The current firmware and the user data on the controller board will be lost in
this procedure.

� Save the user data and/or firmware before continuing (check this section
for more information)!
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Restores firmware from a *.ffb file.

Save Both saves firmware and user data to a *.fb file. Use this function to save your current
settings

Restore Both

CAUTION

Data loss

The current firmware and the user data on the controller board will be lost in
this procedure.

� Save the user data and/or firmware before continuing (check this section
for more information)!

Restores firmware and user data from a *.fb file

Memory

Total shows the total amount of memory

Used shows the currently used memory

Free shows the currently free memory

Largest Free shows the curently largest free memory block

Firmware

Make Time Date creation date and time of the current firmware

Build Mark build mark of the current firmware

Size size of the current firmware

Details Menu

Flash/Reorganize reorganize aprobably corrupted Flashmemoryof the controller
board. The data area is deleted. If the reorganization is done Flash reorganisation
succeeded. is shown in the Messages window (see 8.10 Messages)

Flash/Enhanced Reorganization reorganize a probably corrupted Flashmemory
of the controller board with an enhanced algorithm that tries to collect valid
blocks of the data area to keep them. If the reorganization is done Enhanced flash
reorganisation succeeded. is shown in the Messages window (see 8.10 Messages).

View/Refresh refresh the data shown in the tabs Flashlist and Flash 1

Tabs Flashlist shows statistics about the flash memory

Flash 1 shows a memory map of the flash memory

Flash New
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CAUTION

Data loss

The current firmware and the user data on the controller board will be lost in
this procedure.

� Save the user data and/or firmware before continuing (check this section
for more information)!

Flashes a new firmware from *.fls file a to the controller

The following topics refer to NCC and ASC.

4.5.1. Basic Actions Managing a Controller

This chapter describes some basic and recurring actions manging a controller.

Toggle Between Controllers

To connect to one or more controllers by default on InScript startup, see section 8.4.23 Sub Category
- Startup Connect Controllers.

� In the main menu, click View→ Controllers, see section 8.3.3 View.

Save Data to NVRam

Saves the user data (i.e. configuration and settings of installed devices), jobs, pens (except for the
default pen), files and name settings to the NCC controller board or stores it on the ASC controller.
In not saving this data, it would be lost when switching off the PC with the controller card (NCC) or
resetting/switching off the controller (ASC and NCC).

� In the menu, click Controller→ Save to NVRam.
— or —
In the tree structure in the board symbol context menu, click Save to NVRam.

Save User Data/Firmware to Disk

On NCC Controller:

Saves the user data (i.e. configuration and settings of installed devices), firmware or both to the disk.

Step 1 In the menu, click Controller→ Configure.
— or —
In the board symbol context menu, click Configure.
The Board Configuration window opens.

Step 2 Click Save User-Data or Save Firmware or Save Both.
The Save as window opens
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Step 3 Name the file and select a location to save it to.
The files automatically receive a file name extension *.fdb (flash data backup), *.ffb (flash
firmware backup) or *.fb (flash backup)

Step 4 Click Save.

On ASC Controllers:

Saves shown configuration files to disk.

Step 1 Open the ASC Webinterface and log in (see 4.5.2 ASC Web Interface)

Step 2 Click on Administration→ Backup and Restore

Step 3 Click on Download under Backup Controller Configuration and select a location on e.g. your
hard disk to save the ASC configuration files (packed in conf.tar.gz) that are shown in
the list

Restore NCC User Data/Firmware from Disk or Restore ASC Configuration Files from
Disk

CAUTION

Data loss

The firmware or theuser data togetherwith the firmware present on the controller board
will be lost in this procedure.

Save the actual configuration data and/or firmware before continuing (see 4.5.1 Save
User Data/Firmware to Disk)!

On NCC Controllers:

Restores only the firmware or the user data together with the firmware from disk to the controller
board.

Step 1 In the menu, click Controller→ Configure.
— or —
In the board symbol context menu, click Configure
The Board Configuration window opens.

Step 2 Click Restore Firmware or Restore Both. Restore Both restores the firmware and the user
data.
After a query the Open window opens

Step 3 Select the (saved) file

Step 4 Click Open

Step 5 This process may take some time - all current settings will be replaced with the saved
settings
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On ASC Controllers:

Restores the selected configuration files to the ASC controller.

Step 1 Open the ASC Webinterface and log in (see 4.5.2 ASC Web Interface)

Step 2 Click on Administration→ Backup and Restore

Step 3 Select the checkbox(es) of the configuration file(s) in the list under Restore Controller Con-
figuration and click on Browse

Step 4 Select the (saved) conf.tar.gz file (see 4.5.1 Save User Data/Firmware to Disk) and click
on Open

Step 5 Click on Upload to upload and install the configuration files

Step 6 This process may take some time - all current settings that you selected will be replaced
with the saved settings

NOTE

The version numbers in System Info→ Installed ASCModuleswill not be updated using this
procedure (see 4.5.1 Show Flash or ASCmodule Info)!

Load Firmware from Disk

CAUTION

Data loss

The firmware present on the controller board will be lost in this procedure.

Save the current firmware before continuing (4.5.1 Save User Data/Firmware to Disk)!

On NCC Controllers:

Loads the firmware from disk to the controller board.

Step 1 In the menu, click Controller→ Board Configuration.
— or —
In the board symbol context menu, click Configure.
The Board Configuration window opens

Step 2 Click Flash New
After a query the Open windows opens.

Step 3 Select the Firmware file (normally these files look like this: fw-<version>.fls)

Step 4 Click Open

On ASC Controllers:

Loads the firmware from disk to the controller board.

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 257



4. Job Configuration Window

Step 1 Open the ASC Webinterface and log in (see 4.5.2 ASC Web Interface)

Step 2 Click on Administration→ Install ASCModule

Step 3 Click on Browse

Step 4 Select the firmware file
(normally these files look like this: ARG_ASC_FW_<version>.tar.gz)

Step 5 Click on Install to upload and install the firmware file

Show Flash or ASCmodule Info

On NCC Controllers:

The flash area is a non volatile storage area. Here you can see details about memory usage and frag-
mentation of this area. Cleaning up the flash area can be dangerous for the data stored in this area
- so please consult with AGRES before doing this! In menu Flash→ Reorganize or Flash→ Enhanced
Reorganization you can clean up the flash area.

Step 1 In the menu, click Controller→ Configure.
— or —
In the board symbol context menu, click Configure.
The Board Configuration window opens

Step 2 Click Details.
The Flash Info window opens

On ASC Controllers:

There is no "real" Flash area on an ASC controller. But you can see the installed ASCmodules using
the Webinterface.

Step 1 Open the ASC Webinterface and log in (see 4.5.2 ASC Web Interface)

Step 2 Click on System Info → Installed ASCModules The currently installed firmware and ASC-
modues are shown

Delete Jobs, Pens and Files

CAUTION

Data loss

The Jobs, Pens and Files present on the controller board will be lost in this procedure.

Save the current Jobs, Pens and Files before continuing!

On NCC Controllers:

Deletes only the jobs, pens and files from the controller board.
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� In the menu, click Controller→ Delete.
— or —
In the board symbol context menu, click Delete.
After a query the jobs, pens (except for the default pen) and files will be deleted from the con-
troller board.

On ASC Controllers:

There is no Delete function for the ASC controller. Just delete the items in Job Configuration window.

Reset

CAUTION

Data loss

Changes in user data (i.e. configuration and settings of installed devices), jobs, pens, files
and name settings will be lost, if the controller board is reset and the changes were not
saved to the controller board's NVRam.

Save jobs, pens files and data before continuing (4.5.1 Save Data to NVRam).

On NCC Controllers:

Resets the controller board. This may be necessary, when the controller board does not react any
more as result of an error.

� In the menu, click Controller→ Configure.
— or —
In the board symbol context menu, click Configure.
The Board Configuration window opens

� Click Reset Board.
After a query the controller board will be reset

On ASC Controllers:

On ASC you can reset the firmware, completely restart the controller or halt the controller to switch
it off:

Reset Firmware

Step 1 Open the ASC Webinterface and log in (see 4.5.2 ASC Web Interface)

Step 2 Click on Administration→ InScript Firmware

Step 3 Click on Restart InScript Firmware
The Firmware will restart.

Restart Controller

Step 1 Open the ASC Webinterface and log in (see 4.5.2 ASC Web Interface)

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 259



4. Job Configuration Window

Step 2 Click on Administration→ Halt/Reboot

Step 3 Click on Reboot
The controller will reboot. This may take some time!

NOTE

The Controllerwill reboot. Because of this the connection of theWebinterface
will be interrupted and you can only restart after the controller has rebooted.

Halt Controller
The controller will completely halt and after that you may e.g. switch it off.

Step 1 Open the ASC Webinterface and log in (see 4.5.2 ASC Web Interface)

Step 2 Click on Administration→ Halt/Reboot

Step 3 Click on Halt
The controller will stop all processes. This may take some time!

NOTE

The Controller will halt. Because of this the connection of the Webinterface
will be interrupted and you can only restart after the controller has rebooted.

Step 4 After the ASC controller has halted, you may completely switch it off

The following topics refer to ASC.

4.5.2. ASC Web Interface

To connect to the ASC Web Interface use an internet browser that has a connection to the ASC con-
troller. The PC InScript is running on is connected to the ASC controller and should also be able to
connect to the controller via a web browser:

Step 1 Type the IP address of the ASC controller (e.g. 192.168.1.42) into the address field of the
browser and press the Enter key.
The ASC Web Interface for the addressed controller opens.
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Step 2 Click in the upper right corner of the page.
The login page opens.

The default user name is root and the default password is arges.
When logged in administrative tasks can be done.

Short description of the Web Interface menu:

Administration
Shell input Linux shell commands in the Command input field.

Output will be shown in the Output of your last command field.
Adjust Time sets the time and date on the controller
Network Settings sets the IP Address, Netmask etc.
Network Folders published not implemented, yet

used adds an anonymous user share Share-location to Name on the controller as a search
path by now only for RawLines node
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Backup and Restore Backups and restores current firmware, firmware configuration, work
settings and user settings.

NOTE

Restoring the firmware using this tool will not update the versions of the in-
stalled FW ASCModule.

Install ASCmodule ASCmodules are installationmodules for theASC controller. Thesemod-
ules can be obtained by ARGES and are *.tar.gz files. User the Browse button to browse
to the ASCmodule and press Install to install the module. Be sure that you have a valid
module for your system!

CAUTION

Data loss

Controller settings may be lost

� Be sure that you have the right ASCmodule for your system

� All your settings may be lost after installing ASCmodules

Boards shows hardware information of your ASC cntroller boards

InScript Firmware

CAUTION

Data loss

Please note that your current jobs and configuration will be lost if you did not
save them (just like they would be lost on power down).

� Be sure that you saved your jobs and configuration!

Press the Restart InScript Firmware button to completely restart the firmware of your con-
troller.

RenderServer Press the Restart RenderServer button to restart the RenderServer of your con-
troller.

Halt/Reboot Press the Reboot button to reboot your controller. Press the Halt button to halt
your controller. After Halt, the controller can be switched off

System Info

Config report click on the link to see and print the config report

Processes shows all running processes on the controller

CPU Usage shows a graphic overview of the CPU usage for different time intervals

Memory Usage shows a graphic overview of memory usage for different time intervals

Network Usage shows a graphic overview of network usage in time or packets for different
time intervals
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System Temperature shows the system temperature

System Voltages shows the system voltages

Boards shows hardware information of your ASC cntroller boards

Installed ASCmodules shows all installed ASCmodules (not version of firmware ASCmodule
updated if you Administration / Restore a firmware)

Support Info

Versions shows the exact Linux and firmware versions

Logfiles lets you check the system, secure and CGI log

Create support info lets you create and download a file with information about the con-
troller which is relevant for our support team

InScript

Manual in future versions of the Web Interface you will find the manual here

4.6. Manage (Executable) Jobs

TIP

A complete example for creating, saving and executing a job can be found under 10.1
First and Important Steps.

In the Job Configuration window, jobs are created as direct child nodes of the Exec node, see figure 7.

Figure 7: The Job Configuration window

The toolbar Standard Nodes combines the available node types to groups.

� To open a "node type group" toolbar, click the corresponding symbol on the Standard Nodes
toolbar.
Find a detailed description of each node type in section 5 Job Nodes.
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Figure 8: The Standard Nodes toolbar and the "node type group" toolbars

The nodes are combined to these groups:

• Geometrical Operators geometrically transform their child nodes

• Tools are the actual generators of output and normally the "leaves" of the tree structure

• Organizers structure the job or change its work flow

• Modifiers modify the output appearance

• Dialogs interactively show or query information

• IOs control external devices, mainly motion axes and data
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4.6.1. Basic Steps

The Order How Jobs are Processed
Jobs are executed top down. Have a look to following example, how jobs are composed:

1. At first the Job node is executed. It serves as an element of organization to distinguish one job
from others.

2. Next the Transform node is executed. This geometrically transforms (offsets, scales, rotates and
slants) all its child nodes.

3. Then the Shape node is executed. It outputs a primitive shape (e.g. line, rectangle or ellipse).
Because it is child of the Transform node the transformation set there affects the shape, i.e. the
shape will be output with an offset, scaled, rotated and slanted respectively.

4. At last the Text node is executed. This outputs an user-defined text. Because it has no Transform
node as direct or indirect parent node, it will be output without any change.

How to Create a Job

Step 1 Create a job, see section 4.6.2 Create Job.
— or —
Open a job, see section 4.6.3 Open Job.
— or —
Clear and load a job, see section 4.6.9 Clear and Load Job.

Step 2 Create a view on the job in the Vector Editor window to visualize the scan head's output,
see section 4.6.27 Show VectorEditor View.

Step 3 Use the Standard Nodes toolbar to create nodes.
Find an overview of job nodes in figure 8. Find more information about the different job
node types in section 5 Job Nodes.

Step 4 Use the context menu to manage and structure the job tree.
When designing the hierarchy keep paragraph The Order How Jobs are Processed in
mind.

Step 5 Create pens with special device parameter settings.
For general information about pens see section 4.9 Manage Pens. How to create a pen,
see section 4.9.2 Create New Pen.

Step 6 Apply these pens by using the Pen Link or the Pen Set node in the job, see sections 5.49 Pen
Link and 5.50 Pen Set.
When designing the hierarchy keep paragraph The Order How Jobs are Processed in
mind.
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How to Execute a Job

Find more information about job control in section 6 Job Control Window.

Step 1 Select a job for execution, see section 6.3 Select Job for Execution.

Step 2 CAUTION

Visible and/or invisible laser radiation
The user is responsible for observing the laser safety regulations valid in his
country.
� Avoid eye or skin exposure to direct or scattered radiation.

Start the job, see section 6.4 Start (Execute) Job.

4.6.2. Create Job

NOTE

The Job node can be only created as a child of the Exec node.

We urgently recommend to create a Job node for each job and to place the job in the Job
node subtree. Thus the single jobswill be shownwith the Jobnode name in the submenus
of InScript. Moreover the Job node offers settings affecting how the job is executed (see
section 5.30 Job).

� In the menu, click File→ New Job.
— or —
In the Job Configuration window in the Organizing Operators tool bar, click . Be sure that the
cursor is set to the Exec node to allow this.
In the Job Configuration window a new Job node is created as a child node of the Exec node.

4.6.3. Open Job

Step 1 In the menu, click File→ Open Job.
— or —
In the Exec node context menu, click Open Job.
The Open window opens.

Step 2 Select the job file.

Step 3 Click Open.
In the Job Configuration window the selected job appears as a child node of the Exec node.
Referenced pens of a job are automatically loaded. See 4.9.7 Save Pen as where pens have
to be saved to be loaded automatically.
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4.6.4. Load File

Step 1 In the menu, click File→ Load File.
— or —
In the Exec node context menu, click Load File.
The Open window opens.

Step 2 Select the file.
The file format may be one of the offered formats.

Step 3 Click Open.
In the Job Configuration window the file will appear in the applicable branch of the tree
structure.

4.6.5. Save Job

� In the menu, click File→ Save Job.
If there ismore than one Jobnode as a child node of the Execnode in the Job Configurationwindow
then a sub menu opens. Select the job, you want to save. If you want to save all Jobs that are
in the Exec node, you may choose *ALL* or use the Ctrl-Shift-s shortcut for this action. This
will open the Save All Jobs dialog

4.6.6. Save Job as

Step 1 In the menu, click File→ Save Job As.
If there is more than one Job node as a child node of the Exec node in the Job Configuration
window then a sub menu opens. Select the job, you want to save here.
— or —
In the tree structure, select the Job node you want to save and in the tool bar, click .
The Save as window opens.

Step 2 Name the file and select a folder to save it to.

Step 3 Click Save.
If there is more than one Job node as a child node of the Exec node in the Job Configuration
window then a sub menu opens. Select the job, you want to save

4.6.7. Save Multiple Jobs

Step 1 In the menu, click File→ Save All User Files.
The Save User Files window opens.
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Step 2 Select the jobs you want to save by selecting their prefixed check boxes.

Step 3 Click OK.
The jobs will be saved with the names being displayed in the Job Configuration window.
The file type *.Job will automatically be assigned to the files. The files will be saved to
the folder defined in preferences (see 8.4.26 Sub Category - File Handling).

4.6.8. Delete Job

NOTE

If you want to open a job again later on then you have to save it before deleting the
job from the tree structure. The procedure "Delete" deletes the job only from the tree
structure and not from the file system.

If you want to delete a job from the file system then you have to do so via the operating
system.

Step 1 Select the root node of the subtree you want to delete.

Step 2 In the context menu, click Delete Subtree.
— or —
Press the Shift and Del key at the same time.
The subtree including the selected node is deleted from the tree structure.

4.6.9. Clear and Load Job

NOTE

To clear a job means to delete it from the Digital Signal Processor (DSP) line buffer of the
controller board. Saved jobs will not be deleted from the file system in doing so.

Step 1 Click .
The Open window opens.

Step 2 Select the job file.

Step 3 Click Open.
In the Job Configuration window all jobs are cleared, the selected job loaded as child node
of the Exec node and selected for output.
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4.6.10. Create Node

Step 1 In the tree structure select the node that shall become parent node of the new node.

Step 2 In the Standard Nodes tool bar, click the node group.

Step 3 In the node group tool bar click the node type.
You will find a description of the nodes in section 5 Job Nodes.
In the tree structure the node appears as the child node of the selected parent node.

NOTE

Not all node types accept child nodes, e.g.most of the graphical operators. If
these are selected in the Job Configuration window then the node tool bars are
deactivated and colored gray.
To view a node in the Vector Editor window you have to define first, which
node you want to view, see section 7.9.1 Add View of Node or Subtree from
Job Configuration to Vector Editor.

4.6.11. Drag and Drop Job Nodes

If you want to move an existing job node under another node that is able to hold child nodes (e.g. Job,
Collect, all Geometrical Operators, Script, Raw Lines or PosList), you may just drag and drop it on this
node. After that youmay change its position using the Arrange functions (see 4.6.25 Arrange Subtree).
The place, where the node is added (at the start or at the end of the branch) is determined by the
preferences setting Job Creation (see 8.4.27 Sub Category - Job Creation).

To move nodes or subtrees using the mouse, press and hold the Shift key while you move a node or
subtree in the tree. The node is then placed on, above or below the node where the small indicators
of the positioning bar point:

If you want to duplicate a node or subtree, just press and hold the Ctrl key while you move a node
or subtree in the tree. The node is then duplicated on, above or below the node where the small
indicators of the positioning bar point.

4.6.12. Load Subtree

Step 1 In the tree structure select the node that shall become parent node of the subtree.

Step 2 In the context menu, click Load Subtree.
The Open window opens.
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NOTE

Not all nodes accept child nodes, e.g.most of the Graphical Operators. If these
are selected in the Job Configuration window then the Load Subtree menu item
will be deactivated and colored gray.

Step 3 Select the job file.

TIP

Subtrees can be saved as *.tre files (see section 4.6.13 Save Subtree).

Step 4 Click Open.
In the tree structure the subtree appears as the child node of the selected parent node.

NOTE

To view a node in the Vector Editor window you have to define first, which
node you want to view (see section 7.9.1 Add View of Node or Subtree from
Job Configuration to Vector Editor).

4.6.13. Save Subtree

Step 1 In the tree structure select the subtree root node you want to save.

Step 2 In the context menu, click Save Subtree as.
— or —
In the Standard tool bar, click .
The Save as window opens.

Step 3 Name the file and select a folder to save it to.

Step 4 Click Save.
The file type *.trewill automatically be assigned to the file. The file will be saved to the
Job folder of the InScript installation.

4.6.14. Delete Node

� In the context menu, click Delete Node.
— or —
In the tree structure select the node and press the Del key.
If the deleted node has child nodes, these nodes will be lifted to the level of the deleted node.

4.6.15. Delete Subtree

NOTE

If you want to open a subtree again later on then you have to save it before deleting the
subtree from the tree structure. The procedure Delete Subtree deletes the subtree only
from the tree structure and not from the file system.
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If you want to delete a subtree (saved as job) from the file system then you have to do so
using the operating system e.g. via Windows Explorer.

Step 1 In the tree structure select the subtree root node you want to delete.

Step 2 In the context menu, click Delete Subtree.
— or —
Press the Shift and Del key at the same time.
After you confirm the safety prompt the subtree including the selected node is deleted
from the tree structure.

4.6.16. Edit Node

� In the tree structure double click the node you want to edit.
— or —
In the node context menu, click Edit Job Node.
— or —
Select the node and press the F4 key.
The corresponding editor opens.
You will find a description of the node types in section 5 Job Nodes.

4.6.17. Rename Node

Names have to be unique in one level of the tree structure. If collisions occur, e.g. by renaming
or moving a node, then an unique name will automatically be generated from the double name
(e.g. Rotate will turn to Rotate1).

The following characters are not allowed and are automatically replaced by a _-character:

Character Description
. full stop
: colon
* asterisk
? question mark
" double quote
< less than
> greater than
| vertical bar
/ slash
\ backslash
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Step 1 In the tree structure select the node and click the node slowly once again without trig-
gering a double click.
— or —
In the node context menu, click Rename.
The node name changes into a box.

Step 2 In this box type the new name.

Step 3 Press the Enter key.
— or —
In the Job Configuration window, click a free area.

4.6.18. Cut Subtree

Step 1 In the tree structure select the subtree root node you want to cut.

Step 2 In the context menu, click Cut.
— or —
Press the Ctrl and X key at the same time.
The subtree is cut from the tree structure and pasted to the clipboard.

4.6.19. Copy Subtree

Step 1 In the tree structure select the subtree root node you want to copy.

Step 2 In the context menu, click Copy.
— or —
Press the Ctrl and C key at the same time.
The subtree is copied to the clipboard.

4.6.20. Paste Subtree

Step 1 In the tree structure select the node you want to paste the subtree as its child node.

Step 2 In the context menu, click Paste.
— or —
Press the Ctrl and V key at the same time.
The subtree is pasted to the tree structure. Be aware that variable names may change by
moving the nodes they belong to.
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4.6.21. Expand Exec Tree

In the tree structure subtrees can be expanded, like e.g. in the Windows Explorer folder view.

In addition it is possible to fully expand the Exec tree with the following procedure.

Step 1 In the Exec tree structure select any node.

Step 2 In the context menu, click Full Expand.
The Exec tree expands.

4.6.22. Collapse Exec Tree

In the tree structure subtrees can be collapsed, like e.g. in the Windows Explorer folder view.

In addition it is possible to fully collapse the Exec tree with the following procedure.

Step 1 In the Exec tree structure select any node.

Step 2 In the context menu, click Full Collapse.
The Exec tree collapses.

4.6.23. Expand Subtree

In the tree structure subtrees can be expanded, like e.g. in the Windows Explorer folder view.

In addition it is possible to fully expand subtrees with the following procedure. This may save some
clicks on more complex jobs.

Step 1 In the tree structure select the subtree root node you want to fully expand.

Step 2 In the context menu, click Node Expand.
The subtree expands at the selected node.

4.6.24. Collapse Subtree

In the tree structure subtrees can be collapsed, like e.g. in the Windows Explorer folder view.

In addition it is possible to fully collapse subtrees with the following procedure. This may save some
clicks on more complex jobs.

Step 1 In the tree structure select the subtree root node you want to fully expand.

Step 2 In the context menu, click Node Collapse.
The subtree collapses at the selected node.
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4.6.25. Arrange Subtree

To edit the tree structure in the Job Configuration window, e.g. to change the order of execution or to
group subtrees, there are several possibilities.

� Drag&Drop the subtree root node to the node where it shall be inserted as the node's child.
— or —
While holding the Shift key pressed Drag&Drop the subtree root node to the place on the tree
structure where it shall be inserted. At the current position an indicator appears.
— or —
Move the subtree using Ctrl-↑ and Ctrl-↓ (up or down in its current level)
The child nodes of the moved node will be moved as well. Be aware that variable names may
change by moving the nodes they belong to.

4.6.26. Arrange Node

Step 1 Select a node.

Step 2 In the node context menu, click Arrange→Make First orMake Last and Up or Down respec-
tively.
— or —
Move the node using Ctrl-↑ and Ctrl-↓ (up or down in its current level)
On its level in the tree structure the node will be made the first or last or moved one
position up or down respectively.

4.6.27. Show VectorEditor View

In theVector Editor it is possible to create views ondifferent subtrees from the Job Configurationwindow
and to switch them quickly, e.g. to view a node before and after its transformation. If more than 1
Vector Editor view exists then new viewswill be displayed in new tabs in theVector Editor, see the figure
below.

Step 1 In the Job Configuration window, select the subtree root node you want to view in the
Vector Editor.

Step 2 In the context menu, click Show VectorEditor View.
The subtree will be displayed in the Vector Editor. In the Job Configuration window in the
node's Property column, a icon appears.
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4.6.28. Remove VectorEditor View

Step 1 In the Job Configuration window, select the subtree root node you want to remove from
the Vector Editor.
— or —
In the Vector Editor, select the view tab you want to remove.

Step 2 In the respective context menu, click Remove VectorEditor View or Remove Current View
respectively.
The subtree will be removed from the Vector Editor.

4.6.29. Select in VectorEditor

If it becomes difficult to distinguish objects in the Vector Editor and thus hard to select them there
then this is a good method to pick the right object.

NOTE

Only nodes, that can be displayed in the Vector Editor, can be selected this way.

Step 1 In the Job Configuration window, select the Vector Editor view, containing the node you
want to select in the Vector Editor. In the Job Configuration window a Vector Editor view is
symbolized by an icon in the respective node's Properties column.
— or —
In the Vector Editor, select the view tab, containing the object you want to select.

Step 2 In the Job Configurationwindow in the respective node's context menu, click Select in Vec-
torEditor.
The object will be selected in the Vector Editor. In the Job Configuration window in the
node's Property column, a icon appears.

4.6.30. Edit Backdrop Property

The Vector Editor is able to show a background image for most of the nodes present in the Exec branch
of the tree structure in the Job Configuration window. This image is called backdrop image. The back-
drop image can be a static bitmap or an image provided by a frame grabber. This can be used e.g. for
easier alignment on workpieces.

NOTE

The backdrop image will only be shown, if

in the Vector Editor's Editor mode: the node is selected in the Vector Editor window.

— or —

in the Vector Editor's Previewmode: the node is selected for output in the Job Configuration
window.
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Step 1 In the Job Configuration window in the node context menu, click Edit Backdrop Property.
The Edit backdrop property window opens.

Step 2 Set the backdrop image properties as described below this instruction in paragraph Edit
backdrop property window.

Step 3 Click OK.
in the Job Configuration window, the icon appears in the node's Properties column.

Edit backdrop property window

Image source selects the source of the backdrop

None no backdrop will be used

File a bitmap file will be used as backdrop image

Grabber an image provided by a frame grabber will be used. The frame grabber may be e.g. a
camera, that is connected to the system

Real Dimensions sets the real dimensions of the image

Left sets the left edge of the image (X-coordinate relative to the scan field's origin)

Top sets the top edge of the image (Y-coordinate relative to the scan field's origin)

Width sets the image's width

Height sets the image's height

Options

Preserve aspect ratio if this checkbox is selected then either the backdrop image's width or
height will be fit to the frame (Width, Height) and the aspect ratio will be preserved

Convert to gray scale if this checkbox is selected then the image will be converted to a gray
scale image
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Shading if this checkbox is selected the image's transparency will be set to Shading Level

Shading Level If Shading is set then this value influences the transparency of the backdrop
image. "50" means 50% transparency, "100" means no transparency

Filename if Image source is set to File then this sets the filename of the image. Use to browse for
a backdrop image. removes the filename from Filename

Select Grabber if Image source is set to Grabber and if a compatible image grabber hardware is con-
nected to the InScript PC then select the image grabber hardware here as source of the back-
drop image

Configure Grabber if Image source is set to Grabber and if a compatible image grabber hardware is
connected to the InScript PC then configure the image grabber hardware here

Apply applies the currently set image to the Vector Editor without closing the window

4.7. Manage Macros

Macros are mostly small subtrees of nodes that can be re-used in different spots of a Job. As an ex-
ample you may have a specific graphical object that consists of a number of different nodes.

If you want to use this object in different spots of your job (e.g. in different offsets, sizes and/or rota-
tions) then you may create a macro that has all the elements of this item. After that you can re-use
this element all over your job by dragging and dropping it to the place in your job where you want to
use it.
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Using this mechanism you can re-use pre-defined objects or change objects that are spread over a job
in one central place.

4.7.1. Create a new Macro

Step 1 Select the Macros node in Job Configuration window

Step 2 Click on Organizers →Macro in the Standard Nodes toolbar
A new Macro node is inserted under the Macros node

Step 3 Rename the Macro node to a suitable name (see 4.6.17 Rename Node)

Step 4 Place the nodes that shall build your macro under the Macro node

TIP

To have a visualisation of the macro, you may want to develop it in your Job
(see 4.6 Manage (Executable) Jobs) under Exec. Best you use a Collect node (see
5.31 Collect). In this way you can display themacro inVector Editor (see 4.6.27
Show VectorEditor View) and then drag and drop the Collect node under the
Macro node.

Step 5 Nowyou can use theMacro by dragging and dropping it to your Job (see 4.7.2 Link aMacro
to a Job)

4.7.2. Link a Macro to a Job

To use a macro in a Job, you have to link it into the Job.

Step 1 Create a Job (see 4.6 Manage (Executable) Jobs)

Step 2 Add the nodes that you want to use

Step 3 Create a macro (see 4.7.1 Create a new Macro)
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Step 4 Drag and drop the created macro dragging its node to the place in the Job, where it
shall be executed
— or —
Insert a Macro node (see 5.32 Macro) and type the Macro Group (if the macro is not in a
group just leave the field blank) and Link Target (the macro's name).

Step 5 If the macro is in the wrong place you can move its macro link like a standard node (see
4.6.26 Arrange Node)

4.7.3. Create a Macro Group

To sort macros in different groups (e.g.maths macros, graphic macros etc. ) you can create different
macro groups.

Step 1 Select the Macros node in Job Configuration window

Step 2 Click on Organizers →MacroGroup in the Standard Nodes toolbar
A new MacroGroup node is inserted under the Macros node

Step 3 Rename the MacroGroup node to a suitable name (see 4.6.17 Rename Node)

Step 4 Now you can create macros in this macro group or drag and drop existing macros to this
macro group (see 4.7.4 Group Macros)

4.7.4. Group Macros

Tohavemacros grouped in logical sections, youmay putmacros of similar function into aMacroGroup.

Step 1 Create a MacroGroup node (see 4.7.3 Create a Macro Group)

Step 2 Rename the MacroGroup to a name that characterizes the Macros you want to collect in
this group

Step 3 Now you can create macros in this macro group or drag and drop existing macros to this
MacroGroup (see 4.7.4

4.7.5. Save Macros

Step 1 Create a macro (see 4.7.1 Create a new Macro)

Step 2 To save this macro right click on the Macro node under Macros and select Save Macro
A Save JobMacrowindow opens and you can specify the place and name to save themacro
as a *.imc file
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4.7.6. Load Macros

Step 1 Right click on the Macros node and select Load Macro.
— or —
Right click on a MacroGroup under the Macros node and select Load Macro.

Step 2 Select the *.imcmacro that you want to load to the Macros node
The Macro will be loaded under the right clicked node

4.8. Manage Default Job

In the DefaultJob node any saved job can be set as default. After the controller has been reset, the
default job will automatically be loaded, selected for execution and started.

4.8.1. Set Default Job

Step 1 In theDefaultJobnode's contextmenu, click Set Default Job. TheOpenwindowopens. Select
the job file you want to set as default.
— or —
Drag&Drop the *.job file from the Windows Explorer to the DefaultJob: node.
The path and file name will appear next to the DefaultJob: node.

Step 2 Save the setting to the controller's NVRam, see section 2.7 Store Configuration.

4.8.2. Reset Default Job

� In the DefaultJob node's context menu, click Reset Default Job.
The DefaultJob node will be cleared.

4.9. Manage Pens

The InScript pen concept is similar to that well known fromdrawing programs. In a drawing program
e.g. the line color, width and style can be defined for a pen. In InScript e.g. the laser power, frequency
and processing speed can be defined for a pen instead.

Pens are made up of pen sections. Each pen section contains the settings of the corresponding active
device driver. A pen section only contains device driver parameters that can be changed during a
job.

Pens are self-contained files located in the Pens branch of the tree structure in the Job Configuration
window. They are not embedded into a job. Pen Link or Pen Set nodes link to the pens in a job. This
way a pen can be used in several jobs or in parts of jobs.
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4.9.1. Control Device Parameters During Job Execution

Device parameters can be saved to pens. By linking to these pens from the job tree structure, device
parameters can be changed at specific points during job execution.

Step 1 Create pens with the parameters youwant to change during the job, see 4.9.2 Create New
Pen.

Step 2 Create Pen Link nodes in the job tree structure at the locations, where youwant to change
the parameters, see 5.49 Pen Link.
— or —
Drag&Drop the pens to the locations where you want to change the parameters.

Example In the following figure there are 2 pens defined in the Pens subtree. One pen is called Fast
and setting the processing speed to 1000 mm/s. The second pen is called SlowHighPower and setting
the processing speed to 50 mm/s and the laser power to 80%.

In this example Text1 is output with 50 mm/s and 80% laser power, but Text2 is child node of the Pen
Link nodes SlowHighPower as well as Fast. As Fast is direct parent node to Text2 and SlowHighPower only
is indirect parent node, Fast overwrites the processing speed setting of SlowHighPower with its own
setting. This causes Text2 to be output with 80% laser power and 1000 mm/s processing speed.

Explanation As with other nodes the properties of the nodes Pen Link and Pen Set are inherited by
their child nodes.

The default pen always exists and is used when no other pen is explicitly used. It also contains pen
sections for each device driver, but at least the pen sections dist_xy, dist_xy_2, linepar, head and sas, as
these devices are always active. If additional devices are active then the corresponding pen sections
also appear in the default pen.

Pens can be "stacked" comparable to cards. On these cards the parameters are printed in fixed posi-
tions. The Default Pen is at the stack bottom. All possible parameters are printed on this card. A user
defined pen is a card with specific parameters printed on. All other positions are transparent. By
stacking the cards and looking at the stack from above the parameters result from all visible param-
eters. The following image illustrates this.
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4.9.2. Create New Pen

Step 1 In the Pens node context menu, click New Pen.
The New Pen window opens.

Step 2 In Pen Name, type the name.

Step 3 Click OK.
The new pen is created as child of the Pens node.

Step 4 In the new pen context menu, click New Pen Section.
The New Pen Section window opens.

Step 5 In the Device list, select the device driver containing the parameters you want to control
during a job.
You will find a description of the device drivers in 3 Devices.

Step 6 Click OK.
A new pen section is created as child of the new pen. This pen section belongs to the
selected device driver and represents its parameters controllable during a job.

Step 7 If you need further pen sections for other device drivers then click New Pen Section in the
new pen context menu and proceed as with the pen section created just now.

Step 8 Edit all newly created pen sections, see section 4.9.3 Edit Pen Section.

4.9.3. Edit Pen Section

Step 1 Double click the pen section.
— or —
In the pen section context menu, click Edit Pen Section.
The editor opens.
A pen sections contains only device driver parameters that can be changed during a job.
You will find a description of the respective device drivers in 3 Devices.
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NOTE

Changes made here will immediately take effect on the device. If you want
e.g. increase the laser power then just increase the corresponding value. The
change immediately takes effect.

Step 2 If the input box is locked (gray) then the parameter value is taken from the default pen.
To unlock the input box, click Add in its context menu. To unlock all input boxes, click
Add All in the context menu.

— or —
If the parameter value from the default pen shall be taken then the input boxes have to
be locked. To lock an input box click Remove in its context menu. To lock all input boxes,
click Remove All in the context menu.

Step 3 Set the parameter value.

Step 4 Repeat the previous 2 steps for all input boxes where the settings shall differ from the
default pen.

Step 5 Click OK.

4.9.4. Load Pen

Step 1 In the Pens node context menu, click Load Pen.
The Open window opens.

Step 2 Select the pen.
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Step 3 Click Open.
The pen appears in the tree structure with the name you saved it.

4.9.5. Load Pen as

Step 1 In the Pens node context menu, click Load Pen As.
The Open window opens.

Step 2 Select the pen.

Step 3 Click Open.
The Load Pen As window opens.

Step 4 In Name, type the name, the pen shall have in the tree structure.

Step 5 Click OK.
The pen appears in the tree structure with the given name.

4.9.6. Save Pen

� In the pen context menu, click Save Pen.
The pen is saved with the name visible in the Job Configuration window. The pen is saved in the
Pens folder of the InScript installation.

4.9.7. Save Pen as

Step 1 In the pen context menu, click Save Pen As.
The Save as window opens.

Step 2 Name the file and select a folder to save it to.
NOTE

When a job is loaded then InScript tries to load the pens used within the job.
Save the pen either to the same folder where the job is saved or to the InScript
installation's Pens folder (located in the Windows %ProgramFiles% folder).
That way you ensure that the pens used will be automatically loaded. First
the pen is searched in the folder, where the job is located and then in the In-
Script installation's Pens folder.

Step 3 Click Save.

4.9.8. Delete Pen

� In the pen context menu, click Delete Pen.
The pen will be deleted from the tree structure. Saved pens will not be deleted from the file
system.
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4.9.9. Delete Pen Section

� In the pen section context menu, click Delete Pen Section.
The pen section will be deleted from the tree structure. Saved pen sections will not be deleted
from the file system.

4.9.10. Assign Pens to ”Line Colors” of a Vector Graphics File

In some vector graphics file formats pen numbers are already assigned to lines, e.g. to tell a plotter
to print lines in different colors. In InScript pens can be assigned to these pen numbers. This way
specific lines from the vector graphics file can be output with specific device parameter settings.

Step 1 In a drawing programm, create a vector graphics file, that is supported by InScript and
where pen numbers are assigned to lines.
Lines, that shall be output with the same parameters, shall have the same pen number.

Step 2 Import the file to InScript.

Step 3 Create pens with the parameters you want to use for specific pen numbers, see 4.9.2
Create New Pen.

Step 4 Create a PenSet node as parent of the node, that outputs the vector graphics.

Step 5 Double click the node.
The PenSet Editor window opens.

Step 6 Drag&Drop the pen from the Pens group to the Pen Set group and thewanted pen number.
Find more information about the Pen Set node in section 5.50 Pen Set.
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4.9.11. Force Execution of a Pen Link Node That Has No Child Nodes

If a Pen Linknode does not have any child nodes generating line data then InScript ignores this Pen Link
node in the Exec subtree. However pens can contain parameters e.g. to move a linear axis. You can
force execution of these parameters. For this reason the Force checkbox exists at some parameters in
the pen tabs.

If the checkbox is selected (yellow ) then the parameter will be executed.

If the checkbox is cleared (gray ) then the parameter will be ignored.

� Click the checkbox to execute (yellow ) and ignore (gray ) respectively the corresponding
parameter.
— or —
In the contextmenu, click Force All to execute (yellow ) all parameters and DeForce All to ignore
(gray ) all parameters respectively.

4.9.12. Teach-in pilot Pen

CAUTION

Visible and invisible laser radiation

The user is responsible for observing the laser safety regulations valid in his country.

Avoid eye or skin exposure to direct or scattered radiation while you teach-in or use a
harmless sort of pilot laser to minimize danger.

To use the Teach-in button of the Job Control window (see 6.2 Description of the Window Teach-in),
a pen called pilot has to be created. This pen has to have a sas pen section. Under tab TeachIn the Use
TeachIn checkbox has to be set (see 4.9.2 Create New Pen and 4.9 Manage Pens how to create a pen
and a pen section).

Follow these steps to create a pilot pen:

Step 1 Right click on the Pens node in Job Configuration window and select New Pen.
The New Pen window opens

Step 2 Type pilot into the Pen Name it box

Step 3 Click on OK
A pen called pilot (the name is case dependend) is created under the Pens node

Step 4 Right click the pilot pen node and select New Pen Section.
The New Pen Section window opens.

Step 5 Select sas in the drop down list.

Step 6 Click on OK
A pen section called sas is created under the pilot pen node
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Step 7 Double click the sas pen section.
The SASP usr.pens.pilot.sas window opens

Step 8 Click on tab TeachIn, right click the Use TeachIn checkbox and select Add.
The Use TeachIn checkbox is now active for this pens

Step 9 Check the Use TeachIn checkbox.
The pilot pen is set for TeachIn

Step 10 Optional Step - Only needed if a seperate distortion correction for a pointing laser was
done!
Create a second new dist_xy pen section (as described above)

Step 11 Optional Step - Only needed if a seperate distortion correction for a pointing laser was
done!
Click on tab Common, right click the Optical Path combo box and select Add.
The Optical Path checkbox is now active for this pens

Step 12 Optional Step - Only needed if a seperate distortion correction for a pointing laser was
done!
Set the Optical Path to Pointing Laser.
This enables that the distortion for the pointing laser is used (a distortion for the pointing
laser has to be created: see the Manual -- Scan Head -- Correct scan field for pointing laser) ,
whichdiffers from thedistorionof theprocessing laser because of a differentwave length
of the pointing laser's light.

Step 13 Assure that the pointing laser is activated in a corresponding pen section of your active
laser device.
In TeachIn the Job will be output in a loop. Therefore you have to avoid laser settings
working with a potentially high power processing laser output.

CAUTION

Visible and invisible laser radiation
If the pilot pen settings are set to a output range that is in a dangerous range,
the operator of the TeachIn is in hazard of injury!
We urgently recommend that the pilot pen settings are verifyed to be in a
range that is not dangerous.

TIP

Please be aware that if you execute TeachIn (see 6.2 Description of the Window under
TeachIn) in standard configuration, only nodes that are placed under Geometrical Operator
nodes are output.

4.10. Manage Files

InScript can handle graphic files which were created by other programs.

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 287



4. Job Configuration Window

4.10.1. File Formats

NOTE

Not all graphics formats are supported in all places of InScript.

The following pixel file formats are supported:

• Windows bitmap (*.bmp)
• Joint Photographic Experts Group (*.jpg, *.jpeg)
• Tagged Image Format File (*.tif, *.tiff)
• Portable Network Graphic (*.png)
• Graphic Interchange Format (*.gif)
• Targa (*.tga, *.vst, *.icb, *.vda, *.win)
• PC Paintbrush (*.pcx, *.pcc, *.scr)
• Adobe PhotoShop (*.psd, *.pdd)
• Portable Bitmap (*.ppm, *.pgm, *.pbm)
• Silicon Graphics Inc. (*.bw, *.rgb, *.rgba, *.sgi)

NOTE

At themoment the ARGES RenderServer only supports the PGM format. The PGM format
must not have a comment, like it is inserted e.g. by GIMP. The PGM file has to be in binary
format, there has to be a "P5" signature in the binary file.

The following vector file formats are supported:

• Hewlett Packard Graphics Language (Plotter) (*.hpgl, *.plt)
• ARGES RawLines (*.arl)
• AutoCAD Drawing eXchange Format (*.dxf)
• VeCAD drawing (*.vec)
• LG1(*.lg1)
• IGES (*.igs)

4.10.2. Scope

In the Job Configuration window, see section 4 Job Configuration Window, pixel and HPGL files can be
loaded to the Files node using its context menu. By doing so these files are uploaded to the controller.
They are not automatically embedded into a job, but have to be referred to e.g. by a Bitmap File Link
node, see section 5.13 Bitmap, or a HPGL File Link node, see section 5.12 File Link (HPGL). This way a
file can be referred to several times without increasing the memory requirements on the controller.
Alternatively the Bitmap File Link node can render pixel files using the ARGES RenderServer. Vector
files can be embedded into a job, after the line data has been imported via the Raw Lines node, see
section 5.22 Raw Lines.
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4.10.3. Save

Store graphic files createdwith external programs to one of the following locations in the file system:

• to the same folder, the job file has been loaded from

• to the HPGL or Pics folder of the folder, the job file has been loaded from

• to the HPGL or Pics folder of the InScript installation

When you open a job, InScript automatically tries to load associated files from the file system, in case
they are not yet loaded into the controller's memory.

4.10.4. Load - Creating Nodes Automatically

For all file formats Drag&Drop automatically creates all necessary nodes in the Job Configuration win-
dow.

� Drag&Drop the graphic file from the Windows Explorer to the wanted position in the tree struc-
ture in the Job Configuration window.
With pixel based files a Bitmap File Link node is automatically created on this position in the
tree structure and the file is loaded to the Files node. With HPGL files a HPGL File Link node is
automatically created on this position in the tree structure and the file is loaded to the Files
node. With vector files (with the exception of HPGL) a Raw Lines node is automatically created
on this position in the tree structure and a window for vector graphic import opens.

4.10.5. Load - Creating Nodes Manually

Depending on the file format there are several possibilities to use existing graphic files in InScript.
For this purpose you have to create nodes and edit their settings in the Job Configuration window.

If you want to refer to a pixel file by a Bitmap File Link node

Step 1 In the Files node context menu, click Load and select the file type.
The Open window opens.

Step 2 Select the file.

Step 3 Click Open.
The file appears in the tree structure as child of the Files node.

Step 4 In the tree structure at the wanted position, create a Bitmap File Link node.

Step 5 In the Bitmap File Link node in the File name list, select the file. The list offers only files
located in the Files subtree.

Step 6 Edit the Bitmap File Link node settings, see section 5.13 Bitmap.
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If you want to call a pixel file from a render server

Step 1 In the tree structure at the position wanted, create a Bitmap File Link node.

Step 2 Edit the Bitmap File Link node settings, see section 5.13 Bitmap.

If you want to refer to a HPGL file by a HPGL File Link node

Step 1 In the Files node context menu, click Load and select the file type.
The Open window opens.

Step 2 Select the file.

Step 3 Click Open.
The file appears in the tree structure as child of the Files node.

Step 4 In the tree structure at the wanted position, create a HPGL File Link node.

Step 5 In the HPGL File Link node in the File name list, select the file. The list offers only files
located in the Files subtree.

Step 6 Edit the HPGL File Link node settings, see section 5.12 File Link (HPGL).

If you want to embed a vector file in a job

Step 1 In the tree structure at the wantedposition, create a Raw Lines node.

Step 2 Edit the Raw Lines node settings, see section 5.12 File Link (HPGL).

4.10.6. Examples

• To create graphics you can use standard graphics software. Save the graphic files using these
programs.

• Depending on the file format there are several possibilities to use existing graphic files in In-
Script:
pixel file formats In the tree structure, load the file as child node of the Files node first and

refer to the file by a Bitmap File Link node from the job.
— or —
Create a Bitmap File Link node in the Job and get the file from a render server.

HPGL file format Load the file as child node of the Files node in the tree structure and refer
to the file by a HPGL File Link node from the job.
— or —
Create a Raw Lines node in which the line data will be embedded in the job.
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vector file formats Create a Raw Lines node in which the line data will be embedded in the
job.

That way a Raw Lines, Bitmap File Link or HPGL File Link node is created in the job. The nodes can be
handled as any other graphical operator interactively in Vector Editor or e.g. by inserting a Transform
node in the job.

4.11. Manage Fonts

InScript can handle different font formats. Its native binary font format is the *.fdt format and its
ASCII based counterpart *.sfh.

4.11.1. Font Formats

The following font formats are supported:

NOTE

<data folder> can be either the InScript installtion folder under operating systems≤Win-
dows XP or the InScript Documents folder (see InScript's Start menu entries for these
folders) on operating systems≥Windows Vista.

• InScript Fonts (*.fdt in the <data folder>\Fonts folder)

• Firmware ROM Fonts (special vector fonts available on all controllers)

• TrueType Fonts (*.ttf in the <windows folder>\Fonts folder)

• Raster Fonts (*.FON in the <windows folder>\Fonts folder)

4.11.2. Scope

In the Job Configuration window, see section 4 Job Configuration Window, fonts that are used by the
controller are shown in the Fonts node. InScript *.fdt fonts can be loaded to the Fonts node using
its context menu. The font files are uploaded to the controller board. If you use a Text node, Round
Text node, Barcode node, Barcode 2D node, Split Text node etc. then the fonts will be automatically
converted to *.fdt format and uploaded to the controller.

NOTE

At the moment UTF-8 characters (8-bit UCS/Unicode Transformation Format - it is able
to represent any character in the Unicode standard like Asian, Cyrillic or other non-
latin characters, yet is backwards compatible with the limited ASCII format) are only
supported in the Text node, see section 5.18 Text Native 8 bit, UTF-8.
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4.11.3. Use TTF Fonts without InScript

Newer InScript Firmware versions (≥ v2.6.0.376) fully support TrueType fonts at controller side. To
use a full RenderServer support with this feature you have to have RenderServer≥ v1.1.3.100.

To use these fonts directly andwithout using InScript to convert them, you have to follow these steps:

Step 1 Open e.g. Windows Explorer on a PC that is connected to the ASC

Step 2 Type
e.g. \\192.168.1.42\Data\fonts\ttf
into the Windows Explorer address field for controller 192.168.1.42

Step 3 Copy the TrueType font (TTF) that you want to use on ASC side to this SAMBA share of
the ASC controller

Step 4 After up to 30 seconds the font can be used (the font list is updated in 30 second intervals)

Step 5 To use the font, you have to find out its name (not the filename but its internal English
name).
E.g. double click the TTF file on an English Windows XP and get its name (e.g. "ARI-
ALUNI.TTF" and get "Arial Unicode MS" as its name). From InScript v2.10.1.1780.TP on
English font names are supported on all Windows Language versions

— or —
Open InScript Xplorer, set variable dbg.DebugLog to TRUE and type „DumpLocalFonts“
in string variable dbg.DbgCmd (without quotes and case sensitive). The Debug Log shows
all names and files of the ASC-locale fonts

Step 6 This internal English font name (not the filename) can now be typed e.g. in the field
„Font“ of a Text node (5.18 Text)
At first this Font can not be found in the Font dropdown menue - only after it had been
typed in or if it is also installed in the Windows Fonts folder. Also be sure that Encoding
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is set to UTF-8 if youwant to usemore unconventional glyphs. If the Font is not available
in Windows the Font may not be shown correctly in the Text node editor but in Vector
Editor you have to get the right output

The sequence to find fonts is:

1. Locally on the ASC controller

2. InScript and Windows (only if InScript is running)

Thismeans that if a font is not foundon theASC, InScript/Windows tries to load this font. A controller-
local font will be shown in the Font information dialog as "Local on Controller" (see 4.4.7 Fonts) if you
double-click on exec→ Fonts→ <fontname>.

4.11.4. Convert to FDT

Older versions of InScript (< v2.10.1.1780) and especially of the InScript Firmware (< v2.6.0.376) did
not support the direct use of TrueType Fonts on controller side as described under 4.11.3 Use TTF
Fonts without InScript. In this case the fonts have to be converted to *.fdt format. This can be done
using the InScript menu entry Extras→ Convert Font to FDT, see section 8.14 Convert Font to FDT.

4.11.5. Example

NOTE

<data folder> can be either the InScript installtion folder under operating systems≤Win-
dows XP or the InScript Documents folder (see InScript's Start menu entries for these
folders) on operating systems≥Windows Vista.

Use TrueType Fonts on ASC without InScript Running If you want to use a TrueType font on
an ASC controller without InScript actively running, e.g. while using the ARGES controller li-
brary, you will have to convert the font using InScript and place it in the ASC controller's fonts
folder. The font will only be available for Vector output.

Step 1 If the font you want to use is not in the <windows folder>\Fonts folder, you have
to copy it to this location. You may use either TrueType or Raster fonts.

Step 2 Start the InScript software.
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Step 3 In the main menu, click Extras→ Convert Font to FDT.

Step 4 Read the copyright information:

Step 5 Only if you are sure that your font is compliant with the copyright warning, con-
firm the dialog by clicking Yes.

Step 6 Select the font you want to convert from the list, e.g. Arial:

Step 7 Click OK.

Step 8 Select the Unicode Code Chart that you need (normally chart Basic Latin contains
all European glyphs). We recommend that you do not choose a full set of charts!
The more charts you select, the more extensive the conversion will be
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Step 9 Click OK.

Step 10 Select a destination folder for the converted FDT font, e.g. <data folder>\Fonts.

Step 11 Click Save.
To avoid problems, be sure to save the font with the same filename as the font's
name. The name is case in-sensitive.

Step 12 To have the font available on your ASC controller at all times, you have to copy the
*.fdt file you created into the Fonts folder of this controller
e.g. \\192.168.1.42\Data\fonts
using Windows Explorer or any other method of copying a file.

Step 13 Now you may use this font in any node, e.g. Text or Roundtext, without the need to
have InScript running in the background to convert the font.

5. Job Nodes

Job Nodes are used as parts of complex Job structures. They are arranged in a hierarchical tree and
under normal circumstances, they are arranged under a Job Node of type Job (see 5.30 Job) as root of
this tree.

5.1. Shared GUI Elements

Some GUI elements are common to all job nodes. They are described here in summary.

Node Name When creating a job node, its type will automatically be written into Node Name. You
should name the job node depending on its function in the job. This makes complex jobs easier
to understand.

Action selects the action to be performed when executing the job node.
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Execute The job node and all its children job nodes will be executed, i.e. the complete tree
beneath and including the current job node, will be executed.

Skip The job node and all its children job nodes will not be executed.

Neutral The jobnode itselfwill not be executed. But all its children jobnodeswill be executed.

Some job nodes, e.g. Counter, have additional list items:

Execute Once The job node will be executed exactly once. After it has been executed the list
item is automatically set to Done & Disabled.

Done & Disabled The job node and all its children job nodes will not be executed. Done &
Disabled is automatically set after the job node was executed with setting Execute Once.

stats.totalDuration This variable shows the length of time this job node takes to be executed.
This also includes including its child nodes. The measurement is only valid after the job node
has been executed and after the active state has been left. The active state can be checked
via the variable dev.sas.active. This feature requires a Inscript-FW version 3.0.0-908 or higher.
This feature has to be activated via the variable dev.sas.jobDurationMeasurement. See also 3.3.8
Parametrize - Job Duration Measurement.

OK applies the changes made and closes the window.

Cancel discards the changes made and closes the window.

Restore resets the values to the values which were set when the window was opened.

5.2. Sequence of Transformations

The order of a sequence of tranformations is crucial to its result. Here is an example for this problem:

Let's start with a simple set of two transformations. A 45° counterclockwise rotation about the origin
around the Z-axis, and a translation down the X-axis. Suppose that the object you are drawing is
small compared with the translation (so that you can see the effect of the translation), and that it is
originally located at the origin. If you rotate the object first and then translate it, the rotated object
appears on the X-axis. If you translate it down the X-axis first, however, and then rotate about the
origin, the object is on the line y = x, because of the 45° rotation, as shown in following figure. In
general, the transformation path is critical. If you do transformation A and then transformation B,
you normally get a different result if you do it vice versa.

Please be aware of this problem if you create a jobs using different tranformations from the Geomet-
rical Operators group.
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The example shown above can be realized in InScript like this:

5.3. COM Ports in Job Nodes

There are possibilities to set COM ports in several Job Nodes. These COM ports refer to different phys-
ical ports on the ASC or NCC controller. In this section you may find a small summary which port is
refered to on which controller type.

5.3.1. ASC Controller

CAUTION

Damage of the PC's interface module

If the connector is fully wired, the COM B combined CAN/RS232 interface of the ASC
controller may damage the PC's interface module. Especially caused by the +10V CAN
cable (pin 9).

To avoid damage, only connect pin 2, pin 3 and pin 5. You may obtain a special adpter
connector from ARGES to avoid this problem.

Port Connector Comment Reference
COM A - N/A N/A
COM B CAN/RS232 this is a combined RS232/ see Manual -- ASC

(50-115200 Baud) CAN connector
COM C DVI Connector used for communication see Manual -- NCC

(50-115200 Baud) with the laser

5.3.2. NCC Controller

Port Connector Comment Reference
COM A Serial connector serial connector at see Manual -- NCC

(300-38400 Baud) the slot bracket
COM B Serial connecor serial connector at see Manual -- NCC

(300-38400 Baud) the slot bracket
COM C DVI Connector used for communication see Manual -- NCC

(300-115200 Baud) with the laser
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5.4. Rotate

This node rotates its child nodes by a given angle. Remember that the order of transformations is
essential, see section 5.2 Sequence of Transformations.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Angle sets the angle by which the child nodes will be rotated in decimal representation.

— or —

sets the angle by which the child nodes will be rotated represented in degrees, minutes and
seconds.
Depending on the input fields, each representation is automatically converted into the other.
A positive angle rotates counterclockwise and a negative angle rotates clockwise. Because In-
Script handles angles internally in a decimal representation, small rounding errors may occur
in the seconds value.

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.5. Scale

This node scales its child nodes, i.e. it scales them up or down. Remember that the order of transfor-
mations is essential, see section 5.2 Sequence of Transformations.
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5.6. Slant

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Scale X sets the scale in X-direction.

Scale Y sets the scale in Y-direction.

Proportional If the check box is selected then the node proportionally scales in X- and Y-direction.
If the check box is cleared then different scaling for X- and Y-direction can be specified. That
way graphical objects beneath this node can be orthogonally distorted.

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.6. Slant

This node performs a slant on its child nodes. This transformation turns e.g. a rectangle into a par-
allelogram. Remember that the order of transformations is essential, see section 5.2 Sequence of
Transformations.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Slant X sets the slant in X-direction. A value of 100% changes a vertical line into a line slanted by
45°.

Slant Y sets the slant in Y-direction. A value of 100% changes a horizontal line into a line slanted
by 45°.

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements
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5.7. Offset

This node offsets its child nodes. Remember that the order of transformations is essential, see section
5.2 Sequence of Transformations.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Offset X sets the offset in X-direction.

Offset Y sets the offset in Y-direction.

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.8. Transform

This node is a combination of the geometrical operators Rotate, Scale, Slant and Offset. Remember
that the order of transformations is essential, see section 5.2 Sequence of Transformations.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements
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Offset, Scale, Slant, Rotate The node executes the geometrical operators in the following order:
Scale→ Slant→ Rotate→ Offset

1. Scale (see section 5.5 Scale)

2. Slant (see section 5.6 Slant)

3. Rotate (see section 5.4 Rotate)

4. Offset (see section 5.7 Offset)

If youwant to execute the geometrical operators in a different order then you have tomanually
insert the corresponding operators in the needed order into the tree structure.

NOTE

If you do not make use of all transformations in the node then insert only the geo-
metrical operators you really make use of into the tree structure. The transforma-
tion will be executed faster then.

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.9. Rotate3D

When using a 3D scan head this node rotates its child nodes by the given angle around one defined
axis. This node has to be placed inside a Scan 3D node (see section 5.28 Scan 3D). Remember that the
order of transformations is essential, see section 5.2 Sequence of Transformations.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Axis sets the rotation axis

X-Axis (+Y → +Z) rotates around the X-axis

Y-Axis (+Z → +X) rotates around the Y-axis
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Z-Axis (+X → +Y) rotates around the Z-axis

Angle sets the angle by which the child nodes will be rotated in decimal representation.

A positive angle rotates counterclockwise and a negative angle rotates clockwise

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.10. Offset3D

When using a 3D scan head this node offsets its child nodes. This node has to be placed inside a
Scan 3D node, see section 5.28 Scan 3D. Remember that the order of transformations is essential, see
section 5.2 Sequence of Transformations.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Offset X sets the offset in X-direction

Offset Y sets the offset in Y-direction

Offset Z sets the offset in Z-direction

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.11. Transform3D

When using a 3D scan head this node offsets, scales and rotates its child nodes. This node has to be
placed inside a Scan 3D node. Remember that the order of transformations is essential, see section
5.2 Sequence of Transformations. If you only have to do an offset or a rotation then use the Offset3D
or Rotate3D node. The tranformation will be significantly faster then.

302 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



5.12. File Link (HPGL)

The node executes the geometrical operators in the following order:
Rotate (Angle)→ Scale→ Offset

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Offset

X sets the offset in mm of the subnodes in X-direction

Y sets the offset in mm of the subnodes in Y-direction

Z sets the offset in mm of the subnodes in Z-direction

Angle

X sets the rotation of the subnodes around the X-axis in degrees

Y sets the rotation of the subnodes around the Y-axis in degrees

Z sets the rotation of the subnodes around the Z-axis in degrees

Scale

X scales the size of the subnodes in X-direction with the given percentage

Y scales the size of the subnodes in Y-direction with the given percentage

Z scales the size of the subnodes in Z-direction with the given percentage

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.12. File Link (HPGL)

By this node a file can be output which is located in the Files folder on the controller. This node
representates only a link to this file, i.e. the needed memory does not sum up, if the HPGL file is used
several times in a job.

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 303



5. Job Nodes

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Filename sets the filename the link points to. In the list files appear that are located in the Files
folder on the controller

Upload mode selects when the file shall be uploaded

Replace when loading job When the job is uploaded and a file with the same name already
exists on the controller then the existing file will be overwritten by the new file

Upload when loading job When the job is uploaded and a file with the same name does not
exist yet then the file will be uploaded

Upload before execution The file will be uploaded directly before each job execution, only
if a file with the same name does not exits yet on the controller

Origin

u selects the origin in the file in X-direction

Floating as defined in the file

Left at the left edge

Center in the center

Right at the right edge

v selects the origin in the file in Y-direction

Floating as defined in the file
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Top at the upper edge

Center in the center

Bottom at the lower edge

Options

Auto Join When a plotter outputs a HPGL file, the pen is moved up and down again in the
corners of a zigzag line. The laser beam would switch off and on again at these corners.
If the check box is selected then the line ends are automatically joint. This way the laser
beam stays switched on

Clear when done If the check box is selected and the bitmap file was output by Job Start or
Preview then the file will be deleted from the controller's memory

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.13. Bitmap

This job node outputs bitmap files or renders data from the Bitmap job node's subtree into a bitmap
file, which then is output.

Before the Bitmap job node processes a color bitmap file, the file has to be converted to gray scale,
the so called Raw file. This Raw file is the input data for the Bitmap job node. Parameters which are
set in the Bitmap job node apply directly to this Raw file.

If a subtree of the Bitmap job node shall be output then the subtree is rendered by a render server
into a bitmap file while the Bitmap job node is executed. The bitmap file is saved by the render
server into a folder and then loaded by InScript from this folder to be output by the Bitmap job node.
Some Bitmap job node settings, like e.g. in the Geometry tab in the Target Image Size group are then
specifications for the render server.

The Bitmap job node can output bitmap files in the output modes described in section 5.13.1 Edit -
General, Output mode.

5.13.1. Edit - General

The parameters on this tab affect the general properties of the bitmap file.
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Node name see section 5.1 Shared GUI Elements
Action see section 5.1 Shared GUI Elements

File
Bitmap source selects the source of the bitmap file, which shall be output

File The bitmap file inscribed in the File name box will be output
File created from subnodes The subtree beneath theBitmap jobnodewill be rendered

into a bitmap file, which will be output afterwards
Stream image created from subnodes The subtree beneath the Bitmap job nodewill

be rendered into a stream image, which will be output

NOTE

If you want to render the subtree beneath the Bitmap job node into a bitmap
file and output it then you have to select File created from subnodes in the Bitmap
source list and Streaming in the Upload mode list. In this case you have to specify
the file name in the Render Server tab. This tab is only shown in the created from
subnodes source modes.

File name selects the name of the bitmap file, which shall be output. Using Render Server, the
specified file name will be filled in automatically here

Mode
Upload mode selects when the bitmap file will be uploaded to the controller

Replace when loading job When the job is uploaded and a bitmap file with the same
name already exists on the controller then the existing filewill always be overwritten
by the new file
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Upload when loading job When the job is uploaded and a bitmap file with the same
name does not exist, then the bitmap file will be uploaded

Replace before execution The bitmap filewill always be uploaded directly before each
job execution even if a bitmap filewith the samenamealready exists on the controller

Upload before execution The bitmap file will be uploaded directly before each job ex-
ecution only if a bitmap file with the same name does not yet exits on the controller

Streaming The bitmap file will be uploaded as a continuous streamwhile it is processed
by the controller

Clear when done if this check box is selected and the bitmap file was output using Job Start
or Preview, the file will be deleted from the controller's memory after processing it

Marking selects how the color of the material changes after processing

Dark The material darkens after processing

Bright The material brightens after processing

Output mode selects the mode the bitmap file will be output with

NOTE

Depending on the mode only tabs and parameters that are relevant for the re-
spective mode are displayed.

Line Normal Black and white output. The bitmap is output as a sequence of horizontal
or vertical lines. The figure below shows a bitmap (left) and its output by the Bitmap
job node in mode Line Normal (right). To output lines the Bitmap job node uses set-
tings in the linepar pen section of the actual pen, i.e. the lines are output with head
and tail

Line Optimized Black and white output. Like in Line Normalmode the bitmap is output
as a sequence of horizontal or vertical lines with head an tail. In some situations,
e.g. at high processing speed, the tail of one line may overlap with the head of the
next line. To position the laser beam from the tail end to the head beginning the
direction of movement has to be reversed. This causes jumps. In this case the Line
Optimized mode ignores the normal handling of the affected lines. The Bitmap job
node continues at processing speed and switches the laser beam off and on at the
affected places. This prevents jumps. The line data calculation thereby takes longer.
The time saving in output may be possibly nullified

Raster →OBSOLETE Output mode Black and white output. Like in Dot mode the
bitmap file is output with a dithering algorithm, which approximates gray scales.
Contrary to the Dot mode the Raster mode does not position on each laser pixel, but
outputs a whole scan line with constant speed. In doing so the laser beam is switched
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on and off when passing a laser pixel. To output the laser pixel the Bitmap job node
does not use any settings in pens. The settings have to be made in the Raster Settings
tab

Dot Black and white output. The bitmap is output with a dithering algorithm, which
approximates gray scales. For this purpose the bitmap is divided into cells of n×m
laser pixel (dot positions). According to the gray value within these bitmap cells the
cells are filledwith dot patterns. To output the dots the Bitmap job node uses settings
in the linepar pen section of the actual pen. The scan head separately positions each
dot. This method positions each dot exactly, but needs much time. For materials
needing a very long exposure time solely the Dot mode is suitable

Pseudo Analog Grey scale output. Like in Raster mode a scan line is output with con-
stant speed, while the laser beam is switched on and off. Contrary to the Raster mode
the bitmap gray scales are not approximated by a dithering algorithm, but the laser
pixel are output with more or less laser energy. The laser energy controlled by a
controlled first pulse. A first pulse is generated by exciting the laser active medium
without the laser emitting light. Then the laser emits the accumulated energy in one
pulse. In other situations this effect is unwanted, but here it is used to output true
256 gray scales. To get good results with thismethod you need amaterial where color
changes with absorbed laser energy

Pseudo Analog with Modulation Grey scale output. The image area is scanned with
constant speed. To output grayscale the laser power is affected by pulse width mod-
ulation and an analog control voltage

CW Analog Grey scale output. The image area is scanned with constant speed. To out-
put grayscale the laser power is affected by an analog control voltage

Triggered Analog Grey scale output. The image area is scanned with constant speed.
To output grayscale the laser power is affected by pulse width modulation

External Rendering Grey scale output. Has to be selected when the bitmap is already
rendered by e.g. a Bitmap job node which is child job node of the original Bitmap job
node

Auto set parameter in laser device driver If the check box is selected and the Bitmap job
node is output then the parameters in the laser device driver will be automatically set, as
bitmap graphic possibly need to be output with different parameters than vector graphic.
If the check box is cleared then the parameters have to be set manually, i.e. via pens in
the job

Origin A graphics object is framed by a so called bounding box. In group Origin youmay spec-
ify the point (or handle) within the bounding box of the bitmap which coordinates and
geometrical operations refer to. In group Origin the central radio button is pre-selected.
Thus the bounding box center is at coordinates x/y (see following figure). If e.g. the upper
left radio button is selected instead then the upper left bounding box corner is at coor-
dinates x/y (see following figure). Following examples show settings of Origin and their
effect:
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Show/Hide preview see section 5.13.9 Edit - Preview

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.13.2. Edit - Render Server

NOTE

This tab only appears when in General tab Bitmap source is set to a created from subnodes
setting. The referenced Render Server has to be running or you may get unpredictable
results.

The parameters in this tab affect the external Render Server, which creates a bitmap file from the
subtree of the Bitmap job node. The Render Server is a very powerful tool. Conventional laser output
is only possible in vectorized form. On the other hand you are able to mark bitmaps on different
materials in different brightness and greyscale. The ARGES Render Server combines these features
by giving the possibility to e.g. create white characters on a dark bitmap or to use anti-aliasing for
normally plain vectorized lines in a rendered bitmap before the system starts processing.

There are two independent ARGES Render Server solutions. One way is to use the Render Server that
you may install with the InScript Software on a PC. Another way is to use a Render Server module
controller-side on an ASC-n controller (this is not possible using an NCC controller, which has to use
the Render Server running on a PC). To use the ASC controller-side Render Server, the corresponding
ASCModule has to be installed on this controller.
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Host

Local If the check box is selected then the Render Server has to reside on the local PC (the
PC where InScript is running). If the check box is not selected the Render Server may
reside on a remote PC or ASC-n controller and a correct host address and a port have to
be specified

IP address sets the IP address where the host with the Render Server can be found. The so
called localhost or "this computer" always translates to 127.0.0.1

Port sets the port where the host with the Render Server can be found. Normally InScript
uses local client port 2422

Render Options

Color mode selects the color depth and the color space of the output bitmap

8 bit grayscale greyscale with 256 colors

24 bit RGB RGB with 16. 7 million colors

32 bit RGBA RGB with 16. 7 million colors and an Alpha channel

Oversampling factor sets the oversampling factor

Oversampling filter

Average average filtering

File Repository Specification

Write rendered image to file If the check box is selected then the rendered image will be
written to a file. If Upload mode is set to Streaming in tab General and if you want to view
the result of rendering in the Vector Editor then this check box has to be selected.
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Render Server path sets thepath (viewed fromRender Server site), where theRender Server
saves the bitmap file

InScript PC path sets the path (viewed from InScript site), from which InScript loads the
bitmap file

File name sets the file name. Type in the file name without file name extension

Append sequence number If the check box is selected then a number will be appended to
the file name. This number will be automatically increased by 1 with the next bitmap file

Sequence number shows and sets the number which will be appended to the file name

File extension shows the file name extension

5.13.3. Edit - Geometry

The parameters in this tab define the size and the pixel mapping and the resolution respectively of
the output.

Geometry constraints In this tab there are the 3 groups Target Image Size, Pixel Mapping and Target
Resolution. Geometry constraints selects a superior and a inferior parameter group. The remain-
ing third parameter groupwill then be automatically adjusted to the other groups. If the values
in the inferior parameter group are not conform to the values of the superior parameter group
then they will be automatically set to values near to the original ones. The superior parameter
group always predominates

Size, Resolution Size is superior, Resolution is inferior and Pixel Mapping is subordinated

Resolution, Size Resolution is superior, Size is inferior and Pixel Mapping is subordinated
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Size, Pixel Mapping Size is superior, Pixel Mapping is inferior and Resolution is subordi-
nated. If the render server is used then this menu item is not available

Resolution, Pixel Mapping Resolution is superior, Pixel Mapping is inferior and Size is sub-
ordinated. If the render server is used then this menu item is not available

As an example, youmaywant to be 100% sure that the size of the output is not changed and that
the resolution (in Dots per Inch that have influence of the brightness and contrast of a picture)
are exactly as set. Then you choose Size, Resolution. The size will remain exactly as set and dots
per inch will also not be changed. To be able to represent the image in laser pixel, these have
to be adjusted to maintain size and resolution as set.

Target Image Size

Width sets the width of the bitmap's bounding box. The Bitmap job node scales the bitmap
that it fits completely into the bounding box (see also Retain aspect ratio). If you create a
bitmap using the Render Server then the bitmap is created in the specified size not before
the Bitmap job node is executed. Hence only an already created bitmap can be previewed

Height sets the height of the bounding box, see Width

Oversized bitmap selects the way a bitmap is treated that is bigger than the bounding box
Width×Height. This is only needed in ConstraintmodeResolution, PixelMapping because only
here size may vary.

Keep keeps the bitmap size

Shrink shrinks the bitmap to the bounding box' Width×Height

Clip clips the bitmap to the bounding box' Width×Height

Expand small image to size If the check box is selected then the bitmap will be enlarged to
the size Width× Height

Retain aspect ratio If the check box is selected then the aspect ratio will be retained (see
the following figure, upper row).

If the check box is de-selected then the boxWidth× Heightwill be completely filled. Thus
the bitmap can be stretched or compressed in one direction (see the following figure,
lower row)
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Alignment in bounding box selects, how the bitmap will be aligned within the boxWidth×
Height.

If you create a bitmap using the render server then the bitmap size and the box size always
correspond which makes alignment of the bounding box take no effect

Pixel Mapping

Horizontal sets the mapping of bitmap pixel to laser pixel (spot size) in horizontal direction
and shows the calculated value of the laser pixel to bitmap pixel mapping or vice versa.

If the check box is selected then the calculated value will be truncated

Laser Pixels per Bitmap Pixel The value has the unit Laser Pixels per Bitmap Pixel

Bitmap Pixel per Laser Pixel The value has the unit Bitmap Pixel per Laser Pixel

The following figure shows an example where the laser pixel are bigger than the bitmap
pixel (left side of the figure). The reverse case is also possible (right side of the figure)

Vertical sets the mapping of bitmap pixel to laser pixel (spot size) in vertical direction and
shows the calculated value of the laser pixel to bitmap pixel mapping or vice versa.

If the check box is selected then the calculated value will be truncated

Target Resolution

Horizontal sets the resolution of the output bitmap or the laser pixel size respectively (spot
size) in horizontal direction and shows the calculated values

dpi The value has the unit dpi (dots per inch)

µm The value has the unit µm (micrometer or micron)

Vertical sets the resolution of the output bitmap or the laser pixel size respectively (spot size)
in vertical direction and shows the calculated values

dpi The value has the unit dpi (dots per inch)

µm The value has the unit µm (micrometer or micron)

Circular spot If the check box is selected then the horizontal and vertical size of the laser
pixel (spot size) are assumed to be equal
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5.13.4. Edit - Grayscale Conversion

In this tab you set the parameters for converting a color bitmap into a gray scale bitmap or dithering
it.

Grayscale
Threshold sets within the output modes Line Normal and Line Optimized the threshold where

a line will be output, e.g. from 0.500 = 50.0% black
Brightness sets the bitmap brightness within the output modes Raster, Dot and the Analog

output modes
Contrast sets the bitmap contrast
Gamma sets the Gamma value. The Gamma value maps the source bitmap pixel intensity to

the target bitmap pixel intensity. The following figure shows the connection between
source bitmap intensity Isource, target bitmap intensity Itarget and Gamma

NOTE

TheGammavaluemakes it partially possible to compensate anonlinear response
of the material or the laser system used.
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Dithering
Mode Within the output modes Dot and Raster the gray tones are approximated by variously

dense dot patterns. 2 dithering methods are available

Ordered approximates one gray tone always by the same dot pattern. This method ap-
plies better to bitmaps with large areas of the same gray tone

Error Diffusion approximates a gray value with varying dot patterns, where the gray
values of neighboring bitmap pixel are taken into account

5.13.5. Edit - Output Mode Settings

NOTE

This tab only appears, if in the General tab Output mode is not set to Line Normal or Line
Optimized. Depending on the output mode you have chosen, only the suitable param-
eters are displayed. In Pseudo Analog with Modulation mode most of the parameters are
shown. Therefor not all settings are visible in the screenshot but they are referenced in
the description.

In this tab you set the parameters affecting the corresponding mode and controlling the optical laser
power.

The settings in this tab have a direct effect on the Digital Signal Processor (DSP) of the controller.
Hence most of the values are given in samples. The DSP processes 48000 samples per second, i.e. one
sample equals 1/48000 sec.

Frequency The values in the Frequency section are different approaches of the processing speed
and depend on each other (so if you alter one value the others will also be altered). A pixel
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frequency of 64 kHz is a good base value for ARGES products. Depending on the Frequency, the
charge time is influenced

Samples per pixel sets the time to output a laser pixel

Mark speed shows the processing speed that results from the setting in Samples per pixel

Pixel frequency shows the pixel frequency that results from the setting in Samples per pixel

Lead In

Enable if this check box is selected the Lead In tab will be available, where you can set the
relevant parameters, see section 5.13.6 Edit - Lead In

Pixel ON-time sets the raster timing, i.e. the time the laser beam is switched on for each
laser pixel

Analog These settings control the optical output power dependent on the bitmap pixel intensity.
Normally they are only needed for very demanding approaches

Min sets the value in the Digital Analog Converter (DAC), which defines the pixel intensity 0

Max sets the value in the Digital Analog Converter (DAC), which defines the pixel intensity
255

Gamma see Gamma in section 5.13.4 Edit - Grayscale Conversion

Use mapping If the check box is selected then the Bitmap Analog Mapping is activated

Mapping opens the Bitmap Analog Mapping window, see section 5.13.10 Edit - Mapping

Charge Time A higher frequency is decreasing the available maximum Charge Time and thus the
available energy. So if the marked picture is to light, you may have to reduce Pixel frequency
to get more Max charge time (or more laser energy)

Spiking delay sets the spiking delay

Period duration sets the period duration

Min sets the minimum

Max sets the maximum

Gamma see Gamma in section 5.13.4 Edit - Grayscale Conversion

Use mapping If the check box is selected then the Bitmap Pseudo Analog Mapping is activated

Mapping opens the Bitmap Pseudo Analog Mapping window, see section 5.13.10 Edit - Mapping

Gate Active Time

Value sets the time the Gate signal is active

5.13.6. Edit - Lead In

NOTE

This tab only appears, if in the Output Mode Settings tab the Enable check box is selected in
the Lead In group.
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In this tab you define parameters affecting the lead in and lead out, i.e. the beginning and ending of
a scan line. These settings can for example be used to avoid a first pulse of high energy after the
Q-switch is opened that may cause a dark edge where the laser starts to process.

Lead In

Gate mode selects the mode for the oscillator on the controller

CW at the Gate output a simple on/off signal will be output

Triggered at the Gate output pulses will be output

Duration sets the number of laser pixel used for the lead in. Below this field the calculated
time for the lead in is shown

Lead In PWM

Start value sets the pulse width used at the beginning of the lead in

End value sets the pulse width used at the ending of the lead in

Gamma cp. Gamma in section 5.13.4 Edit - Grayscale Conversion

Use mapping If the check box is selected then the Bitmap PWM Lead In is activated

Mapping opens the Bitmap PWM Lead In window, see section 5.13.10 Edit - Mapping

Lead In Analog

Start value sets the value in the Digital Analog Converter (DAC), which will be used at the
beginning of the lead in

End value sets the value in the Digital Analog Converter (DAC), which will be used at the
ending of the lead in
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Gamma cp. Gamma in section 5.13.4 Edit - Grayscale Conversion

Use mapping If the check box is selected then the Bitmap Lead In is activated

Mapping opens the Bitmap Lead In window, see section 5.13.10 Edit - Mapping

5.13.7. Edit - Scanning

In this tab parameters are defined affecting the output of scan lines. You can set parameters for the
scan direction and optimization.

Scanlines

Direction selects the scan line direction.

NOTE

If in tab General in list Upload mode the item Streaming is selected then the item u
has to be selected here.

u The scan lines are oriented in the u direction (x). The picture is processed horizontally.
If you check Bidirectional the picture is processed left-to-right ' right-to-left ' left-to-
right ' etc.

v The scan lines are oriented in the v direction (y). The picture is processed vertically.
If you check Bidirectional the picture is processed top-to-bottom ' bottom-to-top '
top-to-bottom ' etc.

Repeat sets how often one single scan line will be output. If the Bidirectional check box is
selected then 2 successive scan lines will be repeated together, see following figure.
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Bidirectional If the check box is selected then the scan lines will be bidirectionally output.
The scan head “jumps” at the end of a line to the “end” of next line and scans it in opposite
direction. This behavior is similar to that of dot-matrix printers.

If the check box is de-selected then all scan lines will be output in one direction. The scan
head “jumps” to the beginning of the next line, see following figure.

NOTE

In output modes Normal Line, Line Optimized and Dot be aware that the settings
are adjusted in the actual pen in pen section linepar in a way that the scan lines
are not shifted to each other.

For all other output modes you have to optimize the settings by executing the
following procedure:

Step 1 Be sure that the ARGES Render Server is running.

Step 2 In the Devices Listwindow in the linepar device Editor choose the tab
Raster.

Step 3 Click the red Controlled button beneath the Char Alignment combo
box

Step 4 Choose Low res pixel.from the list

Step 5 Load this job:
jobs\DetermineTrackingError\DetermineTrackingError.job
in the InScript folder.

Step 6 Execute the job.

Step 7 Follow the instructions given in the job.

NOTE

If you are using an ASC controllers then double click the Text Bitmap
node (not the Text Text node below it) and click on the Render Server tab.
Uncheck the Local check box and enter the IP number of the PC that has
a local render server running under IP address. The script is created for
a local render server and adjustments for a ASC based Render Server
would be more complicated to do.
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Flyback speed sets the fly back speed at a line end or column end respectively for jumping
to the next line or column

Head sets the time being used for the line head, see section 3.10 linepar - Line Parameters
Tail sets the time being used for the line tail, see section 3.10 linepar - Line Parameters

Scanline Gap Optimization
Skip empty scanlines If the check box is selected and a scan line contains no output then

the scan line will be skipped
Skip gaps in scanlines If the check box is selected and a scan line contains sections with no

output then these gaps will be skipped
Jump speed sets the jump speed for skipping whitespace within scanlines
Head sets the time being used for the line head, see section 3.10 linepar - Line Parameters
Tail sets the time being used for the line tail, see section 3.10 linepar - Line Parameters

Interleave
Value If the value (N) is greater than 1 then the scan lines will not be successively output, but

N-1 lines will be omitted and only every N-th line will be output. The omitted lines will
be output in later passes.
This may be reasonable, when the material to be processed is sensitive to heat and needs
time to cool down before heating it up again near the first heating, see Type

Type selects, in which order the scan lines will be output
Linear The following figure shows an example for Value = 4 and 12 lines
Bit-reversed Each n'th line is drawn but 2nd and 3rd lines are swapped to prevent over-

heating for more delicate materials. E.g. Value=4 and 12 lines

Tracking Error Compensation
Modulation delay samples sets the delay for switching the laser beam on at the beginning

of a scan line and switching it off at the ending of a scan line. If the Bidirectional check
box is selected in the Scanning tab then this delay prevents the scan lines being output
shifted to each other because of the tracking error. Tracking error means that the laser
is switched on before the laser spot reaches its nominal position at the beginning of the
scan line and is switched off before it reaches the end of the scan line

Subframe delay sets the subframe delay. This setting has a direct effect on the Digital Signal
Processor (DSP) of the controller. Hence it is given in samples. The DSP processes 48000
samples per second, i.e. one sample equals 1/48000 sec
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5.13.8. Edit - Info

This tab summarizes information about the uploaded bitmap file and set parameters.

Info Window opens the Bitmap Info window. The information of the Info window is displayed in a
separate window
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5.13.9. Edit - Preview

Show preview / Hide preview shows / hides the preview of the bitmap file. The preview takes in
account parameters from the groups Target Image Size and Grayscale

Source

File uses the image data from the original bitmap file

Raw uses the original raw image data that will be output by the bitmap node. Color will be
converted to gray scale and the parameters Brightness, Contrast and Gamma will be ac-
counted for. If no raw data is available the preview window will show No preview available

View Bitmap opens the BitmapViewerwindow showing the current bitmap. The parameters Bright-
ness, Contrast and Gamma will have no effect in this window. The bitmap source is defined in
Source

Histogram opens the Histogram window with the current bitmap's histogram. The bitmap source
is defined in Source
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5.13.10. Edit - Mapping

In this window you can freely define a mapping. This mapping can be the Bitmap Analog Mapping,
Bitmap Pseudo Analog Mapping, Bitmap PWM Lead In Mapping or Bitmap Lead In Mapping.

opens the Open dialog

opens the Save As dialog

switches into Select mode where points in the diagram can be moved

switches into Panmode. If the diagram is zoomed in and only a cutout can be seen then the cutout
can be moved

switches into Zoom in/out mode. Place the mouse pointer on the point in the diagram you want
to zoom in/out and click the left/right mouse button

switches into Zoom by windowmode. Place the mouse pointer on a corner of the area you want to
zoom in, hold pressed the left mouse button and and draw the mouse pointer to the opposite
corner of the area. As soon as you release the left mouse button the blue marked area will be
zoomed in

shows the whole diagram

switches into Add points mode. In the diagram, click the position where you want to add a point

switches into Remove points mode. Click the point you want to delete

Show mapping sample points If the check box is selected then the interpolation sample points
will be showed in the diagram (red vertical lines)
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Table - Interpolation Sample points displays the points form the diagram in a tabular form

1st Column In the table the yellowmarked line correspondswith the turquoisemarked point
in the diagram

2nd Column (X) coordinate on the horizontal axis

3rd Column (Y) coordinate on the vertical axis

Table - Interpolations

1st Column For mapping 2 types of interpolations are available (gray line/curve). Linear fits
a linear interpolation to the points. Spline fits a spline interpolation to the points. To
use the spline interpolation there have to be more than 2 points in the table or diagram
respectively

2nd Column To apply a interpolation type to the mapping, click the corresponding row of
the 2nd column. The red pin symbol shows that the interpolation type is in use

3rd Column To show the interpolation in the diagram, click the corresponding row of the 3rd
column. The glasses symbol shows that the interpolation is displayed. The interpolation
will be displayed as a gray line/curve in the diagram

Diagram In the Bitmap Analog Mapping window the value for the Digital Analog Converter (DAC) in
% is plotted against the bitmap pixel intensity (gray value).

In the Bitmap Pseudo AnalogMappingwindow the Charge Time inµs is plotted against the bitmap
pixel intensity (gray value).

In the Bitmap PWM Lead In window the pulse width in µs is plotted against the pixel in the lead
in.

In the Bitmap Lead In window the value for the Digital Analog Converter (DAC) in % is plotted
against the pixel in the lead in.

TIP

To add a point, place the mouse pointer on the position in the diagram where you
want to add it and in the context menu, click Add point. To delete a point, click Delete
in the point's context menu.

5.13.11. Edit - Position Encoder

Step 1 In the Bitmap job node's context menu, click Xplore.

Step 2 Navigate to usr.job.Job.Bitmap.
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enctrk_pos_enc_device_name sets the name of the encoder device used for position tracking.
Look up the name of the encoder device in window Devices List

enctrk_scanlines_per_block sets the number of scanlines in a block. Between the blocks the
encoder waits for the next encoder position. Only for a very high velocity the value might be
> 1

wait_pos_mm_0 sets the distance between C-signal position and object processing

5.14. Dot

Using this node single dots can be output. To drill e.g. holes with defined parameters, set the para-
meters in the Job Configuration window in the Default-Pen, pen section linepar, in the Dot tab.

Node Name see section 5.1 Shared GUI Elements
Action see section 5.1 Shared GUI Elements
Dot here you can activate the local dot parameters

Use local time settings If this check box is selected then the values under Time are used
and not the values that are set in the default pen, another active pen or the linepar device
under Dot (see also 4.9 Manage Pens or 3.10 linepar - Line Parameters)
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Time here you can set local dot parameters

Head sets the time waited after a jump. This is the mirror settling time plus the laser beam
ON delay. In general this time is longer than with other line types as the speed has to be
completely reduced to zero and not to processing speed

Tail sets the laser beam OFF delay. The tracking error with a stationary processing on a fixed
position is zero. This is why contrary to the other line types no negative values can be
used here

ON sets the exposure time ("ON-Time") for dots

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.15. Shape

This node outputs basic geometrical shapes like lines, rectangles and ellipses.

Node Name see section 5.1 Shared GUI Elements

Layout

Type selects the geometrical shape

Line draws a line

Rectangle draws a rectangle

Ellipse draws an ellipse

X1 sets the origin X coordinate

Y1 sets the origin Y coordinate

Width sets the graphic object width
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Height sets the graphic object height

Origin
The graphical object iswithin a bounding box. In theOrigin group you select the bounding
box point of origin to which coordinates and geometrical operations are referring.

In the Origin group the center point is pre-selected. Thus the bounding box center is at
the coordinates X1/Y1. If e.g. the right lower radio button is selected then the right lower
corner is at the coordinates X1/Y1.

Following examples show settings of Origin and their effect:

Absolute If the check box is selected then group Origin is deactivated and Width / Height are
replaced by 2 absolute coordinates X2 / Y2. This way you can specify the graphic object
size and position in the absolute coordinates X1, Y1, X2 and Y2

Corners
Only if Rectangle is selected in the Type list then this group is activated. By this group the rect-
angle corners can be rounded

Radius sets the rectangle corner radius

Segments sets the number of lines the corner radius is approximated with. A higher number
improves the approximation but increases memory requirements and output time

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.16. Polygon

This node outputs polygons. These can have a convex or concave outline.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

General
Type selects the polygon type

Polygon draws a polygon with as many corners as specified in Vertices. If this list item is
selected then Angles — Offset, Concave — Radius and Concave — Corner are deactivated.
These settings are only required if Type Star is selected

Star draws a star with N corners on the inner radius and N corners on the outer radius,
where N is set in Vertices

Vertices sets the number of corners

Angles
Start sets the angle, where the first corner occurs

Offset If Star is selected in the Type list then the corners on the inner radius are rotated by
this angle regarding the corners on the outer radius

Convex
Radius sets the outer radius

Corner Radius sets the corner radius

Corner Segments sets the number of lines approximating the corner radius

Concave
Radius sets the inner radius

Corner Radius sets the corner radius

Corner Segments sets the number of lines approximating the corner radius

Preview shows the polygon preview with the parameters set

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements
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5.17. Concentric Circles

This node outputs concentric circles.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Layout Specification selects by which parameters concentric circles are specified in the Layout
group. Whichever list item is selected, input boxes are deactivated and calculated automati-
cally in the Layout group

Radius1, Radius2, Circles set inner, outer radius and number of circles

Radius1, Step, Circles set inner radius, step width between radii and number of circles

Radius2, Step, Circles set outer radius, step width between radii and number of circles

Radius1, Radius2 → Step set inner, outer radius and number of steps. Here the number of
steps is subordinated to the other both parameters and will be automatically fitted, when
not according to these parameters

Radius1, Step → Radius2 set inner, number of steps and outer radius. Here the outer ra-
dius is subordinated to the other both parameters and will be automatically fitted, when
not according to these parameters

Radius2, Step → Radius1 set outer radius, number of steps and inner radius. Here the in-
ner radius is subordinated to the other both parameters and will be automatically fitted,
when not according to these parameters

Interleave

Value If the value (N) is larger than 1 then the circles are not output back-to-back, but N−1
circles will be skipped and only each Nth will be processed. Skipped circles will be output
in later passes.

This may be reasonable, if the processed material is sensitive to heat and needs time to
cool down before being heated up again in a nearby area (see Type)

Type selects the order the circles are output with
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Linear/Bit-reversed the following figure shows an example for Value = 4 and 12 lines

Layout

Radius 1 sets the inner radius

Radius 2 sets the outer radius

Step sets the step width between the radii

Circles sets the number of circles

Start selects the circle the output shall begin

Small with the smallest circle

Large with the largest circle

Approximation

Mode The circles are approximated by polygons. Select the boundary condition for these
polygons. Specify the boundary value in Value

Segments per 360° number of lines in the polygon

Segment length limit length of polygon lines [mm]

Deviation limit max. deviation for circular shape [mm]

Value sets the boundary value of Mode

Line handling optimization If the check box is selected then InScript arranges the start of a circle
relative to the end of the previous circle in a way a fluent motion results

Preview shows the concentric circles preview with the parameters set

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.18. Text

By this node you can create and format text. The text can be slanted in different angles, scaled in
width and height and distorted.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Text Box In the text box type in the text or variable to be output. Embed a variable in 2 $-characters,
e.g. the variable $stat.time.DateStr$ outputs the actual date. How the name of a variable is
acquired and how to work with variables, you will learn in section 5.44.2 Scripting Language.

If you want to output the $-character then it has to be preceded by the \-character, thus you
have to type in \$. If you edit a job file directly via a text editor then the $-character has to be
preceded by 2 \-characters, thus you have to type in \\$.

Apply applies the text without closing the Text Editor window

Clear clears the text from the text box

Origin
The graphical object is within a bounding box. In the Origin group you select the bounding box
point of origin to which coordinates and geometrical operations are referring.

In the Origin group the center point is pre-selected. Thus the bounding box center is at the
coordinates X1/Y1. If e.g. the right lower radio button is selected then the right lower corner
is at the coordinates X1/Y1.

Following examples show settings of Origin and their effect:
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Character
Font selects a font from a dropdown list.

opens the Select Fontwindow, see section 5.67 Select Font - Window. All installed customer
specific fonts are displayed and can be used. The fonts are located in the Fonts folder of
the InScript installation

Size sets the character height
Slant sets the text slant. The slant angle results from the arctan of the entered value. Values

from +3 to 3 are allowed
Clear when done If the check box is selected and the node has been executed then the font

will be deleted from the controller's memory
Paragraph

Alignment justifies the text (left, center, right, full)
Char spacing sets the distance between characters (tracking)
Line spacing sets the distance between lines

selects the unit for the values in Char spacing and Line spacing
Relative (%) The values are given relative to the single tracking and single line dis-

tance
Absolute (mm) The values are given absolute

Layout width sets the bounding box width
Layout height sets the bounding box height
Encoding selects the encoding

Native 8 bit, UTF-8 available encodings. If youwant to copy UTF-8 or UNICODE char-
acters to the Text editor, the source of the copying has to be capable of doing this
(e.g.Windows WordPad supports this data exchange). The used font also has to sup-
port all glyphs or characters that you want to use. UTF-8 is the 8-bit UCS/Unicode
Transformation Format - it is able to represent any character in the Unicode stan-
dard like Asian, Cyrillic or other non-latin characters, yet is backwards compatible
with the limited ASCII format
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Auto Width If the check box is selected then the bounding box width will be automatically
adjusted to the width of the longest line

Auto Height If the check box is selected then the bounding box height will be automatically
adjusted to the text height

Auto Wrap If the check box is selected then the text will be automatically wrapped at the
bounding box. If the check box is cleared then the text will be automatically condensed
to fill the bounding box width

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.19. RoundText

This node outputs text aligned to circular or elliptical arcs.

5.19.1. Edit - Shared GUI Elements

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements
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5.19.2. Edit - Text

Text In this text box type in the text or variable to be output. Embed a variable in 2 $-characters,
e.g. the variable $stat.time.DateStr$ outputs the current date. How the name of a variable
is acquired and how to work with variables, you can see in section 5.44.2 Scripting Language.
If you want to output the $-character then it has to be preceded by the \-character, thus you
have to type in \$. If you edit a job file directly via a text editor then the $-character has to be
preceded by 2 \-characters, thus you have to type in \\$

Align selects the alignment in an angular range. The angular range is specified in tab Angles

Left aligns the text to the left

Center aligns the text centered

Right aligns the text to the right

Block aligns the text with justified settings - the gaps between characters are stretched

Stretch aligns the text with justified settings - the characters are stretched

Font Name selects the font

opens the Select Fontwindow, see section 5.67 Select Font - Window. All installed customer
specific fonts are displayed and can be used. The fonts are located in the Fonts folder of
the InScript installation

Size sets the character height

Storage selects what happens to the font after the text was output

Keep The font will be kept in the controller board memory

Remove The font will be removed from the controller board memory
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5.19.3. Edit - Characters

Characters Width sets the character width. The character width is given in percent of the stan-
dard character width. Values between 1% and 500% are allowed

Additional Spacing sets the additional distance between characters. The additional distance
is given in % of the standard character width. Values between -50% and 500% are allowed

Rotate selects the character alignment regarding their base line. If you select the upper button then
the characters will keep their direction. If you select the lower button then the characters will
be aligned along the arc, i.e. they will be rotated

Baseline selects whether the base line, the center line or ascender shall be aligned to the arc

5.19.4. Edit - Ellipse

Ellipse

Half Axis a sets the length of major axis a

Half Axis b sets the length of minor axis b
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Flatness sets the distance from the center to either focus of the ellipse divided by the distance
from the center to either vertex or Flatness

Particularities The characters are aligned along an arc. This arc is approximated by a polygon.
Depending on the number of polygon lines a deviation from the arc occur. The parameter sets the
maximal allowed deviation from the arc.

5.19.5. Edit - Angles

Angles

Start sets the angle at the arc, where the text begins

Stop sets the angle at the arc, where the text ends

Direction selects the text direction

Clockwise clockwise from Start to Stop

Counterclockwise counterclockwise from Start to Stop

Preview shows angle, range and direction in which the text is output

5.20. Barcode

Using the Barcode node different barcode types can be created.
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Barcode

Type selects the barcode type

Code 39 also known as "USS Code 39", "Code 3/9", "Code 3 of 9", "USD-3", "Alpha39" or
"Type 39" is a barcode symbology that can encode uppercase letters (A through Z),
digits (0 through 9) and a handful of special characters like the $ sign

Code 93 is a barcode symbology designed in 1982 by Intermec to provide a higher den-
sity and data security enhancement to Code 39. It is an alphanumeric, variable length
symbology

Code 128 is a very high-density barcode symbology. It is used for alphanumeric or
numeric-only barcodes. It can encode all 128 characters of ASCII and, by use of an
extension character (FNC4), the Latin-1 characters defined in ISO/IEC 8859-1

Code 2/5 interleaved is a continuous two-width barcode symbology encoding digits

Codabar is a linear barcode symbology. The body of a Codabar string may only encode
the numerals 0 through 9. Some variants allow the symbols dollar, dash, plus sign,
colon, slash, and dot

EAN 13 European Article Number (EAN) is a barcoding standard which is a superset of
the original 12-digit Universal Product Code (UPC). In EAN-13 the symbol encodes 13
numerals divided into four parts

EAN 8 is a shortened version of the EAN-13 code. It includes a 2 or 3 digit country code,
4 or 5 data digits (depending on the length of the country code), and a checksum digit

UPC A UPC-A barcode consists of two bars and two spaces, all UPC-A barcodes consist
of exactly (3 × 2) + (12 × 2) = 30 bars

UPC E To allow the use of UPC barcodes on smaller packages where a full 12-digit bar-
code may not fit, a 'zero-compressed' version of UPC was developed called UPC-E
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Content Type in the text or variable to be output into this text box. Embed a variable in 2
$-characters, e.g. the variable $stat.time.DateStr$ outputs the current date. How the
nameof a variable is acquired andhow toworkwith variables, you can see in section 5.44.2
Scripting Language. If you want to output the $-character then it has to be preceded by
the \-character, thus you have to type in \$. If you edit a job file directly via a text editor
then the $-character has to be preceded by 2 \-characters, thus you have to type in \\$

Layout

Offset X sets the reference point X position

Offset Y sets the reference point Y position

Height sets height of the the barcode

Width sets the width of the barcode depending on Width Mode

Width Mode selects to what the Width refers

Width Width refers to the whole barcode

Module width Width refers to one barcode module (i.e. the width of a "bar")

Origin
The graphical object iswithin a bounding box. In theOrigin group you select the bounding
box point of origin to which coordinates and geometrical operations are referring.

In the Origin group the center point is pre-selected. Thus the bounding box center is at
the coordinates X1/Y1. If e.g. the right lower radio button is selected then the right lower
corner is at the coordinates X1/Y1.

Following examples show settings of Origin and their effect:

Auto Width If this check box is selected then the bounding box' width will be automatically
adjusted to the width of the barcode

Auto Height If this check box is selected then the bounding box' height will be automatically
adjusted to the height of the barcode

Options
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Outline If the check box is selected then the barcode modules will be outlined

Fill If the check box is selected then the barcode modules will be filled

Bidir. Fill If the check box is selected then the barcode modules will be bidirectionally filled

Fixed Fill If the check box is selected then the distance between the filling lineswill be strictly
adhered to. Thus the module width may differ from the nominal value and some barcode
scanners may have problems to read the barcode. If the check box is cleared then the
outlines confining the module will be set exactly. Thus the readability is increased for
barcode scanners. The distance between filling lines may differ from the nominal value,
so that visible gray scales occur on certain materials

Checksum If the check box is selected then the checksum will be coded into the modules.
Only specific barcode types provide this option

Font

Name selects a font from a dropdown list

opens the Select Fontwindow, see section 5.67 Select Font - Window. All installed customer
specific fonts are displayed and can be used. The fonts are located in the Fonts folder of
the InScript installation

Size sets the character height

Storage selects what happens to the font after the text was output

Keep The font will be kept in the controller board's memory

Remove The font will be removed from the controller board's memory

Font Options

Draw ASCII If the check box is selected then the ASCII characters from the Content box will
be output beneath the barcode

Fill ASCII If the check box is selected then the ASCII characters from the Content box will be
filled

Misc

Mark Bright select this check box, if the material becomes brighter marking it

Spot Size sets the real physical spot size on the target

Width reduction reduces the width of barcode modules by the input value to compensate
for the line width on the target

Width factor Some Barcode types provide modules in exactly 2 widths (narrow and wide).
Width factor sets the ratio of narrow and wide modules. With a factor of 2.000 the wide
modules are twice as wide as the narrow modules

Quiet Zone X sets the width in X-direction of the area, where no marking will be output
around the barcode

Quiet Zone Y sets the height in Y-direction of the area, where no marking will be output
around the barcode
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5.21. Barcode 2D

This node creates 2D barcodes in different encodings.

Barcode

Type selects the 2D barcode type

DataMatrix version may 8, 1997 / ISO 16022; Error Correction Code 200 is supported

Content Type in the text or variable to be output into this text box. Embed a variable in 2
$-characters, e.g. the variable $stat.time.DateStr$ outputs the current date. How the
nameof a variable is acquired andhow toworkwith variables, you can see in section 5.44.2
Scripting Language. If you want to output the $-character then it has to be preceded by
the \-character, thus you have to type in \$. If you edit a job file directly via a text editor
then the $-character has to be preceded by 2 \-characters, thus you have to type in \\$.

Encoding Options

Encoding selects the encoding according to ISO 16022

ASCII is used to encode data that mainly contains ASCII characters (0-127). It encodes
approximately one alphanumeric or two numeric characters per byte. As a general
rule, use ASCII to encode text that includes uppercase and lowercase letters with or
without numbers and punctuation

C40 is used to encode data that contains only numeric and upper case characters. C40
encodes approximately three alphanumeric data characters into two bytes

Text is used to encode data thatmainly contains numeric and lowercase characters. Text
encodes approximately three alphanumeric data characters into two bytes
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Base256 is used to encode images, double-byte characters, binary data and 8 bit values

None no encoding is used

Auto tries to automatically choose an encoding

Format selects the encoding format

nXm sets the number of cells per line and the number of lines in the barcode

Auto automatically selects the format to encode the information given in Text with the
smallest possible format

Format warning If the check box is selected and you enter an information which can not be
encoded then a warning will be output

Size

Width sets the 2D barcode width

Height sets the 2D barcode height

Spot Size specifies the real physical spot size on the target. The spot size can not be set this
way, but is specified so InScript can perform calculations. If Cell Lines, Cell Lines Bidi, Cell
Lines Bidi Cont, Cell Dot Array Quad or Cell Dot Array Hex are selected in Fill Mode then
the dot density can be modified by changing the Spot Size. At 50µm 20 dots per mm will
be output, at 100µm only 10 dots per mm will be output

Output Options

Fill mode selects the way the 2D barcode cells will be filled

Cell Lines fills the barcode cells with horizontal lines. The distance between the lines
is specified in Spot Size. The lines will be output unidirectionally from the left to the
right

Cell Lines Bidi as Cell Lines, but bidirectionally, i.e. the lines will be output alternating
from the left to the right and vice versa

Cell Lines Bidi Cont as Cell Lines Bidi, but the end of a line will be connected to the
start of the next line by a vertical line. A kind of sinuous line develops

Cell Dot outputs a dot in the barcode cell center

Cell Dot Array Quad fills the barcode cell horizontally and vertically with n times n
dots. The number n results from the Spot Size setting and the cell size

Cell Dot Array Hex as Cell Dot Array Quad, but the dots of successive lines will be
shifted against each other and a kind of honeycomb pattern develops

Cell Subnodes fills each barcode cell with the object which is child node of the Barcode
2D node

Scanline unidirectional fills the barcode cells with scanlines in one direction

Bitmap creates a bitmap of the set-up barcode with Bitmap Name (see there for more
information) in the Files folder of the controller
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Mark Polarity specifies, how the color of the material changes after marking

Bright the material darkens

Dark the material brightens

Include quiet zone If the check box is selected then a margin around the 2D barcode stays
unmarked. This margin takes 10% of barcode width and height

Disable quiet zone If the check box is selected then the whole width and height will be used
for the 2D barcode

Origin
The graphical object is within a bounding box. In the Origin group you select the bounding box
point of origin to which coordinates and geometrical operations are referring.

In the Origin group the center point is pre-selected. Thus the bounding box center is at the
coordinates X1/Y1. If e.g. the right lower radio button is selected then the right lower corner
is at the coordinates X1/Y1.

Following examples show settings of Origin and their effect:

Bitmap Name this input field is only accessible, if Fill mode→ Bitmap is selected. As default a
file called BC2D is created in the Files folder on the controller. It refers to a bitmap of the set-
up barcode. If you change the filename and execute the Job containing the Barcode 2D node, a
new file will be created in the Files folder of the controller. If the filename is not changed, the
bitmap of the barcode will be recreated using the same filename. This can be used to put the
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Barcode2D under a Bitmap node (see 5.13 Bitmap) using the setting File created from subnodes or
Stream image created from subnodes

5.22. Raw Lines

Using this node, line data can be integrated into a job. The line data can either be embedded directly
in the Raw Lines node or be loaded, pre-processed and passed on to the controller on request.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Import opens the Open window. Select a file of type arl, hpgl, plt, lg1, dxf or vec to open it.
In the latter 2 cases the Vector Graphics Import window will be opened, see section 5.22.1 Vector
Graphics Import Window

Export saves the line data in a file of type ARGES Raw Lines arl
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Create rawlines from subnodes creates line data from subnodes of the Raw Lines node

Refresh fetches the line data from the controller in offline mode

Apply sends the line data to the controller in offline mode

Switch to online (embedded) mode Switch to offline (request) mode selects, whether
the line data will be embedded to the job or the line data will be requested by the controller,
when the node is executed. In online mode the line data is together with the job on the con-
troller and changes are applied immediately. In offline mode changes have to be manually
applied to the controller and the line data will be pre-processed, when the file is requested.
The offline mode is used when a huge amount of data has to be processed especially by an NCC
controller. External line data greater than 1MB (e.g. Autocad DXF) has to be converted to ARL
(Arges RawLines Format) in offline mode and has to be streamed using the offline mode. Here
is an overview of the two modes:

Shown Button Icon Current mode Comment

RawLines node is in online mode (Default) Data less than 1MB
→ the line data is stored on the controller

RawLines node is in offline mode Data greater than 1MB
→ the line data is streamed to the controller
from an ARL file

Cut cuts the selection and puts it to the clipboard

Copy copies the selection to the clipboard

Paste pastes the contents of the clipboard

Delete deletes the selected paths, segments or points

Select all selects all paths, segments and points

Deselect all deselects all paths, segments and points

Fill fills a closed path. The end point of such a path is jointed with its start point. The symbol ist
active only in this case

NOTE

Fill can only be applied to closed line paths!

The Fill Options window opens:

344 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



5.22. Raw Lines

General

X sets the X-coordinate of the first hatching line’s reference point. If X = 0 and Y = 0 then
the first hatching line goes through the origin of the filled object

Y sets the Y-coordinate of the first hatching line’s reference point. If X = 0 and Y = 0 then
the first hatching line goes through the origin of the filled object

Delta sets the distance between the hatching lines

NOTE

E.g. a Scalenode above a Fillnodewill also influence theDelta! Itmay be better
to place Geometrical Operator nodes below a Fill node.

Reduction sets the scan distance (scd) between the contour and the hatching lines. The
real distance results from this value times the distance between the hatching lines in
Delta

Fill Passes sets the number of fill passes

Start Angle sets the angle for the hatching lines in the first fill pass

Rotation sets the angle by which the hatching lines are rotated after every fill pass

Options

Outline if this check box is selected then an outline will be drawn

Outline first if this check box is selected then the outline will be drawn first and ater
that the object will be filled. The Outline check box has to be selected

Bidirectional if this check box is selected then the hatching lines will be output bidi-
rectionally. This increases output velocity but deteriorates the quality to a minor
degree. If head-, tail-, on- and off-delays are not correctly set in device Line Param-
eter (see 3.10 linepar - Line Parameters) then output errors will occur e.g. shifted fill
lines

Interleave

Mode selects the interleave mode

Linear every nth hatching line will be output. The value for n is entered in Passes
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Bit reversed the hatching lines will be output in a pattern which will maintain a
minimal distance during the passes

Passes if Passes is greater than 1 then the hatching lines will be not output immediately
one after another. Hatching lines will be skipped and output in a later pass. This is
useful when the material that will be processed is sensitive to heat and needs time to
cool down before heating it up again nearby

Optimize sorts all segments of a path in a sequence and optionally reverses its subpaths, if you
selectReverse Subpaths in theOptimizationOptionswindow. Select the paths youwant to optimize
and click Optimize

The Optimization Options window opens:

General

Reverse Subpaths if this check box is selected then the sub paths are reversed in out-
put direction

Create dot creates a point at the scan field's origin

Create line creates a line at the scan field's origin

Append line appends a line to a path. The point of type End will be in the scan field's origin.
Select a point of type End and click Append line

Split path splits a path in 2 paths at 1 point. Select a point of type Join and click Split path

Join joins 2 points to 1 at half distance between them. Select a point of type End and a point of
type Start and click Join

Connect connects 2 points with a line. Select a point of type End and a point of type Start and
click Connect

Make path(s) first moves a path in the Paths list to the beginning of the list. Select a Path and
click on Make path(s) first in list

Move path(s) up moves a path up in the Paths list. Select a Path and click Move path(s) up

Move path(s) down moves a path down in the Paths list. Select a Path and click Move path(s)
down

Make path(s) last moves a path in the Paths list to the end of the list. Select a Path and click
on Make path(s) last in list

Reverse path(s) reverses the direction a path is being executed
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Show previous selected block shows the previous selected block in the Paths, Segments and
Points list

Show next selected block shows the next selected block in the Paths, Segments and Points list

Paths lists all paths. Paths consist of jointed segments

Segments lists all segments. A segment has a start and an end point. If the end point of segment A
is also the start point of segment B then it is of type Join

Points lists all points. A point can be the Start or End of a segment or it can be the Join between 2
segments

File shows the file used

Properties shows some properties regarding the line data.

Additionally pens can be assigned to Paths here. To do so the Raw Lines node has to be child of
a Pen Set node and Pens have to be defined, see section 4.9 Manage Pens. To assign a pen to a
path select the Path. In Properties, double click PenNo. Type in the pen number to be used for
this path and press the Enter key

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

Example 1 Figures 9 and 10 show an example where 2 paths are selected in the Paths list and their
corresponding Segments and Points as well as their graphical representation.

Figure 9: Two paths selected in the Paths list and their corresponding Segments and Points
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Figure 10: Graphical representation of the line data in figure 9 (selected paths red)

Example 2 Figure 11 shows, how you can add a point on an existing line in Vector Editor. The
Vector Editor has to be in Handle Points mode to do this.

Figure 11: RawLines point added by double clicking

If the first point in the RawLines list is a 2D point, a 2D point is inserted. If the first point in the
RawLines list is a 3D point, a 3D point is inserted.

5.22.1. Vector Graphics Import Window

This window opens, when importing a DXF or VEC file. It provides the possibility to define which
layers to import and to assign pens to layers.
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File selection shows the name of the file

Browse opens the Open window

Mapping In the left window area pens can be assigned to layers of the file. The layers to be imported
can be selected

Layer → pen mapping In the list all layers available in the file are shown as [Layername]
→ [PenNr]. Each layer is assigned to PEN 1 by default. To assign a layer to a pen, select
the layer and then in Pen selection select the pen

Map all to current pen assigns all layers to the pen selected in Pen selection

Delete selected layers excludes the selected layers from import andmarks themas "deleted"

UnDelete selected layers includes the selected layers to import

Show only selected layer If the check box is selected then only selected layers are shown.
Use this function to check, whether the layers marked for import are complete or not.
Select all layers marked for import and check in the preview

Device units in 1mm sets the "device units" per mm.

DXF files are unitless. A distance of e.g. 10 "device units" may correspond to 10 microns,
10 inches, or even 10 meters. It is therefore very important that you specify the meaning
of the device units

Auto-convert to linear interpolation If the checkbox is selected then

View selects the view (if present) on the drawing

Preview The right window area shows the vector graphic to be imported

OK see section 5.1 Shared GUI Elements
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Cancel see section 5.1 Shared GUI Elements

The preview window has some additional functionality, which can be accessed using its context
menu. You have two different context menues. If no elements are selected, the Zoom and Proper-
ties Context Menu is available and if you select objects in the preview window, the Edit Context Menu
menu can be used.

Zoom and Properties Context Menu and Mouse Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

This menu is available, if no objects are selected in the preview window. If Objects are selected, use
Unselect all from Edit Context Menu to get back to the Zoom and Properties Context Menu.

Mouse in the Selection mode the hair cross is shown with an additional square at the intersection.
This square shows the tolerance area, i.e. all objects within this square will be selected by a
click. Selected objects are shown in color and have additional handling points.

To select an object in the Selection mode, place the mouse pointer on the object and press the
left mouse button. If the mouse pointer is not placed on an object a rectangle can be dragged
open. All objects within this rectangle will be selected

Mouse Wheel themouse wheel can be used to zoom in or out of the previewwindow. The position
of the cursor is the center of zooming

Repeat ... lets you repeat the action shown after Repeat

Zoom Extents zoom to fit all lines to the preview window (you can re-center the drawing using
this function)

Zoom Window the next left click and drag action will open a zoom window

Zoom Previous goes back to the previous zoom setting

Magnifier opens or closes a magnifier window in the lower right corner of the preview window

Undo undo the last action

Redo redo the last action

Properties opens a properties window of the DXF or VEC file

Drafting Aids opens the Drafting Aids window

In this window you can set the Grid, Polar Tracking (pre-defined angles) and Object Snap (the
cursor snaps to different objects).

Options opens the Drafting Options window

In thiswindowyou can set options for theDisplay, Selection of objects, Drafting, Import/Export
formats and seave these settings in Profiles.
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Edit Context Menu and Mouse Usage . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

This menu is available, if any object is selected in the preview window. Select Unselect all to get back
to the Zoom and Properties Context Menu.

NOTE

Keep in mind that this dialog shall and can not replace a CAD program. In general the
graphic should be completely edited, when starting the import into InScript. If you
change a graphic within this dialog then it will most probably not be consistent with
the VEC or DXF file any more.

Mouse in the Selection mode the hair cross is shown with an additional square at the intersection.
This square shows the tolerance area, i.e. all objects within this square will be selected by a
click. Selected objects are shown in color and have additional handling points.

To select an object in the Selection mode, place the mouse pointer on the object and press the
left mouse button. If the mouse pointer is not placed on an object a rectangle can be dragged
open. All objects within this rectangle will be selected

Mouse Wheel themouse wheel can be used to zoom in or out of the previewwindow. The position
of the cursor is the center of zooming

UnSelect All de-selects all selected objects

Properties depending on the selected objects, properties can be edited like e.g. line thickness, ar-
rows, font, etc. A reference to the parameters can be found in the documentation to your CAD
system

Copy copies selected objects

Move moves selected objects

Rotate rotates selected objects; the center of rotation can be selected freely

Scale scales selected objects

Mirror mirrors objects

Explode explodes groups to less complex objects

Join join objects

Erase erases selected objects

Create Block blocks groups of selected objects

5.22.2. ARGES ARL File Preprocessor

The functionality of the ARGES ARL File Preprocessor is now included into the RawLines node. See Fill
and Optimize under 5.22 Raw Lines. The original preprocessor ArlPro.exe can still be accessed in the
\Program Files\InScript\bin folder.
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Its usage is very similar to the integrated functionlity.

5.23. Spline

By this node spline curves can be created and output.

Curve type selects the curve type

B-Spline the curve is of type B-Spline

End type selects what type of ends the curve has

Open the curve begins at the second point defined and ends at the last but one point defined

Extended the curve begins at the first point defined and ends at the last point defined

Closed the curve is automatically closed between the last and the first point defined

Flatness the curve is approximated by a polygon. Depending on the number of polygon lines a
deviation from the curve occur. This parameter sets the maximal allowed deviation from the
curve
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5.23.1. How to create a spline curve

Step 1 Create a Spline node in the Job Configuration tree structure.
A Spline node is shown in the tree structure and in Vector Editor window a blue Spline
wild-card symbol is shown.

Step 2 Optionally set any parameter (see above) in the Spline node.

Step 3 In the Vector Editor window, select the Spline wild-card symbol.
The Spline wild-card symbol changes its color from blue to red.

Step 4 Right click the Spline wild-card symbol and select Handle Points.
The Spline wild-card symbol turns color from red to green.

Step 5 In the Vector Editor window, double click the positions where the interpolation points
for the spline curve shall be.
A grey connecting line between points is drawn. This is an auxiliary line to see which
points are successive.

Step 6 If you double click any already set point, it will be removed Handle Objects.

Step 7 If all points are set, right click the gray spline and select Handle Objects.
The spline will turn from gray to blue.

NOTE

You have to create at least four points to create the first spline curve.

5.23.2. How to handle points of a spline curve

Step 1 In the Vector Editor window, select the spline curve.
The spline curve turns color from blue to red.

Step 2 Right click the spline and select Handle Points.
The spline changes its color from red to grey.

Step 3 To create a new end point, double click at the new position.
The new point will become the last point defined.
— or —
To create a new point between 2 existing points, double click the connecting auxiliary
line between these 2 points.
— or —
To move a points, Drag&Drop the point to its new position.
— or —
To delete a point, select the point to be deleted and press the Del key. The point will be
deleted after confirmation.
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5.24. ARL P3D

This node loads and outputs ARL-files and converts IGES-files to ARL-files.

The acronym ARL means ARGES Raw Lines. The ARL data format is used by InScript to process 3D
data.

The acronym IGES means Initial Graphics Exchange Specification. IGES defines a neutral data format
that allows the digital exchange of information among computer-aided design systems. The IGES data
format is standardized.

NOTE

A scan head with focus translator (without a flat field lens) and a 3D cartesian field cor-
rection for this scan head are required to use this node.

Source sets the location of the ARL-file to use. Only if an IGES-file is specified as Source then the
group Convert from IGES-file to ARL-filewill be shown (see also 8.15 Convert IGES file to Jobstruc-
ture for more IGES conversion options)

Convert from IGES-file to ARL-file only if the Source is an IGES-file then this group appears,
where an IGES-file can be converted to an ARL-file. This is necessary as an IGES-filemay consist
of geometrical elements that can not be processed by InScript. Only geometrical elements of
type line and B-spline will be converted. All other elements will be ignored. The conversion
approximates curves by polylines with a max. allowed deviation from the curve's shape given
by the user

Destination sets the location, where the converted file will be saved to. After conversion this
location will be copied to Source

max. deviation from curve sets the max. deviation of a ARL-file's polyline from the shape
of the IGES-file's curve. In general a value of 0.01 mm is recommended

Start conversion starts the conversion

5.25. Spiral

To enable the node functionality, you have to set Type to circular in the Job Configuration window in
Pens→ default→ head in the Wobble tab.
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This node creates spirals. Particularly when producing drill holes this node is useful. In this node a
lead in can be defined to place the first pulse in an area outside the later function area. Trepanning
cycles can be specified for the inner and outer radii of the spiral. By defining the phase angle e.g. laser
specific roundness deviations can be compensated or oval shapes can be intentionally set.

General

Mode determines the speed that will be held constant

Fixed Angular Speed the spiral is output with constant angular speed

Fixed Linear Speed the spiral is output with constant track speed

Frequency sets the rotation frequency the spiral is output with

Phase sets the spiral projection angle. At 0° the spiral is symmetrical, at 90° only a line is
visible

Rotation sets the projection axis angle referring to the XY coordinate system

Start sets the start point angle referring to the XY coordinate system

ON Delay sets the ON delay

OFF Delay sets the OFF delay

Direction selects the rotational direction of the spiral

clockwise clockwise rotation

counter-clockwise counter-clockwise rotation

Radii

R1 sets the spiral radius R1

n(R1) sets the number of revolutions output with radius R1

R2 sets the spiral radius R2

n(R2) sets the number of revolutions output with radius R2
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n(R1→R2) sets the number of revolutions output between the radii R1 and R2

Lead In if the check box Lead In is selected then an additional radius can be specified here

Lead In (check box Check box to activate Lead In input field

Approximation

Mode selects, how the spiral is approximated. This list is only active, if Fixed Linear Speed is
selected in list Mode in group General

Segments per 360° number of segments per revolution. The value is set in Value

Segment length limit maximal segment length in mm. The value is set in Value

Deviation limit maximal segment deviation in mm from the spiral. The value is set in
Value

Value sets the value regarding Mode

Particularities Simultaneously to inputs all changes will be shown in the preview window. The
colors beside the input fields represent the colors in the preview.

5.26. Split Text

By this node text can be divided into tiles. You can define the size, offset and overlap of these tiles.
That way e.g. curved objects can be processed rotating around an axis in the scan field or work pieces
can be processed that are larger than the scan field.

NOTE

In Tab Split axes have to be selected, otherwise the textwill not be displayed in theVector
Editor.
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5.26.1. Edit - Shared GUI Elements

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.26.2. Edit - Text

Using this tab you can create and format text. The text can be slanted in different angles, scaled in
width and height and distorted.
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Text Box in the text box type in the text or variable to be output. Embed a variable in 2 $-characters,
e.g. the variable $stat.time.DateStr$ outputs the actual date. How the name of a variable is
acquired and how to work with variables, you will learn in section 5.44.2 Scripting Language.

If you want to output the $-character then it has to be preceded by the \-character, thus you
have to type in \$. If you edit a job file directly via a text editor then the $-character has to be
preceded by 2 \ characters, thus you have to type in \\$.

Apply applies the text without closing the Text Editor window

Clear clears the text from the text box

justifies the text (left, center, right, full)

Slant sets the text slant. The slant angle results from the arctan of the entered value. Values from
+3 to 3 are allowed

Font

Name selects a font from a dropdown list.

opens the Select Fontwindow, see section 5.67 Select Font - Window. All installed customer
specific fonts are displayed and can be used. The fonts are located in the Fonts folder of
the InScript installation.

Size sets the character height

Storage selects what shall happen to the font after the text was output

Keep the font will be kept in the controller board memory

Remove the font will be removed from the controller board memory

Spacing
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Char sets the distance between characters (tracking)

Line sets the distance between lines.

The second list selects the unit for the values in Char and Line

Relative the values are given relative to single tracking and single line distance in %

Absolute the values are given absolute in mm

Layout

X sets the origin X coordinate

Y sets the origin Y coordinate

Width sets the bounding box' width

Height sets the bounding box' height

Auto Width if the check box is selected then the bounding box width will be automatically
adjusted to the width of the longest line

Auto Height if the check box is selected then the bounding box height will be automatically
adjusted to the text height

Auto Wrap if the check box is selected then the text will be automatically wrapped at the
bounding box. If the check box is cleared then the text will be automatically condensed
to fill the bounding box width

Origin
The graphical object iswithin a bounding box. In theOrigin group you select the bounding
box point of origin to which coordinates and geometrical operations are referring.

In the Origin group the center point is pre-selected. Thus the bounding box center is at
the coordinates X1/Y1. If e.g. the right lower radio button is selected then the right lower
corner is at the coordinates X1/Y1.

Following examples show settings of Origin and their effect:
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5.26.3. Edit - Split

In this tab you can divide the text into tiles, i.e. set their size, offset and overlap as well as set the axes
to be moved after each tile has been output.

Axes

X, Y selects the axes and direction they will be moved

+ axis forward direction (depending on the device)

- axis backward direction (depending on the device)

→ The second list offers only axes which have a present and activated device driver. In
this list axes can be assigned to the X and Y direction

Scan bidirectionally If the check box is selected then successive lines will be output in op-
posite direction

Primary axis selects the axis, the lines will be output with

X the X axis

Y the Y axis

Mode selects the mode, the tiles will be output with

Production show the tiles as they will be output. As the to be processed object is moving in
the scan field, the tiles will be shown overlapped

Setup "simulates" themovement of the axes and shows the tiles clearly arranged side by side

Field Size
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X sets the tile size in X direction

Y sets the tile size in Y direction

Offset

X sets the tile offset in X direction

Y sets the tile offset in Y direction

Overlap

X sets the tile overlap in X direction

Y sets the tile overlap in Y direction

5.27. TestPat

This node creates a test pattern for testing ans setup purposes at factory side.

NOTE

This special node should only be used if you are instructed to do this by ARGES.

5.28. Scan 3D

This node enables you to use the nodes Offset 3D and Rotate 3D, i.e. to offset the output plane in 3
dimensiones and to rotate it around 3 coordinate axes. The offset and rotation is restricted by the
frustum of pyramid which is spanned by the maximum deflection of the XY scan block and the focal
range of the focus translator.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

Particularities

NOTE

This node can be only used in combination with a scan head of type Elephant including
a focus translator. A 3D cartesian field correction has to be performed during configura-
tion. The Z range given in the 3D cartesian field correction determines the height of the
frustum of a pyramid.
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5.29. Spiro 3D

CAUTION

Damage of scan head possible

To control the focus translator Spiro 3D uses the same channel which is also used by
Bitmap File Link to control gray scale output.

� Do not use Spiro 3D in any combination with Bitmap File Link.

NOTE

To enable the function of this node Type has to be set to circular in window Job Configura-
tion in Pens→ default→ head in the Wobble tab.

To Enable Precession
If your scan head has a precession unit built in then you have to set some more parameters else skip
this procedure.

Step 1 In the main menu, click View→ Xplorer.
— or —
In the tool bar, click .
The Xplorer window opens.

Step 2 In the tree structure open the folder dev→ head→ config.

Step 3 In the list set the variables:
ssi_protocol to Specified
ssi_n_chn to 6

Step 4 In the main menu, click Controller→ Save to NVRam.

Step 5 In the main menu, click Controller→ Configure.
The Board Configuration window opens.

Step 6 Click Reset Board.

Principle
Circles, ellipses, spirals and helixes are defined by states. Each state in his part is defined by a set of
parameters. You specify the states in a sequence. Circular, elliptical, spiral and helical movements
are generated by interpolation of the set of parameters of one state into the set of parameters of the
next state. The number of turns it takes to change one state into the next state is the base for this
interpolation.

Here is a short overview of requirements and parameter sets:
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Circles, Ellipses and Spirals
Requirements: scan head with XY-block (degrees of freedom 2: X- and Y-direction)

Toprocess circles and ellipses InScript combines a sinusoidal rotarymovement of theX-galvanometer
with the cosinusoidal rotary movement of the Y-galvanometer. To describe these shapes you need a
base set of 4 parameters. These are:

Revs specifies the revolutions it takes to interpolate linearly the current state from the previous
state. Thus the parameter Revs and the frequency define the time of transition from the pre-
vious state to the current state. As there exist no previous state for state 1 the parameter Revs
always is 0 in state 1.

Rad1 specifies the radius [mm] or in other words the amplitude of the sinusoidal and cosinusoidal
rotary movement of the mirrors.

Phase1 specifies the phase [°] between the sinusoidal and cosinusoidal rotary movement of the
mirrors. A phase of 0° results in a circle. A phase >0° and <90° results in a ellipsewhere ellipticity
grows with increasing phase angle. The long axis of this ellipse lies at 45° between the X- and
Y-axis. A phase of 90° results in a line which lies at 45° between the X- and Y-axis. Etc (see
following figure).

Rot1 specifies the rotation [°] around the center of the movement or in other words a phase shift
between the frequency and the sinusoidal and cosinusoidal rotary movement of the mirrors
simultaneously. An example is shown in the following figure.

To describe a spiral you need the previous base set of parameters plus a second state of these
parameters. The movements that can be achieved are shown in the following figure. For sim-
plification a telecentric lens is assumed and parameters Phase1 and Rot1 are set to 0.
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The following effect occurs with larger apertures of the scan head and the larger internal beam ex-
pansion factors.
Themass and thus the inertia of the Y-mirror is larger than of the X-mirror. This causes a phase shift
between the sinusoidal and cosinusoidal rotary motion of the mirrors.
With small frequency (typically < 50 Hz) the phase shift is negligible small. With a circular steering
command a circle is processed. By increasing the frequency continuously the phase shift finally is
not negligible any more. Instead of the circle an ellipse is processed, whose long axis shrinks and
rotates around the center. Additionally the ellipse gets increasingly flatter (see following figure).

NOTE

To process circles even with small radii and high frequencies you have to determine by
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experiment the compensating values for radius, phase and rotation. This is the first step
you have to take before continuing to other shapes.

With increasing frequency the described effect leads to a non-linear rise of the power dissipation
in the galvanometers. To prevent the galvanometers' burn out a hardware and a software fuse exist.
The hardware fuse can not be set. As software fuse a limit of the frequency is used. This limit is preset
in a way that with larger apertures the hardware fuse and with smaller apertures the software fuse
responds. If your application demands it and you got a scan head with small aperture then the limit
can be increased. If you wish to do this, please contact ARGES.

Helixes
Requirements: scan head with XY-block and focus translator (degrees of freedom 3: X-, Y- and Z-
direction)

The set of parameters for helixes is based upon the set of parameters for circles, ellipses and spi-
rals. In addition a parameter to position the Z-axis has to be specified. The principle of defining the
mentioned movements by states allows e.g. helical movements even with variable slope.

Z specifies the position of the focus translator [%]. You need a calibration curve whichmaps the po-
sition of the focus translator [%] to the resulting position of the focus in Z-direction, e.g. [mm].
As this curve is dependent on the optics used and as there is a high variety of combinations pos-
sible, determine the calibration curve by experiment, please. Note that scan field is corrected
only for one Z-position of the focus.

The movements which can be achieved are shown in the following figure. To simplify matters a
telecentric lens is assumed and the parameters Phase1 and Rot1 are set to 0.

Attenuation

Requirements: scan head with XY-block, focus translator and attenuator (degrees of freedom 4: X-,
Y-, Z-direction and attenuation of the laser beam)

The set of parameters for attenuation is based upon the set of parameters for helixes. In addition a
parameter for the attenuation of the laser beam has to be specified.
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Aux specifies the position of the attenuator [%]. You need a calibration curve which maps the posi-
tion of the attenuator [%] to the resulting attenuation of the laser beam, e.g. [W]. Please deter-
mine the calibration curve by experiment.

The movements which can be achieved are shown in the following figure. To simplify matters a
telecentric lens is assumed and the parameters Phase1 and Rot1 are set to 0.

Precession
Requirements: scan head with XY-block, focus translator and precession unit (degrees of freedom 5:
X-, Y-, Z-direction and precession of the laser beam, but because of technical reasons precession is
configured for 6 channels)

NOTE

The precession frequency is identical to the wobbling frequency. The focus stays any
time on the trajectory described in circles, ellipses, spirals and helixes.

The set of parameters for precession is based upon the set of parameters for helixes. In addition some
parameters for precession of the laser beam has to be specified. These are:

Rad2 specifies the radius of beamdisplacement [%]. In combinationwith focusing optics this results
in a precession angle on the target. You need a calibration curve which maps the radius [%] to
the resulting precession angle of the laser beam [°].

Phase2 As both plates for beam displacement have the same inertia, so the problem with differ-
ent inertias like with the X- and Y-mirror does not occur here. Therefore the radius of beam
displacement, which is defined by radius Rad2, will be constant even with higher frequencies.
Nevertheless the parameter Phase2 is useful to obtain elliptical movements. For more infor-
mation see parameter Phase1.

Rot2 As both plates for beam displacement have the same inertia, so the problem with different
inertias like with the X- and Y-mirror does not occur here. Therefore the radius of beam dis-
placement, which is defined by radius Rad2, will be constant even with higher frequencies.
Nevertheless the parameter Rot2 is useful to obtain elliptical movements. For more informa-
tion see parameter Rot1.
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There is a useful relation between the parameters Rot1 and Rot2 which is shown in the following
figure.

5.29.1. Edit - General

In the general tab parameters for output are set.
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Frequency rotary frequency of the circle, ellipse, spiral or helix [Hz]

ON Delay ON Delay [ms] (see section 3.10 linepar - Line Parameters)

OFF Delay OFF Delay [ms] (see section 3.10 linepar - Line Parameters)

Direction

Clockwise clockwise rotation

Counterclockwise counterclockwise rotation

Accuracy

Rotation1 accuracy of rotation 1 [mm]

Phase1 accuracy of phase 1 [mm]

Rotation2 accuracy of rotation 2 [%]

Phase2 accuracy of phase 2 [%]

5.29.2. Edit - Spiro Specification

The Spiro Specification and Spiro States tabs display the samedata in 2 differentways. For description
of parameters see section 5.29.3 Edit - Spiro States.
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List of parameters
In the list activated parameters are shown in the diagram.

NOTE

All parameters can be activated even if they are not used with the configuration of your
scan head.

Table
The table shows the manually set parameters of a state.

NOTE

A change in column Revs can result in the addition of a new state or in the combination
of existing states.

Diagram
The yellow marked area corresponds to the yellow marked state in the Spiro States tab.

Menu, Tool Bar and Usage

File → Apply save the current specification to the controller board

File → Reload load specifications from the controller board

File → Save and Close save the current specification to the controller board and close the win-
dow

File → Discard and close discard the changes and close the window

Mode → Select edit diagram
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Mode → Pan pan shown area (if zoomed in)

Mode → Zoom in to zoom in the shown area press the left mouse button; to zoom out the
shown area press the right mouse button

Mode → Zoom window span with the mouse pointer an area which should be zoomed in

Mode → Zoom 1 reset zoom factor to 1

Edit → <parameter> select a parameter for editing. To edit a parameter in the table and the
diagram:

Step 1 Mark the parameter in the list of parameters.
— or —
Click Edit→ <parameter> in the menu.
— or —
Click Edit→ <parameter> in the context menu of the diagram.

Step 2 Drag the point in the diagram.
— or —
Delete a point via its context menu.
— or —
Add a point via the graphs context menu.

Show → <parameter> shows a parameter. To show a parameter in the diagram:

� Activate its check box in the list of parameters.
— or —
Click Show→ <parameter> in the menu.
— or —
Click Show→ <parameter> in the context menu of the diagram.

Show → Nothing except shows only the parameters which are selected in the sub menu

Show → Show all Shows all parameter

Show → Edited data only couples view with editing. As soon a parameter is selected for editing
it is shown and all other parameters are hidden

Show → horizontal/vertical lines show horizontal/vertical lines at the interpolation points in
the diagram

Axes → <Parameter> → top/bottom/both or left/right/both show axes at specified posi-
tions in the diagram

An area of values can be zoomed in by holding the leftmouse button pressed on the axis and spanning
the area with the mouse pointer.

All axes on left side Shows all axes on the left side of the diagram

All axes on right side Shows all axes on the right side of the diagram

All axes on both sides Shows all axes on both sides of the diagram
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Axes → Show only active axis showonly the axiswhich is relevant to edit the current parameter

Axes → Colorize active axis highlights the axis which is associated to the current parameter

5.29.3. Edit - Spiro States

The Spiro States and Spiro Specification tabs display the same data in 2 different ways.

The Spiro is defined by states. Each state is represented by a set of parameters which can be set
manually (black values) or which are calculated automatically (grey values). The spiral develops by
linear interpolating the set of parameters from one state to the next state.

The yellow marked state corresponds to the yellow marked area in the Spiro Specification tab.

Please read the introduction to this node for a description of parameters (columns of the table).

Menu, Tool Bar and Usage

File → Apply save the current specification to the controller board

File → Reload load specifications from the controller board

File → Save and Close save the current specification to the controller board and close the win-
dow

File → Discard and close discard the changes and close the window

Edit → Add append a new state to end of table. The values of the last state are copied to the
new one

Edit → Insert after insert a new state after the currently marked state. The values from the
marked state are copied to the new one
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Edit → Delete delete the currently marked state

Edit → Calculated Calculate values between states

To edit automatically calculated values (grey values) deactivate Calculated in the context menu of
the cell. An interpolation point is added to the diagram in the Spiro Specification tab.

5.29.4. Edit - Spiro Preview

The Preview tab visualizes the set parameters. For visualization the parameters are optimized:

• Dimensions x, y, z are normalized. The spiral is drawn into a virtual cube and in this way
changes to one dimension are shown proportionally

• The number of shown revolutions in interstate transitions is limited. If the number exceeds 5
the number is scaled by a root-function in such way the numbers of revolution in all interstate
transitions is proportional

• Parameters Rad2, Phase2, Rot2 and Aux are not shown

Tool Bar and Usage

Rotate Mode To rotate the scene hold the left mouse button pressed and move the mouse. If
you do this when the mouse pointer is inside the colored areas the rotation is restricted to one
axis. If you additionally press the CTRL button the scene is rotated additionally along the z-
axis. To move the camera hold the right mouse button pressed and move the mouse. If you do
this when the mouse pointer is inside the colored areas the movement is restricted to one axis

Move Mode Tomove the scene hold the left mouse button pressed andmove themouse. If you
do this when the mouse pointer is inside the colored areas the rotation is set to a special axis
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Zoom out , Zoom menu , Zoom in and Zoom in slider To zoom in or out of
the scene click on the Zoom in or Zoom out button. Another possiblity is to use the Zoom in Slider
towards the in or out direction. All functionality plus a direct input of a zoom percentage is
combined in the Zoommenu. Zooming step-by-step can also be achieved using themouse wheel

Reset camera view resets the camera position to standard

View options the Show axis command in this menu switches the axis indicator in the bottom
left corner on or off

5.30. Job

This node combines all its child nodes to an executable unit with a name. A Job can be saved and
loaded. These files normally have the extension .job.

5.30.1. Edit - Shared GUI Elements

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.30.2. Edit - General

In this tab you can define variables changeable in Operator Mode, see section 9 Supervisor and Oper-
ator Mode.
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Job

Name shows the job name. If you want to change the name then rename the node itself, see
section 4.6.17 Rename Node

Variables changeable in Operator Mode In this table, you can define the variables changeable
in Operator Mode. How this is done, see section 9 Supervisor and Operator Mode.

5.30.3. Edit - On Loaded

In this tab enter the script, that shall be executed as soon as the job is loaded.

Text box in this text box type the script that will be executed as soon as the job is loaded. You will
find a description of the scripting language in section 5.44.2 Scripting Language

5.30.4. Edit - On Selected

In this tab enter the script, that shall be executed as soon as the job is selected.
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Text box in this text box type the script that will be executed as soon as the job is selected. You
will find a description of the scripting language in section 5.44.2 Scripting Language

5.30.5. Edit - About

This tab shows information about the operating system and the InScript version under that the job
file was saved. These fields are only filled if the job was saved and loaded.

Last modified with
Operating System shows the operating system under that the job was saved

OS-Version shows the operating system version under that the job was saved

InScript-Version shows the InScript version under that the job was saved

5.31. Collect

This node combines its subtrees to one node. That way a collection of subtrees can be linked to (see
section 5.35 Link), saved or executed if necessary. Also execution units under nodes can be combined
for scripting (e.g. exec_subtree() see 5.44 Script) or ExtSelect nodes (see 5.65 ExtSelect).
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.32. Macro

Like a Job, a macro node consists of a subtree of child nodes that can be executed. Macros are collec-
tions of nodes that can be re-used at several places in a job. E.g. you can create a macro that creates a
special geometrical figure that consists of several shapes. If you need that figure in different places,
you can reuse the macro and don't have to re-create the figure (see 10.3 Create Macros for an exam-
ple).

A new Macro node is always created under Job Configuration→ Macros (see 4.7 Manage Macros). It
can also be created under a MacroGroup node, see section 5.33 MacroGroup, to put similar macros in
groups that are easier to handle and to find. Macros can be saved and loaded and get the extension
.imc.

After you have created amacro it can be dragged& dropped to the place in the job, where it is needed.
The standard name after dropping themacro in a Job tree will beMacro orMacron, where n is a rolling
number.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements
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Macro Group Name of the MacroGroup the Macro was created in (if the Macro is created directly
under Job Configuration→Macros this field is blank

Link Target original name of the Macro that is linked to the node

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.33. MacroGroup

AMacroGroup can be used to combine several macros under a group. As an example you could group
all macros that do graphical output under MacroGroup Graphics or all IO dependend macros under
MacroGroup IOs (see 4.7 Manage Macros for more information)

Particularities MacroGroups can only be created under Job Configuration→Macros.

5.34. Repeat

This node repeats all child nodes in its subtree.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Count sets the number of repetitions. If Count is set to -1 then the child nodes will be repeated
infinitely. If Count is set to 0 then the child nodes will not be executed

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

Particularities If the Repeat variable can be found under e.g. usr.job.Job.Repeat..num, the re-
peat counter can be found under usr.job.Job.Repeat..n for e.g. processing its current value in e.g. a
Script node, see section 5.44 Script.
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5.35. Link

This node creates a logical link to another node in the tree structure. With this node a sequence of
nodes can be called and applied to a subtree. Such a sequence of nodes can be combined e.g. under a
Collect node, see section 5.31 Collect or all linked nodes can be stored in a Job node in several Collect
nodes to save and load them.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Link Node sets the target node name within the tree structure. Just use the name of this node. If
several nodes of the same name are available in the tree hierarchy, then the first occurence
of this name in the job tree(s) is executed

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

Particularities Almost any type of node can be linked. Here is an example for a Job called LinkJob
that contains a Shape node called LinkShape and a Collect node called LinkCollect that are linked
from Job Job using the Link nodes Link to LinkShape and Link to LinkCollect:
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TIP

You could also create a Link node to the Job LinkJob itself.

5.36. Mat2Off

With this node, positions of output nodes can be arranged in a matrix of columns and rows. This is
a fast and optimized method to output graphical elements, text or the output of any node in defined
rows and columns.
This node is a combination of the Repeat-X and Repeat-Y nodes, see sections 5.37 Repeat X and 5.38
Repeat Y. But this node offers extended functionality by providing accelerated output, offset and
rotation for single elements without further programming and origin alignment. It also provides the
possibility for bi- and unidirectional output over X axis or Y axis.

5.36.1. Edit - Shared GUI Elements
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

5.36.2. Edit - General

Arrangement of the columns and rows.

OffsetX sets the offset for the first matrix element in X direction

OffsetY sets the offset for the first matrix element in Y direction

DeltaX sets the column distance in X direction

DeltaY sets the row distance in Y direction

Columns sets the number of columns

Rows sets the number of rows

Scanning

outputs with primary axis = x, unidirectional

outputs with primary axis = x, bidirectional

outputs with primary axis = y, unidirectional

outputs with primary axis = y, bidirectional

Align offset
using these buttons OffsetX and OffsetY can be adjusted that the matrix field of all elements is
centered or offset to the origin of the coordinate system (or to a point in the coordinate system,
if e.g. an Offset node (see 5.7 Offset) that moves the matrix to this point is placed before the
Mat2Off node). The calculation is also dependend on the Origin settings of the Mat2Off node's
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sub elements. Offsets or rotations of single matrix elements (see 5.36.3 Edit - Offset Edit or
5.36.4 Edit - Rotation Edit) are ignored in the calculation.

If you click on one of the Align Offset buttons, OffsetX and OffsetY are modified.

Following examples show settings of Align Offset and their effect on the offset of whole group
of matrix elements:

After a button was clicked, OffsetX and OffsetY are modified and the offset of the Mat2Off can
be seen in the Vector Editor, if a Vector Editor view is defined under Job Configuration (see 4.4.2
Exec Show VectorEditor View how to do this).

5.36.3. Edit - Offset Edit

In this tab single matrix elements can be offset, e.g. the element in row 1, column 1 3.000 mm in X
direction and 2.000mm in Y direction from its normal position in thematrix, see the following figure.

Table Cells enter the offset data here. To enter the data, double click the corresponding cell or in
the cell context menu, click Edit Cell and confirm the input by pressing the Enter key. The
columns correspond to the matrix X direction. The rows correspond to the matrix Y direction.
Within a cell at the left the X coordinate and at the right the Y coordinate of the offset in
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reference to the normal position in the matrix are displayed. To delete the values in a cell
select Delete Cell from the context menue

Clear discards and clears the entered values

5.36.4. Edit - Rotation Edit

In this tab single matrix elements can be rotated. Enter the rotation angle into the corresponding
cell.

Table Cells Enter the rotation value here. To enter the data, double click the corresponding cell or
in the cell context menu, click Edit Cell and confirm the input by pressing the Enter key. To
delete the values in a cell select Delete Cell from the context menue

Clear discards and clears the entered values

5.36.5. Simple Edit

The Simple Edit window displays offset data as present on the controller board. In this window the
offset and rotation data can be edited directly.
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Auto Update If the check box is selected then the data will automatically be updated on the tabs
Offset Edit and Rotation Edit as soon as the data is modified in the Simple Edit window

Synchronize Cursor If the check box is selected then the cursor on tabs Offset Edit and Rotation
Edit will be synchronized with the cursor in the Simple Edit window

Text Box values can be entered like this:
x-position,y-position:(x-offset,y-offset), rotation;
e.g.
1,1:(10.000,10.000),10.000;
2,1:(20.000,20.000),30.000;
1,2:(30.000,30.000),20.000;
2,2:(40.000,40.000),40.000;

Clear discards and clears the entered values

OK applies the entered values and closes the window

Cancel discards and clears the entered values and closes the window

Particularities A green indicator signals a valid input and a red indicator signals an error in the
input values or structure.

5.37. Repeat X

This node repeats the output of all its child nodes and moves each output in X direction.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Offset X sets the offset of the first output in X direction

Delta X sets the distance between the single outputs in X direction

Count sets the number of repetitions

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements
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5.38. Repeat Y

This node repeats the output of all its child nodes and moves each output in Y direction.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Offset Y sets the offset of the first output in Y direction

Delta Y sets the distance between the single outputs in Y direction

Count sets the number of repetitions

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.39. Conditional

This node evaluates a condition. If the condition is true then the node's subtree will be executed. If
the condition is false then the node's subtree will be skipped.

5.39.1. Edit - Expert Mode

Node Name see section 5.1 Shared GUI Elements
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Action see section 5.1 Shared GUI Elements

Expression sets the expression containing the condition in the scripting language, see section 5.44.2
Scripting Language

Result shows the result. The condition may be true or false

Evaluate evaluates whether the condition is true or false and shows the result in Result. For the ex-
ample below a variable xwas defined and set to a value. The node checkswhether the condition
$x$==1 (i.e. x equals 1) is true or false. As the condition is true, its subnodes will be executed

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.39.2. Edit - n of m

Search Population gets the population size of the parent node and fills it into Population size.

Possible parent nodes and their population variables for Population size are:
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Node population variable
Repeat ..num
Repeat X ..num
Repeat Y ..num
Clock ..num
ExtRep ..num
Mat2Off ..nx * ..ny
ExtMat2Off ..nx * ..ny
PosList ..positions (number of ~)

Sample size can be set after pressing Search Population. This is the maximum number of samples
taken randomly from the population or elements of the parent node

Population size can be set after pressing Search Population and defines the last element taken for n
of m from the parent node

Population var shows the population variable used from the parent node

Create Expression creates an expression from the data entered in tab n of m and inserts it into Ex-
pression on tab Expert Mode. The example below was created from the data given in the screen-
shot above

5.40. Delay

By this node a defined delay can be inserted in a job.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Delay sets the delay in ms

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.41. Clock

Using this node you can arrange output around a circle. The node divides a circle into positions and
alignments. Then it outputs a subtree at these positions. If the node has several subtrees then these
subtrees will be output after their sequence and distributed to the positions until all positions are
taken.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Radius sets the radius of the circle on which the objects are positioned

Offset sets the start angle for the first position. A positive angle rotates counterclockwise. A nega-
tive angle rotates clockwise

Num sets the number of positions distributed on the circle
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Object Rotation

Type selects whether the objects shall be rotated

objects upright all objects stay upright

objects rotated the objects are rotated around the circle

Offset The offset can only be set, if objects rotated is selected. The offset sets the angle ap-
plied to the objects additional to rotation. A positive angle rotates counterclockwise. A
negative angle rotates clockwise

Direction selects the direction the objects are distributed with

counterclockwise distributes the objects counterclockwise

clockwise distributes the objects clockwise

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.42. Counter

By this node you can set andmodify numerical and alpha numerical variables, see section 10.6 Rolling
Barcode Numbers.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Variable sets the variable name, which shall be modified (without $ signs)

Value sets the value, which shall be assigned to the variable. The specific action can be set under
Mode

Mode selects the mode, how Value is will be assigned to Variable. A the string or value has to be set
under Value

Set String assigns a string to an alpha numerical variable (e.g. of type STRING or TEXT)

Set Value assigns a value to a numerical variable (e.g. INT32, REAL64 etc.)
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Add Value adds a value to a numericalOR even to an alpha numerical variable (e.g. a STRING
variable "000-000-999" will be updated to "000-001-000" after Add Value with Value 1 was
executed - any alphabethic characters may be inserted before, between or after the nu-
merical values)

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

Particularities Right-clicking on a variable field in a Node editor, selecting Name to Clipboard and
using using ctrl-V on the Variable filed can be used to fill a variable name into this field. Youmay also
use the Xplorer to create variables under usr.var to use them here, see section 8.5 Xplorer.

5.43. PosList

The PosList node outputs graphical objects at specified positions. These positions are managed in a
list. The node contains exactly 2 child nodes, the Draw and the Align node.

When the PosList node is executed, the content of the Draw branch is output at all listed positions.
To produce an output the Draw node has to contain graphical child nodes.

Bymeans of the Align node new positions can be generated along a path or already existing positions
can be aligned to a path. Usage of the Align function and of the Align node respectively is optional.
The following figure shows an example.
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PosList Menu

Edit

Cut cuts the selected position

Copy copies the selected position

Paste pastes the position

Delete deletes the selected position

Select All selects all positions

Deselect All deselects all positions

Options

View if menu item Z-Pos, A-Val, PathId, Repeats or Ramping is selected these values are
shown in the properties window

Conversion Options opens the Poslist's Line To Dot Conversion Options window, see
section 5.43.2 Conversion Options

Old-Style Node Editor opens the "Old Style" PosList node, see section 5.43.5 PosList
"Old Style"

Alignment Paths

Get gets the alignment path lines
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Convert to Positions creates new positions along the alignment pathn under Align as
defined in Conversion Options

Remove removes the alignment path

5.43.1. Edit - PosList

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Order,(X,Y)-Position position list. This list shows the order and coordinates of all positions. In
the Properties list the values of selected positions can be edited.

Count shows the number of positions and how many are selected

Properties all properties of selected positions can be edited here

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

NOTE

The PosList node is able to hold up to 10000 positions.

5.43.2. Conversion Options

In this window set the parameters for the "Line To Dot Conversion" algorithm. The algorithm con-
verts line data from the Align node in an order of positions. Its function will be explained in the
following of the window description.

To open the PosList Conversion Options window, in the menu, click Options→ Conversion Options.
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Position Distance sets the distance between positions to be created along the alignment path

fixed if the check box is selected then the distance between the positions is fixed and must not be
varied by the algorithm

Min. Point Distance sets the minimal distance between the positions

Quiet Zone Start sets the length of the quiet zone at the start of the alignment path. The quiet
zone will not be converted into positions by the algorithm

Quiet Zone End sets the length of the quiet zone at the end of the alignment path. The quiet zone
will not be converted into positions by the algorithm

Points at Ends if this check box is selected then positions will be forced at the start and end of an
open alignment path

Points in Corners if this check box is selected then positions will be forced at the corners of an
alignment path

Corner Angle if Points in Corner is selected then Corner Angle sets the minimal angle to create a po-
sition

Particularities
The Line to Dot Conversion algorithm converts line data from the Align node into a sequence of po-
sitions.

Here is an explanation of its functionality:

Definition of Terms

segment a single line with a start point and an end point

path an order of connected segments, where the end point of one segment lies on the start point of
the next segment

open path a path, where the end point of the last segment differs from the start point of the first
segment

closed path a path, where the end point of the last segment lies on the start point of the first seg-
ment
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distance on path distance between the start point of the path and the positionmeasured along the
path itself

corner a point, where 2 consecutive segments meet

corner angle angle describing the change in direction of 2 segments forming a corner

Example: Open Path

Description of the points:

Point 1 The quiet zones are determined. If the sum of the quiet zones is greater than the path
length then the algorithm does not create any positions. In this case the algorithm ends.

Point 2 If the Points at Ends check box is selected then the algorithm creates positions at the inner
end of the quiet zones. If the distance between 2 positions along the path is less than the Min.
Point Distance then the algorithm creates only the position at the inner end of the start quiet
zone.

Point 3 If the Dots in Corners check box is selected then the algorithm creates positions at corners
where the angle exceeds the angle defined in Corner Angle. If the distance to the previous point
or the end point is less than the Min. Point Distance then the algorithm creates no position at
that point.

Point 4 The algorithm creates further positions in between the already existing positions.

Example: closed path

• At first the algorithm analyzes all corners. The first corner exceeding the Corner Angle is de-
fined as first position and serves as starting point for further proceeding. If no corner exceeds
the Corner Angle or if the Points in Corners check box is not selected then the starting point of
the analysis itself serves as starting point for further proceeding.

• The algorithm creates positions at the following corners exceeding the Corner Angle andwhere
the distance before and after is less than the Min. Point Distance.

• The algorithm creates further positions in between the already existing positions.
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Example: creating further positions

For each path segment created up to now between 2 corners the following procedure is used:

• If the fixed check box is selected and if the Min. Point Distance is not exceeded then a position is
created exactly in the middle between 2 corners. Beginning at this position further positions
are created in both directions until their distance is equal to theMin. Point Distance (see figure).

• If the fixed check box is cleared then the distance between 2 corners is divided by Point Distance
and the result made an integer (n). n is reduced by 1 as long as the position distance is larger
thanMin. Point Distance at an equal spacing (with On Path Distance = Point Distance). That followed
the algorithm creates positions equally spaced between the 2 original positions (see figure).

5.43.3. Using PosList

Positions
The Position List Editor shows the x- and y-coordinates of the positions and their order for output. If
the PosList node is in the current view of the Vector Editor then these positions are also graphically
displayed in the Vector Editor.

The positions can be edited either in the Position List Editor or the Vector Editor, that is by editing
the coordinates in the list or moving the positions with the mouse or the cursor keys.

NOTE

To enable editing of positions in the Vector Editor, click Handle Elements in the PosList
objects context menu (see 7.4.1 Mode).

If you right click an element of a PosList or the Alignment Path inHandle Elementsmode, theVector Editor
context menu shows these aditional entries:

Here is a description of Alignment Path-related and element-related options:

Edit under this menu item selection and modifcation of elements on a specific Alignment Path can
be set
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Cut copy selected postion(s) to the clipboard and remove it/them from the current path

Copy copy selected postion(s) to the clipboard

Paste insert Cut or copied (Copy) positions at the position where they were originally cut or
copied from

Delete delete selected position(s)

Select All select all positions on the path

Deselect All deselect all positions on the path

Select All Ramped if Ramping is selected inOptions→Viewmenu of the PosList editor, Ramp-
ing can be set for each element. If it is set for an element, this element will be selected
using this item

Select All Repeated if Repeats is selected in Options→ View menu of the PosList editor, Re-
peats can be set for each element. If more than one repeat is set for an element, it will be
selected using this item

Select Positions On Path all positions on the current path wil be selected

Deselect Positions On Path all positions on the current path wil be deselected

Modify Selected Positions distribute positions along the Alignment Path

Move To Closest Line moves the selected position(s) to the closest line(s) in relation to the
coordinates of each position of the Alignment Path to their current position (after it was
e.g. removed from the path using the Shift key)

Move To Closest Corner moves the selected position(s) to the closest corner(s) of theAlign-
ment Path to their current position (after it was e.g. removed from the path using the Shift
key)

Distribute On Whole Line distributes the selected position(s) evenly across the complete
Alignment Path ignoring all corners

Distribute Between Two Positions On Line distributes the selected positions evenly be-
tween the outermost selected positions along the Alignment Path

Distribute Between Closest Corners distributes the selected position(s) evenly between
the Alignment Path's nearest corners enclosing the selection

Add Closest Corners And Distribute Between distributes the selected position(s) evenly
between the Alignment Path's nearest corners enclosing the selection and adds a position
at each corner

Order Selected Positions modify the order of the positions in the PosList

Make First make selected position(s) the first in the list

Make Last make selected position(s) the last in the list

In Path Direction order selected positions of a Alignment Path by their occurence along the
Alignment Path in its output direction (an Alignment Path has to be visible)
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Opposite Path Direction order selected positions of a Alignment Path by their occurence
along the Alignment Path against its output direction (an Alignment Path has to be visible)

Alignment Paths modify alignment paths

Get get an Alignment Path and display it

Convert To Positions after you Get an Alignment Path from the PosList's Align subnode, you
can convert the path to positions according to the PosList's Conversion Options (see 5.43.2
Conversion Options) - the current positions will not be affected

Remove remove the current Alignment Path

Snap Positions To Path if this item is selected, all positions will only be dragable along the
current Alignment Path if you do not use the Shift key to override this option

Conversion Options shows the PosList's Conversion Options dialog (see 5.43.2 Conversion Op-
tions for more information)

Here are some practical examples to show the posibilities editing single or multiple Positions using a
PosList node. The examples refer to editing using the PosList editor or the VectorEditor:

Add click Add Position in the Vector Editor context menu. A position is added at the current mouse
pointer position.

NOTE

Momentarily positions can only be added via Vector Editor and not via Position List
Editor!

. the Using Add Position(s) sub menu you can add positions At Closest Corner, At All Corners or At
Line Ends.

Select in the Position List Editor select a region of Positions using Shift-click or several Positions
using Ctrl-click. In Vector Editor select one position by just clicking on it or more positions by
using Shift-click.

Select All Press the Ctrl and 'a' key at the same time or Edit→ Select All in the context menu.

Copy, Cut & Paste Copy (Ctrl-c), cut (Ctrl-x) and paste (Ctrl-v) can be used

Delete

Step 1 Select the position that you want to delete.

Step 2 Press the Delete key.
— or —
Click Delete Position in the context menu.

Move (in VectorEditor)

NOTE

To snap positions to alignment paths, in the Vector Editor in the contextmenu, click
Alignment Paths→ Snap Positions To Paths. To activate or de-activate Snap Positions To
Path temporarily, press and hold the Shift-key while moving positions.
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Step 1 In the graphical editor select the position you want to move. If several positions
are selected then their relative distances will be preserved.

Step 2 Drag the Position to the new place.

Move (exact values in PosList editor) In the PosList Editor's position list click the position you
want to edit. Now you can edit the values of this position under Properties. These keys can be
used:

Key Function
Tab / Shift-Tab toggles between x, y and the values that are selected

under Options→ View
Enter confirms the input
ESC unmarks the position in the positions list

Alignment Paths
The Align node that is automatically created with the PosList node contains all alignment path line
data. You only need the following functions, when aligning the positions to the line data in the Align
node.

NOTE

To display alignment paths in Vector Editor, click Handle Elements in the PosList objects
context menu in Vector Editor.

Get Alignment Paths

� In the menu, click Alignment Paths→ Get.
All previously defined alignment paths will automatically be removed before loading the
new paths. If the maximal position area (red rectangle) is too small to show all lines then
it will automatically be resized.

Select All Positions On an Alignment Path

Step 1 Select the alignment path containing the positions you want to select.

Step 2 In the context menu, click Edit→ Select Positions on Path.

Add Positions To an Alignment Path

Step 1 Select the positions to be added to the nearest alignment path.

Step 2 In the context menu, click Modify Selected Positions→Move To Closest Line.
The positions are added to the alignment path so that their coordinates are as close
as possible to their original coordinates.

Distribute Positions On an Alignment Path

Step 1 Select the positions to be distributed.
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Step 2 In the contextmenu, clickModify Selected Positions→ OnWhole Line to distribute the
positions equally spaced on the whole alignment path, click .
At first positions which are not on the alignment path are added to the alignment
path in away their coordinates are as close as possible to their original coordinates.
Then the first position is placed on the path start and the last position on the path
end. All other positions are equally spaced on the path. Their order is preserved.
— or —
To distribute the positions equally spaced between two positions, click Modify Se-
lected Positions→ Between two Points on Line.
The positions are distributed between (two) outer positions. These two positions
remain at their place. The order of the positions is preserved.

Order On the Alignment Path

Step 1 Select the positions that shall be newly ordered.

Step 2 In the context menu, select Order Selected Positions→ In Path Direction or Opposite
Path Direction to reverse the position execution order.
The position coordinates are preserved. Only the order is changed.
— or —
To make the positions first / last in the order of execution, select Order Selected
Positions→Make First or Make Last.
The position's coordinates are preserved. Only the order is changed.

5.43.4. Position Teach-In

To execute a teach-in for positions, a scan field correction has to exist for the device you want to
do the teach in with. This device can be a processing laser, a pointing laser or a video capture de-
vice. The scan field correction ensures, that the device’s coordinate systems are congruent and that
the different optical paths are taken into account. We presume, you already have created scan field
corrections for the devices (see the Manual -- Scan Head).

As a teach-in can be executed with different devices, InScript has to be told, which device it is, you
want to execute the scan field correction with. For this purpose you will learn in this section, how to
create an execution context.

To execute a Teach-In, you just select the appropriate execution context then and start the Teach-In.

Create/modify a Pen for Teach-in
A valid scan field correction is required for the device, you want to execute the teach-in with (see the
Manual -- ScanHead). As an execution context is created via InScript’s pen-mechanism,we additionally
presume, that you are familiar with, how to manage pens (see section 4.9 Manage Pens).

Step 1 Create a new pen, named e.g. Teach-In with pointing laser or Teach-In with video
capture device.

Step 2 Create a new pen section for the dist_xy device in this pen.
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Step 3 Double click this dist_xy pen section.
The DIST_XY window opens.

Step 4 In the context menu of group Optical Path, click Add.
The options become selectable.

Step 5 Select the device, you want to create the execution context for, e.g. Pointing laser or
Video capture device.

Step 6 Click OK.

Step 7 Create further pen sections for devices, you want to switch on via the execution context
later on (be sure that no potentially dangerous devices are used for teach-in)
These devices may be e.g.

• Laser, whose device drivers and pen sections respectively allow to switch on and
off a pointing laser

• Pointing laser, video capture device, illumination, etc.. Find applicable device drivers
in section 3 Devices. Read about how to configure a video capture device in section
8.12 Video Capture Device.

Another possibility would be to modify the pen you use in your Job for the PosList so it only uses e.g.
Pointing laser or Video capture device.

CAUTION

Visible and/or invisible laser radiation

The user is responsible for observing the laser safety regulations valid in his country.

Step 1 Avoid eye or skin exposure to direct or scattered radiation.

Step 2 Be sure that you only use this pen for teach-in and that all dangerous emis-
sions of the laser device are switched off in this pen.

Execute Teach-In

A teach-in can be executed either in theVector Editorwindowor on the target directly. You canmove
positions with a pointing device in the Vector Editor. Depending on which optical path you selected,
this can be monitored live on the target (pointing laser) or in a video window (video capture device).

Furthermore all elements on the InScript GUI can be accessed. When executing the teach-in at the
target, a pointing laser projects the positions on the target. It is not necessary to sit in front of the PC
at the screen, but it is possible to move the positions with a mobile pointer device. InScript prevents,
that elements in the GUI can be clicked by mistake.

Requirements to execute a teach-in are:

• A teach-in pen has to exist for the device, you want to execute the teach-in with, see section
5.43.4 Create/modify a Pen for Teach-in)
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• A PosList node with positions has to exist

Teach-In at the PC

Step 1 Be sure that you use a pen that is set-up for teach-in in your job

Step 2 In the Job Configuration or Vector Editor window, select the PosList node.

Step 3 Switch the Vector Editor to "Handle Elements" mode ( ).

Step 4 In the Vector Editor window in the context menu, click Teach-In Start.
The Teach-In Status window opens. It shows the teach-in status and the selected
position’s absolute coordinates.

NOTE

You could also use Teach-In Target Start, if you only want to move one
position.

Step 5 Select the position you want to move.

Step 6 To move the position in the XY-plane, move it with the pointing device or the
keyboard, as you are used to.
To edit the Z-coordinate, turn the mouse wheel.
— or —
Enter the coordinates in the Teach-In Status window.

Step 7 Edit further positions as described in the previous 2 steps.

Step 8 To quit the teach-in, in theVector Editorwindow in the contextmenu, click Teach-In
Stop.

Teach-In directly at the target

Step 1 Be sure that you use a pen that is set-up for teach-in in your job

Step 2 In the Job Configuration or Vector Editor window, select the PosList node.

Step 3 Switch the Vector Editor to Handle Elements mode ( ).

Step 4 In the Vector Editor window in the context menu, click Teach-In Target Start.
The Teach-In Status window opens. It shows the teach-in status and the selected
position’s absolute coordinates.

NOTE

You could also use Teach-In Target Start, if you only want to move one
position.

On the screen the mouse pointer is fixed and at the target the positions can be
moved now.

Step 5 To select a position, press and hold the right mouse button and turn the mouse
wheel.
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Step 6 To move the position in the XY-plane, press and hold the left mouse button and
move the mouse.
To edit the Z-coordinate, turn the mouse wheel.
— or —
Enter the coordinates in the Teach-In Status window.

Step 7 Edit further positions as described in the previous 2 steps.

Step 8 To quit the teach-in, press the Esc-key on the keyboard.

Particularities This mode is not connected to the F8 Start teach-in mode in Job Control.

5.43.5. PosList ”Old Style”

This is an older version of the PosList Editor. The functions are identical to the PosList node. Please
find a description of the functions in section 5.43 PosList.

To Open the Old Style PosList Editor:

Step 1 Open the PosList node.

Step 2 In the menu, click Options→ Old-Style Node Editor.
The Old Style Position List Editor window opens.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Menu

Edit
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Cut cuts the selected position

Copy copies the selected position

Paste pastes the selected position

Delete deletes the selected position

Select All selects all positions

Options

Preferences opens the Pos List Options window

Alignment Paths

Get gets the alignment path lines

Convert to Points converts the alignment path lines into positions

Remove removes the alignment path

List of positions The position list shows the coordinates. You may type in exact values here or
change the order, the positions are output with

NOTE

The PosList node is able to hold 10000 positions at most.

Tool bar

pointer selects positions or moves selected positions

zoom in zooms in the view beneath the mouse pointer by pressing the left mouse button

zoom 1:1 zooms the view to the maximal allowed position area

zoom out zooms out the view beneath the mouse pointer by pressing the left mouse but-
ton

zoom area zooms in the area dragged open by the mouse pointer

zoom to fit fits the view so all positions can be seen

measure measures distances and angles

hand moves the view within the graphical editor

Graphical Editor in the graphical editor positions can be created, deleted and edited. These posi-
tions serve as alignment coordinates. The red rectangle shows the maximal value range. The
rectangle size can be set in the menu Options→ Preferences in the Pos List Options window in
the General tab in group Pos List Range
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Status bar the status bar shows the actual mouse pointer position, the number of positions and the
number of selected positions

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

Apply applies the position list to the controller board without closing the window

Window Pos List Options To open the Pos List Options window, in the menu, click Options→
Preferences.

General

Pos List Range the maximal allowed position area is shown by a red rectangle in the graph-
ical editor.

x ± sets the maximal position range in x-direction

y ± sets the maximal position range in y-direction

Position Diameter sets the point diameter representing the positions. If this value is 0 (zero)
then the point diameter is independent of the zooming factor

Line To Dot Conversion in this tab the parameters for the "Line To Dot Conversion" algorithm
are set, see section 5.43 PosList
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You will find a description of these parameters in section 5.43.2 Conversion Options

Colors in this tab the assignment of colors to possible position states can be set

Positions

Standard, Selected, Highlighted to select the colors in a dialog, click the colored but-
tons

5.44. Script

To implement complex programs with specific functions InScript offers an internal scripting lan-
guage (see section 5.44.2 Scripting Language).

In the Script node such scripts can be input and conditions for their execution can be set.

5.44.1. Edit - Script

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements
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Edit Box type the script (source code) in this box

Clear discards and clears the current script

Purge if the check box is selected then the script will not be executed until all line data is executed
above the Script node in the job tree

Thread if the check box is selected then the job tree beneath the Script node will be executed while
the script will be executed in parallel

Wait for ready if the check box is selected then the controller waits with executing the script, until
the SASP device driver is in state Ready. Example: In windowDevices List there is the device
driver of a linear axis in the subtree of device driver SASP. While the linear axis is moving, its
device driver and thus the device driver SASP are not in state Ready

Wait for processing or previewing if the check box is selected and in device driver SASP in tab
General the parameter Preload is set to always then the controller waits with executing the
script, until the SASP device driver changes its state from Preloading to state Processing or
Previewing

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.44.2. Scripting Language

The InScript controller scripting language resembles the syntax and semantics of the programming
language C. Unlike in C the object types are not determineduntil runtime. Furthermore theparameter
values of functions have no strict type. Like in C Script formatting, like e.g. line breaks or line indents
only improve readability and have no effect on execution.

NOTE

The scripting language is case-sensitive.
It is vital that each command is terminated by a semicolon.

Data Objects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Terms can consist of constants, variables, function calls and their combinations. Constants can be
strings, numbers or logical values (true, false).

String Constants string constants are character strings which are enclosed in double quotes (e.g.
"This is a string"). It is possible to insert certain ASCII control characters by escape sequences
with a leading backslash:
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Escape-Sequence ASCII-Code decimal Character
\a ASCII BEL 07 bell
\b ASCII BS 08 backspace
\f ASCII FF 12 form feed
\n ASCII LF 10 line feed
\r ASCII CR 13 carriage return
\t ASCII HT 09 horizontal tab
\v ASCII VT 09 vertical tab
\" " 34 quotation marks
\? ? 63 question mark
\0 ASCII NUL 00 null
\\ \ 92 backslash

Numerical Constants numerical constants can be integer (in a range from -2147483648 to
+2147483647) or floating point values (in a range from ±1038) and are notated e.g. as 3.141593
or 3.8e10 or 1e10.

Variables can have the following properties:
name, value, unit (e.g.mm, degree, sec), type, flags

Variables do not have to be declared. They will be automatically created. The type results from
the assigned value. But the user can also declare variables, e.g. in $usr.var.$, in two ways. On
the one hand they can be declared in the Xplorer and on the other hand in a Script.

To access a variable the variable name is enclosed in two $ (e.g. $sys.BoardName$ or
$usr.job.TestJob.Text..text$).

In InScript variables are arranged in a hierarchical tree structure which is reflected in the vari-
able names and in the job tree structure.

Take e.g. the variable angle in JobXYZ in node Rotate. In the Xplorer you will see its tree struc-
ture and address:

Please note, that variables of a node are combined in a sub folder of this node. As nodes can
contain further child nodes, this is more clearly arranged. As this sub folder is nameless, two
dots are previous to the variable name in the address.
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You can address variables by their absolute names. In the above example this is
$usr.job.JobXYZ.Rotate..angle$.
If you are using variables in scripts then we strongly recommend to address variables by their
relative names. Here is an example for relative names to show the advantages:

Example

From the script in the above figure you want to address the variables
$usr.job.JobXYZ.Repeat..num$ and $usr.job.JobXYZ.Scale.Rotate..angle$
by their absolute names. That followed you decide to rename the node JobXYZ in JobABC or to
move the branches repeat and Scale in a JobABC. In this case InScript does not find the variables
any more, as their absolute names are no longer valid.
If the variables are addressed by their relative names and you execute the above mentioned
operations then the names will stay valid.
The respective Script node is the origin for a relative name. The <-character refers to the next
higher level in the tree structure. The relative names of these variables from the example are
(relative to the Script node):
$<<<.Repeat..num$
$<<.Rotate..angle$

Please note, that even relative namesmay become invalid, e.g. when you change the level depth
relative to the Script node. In this case just match the number of <-characters in the relative
name.

NOTE

If the variable name is givenwithout an explicit path then InScript assumes the vari-
able as user defined and located in the branch usr.var.

Types Variables can have different Types. Possible types are:

Type Value Example
boolean binary value true or false true
int integer 32 Bit 64738
long integer 64 Bit 2047413647

(not usable for constants)
float IEEE 754 floating-point number 32 Bit 3.141593
double IEEE 754 floating-point number 64 Bit 123.12345

(not usable for constants)
string sequence of Bytes "This is a string"
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NOTE

The types long and doublemay be used but it is not possible to define constants with
this types. That is, constant values (like e.g. 100 or 123.456) always are of type int or
float in InScript.

Type conversion (type casting) within a term is automatically carried out, but can also be forced.
Here is an example:

$var$ = (2+3.1) + (string)(3+4) + "xyz";

2 and 3.1 are added, the "smaller" type is expanded, i.e. 2 (int) becomes 2.0 (float), then 2.0 and
3.1 are add together, the result is 5.1 (float). 3 (int) and 4 (int) are add together to 7 (int) and
then converted into the string "7" (string). Due to analysis order 5.1 (float) is converted to "5.1"
(string) and ’add together’ with "7" (string), i.e. the strings are joined. The result "5.17" (string)
is joined with "xyz" (string). Finally the value "5.17xyz" (string) is assigned to the variable
$var$.

Flags each variable can have a set of flags that control its behaviour. Possible flags are:
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Flag Function Description
U user defined variable The user created the variable
W writable The user can change the variable's value
C controlled by device only for variables with o-flag. If the c-flag is

set then the variable is controlled by the owner
variable and adopts its value. If the c-flag is
cleared then the variable value can differ from
the owner variable's value

O owned by device Another variable owns the variable value. If the
value of the owner changes then this variable adopts
the value. Example: If the processing speed changes in
the default pen linepar pen section then the processing
speed also changes in the linepar device

T protected This variable is changeable but write-protected by
the t-flag

M modified only for variables with the n-flag. The variable was
changes since the last "Save To NVRAM" operation

N mirrored in NVRAM the variable value will be written into the NVRam at
the next "Save To NVRAM" operation

Q quick save to NVRAM only for variables with the n-flag. This means, with
every change the variable value will automatically be
saved to the NVRam

R override momentarily not used
F force momentarily not used
P pen-able This variable can be used in a pen
c consumable The variable is consumed after each job execution and

has to be re-set with a new value before it can be
accessed again

Operators . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Unary Operator Description
! logical "not"
~ complement

binary inverting of all Bits
+ no-op

provides symerie with unary "-"
- minus signed
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Binary Operator Description
+ addition or chaining of strings
- subtraction
* multiplication
/ division
% modulo (calculates the remainder after division)
<< binary left shift
>> binary right shift
| binary "or"
& binary "and"
ˆ binary "exclusive-or"
> comparison "greater than"
>= comparison "greater than or equal"
< comparison "less than"
<= comparison "less than or equal"
== comparison "equal"
!= comparison "not equal"
+= addition with assignment

Example: "a+=1;" is identical to "a=a+1;". This applies
to the following operators with assignment as well.

-= subtraction with assignment
*= multiplication with assignment
/= division with assignment
%= modulo with assignment
<<= binary left shift with assignment
>>= binary right shift with assignment
|= binary "or" with assignment
&= binary "and" with assignment
̂= binary "exclusive-or" with assignment

Functions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

NOTE

Not all functions are available in all firmware versions. Older firmware versionsmay only
provide a subset of these functions.
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Definition of own functions is not possible with the momentarily available version. But a lot of inter-
nal functions are available:

Graphical functions

commit_pen_stack() commits the pen stack and forces pen change

draw_line(x1,y1,x2,y2) draws a line from <x1>/<y1> to <x2>/<y2> (<xn> and <yn> in mil-
limeters)

previewing() returns true, if the controller is in preview mode; otherwise false

set_clip_rect() applies the values of "Field Size" and "Field Offset" to the global clipping
rectangle. After the function was called it is valid for all job nodes. Then dots and lines
can be output only within the specified rectangle

set_clip_rect (x1,y1,x2,y2) applies the specified values to the global clipping rectangle.
After the function was called it is valid for all job nodes. Then dots and lines can be output
only within the specified rectangle

String functions

strlen(str) provides the number of characters in the passed string <str>
1 // strlen example
2 $lenstr$ = "One two two three";
3 $num$ = strlen($lenstr$); // $num$ == 17

strndup(str,b,n) provides a part of string <str> with length <n>, where <b> characters will
be omitted out at the beginning of <str>

1 // strndup example
2 $str$ = "One two two three";
3 $substr$ = strndup($str$ ,4,7); // $substr$ == "two two"

chr(chr) provides a string containing ASCII character chr
1 // chr example
2 $str$ = chr(65); // $str$ == "A"

asc(str) returns the ASCII code of the first character of string <str>
1 // asc example
2 $num$ = asc("A"); // $num$ == 65

strpos(str1,str2) returns the first occurence (0 based) of <str2> in <str1> or -1 if <str2> is
not found

1 // strpos example
2 $posstr$ = "One two two three";
3 $num$ = strpos($posstr$ , "two"); // $num$ == 4

strrpos(str1,str2) returns the first occurence (0 based) of <str2> in <str1> searched from
the back or -1 if <str2> is not found
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1 // strrpos example
2 $posstr$ = "One two two three";
3 $num$ = strrpos($posstr$, "two"); // $num$ == 8

strtok(str,strdelim,n) returns information about a substring in <str> between characters
in <strdelim> (<n>=0: return number of tokens <n>=1:return first substring <n>=-1:return
last substring)

strtok(str,strdelim) returns number of substrings in <str> between characters in <strde-
lim>

1 // strtok example
2 $tokstr$ = "token1.token2,token3";
3 $str$ = strtok($tokstr$, ".,", 1); // $str$ == "token1"
4 $num$ = strtok($tokstr$, ".,", 0); // $num$ == 3
5 $str$ = strtok($tokstr$, ".,", -1); // $str$ == "token3"
6 $num$ = strtok($tokstr$, ".,"); // $num$ == 3

Processing functions

mark_start() starts execution of a selected job

mark_stop() sets the "stop" flag to stop at a specific point (i.e. at a Stop node in the job)

mark_abort() aborts a running job

wait4marking() waits until the system is in state "processing"

wait4ready() waits until the "System Activity State" device (SASP) is in state "ready"
(e.g. when values were changed in the default pen and the changes are executed)

purge() causes the scan head to completely output buffered vector data; after this, the func-
tion returns

idle() distributes computing time to other processes (e.g. in waiting loops)

msleep(t) delays further execution for the given time <t> (in milliseconds), the computing
time is distributed to other processes

info_dlg(value) outputs a simple information window showing the <value> in brackets
1 // info_dlg example
2 $i$ = 10;
3 $str_hw$ = "Hello World";
4

5 // dialog with "Hello World!"
6 info_dlg("\"" + $str_hw$ + "!\"");
7

8 // dialog with i=10
9 info_dlg("i=" + $i$);

10

11 // in this example the dialog with i=10 will show ABOVE the
12 // dialog with "Hello World!" because it executed after it
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subtrees() returns the number of sub nodes of the Script node

exec_subtree(n) executes the <n>th sub node of the Script node, counting starts at 0

exec_subtree(name) executes the subtree <name> (e.g. exec_subtree(Transform); if you
have a subtree usr.job.Script.Transform) below the script node

disable_abort() after calling this function, abort (viz. ms_break) is disabled

enable_abort() after calling this function, abort (viz. ms_break) is (re-)enabled

HostExec(prg,arg) calls executable <prg> with argument <arg> on host

ms_break() returns true if job is aborted or false otherwise (useful in connection
with disable_abort(),enable_abort())

clock() returns a value in seconds
1 // clock example
2 $time1$ = clock();
3 msleep(2000); // sleep 2 seconds
4 $time2$ = clock();
5

6 $timeelapsed$ = $time2$ - $time1$; // calculates elapsed time
7 // between time1 and time2
8 // this should be _around_
9 // 2.000000 seconds

Math functions

random() returns a pseudo-random 64-Bit integer value

sin(f) returns the sine of <f>

cos(f) returns the cosine of <f>

sqrt(f) returns the square root of <f>

fabs(f) returns the absolute value of <f>

baseconv(v,b,d) returns a string of value <v> to the numeral base of <b> with <d> digits (e.g.
baseconv(255,16,8) results in 000000FF,which is the value 255 to the base 16 (hexadecimal)
with 8 digits)

acos(f) returns the arccosine of <f>

asin(f) returns the arcsine of <f>

atan(f) returns the arctangent of <f>

atan2(f1, f2) returns the arctangent of <f1>/<f2>

exp(f) returns the exponential function e raised to the power <f> (e is Euler's constant)

log(f) returns the natural logarithm of <f> (<f> has to be greater than 0)

log10(f) returns the base-10 logarithm of <f> (<f> has to be greater than 0)

pow(f1,f2) returns the number <f1> raised to the power <f2>
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tan(f) returns the tangent of <f>

Data management

remove_files() removes all data objects in the "Files" set

create_node(name, type, flags) creates a new node with properties <name>, <type> and
<flags>

1 // create_node example
2 create_node("usr.var.x", "VAR:INT32", "NQ");

delete_node(name) tries to delete a node (variable, job, etc.) with the given <name>

set_node_flags(name, flags) sets the <flags> of a node with the given <name>

set_minval(name, minval) sets the minimal value for the variable <name> to <minval>

set_maxval(name, maxval) sets the maximal value for the varaible <name> to <maxval>

node_exists(name) returns true, if the node <name> exists, else false

get(name) gets the value of a node with the given <name> ($usr.var.x$=get("usr.var.y") does
the same as $usr.var.x$=$usr.var.y$, but the <name> argument to get() can be constructed
at run-time)

set(name, value) sets the value <value> of a nodewith the given <name> (set("usr.var.a",123)
does the same as $usr.var.a$=123, but the <name> argument to set() can be constructed at
run-time)

DebugLog(str) enter <str> to the Debug Log

get_unit(name) returns unit of variable <name>

line_flush() flushes the DSP line draw buffer (like purge in script node e.g. change external
parameter (focus, axis etc.), draw line, flush, change external parameter (focus, axis etc.),
draw line, flush etc.)

select_job(name) select job <name> (e.g. select_job("usr.job.MyJob");) could beused for vari-
able dbg.script_cmd as a "run once" (not usable in a conventional script because then
system is processing)

test_node_flags(name,flags) check if flags are set in <flags> of node <name>
1 // test_node_flags example
2 if(test_node_flags("usr.var.TEST","U") == true)
3 {
4 info_dlg("Flag U set!");
5 }

Input and output functions

serial_setup(port, bps, bits, parity, stop) Initializes interface <port> ("COM A" or
"COM B") with the settings <bps> bits per second, <bits> data bits (7,8,9), <parity> (0=none
1=odd 2=even), <stop> stop bits (1,2)
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1 // serial_setup example
2 serial_setup("COM A", 9600, 8, 0, 1); // COM A, 9600 bps, 8 data

bits, no parity, 1 stop bit

send(port, string) sends <string> via interface <port> ("COM A" or "COM B")

send_hex(port, string) sends <string> via interface <port> ("COM A" or "COM B"), where
<string> represents the bytes to be transmitted in hexadecimal notation

1 // send_hex Example
2 serial_setup("COM A", 9600, 8, 0, 1); // COM A, 9600 bps, 8 data

bits, no parity, 1 stop bit
3 send_hex("COM A", "48616c6c6f0d0a"); // sends the charachters "

Hallo<CR><LF>" via interface COM A

receive_byte(port) receives a character from interface <port> and returns its value as INT32.
If no character is available then -1 is returned

$byte$ = receive_byte("COM A"); // wait forever for a byte

receive(port, maxchars, delim, timeout) receives data from interface <port> and returns
received data as a string. Maximum <maxchars> characters will be receiced. If a charac-
ter is received contained in string <delim> then receiving will also be stopped (this last
character will not be returned). At the latest after <timeout> (in seconds) the function
returns its result

1 // wait 10 minutes (600 seconds) for 10 Bytes
2 $tenchars$ = receive("COM A", 10, "", 600);
3 if(strlen($tenchars$) < 10) info_dlg("Reply too short - timeout

occured!");
4

5 // wait 10 minutes (600 seconds) for a maximum of 1024 Bytes
6 // until \n (newline) is sent
7 $string$ = receive("COM A", 1024, "\n", 600);

TCP_Open(ip,port) open TCP connection <ip> on <port>, returns handle to TCP connection

TCP_Close(handle) close TCP connection <handle> (returned by TCP_Open)

TCP_Receive(handle,maxch,delim,timeout) receives data from TCP handle and returns re-
ceived data as a string. Maximum <maxchars> characters will be receivced. If a character
is received contained in string <delim> then receiving will also be stopped (this last char-
acter will not be returned). At the latest after <timeout> (in seconds) the function returns
its result

1 // TCP_Receive Example
2 $handle$ = TCP_Open ("192.168.1.42" , 80);
3

4 TCP_Send($handle$ , "GET index.html\r\n");
5 $html$ = TCP_Receive($handle$ ,10 ,"" ,5); // wait 5 seconds for

10 Bytes
6
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7 // see if 10 characters were received or if we had a timeout
8 if(strlen($html$) != 10) info_dlg("A timeout occured - received

less than 10 chars!");
9 else info_dlg($html$);

10

11 TCP_Close($handle$);

TCP_Send(handle,data) send data <string> to TCP <handle> (returned by TCP_Open)

1 // TCP Example
2 $handle$ = TCP_Open("192.168.1.227", 80);
3 TCP_Send($handle$, "12345");
4 TCP_Close($handle$);

Control Flow . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

A control flow statement is a statement whose execution results in a decision beingmade as to which
of two or more control flows should be followed. See 5.44.2 Scripting Examples for some examples.

Simple statements are e.g. assignment of values or function calls. Each instruction of a statements is
ended by a semicolon ";". Several instructions can be combined to a single statements by enclosing
them into curly braces, e.g.:

$second$ = $second$ + 1;
if($second$ >= 60)
{

$second$ = 0;
$minute$ = $minute$ + 1;

}

statement a statement can be one or more scripting command. If there are more scripting com-
mands, they may be grouped using curly braces { and } or have to be grouped if they are exe-
cuted e.g. under an if statement:

command1

{
command2
command3
command4

}

goto and labels a goto is a direct jump to a label:

goto label1;
/* whatever you like here - this code is skipped */

label1; // goto jumps here

if is a conditional statement. The if statement has two forms:
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if(expression) statement // if the expression after the if
// is true statement is executed if
// it is false statement is skipped

if(expression) statement1 // if the expression after the if
else statement2 // is true statement1 is executed

// if the expression after the if
// is false statement2 is executed

The structure can be as complicated as e.g. this:
if(expression){

if(expression){
statement(s)

}
}else{

statement(s)
}

while a while loop is a control flow statement that allows code to be executed repeatedly based on a
given boolean expression:

while(expression)
statement // statement is executed while expression

// is true expression normally is influenced
// in statement but expression can also be a
// function that returns true or false

do .. while occasionally it is profitable to guarantee at least one execution of the statement follow-
ing while, so an alternative form exists:

do
statement // statement is executed while expression

// is true (but at least once)
while(expression); // be aware of the semi-colon after the

// while

for a for loop is a control flow statement which allows code to be repeatedly executed. A for loop is
classified as an iteration statement because it normally uses an internal loop counter.

for (initialize; check; update) statement
// initialize: e.g. $i$=0
// check: e.g. $i$ < 10
// update: e.g. $i$ += 2

break a break statement can be used to leave any loop before its expression is fulfilled or count has
expired:

while(expression)
{

statement
break; // leave while loop even
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// if expression is not false
}

for(initialize; check; update)
{

statement
break; // leave while loop even

// if check is not false
}

return a return statement exits a script

info_dlg("This is shown!");
return;
info_dlg("This is NOT shown!");
$x$ += 1; // not done

Scripting Examples . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .

Please reference to these examples for a easier understanding of the scripting language.

Example: A variable usr.var.x of type INT32 is created and initialized with value 5. If the variable
already exists then only the value is assigned.

$x$ = 5;

Example: The output o1 (dev.pio.o1) is set to true, then the input i1 (dev.pio.i1) is waited
for before output o1 is set to false.

1 $dev.pio.o1$ = true;
2 while (!$dev.pio.i1$)
3 idle();
4 $dev.pio.o1$ = false;

Example: The output o1 (dev.pio.o1) is set to 1 for 1 second.

1 $dev.pio.o1$ = 1;
2 msleep(1000);
3 $dev.pio.o1$ = 0;

Example: In the usr.var.x node the flag N is set (+) and the flag Q is cleared (-).
set_node_flags("usr.var.x", "+N-Q");
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Example: How to create a random value between 4 and 10.
1 $n$ = 4; // low value
2 $m$ = 10; // high value
3

4 $num$ = $m$ - $n$ + 1; // get number of items
5 $rnd$ = random(); // randomize a number
6 if($rnd$ < 0) $rnd$ *= -1; // remove negative values
7

8 // calculate numbers between $n$ and $m$
9 $rndnum$ = $rnd$ % $num$ + $n$;

10

11 info_dlg($rndnum$);

Example: To comment your scripts you have two possiblities:
1 /*
2 Several lines of
3 comment
4 */
5

6 // one-line comment

Example: Each command line is terminated by a semicolon.
1 $strHelloWorld$ = "Hello World";
2 info_dlg($strHelloWorld$);
3

4 // info_dlg is also handy for debugging output!

Example: Possible scripting control flow:
1 $x$ = 10;
2 $y$ = 10;
3

4 if($x$ == 10) $x$ = 20; // if equal
5 else
6 {
7 $x$ = 15;
8 $y$ = 5;
9 }

10

11 if($x$ != 10) // if not equal
12 {
13 $x$ = 30;
14 $y$ = 40;
15 }
16 else // else (in this case "if equal")
17 $x$ = 5;
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18

19 while($x$ <= 40) // while x is less than 40
20 {
21 $x$ += 5; // this is the same as %x% = %x% + 5;
22 }
23

24 do
25 {
26 $x$ = $x$ + 5;
27 }
28 while($x$ <= 50); // while x is less than 50
29

30 $x$ = 0;
31 while($x$ < 10)
32 {
33 $x$ += 1;
34 if($x$ == 5) break; // leave while($x$ < 10) loop after its closing

"}"
35 }
36 info_dlg($x$); // $x$ is 5!
37

38 for($x$=0;$x$<10;$x$+=1) // for i from 0 to 9
39 {
40 $usr.job.Job.Script.Transform..sx$ = $x$;
41 exec_subtree("Transform"); // execute node "Transform" below the

script node
42 }

Example: Variables are automatically created if you use them, they have to be enclosed by 2 $-
characters e.g.:

1 // creates the InScript variable usr.var.myVar
2 $myVar$ = 10;
3

4 // existing variables can also be used e.g.:
5 if($dev.sas.stat.marking$ == true) goto next;
6

7 next:

Example: Node variables. You may also use variables that represent node values e.g.: Copy the
variable's name to the clipboard andpaste it in your script (be careful, if youmove the node or rename
a job, the variable name may change, so it is better to use relative variables):
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1 $usr.job.Job.Shape..x1$ // absolute variable
2 $<.Shape..x1$ // relative variable

In the second example, you only need one "<" because the Script node is in the same level as the Shape
node (be careful, if you move the Script node to a different level it will still invalidate the variable).

Example: String variable arithmethic. For output or edit, variables of different type can be con-
catenated as strings by using a '+' character.

1 $strVar$ = "It is ";
2 $x$ = 1;
3 info_dlg("[Output #" + $x$ + "] " + $strVar$ + $stat.time.TimeStr$ + " o

'clock!");

This will output the current time:

Example: Cast a variable. You can cast variables to different types, which may be handy if you
want to format a number (e.g. int) as a string or use a string as a number. To do this you can use the
cast operator (<type>). <type> can be e.g. string, int, long, float, double or boolean.

1 // string with 990 as three characters
2 $strVar$ = "990";
3

4 // intVar is the number 990
5 $intVar$ = (int)$strVar$;
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6

7 // add 11
8 $intVar$ += 11;
9

10 // strVar is the string "1001" with four characters
11 $strVar$ = (string)$intVar$;
12

13 // $len$ is 4
14 $len$ = strlen($strVar$);
15

16 info_dlg($strVar$ + " is a " + $len$ + "-digit number!");

Example: Execute a subtree below the Script node. To execute node elements from within Script
nodes you are able to put a call to an exec_subtree function in your script code. Here is the Job
Configuration view of a job that uses the script snippet below:

1 $usr.job.Script_exec_subtree_Example.Script.Transform..sx$ = 0;
2 $usr.job.Script_exec_subtree_Example.Script.Transform..sy$ = 0;
3 $usr.job.Script_exec_subtree_Example.Script.Transform..angle$ = 0;
4

5 for($i$=0;$i$<=360;$i$+=10)
6 {
7 $usr.job.Script_exec_subtree_Example.Script.Transform..sx$ = $i$ * 2;
8 $usr.job.Script_exec_subtree_Example.Script.Transform..sy$ = $i$ * 2;
9 $usr.job.Script_exec_subtree_Example.Script.Transform..angle$ = $i$;

10

11 exec_subtree("Transform");
12 }

Example: Check if a variable (or node because variables are also nodes) exists.
1 if(node_exists("usr.var.DoIExist"))
2 {
3 // Variable DoIExist exists in usr.var
4 info_dlg("usr.var.DoIExist exists!");
5 }
6 else
7 {
8 // Variable DoIExist does not exist in usr.var
9 info_dlg("usr.var.DoIExist does not exist!");
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10 }

Example: Output a text file from a Script. To output text into a file on the host PC you can use the
HostExec script command in combination with the Windows shell command echo.

The example shows a for loop that increments $i$ from 0 to 9. These numbers and $i$ * 2 are output
to the file C:\Output.txt.

1 HostExec("C:\\Windows\\System32\\cmd.exe", "/C echo Values: > C:\\Output
.txt");

2 for($i$ = 0; $i$ < 10; $i$+=1)
3 {
4 $y$=$i$*2;
5 HostExec("C:\\Windows\\System32\\cmd.exe", "/C echo i=" + $i$ + " i

*2= " + $y$ + " >> C:\\Output.txt");
6 }

Description of the code lines:

• initialize the file Output.txt via Windows Shell command echo with first line "Values:"
HostExec("C:\\Windows\\System32\\cmd.exe", "/C echo Values: > C:\\

Output.txt");

• repeat code in curly braces 10 times and increment $i$ from 0 to 9
for($i$ = 0; $i$ < 10; $i$+=1)

• calculate $i$ * 2 for output in second column
$y$=$i$*2;

• output $i$ 0…9 0…18 to the file Output.txt
HostExec("C:\\Windows\\System32\\cmd.exe", "/C echo i=" + $i$ + "

i*2= " + $y$ + " >> C:\\Output.txt");

Some Background:

Using echo on a CMD.EXE command prompt to output text is used like this:
echo Here is some text

The > pipe command redirects console program text output to a text file and >> appends to a text file.
So this appends Hello to the text file TEXT.TXT:
echo Hello >> TEXT.TXT

NOTE

Do not put a number directly before the Windows Shell pipe commands > or >> (e.g. 0>>,
which $i$ + ">>"would do) this will lead to output to e.g. stdout or sterr. Just put a space
between the number and the pipe (e.g. 0 >>). Also be sure that e.g. no newline \n or
similar characters are in the HostExec line because this would act like having a CMD.EXE
line with these characters, which could lead to unwanted effects.
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5.45. Stop

If you click Job Stop then a job will be aborted or paused at the next Stop node. Thus a job can be
aborted or paused at specified points, so that e.g. a just processed part can be finished.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Behavior selects, how the node behaves

Abort The job will be aborted

Pause The job will be paused. The job will be continued by clicking Job Stop once again

Execute The job will be executed without restrictions

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.46. Flush

The Flush node is closely associated with the Repeat node function. The Repeat node "seamlessly"
repeats its child nodes, i.e. without switching off the laser beam in between the repetitions. The Flush
node forces the laser beam to switch off between repetitions. For this purpose place the Flush node
beneath the node to be repeated. In the example below the Flush node is beneath the Shape node).

Sequence of execution:
Job→ Repeat→ Laser on→ Process Shape→ Flush→ Laser off→ Repeat→ Laser on→ Process
Shape→ etc. until the Repeat is exhausted.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.47. Tiling

Graphic objects that shall be processed on a bigger surface than the scan field can be divided into tiles
by this node. The node has four standard child nodes Source, Pre-Tile, Post-Tile and Tiles, see following
figure.

Graphical objects that shall be divided up into tiles have to be child nodes of the Source node. The
Tiles subtree will contain the definition of the single tiles. These tiles are defined by Tile nodes, see
section 5.48 Tile. These tiles can be automatically generated and filled with the splitted parts by first
defining the working area and then clicking on Create Tiles and Split. To output these tiles side by
side on the target area, the target has to be moved after each processing e.g. by external axes. For
this purpose further nodes, e.g. Script nodes, can be placed into the Pre- and Post-Tile node, which are
executed before and after a single tile is output.

TIP

In the Tiles node context-menu, click ShowVector-Editor View to get an overview about the
graphic objects, the working area and the tiles.

To move points of graphic objects in the Vector-Editor window, in the corresponding Tile
node's context menu, click Show Vector-Editor View. In the Vector-Editor window, select
the graphic object. In its context menu, click Handle Points. The points of the selected
graphic object can be moved now.
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5.47.1. Edit - Shared GUI Elements

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Create Tiles automatically creates the tiles needed to output the graphic objects defined in the
Source subtree. It is possible to create the tiles manually by creating Tile nodes, see section 5.48
Tile, as children of the Tiles node

Split distributes the content of the Source subtree to tiles, which already have to be defined in the
Tiles subtree. Either create the tiles automatically by clicking Create Tiles or create the tiles
manually by creating Tile nodes as children of the Tiles node, see section 5.48 Tile

Autosplit If the check box is selected and the node is being executed then the content of the Source
subtree is automatically split to the tiles. This is necessary if the content of the Source subtree
is dynamically modified during job execution

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements
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5.47.2. Edit - Working Area

Figure 12: (1) working area; (2) origin of working area; (3) origin of line data; (4) tile; (5) overlap; (6)
origin of tile = center of tile

Position X sets the offset between line data origin and working area origin in X-direction

Position Y sets the offset between line data origin and working area origin in Y-direction

Size X sets the working area size in X-direction

Size Y sets the working area size in Y-direction

Clip If the check box is selected then the line data in the Source subtreewill be clipped at theworking
area before creating the tiles. The tiles will be created for the remaining line data. The tiles
thereby can protrude the working area. The line data will be output within the tiles and thus
also outside the working area as the case may be
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5.47.3. Edit - Tiles

Tile Overlap

X sets the overlap of the tiles in X-direction

Y sets the overlap of the tiles in Y-direction

Splitting intent

Simple clipping clips the line data at each tile border, i.e. the line datawithin the overlapwill
be output by each respective tile

Minimize overlap minimizes the overlap and tries to output a path segment completely in
one tile whenever possible, even if it is located partially or completely in the overlap.
If the next path segment is partially located in a second neighboring tile (the overlap
between these tiles excluded) then it will be completely output by the second tile and
additionally the path segment's part within the overlap will be output by the first tile

NOTE

The Angle of all tiles has to be zero when using this setting.

Figure 13: (1), (3) tiles; (2) overlap; (A) path segment located completely in tile 1 and thus output in
tile 1; (B) path segment located in tile 1 and tile 2 and thus output in the overlap of both
tiles; (C) upper path segment located completely in tile 1 and thus output in tile 1, lower
path segment assumed by algorithm to be of type B
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TileSets This list is only active, if Minimize overlap is selected in Splitting intent

No TileSets writes all line data to 1 TileSet

Create TileSets by Pen unites path segments by pen to independent TileSets with own tile
count and position. Thus e.g. paths, which are located across several tiles but would fit
into 1 tile, can be output in 1 tile by assigning a seperate pen to them

Pen pass-through from Source This list is only active, if Minimize overlap is selected in Splitting
intent

Discard Pens discards the pen information when splitting the line data to the tiles

Pass-through pens passes through the pen information when splitting the line data to the
tiles

5.47.4. Edit - Current Tile

Node Name shows the node name of the current tile

Angle shows the rotation angle of the current tile

Offset X shows the offset between line data origin and origin of the current tile in X-direction

Offset Y shows the offset between line data origin and origin of the current tile in Y-direction

Size X shows the size of the current tile in X-direction

Size Y shows the size of the current tile in Y-direction

5.48. Tile

This node defines a tile and is placed as direct child of the Tiles node in the Tiling node, see also section
5.47 Tiling. The Tile nodes are automatically generated and filled with content, when clicking Create
Tiles and then Split in the Tiling node.
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Node Name see section 5.1 Shared GUI Elements
Action see section 5.1 Shared GUI Elements
Angle sets the angle to rotate the tile
Offset X sets the offset between line data origin and origin of the tile in X-direction
Offset Y sets the offset between line data origin and origin of the tile in Y-direction
Size X sets the size of the tile in X-direction
Size Y sets the size of the tile in Y-direction
Mirror X If the check box is selected then the tile X coordinates will be mirrored
Mirror Y If the check box is selected then the tile Y coordinates will be mirrored
OK see section 5.1 Shared GUI Elements
Cancel see section 5.1 Shared GUI Elements
Restore see section 5.1 Shared GUI Elements

5.49. Pen Link

This node refers to a pen in the Job Configuration window in the Pens folder. When a Pen Link node is
reached during the execution of a job then the parameters will be set to the values which are defined
in the pen at the moment. If several Pen Link nodes are referring to one and the same Pen then the
memory required on the controller board does not multiply, because only links to already existing
data are used.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Pen Name selects the name of a pen that is stored on the controller board. The pen link is set to
this pen

Upload before execution if this check box is selected then the pen will be loaded from the PC to
the controller board directly before execution of the Pen Link node. If the pen was already
loaded to the controller board then the pen on the controller board will be overwritten. If the
pen does not exist on the PC then the pen on the controller board will persist

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.50. Pen Set

By this node pen numbers can be assigned to pens (sets of parameters). Pen numbers are used e.g. in
HPGL-files. In that way you can select pens during a job via the content of e.g. HPGL-files.

By dragging & dropping pens from the Pens group they can be assigned to pen numbers in the Pen
Set group. You can select pens from the Pens folder (on the hard disk e.g. from the C:\Program
Files\InScript\Pens folder) or pens from the controller board (in the Job Configuration window in
the Pens folder).

If the Job reaches this node on its execution pen numbers from 1 to maximal 32 are assigned to the
pens defined in the pen folder on the controller board. When a Pen Set node is reached during the
execution of a job then the parameters will be set to the values which are defined in the pens at the
moment.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Pens

switches to the folder view. To return to the previous view double click the wanted folder
in the folder view

Pens on Hard Disk refreshes the list of pens on the hard disk

Path Box currently selected path for pens on hard disk

Pens on Hard Disk List pens which are available on the hard disc in the current path

Pens on Controller Board refreshes the list of pens on the controller board

Pens on Controller Board List pens which are available on the controller board

PenSet

Pen Set List to assign a pen number to a pen drag & drop a pen either from the list Pens on
Hard Disk or from the list Pens on Controller Board to the wanted pen number (PenSetListEn-
trynn) in the PenSet group. After that the name of the pen is shown. To change the colors
of the pen numbers see 8.4.14 Sub Category - Screen Styles / View Styles / Editor Mode
Vector Editor Pen Settings.

Delete entry deletes the selected mapping between pen and pen number

Clear all clears all mappings between pen and pen number

Upload before execution if this check box is selected then the pen will be loaded from the
PC directly before execution of the Pen Link node to the controller board. If the pen was
already loaded to the controller board then the pen on the controller board will be over-
written. If the pen does not exist on the PC then the pen on the controller board will
persist

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.51. Fill

Using this node graphical objects can be filled with several hatchings. All graphical nodes below a
Fill node will be modified by this node by adding the fill lines between outlines. Because of this these
nodes are treated as a group in Vector Editor and can't be set to element or point mode (see Handle
Elements and Handle Points under 7.4.1 Mode or 7.5 Context Menu). In standard color settings these
subnodes will be visualized gray if you e.g. point edit inside a RawLines (see 5.22 Raw Lines) node;
to see the currently edited point or line in Vector Editor, you may set the Fill node's Action field to
Neutral (see 5.1 Shared GUI Elements).
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NOTE

If you fill a graphical object with a hatching and scale it after that the hatching will also
be scaled (e.g. the Delta settings will not be correct). You can avoid this by placing the
Scale node under the Fill node and not vice versa.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

General

X sets the X-coordinate of the first hatch line’s reference point. When X = 0 and Y = 0 then
the first hatch line passes through the origin of the filled object

Y sets the Y-coordinate of the first hatch line’s reference point. When X = 0 and Y = 0 then the
first hatch line passes through the origin of the filled object

Delta sets the distance between the hatch lines or fill lines

Reduction sets the scan distance between the contour and the hatching lines

Mode selects the fill mode

Single simple hatching with angle Angle 1

Cross cross hatch with angles Angle 1 and Angle 2

Multi multiple hatching with starting angle Angle 1. All folllowing hatches will be ro-
tated by angle Multi D as many times as specified in Multi N

Offset filling pattern, which consists of equidistant contours to the outer contour

Angle 1 sets the angle of hatching 1

Angle 2 sets the angle of hatching 2, if Cross (cross hatch) is selected in Mode

Multi D see Mode, list item Multi

Multi N see Mode, list item Multi
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Interleave

Mode selects the interleave mode

Linear every nth hatch line will be output. The value for n is entered in Passes

Bit-reverse The hatch lines will be output in a pattern which will maintain a minimal
distance during the passes

Passes if Passes is greater than one then the hatch lines will be not output immediately one
after another. Hatch lines will be skipped and output in a later pass. This may be useful,
when thematerial to be processed is sensitive to heat and needs time to cool down before
heating it up again near the first heating

Options

Fill if this check box is selected then the object will be filled

Outline if this check box is selected then an outline will be drawn

Outline first if this check box is selected then the outline will be drawn before the object will
be filled. The Outline check box has to be activated to use this option

Bidirectional if this check box is selected then the hatch lines will be output bidirectionally.
This increases the velocity but deteriorates the quality. If head-, tail-, on- and off-delays
are not set correctly in device Line Parameter (see 3.10 linepar - Line Parameters) output
errors will occur

Optimize this check box is grayed out and can not be activated. The optimize algorithm is
still experimental and would produce unexpected results

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.52. Memo

Using this node you may add remarks and comments into the tree structure of the job. This node is
completely neutral and executes no further function.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

NOTE

The node always acts neutral, no matter what is selected here.

Textbox In the text box type in the text which should be shown when the node is edited

Apply applies the text typed in

Clear clears the text typed in

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.53. Info

This node displays notes, warnings, variables and/or plays sounds.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Textbox In the text box type in the text which should be displayed when the node is executed. A
variablemay also bedisplayedbyusing InScript's scripting language syntax, see 5.44.2 Scripting
Language

Apply applies the text typed in

Clear clears the text typed in

Time to Live

Duration sets the duration the information is displayed with. If the value is set to 0 then the
Info window is displayed until you click one of its buttons

Sound From the list select a file in the wav-format to be played back. In the list only wav-files are
shown which can be found in the InScript Sounds folder, e.g. in C:\Program Files\InScript\
Sounds
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plays the selected wav-file

stops the play back of the selected wav-file

Options

Wait If the check box is selected then the job will be halted until the Continue button has been
clicked or the Time to Live has elapsed

Abort If the check box is selected then an Abort button is displayed by which the still running
job can be aborted.

If the check box Wait is additionally selected then the job will be halted and a Continue
button is displayed by which the job can be continued

Auto abort If the check box is selected then the job is automatically aborted after Time to Live
elapses. If Time to Live is set to 0 then the job will be aborted immediately

Beep If the check box is selected then a beep will be played back

Dialog Only if the check box is selected then an Info window will be displayed. This is useful
when only a sound should be played back

Purge If the check box is selected then all lines data, which lies before this node, will be exe-
cuted before the Info window is displayed

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.54. Input

Use this node to display or to input a variable during job execution. The job will be halted until the
Continue button has been clicked.

Node Name see section 5.1 Shared GUI Elements

Variable sets the variable name, that you want to display and/or to input

If you want to edit a system parameter, type in the complete path, e.g. usr.pens.default.
linepar.common.speed_m for the processing speed in the default pen.
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If you want to edit an user specific parameter, type in either the complete path, e.g. usr.var.
MyParameter or just MyParameter.

Make sure to use the correct Type (see below)

Title sets the text which is shown when the Input window is displayed

Column if the Input node is a subnode of a Query node (see section 5.56 Query) then you can se-
lect columns of the Query node's Database source that will be handed over to a variable in the
Variable field

Type selects the variable type. All numerical variables are signed

VAR:INT32 Integer 32 Bits

VAR:INT64 Integer 64 Bits

VAR:REAL32 IEEE 754 floating-point number 32 Bits

VAR:REAL64 IEEE 754 floating-point number 64 Bits

VAR:STRING Sequence of Bytes

Min sets the minimal permitted input value

Max sets the maximal permitted input value

Show current value If the check box is selected then the current value of the variable is shown
when the Input window is displayed

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.55. Dual Scan

The Dual Scan technology was developed by ARGES and applied for a patent. It is applied in wave-
length selective processing and is based on a single pulsed laser beam source which simultaneously
emits 2 wavelengths. Both wavelengths are separated and directed into 2 independent scan heads.

NOTE

To control both scan heads independently settings have to be changed in theHead device
driver in the Channels tab:

In the Vector Processing list, select VP1 Enabled and in the Scan Field Correction list, select
COR1 Enabled. Using these settings vector calculations and scan field correction will be
performed seperately for scan head 1 (Head 1, slave). Or else the slave scan head follows
the master scan head output.
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The Dual Scan node contains 2 child nodes, where Head 0 stands for the master scan head and Head
1 stands for the slave scan head. Settings are made only in the Dual Scan node as neither the Head 0
nor the Head 1 node have editors.

All nodes in the Head 0 subtree generate an output only on the master scan head. All nodes in the
Head 1 subtree generate an output only on the slave scan head.

5.55.1. Edit - Shared GUI Elements

Node Name see section 5.1 Shared GUI Elements
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Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.55.2. Edit - General

In the General tab the mode and the jump time for the Dual Scan node can be set.

Mode selects the mode of the Dual Scan node

Dots this setting is obsolete

Jump Time selects the time a scan head needs to jump from one position to the next

2667�s, 5333�s, 10667�s, 21333�s possible times that can be set

5.55.3. Edit - Beam Dump

A Dual Scan system uses a single laser beam source which simultaneously emits pulses at 2 wave-
lengths. Both scan heads direct laser pulses to the respective target. The number of pulses needed
depends on the process and may be different for both scan heads. If e.g. the master scan head needs
100 pulses for its task, while the slave scan head needs only 70 pulses, then a beam dump position
has to be specified for the slave scan head. The super numerous pulses of the slave scan head will be
output to this position where they do not affect the process result.
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Head 0, Head 1

Mode selects the position to which the super numerous pulses are output

Specified the beam dump position is specified in X-Pos and Y-Pos

Last Dot the last dot position will be used as beam dump position

X-Pos, Y-Pos sets the beam dump position X- and Y-coordinate

5.55.4. Edit - Cache

In this tab the cache memory settings are specified.

Enable if the check box is selected then the whole output is saved internally. If the same job is
executed several times then the data from the 1st output will be re-used. This way the output
will be accelerated as the vectors have not to be calculated again

Clear clears the cache memory content
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Exec Mode selects the cache mode. If you want to output lines then Parallel Execution has to be
selected. If you want to output dots then use one of the other settings
Cache the cache memory content stays preserved upon the Dual Scan subtree was executed
Cache, clear after execution the cachememory content will be cleared upon the Dual Scan

subtree was executed
Parallel Execution the line data will not be saved to the cache memory. Both Dual Scan sub-

trees will be output in parallel

5.55.5. Edit - Target Area

The rectangle enclosing both scan fields is called the target area. In this tab the size as well as the
position and the rotation of both scan fields regarding the target area can be specified.

NOTE

The Target Area is only set for better visualisation of the dual scan fileds. It does not
influence the actual laser output.

Geometrical Constraints
X-Pos, Y-Pos sets position of the target area origin. The target area origin is in its left upper

corner. The reference point of this position is specified by the 3 Set Target Origin To buttons
X-Size, Y-Size sets the target area width and height

Head 0, Head 1
X-Pos, Y-Pos sets the positions of the scan field center points. The reference point of this

position is specified by the 3 Set Target Origin To buttons
Rotation sets the scan field rotation angles around their center point

Set Target Size To H0/H1 Bounds sets the target area size to the bounding box of both scan
fields. I.e. in the Geometrical Constraints group the X-Size and Y-Size values will automatically be
calculated from the scan field size, position and rotation
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Set Target Origin To Upper Left Corner defines the target area origin as origin for all coordi-
nates on this tab

Set Target Origin To Head 0 Center defines the center point of the Head 0 scan field as origin
for all coordinates on this tab

Set Target Origin To Head 1 Center defines the center point of the Head 1 scan field as origin
for all coordinates on this tab

5.55.6. Example

To control two scan heads with one laser source, you can use the Dual Scan node. The laser beam has
to be splitted by a beam splitter. In this case, the scan heads can be located above the same area or on
oposite sides of the workpiece. The laser power is always the same for both scan heads because the
Dual Scan node handles both scanheads with a single laser source. So the source always has to obey
the needs of both scan heads and can not act individually for each scanhead. Here is ane example
that shows this behaviour:

Step 1 Create a new Job via Organizers / Job. Rename it e.g. to Dual

Step 2 Add a Dual Scan node under the newly created Dual job node

Step 3 You will automatically get Head 0 and Head 1 nodes under this Dual Scan node

Step 4 Double-click the Dual Scan node. The Dual Scan Editor opens. On tab Target Area (see
5.55.5 Edit - Target Area), the scan field and rotation for each head can be set:
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Step 5 Create two shapes under each head (e.g. rectangles called ShapeHead0 and ShapeHead1).
Be sure that both shapes have the same number of lines! If there are more lines in one of the
shapes, the laser beam of this head has will go to the beam dump outside the scanfield
while the other head processes the surplus line(s)

Step 6 You may create a Vector editor view for each scan head using right-click, "Show Vec-
torEditor view" on Head 0 and/or Head 1 or you use the dual view in the Vector Editor:

Step 7 Each shape can be modified in any way (e.g.move points via a Raw Lines node or Reverse
Paths in the Raw Lines Editor see 5.22 Raw Lines), rotate, scale, offset or slant each shape
of each head:

→

444 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



5.56. Query

NOTE

As long as the lines have the same length (e.g. rotate, offset etc.) there is
no problem, but if you have different line-lengths after transformations, you
may get problems because the laser's energy will be distributed over a longer
stretch or condensed on a smaller stretch causing different intensity of the
marking.

5.56. Query

The Query node is used to read data from external files. The file formats range from ASCII (INI, TXT)
over Excel (XLS) to database (MDB, DBF) files.

The ASCII file formats

INI The INI file format is the standard INI configuration file format e.g.:

; comment
[section]
name=value

TXT The TXT file format's values are tab-separated. The first line holds the column names and "»
" is a tab (ASCII 09) e.g. a file with three columns "Column A", "Column B", "Column C":

Column A» Column B» Column C
Value a1» Value b1» Line 1
Value a2» Value b2» Line 2
Value a3» Value b3» Line 3

NOTE

To read columns of data sources into variables, place an Input node under the Query node
for each column you want to read, see section 5.54 Input.

If an Input node is subnode of a Query node then it will show a new field called column
showing all possible columns of the parent Query node's data source.

See section 10.7 Read Data From a TXT File for an example.
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Node Name see section 5.1 Shared GUI Elements
Action see section 5.1 Shared GUI Elements
Database sets the database file name
Find opens an Open window for the file type set under Type
Edit opens the specified file with the editor/application registered underWindows for the specified

Type
Query Mode selects the sort of information the query provides

Data data will be provided by the query
Number of Records the number of records will be provided by the query

Type selects the database type
INI INI file
TXT ASCII text file with tab as separator
XLS Excel file
MDB Microsoft Access file
DBF DBase file

Table selects a table from the file. This box is only available, if a Type is selected that may contain
several tables in one file (e.g. XLS or MDB)

refreshes the tables if the data source was changed
Line-variable sets the line number that shall be read. E.g. a Variable of a Counter node (see section

5.42 Counter) or a variable that is incremented in a Script node (see section 5.44 Script) can be
used

INI-Section sets the INI section of a standard INI file that shall be queried. This box replaces Line-
variable if Type INI is selected

Purge if this check box is selected then InScript waits for output of all line data in nodes before the
Query node in the tree structure

OK see section 5.1 Shared GUI Elements
Cancel see section 5.1 Shared GUI Elements
Restore see section 5.1 Shared GUI Elements
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5.57. Head Offsets

Use this node with multi scan head systems

• to compensate minor offsets between scan heads

• to adjust a synchronous output to different targets

5.57.1. Edit - Head 1 to 4

In these tabs the offset for scan heads 1 to 4 can be set.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

X sets the offset of the respective scan head in X direction

Y sets the offset of the respective scan head in Y direction

Coordinates drop down selects the offset's origin

absolute the offset is specified in absolute coordinates

relative the offset is specified in relative coordinates

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.58. ExtRep

Using this ExtRep or External Repeat node a subtree can be output repeatedly and e.g. an external linear
axis can bemoved after each repetition. This way e.g. scales or other linear repetitions can be output.
The function is similar to that of the "internal" Repeat node (see section 5.34 Repeat).
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Axis selects the axis to be controlled. Only installed and active device driver can be selected here

Start Position sets the start position of the first output element

Position drop down selects the start position origin

absolute the Start Position is specified as absolute position on the axis

relative the Start Position is specified relative to the current axis position

Delta sets the distance by which the axis is moved between the repetitions

Number of Steps sets the number of repetitions

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.59. ExtPos

Using this node up to 8 external axes can be positioned. The axes will be positioned in the order from
1 to 8.

5.59.1. Edit - 1 to 8

In these tabs you define the axis and set the position the axis shall move to.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Axis sets the axis that shall be moved. Only installed and activated device drivers can be selected
here

Value sets the position

Mode selects the origin of the position in Value

absolute Value is specified as absolute position on the axis

relative Value is specified as relative position on the axis

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Teach in opens the Teach in - Realtime Controlwindow. This button is only active if one device driver
for external devices is installed and active

Restore see section 5.1 Shared GUI Elements

5.59.2. Edit - Teach in Realtime Control

In this window the specified axis can be positioned directly. The position can be transfered to the
ExtPos window.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Axis variable shows the variable name of an axis that can be modified

and moves the axis in one direction by 10 steps

and moves the axis in one direction by 1 step

Position input field sets the position directly. Using the keyboard or the arrow keys the axis can
be moved continuously in the needed direction

Position check box if the check box is selected then the position will be transfered directly to the
ExtPos window
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OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Reset resets all entries

Restore see section 5.1 Shared GUI Elements

5.60. ExtMat2Off

This node is comparable to the "internal" Mat2Off node. But instead of two galvanometer axes two
external axes can be controlled. E.g. a XY table. This way the scan field can be enlarged.

Using the External Mat2Off node matrix like layouts of positions can be created. The node is a com-
bination of the Repeat-X and the Repeat-Y nodes (see section 5.37 Repeat X and section 5.38 Repeat
Y), but with extended functionality. This provides accelerated output, exceptions from the normal
position in the matrix without special programming as well as bidirectional output.

5.60.1. Edit - Shared GUI Elements

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements
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5.60.2. Edit - Standard

Axis X

Axis X assigns an axis to the X direction. Only axes of installed and active device drivers can
be selected here

Offset X sets the first matrix element offset in X direction

Offset drop down selects whether the offset is specified in absolute or relative coordinates

absolute the axis will be positioned to the absolute coordinate in Offset X

relative the axis will be positioned relatively to the current position by the value in Off-
set X

Delta X sets the distance between the columns in X direction

Columns sets the number of columns

Axis Y

Axis Y assigns an axis to the Y direction. Only axes of installed and active device drivers can
be selected here

Offset Y sets the first matrix element offset in Y direction

Offset drop down selects whether the offset is specified in absolute or relative coordinates

absolute the axis will be positioned to the absolute coordinate in Offset Y

relative the axis will be positioned relatively to the current position by the value in Off-
set Y

Delta Y sets the distance between the columns in Y direction

Rows sets the number of rows
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Primary Axis sets the axis the output begins with. This causes a line by line or column by column
output

Bidirectional if the check box is selected then the matrix will be output bidirectionally. If it is
cleared then the columns or rows will always be output in one direction

5.60.3. Edit - Offset Edit

In this tab single matrix elements can be offset, e.g. the element on position in row 1, column 2 is
offset by -1.000 mm in X direction and 5.000 mm in Y direction referring to its normal position in the
matrix (see figure below).

Table Cells enter the offset data here. To enter the data, double click the corresponding cell or in
the cell context menu, click Edit Cell and confirm the input by pressing the Enter key. The
columns correspond to the matrix X direction. The rows correspond to the matrix Y direction.
Within a cell at the left the X coordinate and at the right the Y coordinate of the offset in
reference to the normal position in the matrix are displayed. To delete the values in a cell
select Delete Cell from the context menue

Apply applies the entered values

Clear clears and discards the entered values

5.61. Cache

This node saves line vectors for further output. In this way the output speed can be optimized as the
line vectors do not have to be re-calculated for each output. Calculation timemay especially be saved
outputting complex graphical objects like e.g. filled outlines.
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Control
Mode selects the node mode

Default currently only Default is implemented
Enable if this check box is selected then the complete output will be saved internally. If the

same job is executed for several times then the data of the first output will be re-used. In
this way the output will be sped up as the line vectors do not have to be re-calculated

Clear Cache clears the cache memory contents
Memory(kB)

Max. Size sets the maximum memory size reserved for the cache
Min. Free sets the minimum free memory size
Size shows the current memory requirements of the subtree

Auto Update
Interval spin control sets the time interval n, afterwhich the line vectorswill be re-calculated
Interval unit dropdown sets the time interval unit, after which the line vectors will be re-

calculated
No cyclic update the line vectors will not be re-calculated in intervals
Seconds, Minutes, Hours, Days the line vectors will be calculated after n seconds, n

minutes, n hours or n days
New Second, New Minute, New Hour, New Day the line vectorswill be calculated

each n new second, n new minute, n new hour or n new day

5.62. ExtCmd

Using this node a command can be sent via one of the controller board's serial interfaces (COM A or
COMB) to an external device. Then a specific timewill be waited for an answer and, corresponding to
the answer, it will be decided whether the job is continued, a warning is output or the job is aborted.

NOTE

Re-introduced to ASC from firmware version 2.6.0.412 on. In older firmware versions,
this node was only available on NCC controllers.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Command enter the command to the external device here. The command line end is the command
end here. The command line must not exceed 4kB

List of possible control characters:

Escape-Sequence ASCII-Code decimal Character
\a ASCII BEL 07 bell
\b ASCII BS 08 backspace
\f ASCII FF 12 form feed
\n ASCII LF 10 line feed
\r ASCII CR 13 carriage return
\t ASCII HT 09 horizontal tab
\v ASCII VT 09 vertical tab
\000 octal 000 00 octal input e.g. \015 = CR
\x00 hex 00 00 hexadecimal input e.g. \x0D = CR

Response shows the string received by the controller board via the serial interface

Protocol

Initialize if the check box is selected then the serial interface will be initialized before the
External Command node is executed and the receive buffer will be cleared
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Close on Exit if the check box is selected then the serial interface will be closed as soon the
External Command node has been executed

Port selects the serial interface on the controller board for communication

COM A available serial interfaces (COM A) NCC

COM B available serial interfaces (COM B) NCC & ASC

COM C available serial interfaces (COM C) ASC (available only in firmware versions >
2.6.0.412)

Baud selects the serial interface baud rate

300, 600, 1200, 2400, 4800, 9600, 19200, 38400 possible baud rates

Bits selects the transmission format length in Bit

7, 8 possible lengths

Parity selects the parity

None no parity

Odd odd parity

Even even parity

Stop selects the number of stop bits

1 1 stop bit

2 2 stop bits

Handshake selects, how the data flow is controlled

None not controlled

XON/XOFF controlled via software

RTS/CTS controlled via hardware, i.e. via the RTS/CTS lines

Time Out sets the maximal allowed time between receiving the last character and receiving
the line end character. If this time is exceeded then the whole input will be discarded

Max. resp. char. maximum response characters. Sets the number of characters waited for
reception after the string from the Command box was sent

Resp. Term. response terminator. Sets the string marking the answer's end. These charac-
ters are waited for after the string from the Command box was sent

Warn after a valid answer was received, it will be compared with the string entered here. If
the answer is equal to this string then a warning will be output

Abort after a valid answer was received, it will be compared with the string entered here. If
the answer is equal to this string then the job will be aborted

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements
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5.63. Host Execute (or Execute Host Application)

Using this node programs can be executed on the host PC. If the called program generates a file of
name >program name<.result InScript tries to read this file. Entries of the following form can be
read by InScript:

FloatVariable=nnn,nnn
IntegerVariable=nnn
BoolVariable=TRUE, FALSE, True, False, true, false
StringVariable=abc..xyz

Each entry that is found in the file is saved as the recognized variable type to the ..opt subtree of
the Host Execute node. Thus results produced by the called program can be reported back to InScript.

NOTE

This node is only available on NCC controller.

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Program sets the program to be executed, e.g. c:\windows\system32\notepad.exe

opens the window Select File to execute where a program can be selected

Commandline sets the parameter(s) for the Program that is executed. According to upper exam-
ple this may be the file to be edited e.g. C:\Program Files\InScript\config\inscript.ini.
Parameters may contain variables e.g. $VarName$, see 5.44.2 Scripting Language

Expand Commandline if variables are used in the command lne the commandline is shown with
all resolves variables in the Exp. Cmdline box

Exp.Cmdline shows the commandline with resolved variables

Visible if this check box is selected then the program will be executed Visible. If it is not checked,
you will see no Windows of the called program. It is executed in the background

Timeout sets the timeout for executing the program. After this time period the application is ter-
minated if possible and a failure is shown. If you choose a period of -1 seconds InScript waits
until the application terminates by itself
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OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.64. Split

Using this node objects can be output that are larger than the scan field. The node divides an object
in fields that can be covered by the scan field. To reassembles these fields, the workpiece is moved
by 1 or 2 axes as soon as one field has been output.

NOTE

The principle effect of the parameters is shown in the white area on the right side of
the Split Editor window. The diagram appears not until the bounding box values are
"known" to the Split node. For this purpose the Split node has to have at least one child
node producing output. After axis are defined the green area shows the area in that the
axis can operate, the lines show which splits are assigned to which part of the axis.

The following figure illustrates the terms used in the following text.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Axes

X, Y selects the axis movement direction

+ positive direction

- negative direction

assigns an axis to the X or Y direction. Only axes of installed and active device drivers can be
selected here

Primary Axis

Axis down selects the primary axis

X the fields will be output line by line

Y the fields will be output column by column

Mode

Mode drop down If you want to output an object with fixed size then select Cache in Mode.
Then the bounding box will be automatically calculated and you do not have to specify
the size in the Bounding Box group. If you want to output an object with variable size then
select Execute in Mode and specify the size in the Bounding Box group

Cache the Split node calculates the lines of the whole subtree first and stores it to an
internal cache memory. Then the single fields are output. All dynamic subtree ele-
ments, as e.g. serial numbers, get the values they have at the moment the Split node
is output

Execute the child node is executed for each field. Each dynamic element gets the value
it has at the moment the field is output

NOTE

If Cache is selected then enough RAM storage space has to be available on the con-
troller board to store the line data.

Field Size

X, Y sets the field size the object is divided to. The size must not exceed the scan head field
size. The scan head field size is defined in device driver dist_xy

Fields

Cols, Rows shows the number of columns and rows the object is divided to

Overlap

X, Y sets the overlap the fields are output with. Negative values create a gap between the
fields

Offset

458 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



5.65. ExtSelect

X, Y sets the offset between the job coordinate systemorigin and the position on the external
X or Y axis The following figure illustrates how the bounding box coordinates are linked
to the offset.

Bounding Box

Lower left / Upper right X, Y lower left or upper right corner of the object bounding
box. If you want to output an object with fixed size then select Cache in Mode. Then
the bounding box will be automatically calculated and you do not have to specify the
size in the Bounding Box group. If you want to output an object with variable size then
select Execute in Mode and specify the size in the Bounding Box group

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.65. ExtSelect

Using the External Select node and the parallel interface inputs (see theManual -- NCC System Controller)
a subtree beneath the External Select node can be selected for execution by evaluating digital inputs.
Up to 8 of the 11 digital inputs are available for this purpose. The remaining 3 digital inputs are re-
served for communication with an external super ordinatemachine control (3.3 sas - System Activity
State).

Timing Diagram
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Description Timing Diagram
Digital inputs can be configured to be either high-active or low-active. Therefore they are only ad-
dressed as active or inactive signals in the following.

No. 1 When the controller board shows its readiness by an active Ready signal you may request the
execution of a program by setting the Start signal to active.

No. 2a The controller board acknowledges the Start signal by setting the Ready signal to inactive.

No. 2b The controller board shows the beginning of program execution by setting the Active signal.

No. 3 After the controller board has set the Active signal to active you may set the Sel valid signal to
inactive to prepare a new selection.

No. 4 Once the Sel valid signal is set to inactive you may change the selection at the digital inputs
SEL_0 to SEL_7.

No. 5 As soon as valid data is set to the digital inputs SEL_0 to SEL_7, accept this data by setting the
Sel valid signal to active.

No. 6 Once the data is accepted, set the Start signal to inactive again.

No. 7 When the program ends the controller board sets the Active signal to inactive and the Ready
signal to active.

No. 8 Once the Ready signal is active again you may request the execution of the next program.

No. 9a see No. 2a.

No. 9b see No. 2b.

No. 10 see No. 3.

etc.
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Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

Mode
Parallel inputs uses the parallel interface inputs (see the Manual -- NCC System Controller) for

the external selection of a subtree

Selection valid defines the digital input which enables the reading of digital inputs (cp. timing
diagram above). A positive value stands for a high-active digital input. A negative value stands
for a low-active digital input. The value 0 (zero) means that no digital input will be used

NOTE

If Preload is set to always in the device driver SASP (see SASP 3.3.3 Parametrize - Gen-
eral), you have to set a digital input in Selection valid because the DSP will immedi-
ately start to pre-process the job and ExtSelect will very probably check the input
values too early. So setting a Selection valid input, the digital inputs are not read until
the level at this input is "active". If Preload is set to never in the device driver SASP
this is not necessary because job processing is not immediately done but can e.g. be
triggered from extern.

e.g.
Preload=false: Set inputs→ start Job→ ExtSelect evaluates inputs

Preload=true: Job processing immediately starts→ Set inputs→ ExtSelect waits
for Selection valid input high/low (e.g. Input 8 would be high = 8 and low = -8)→ Set
Selection valid Input→ ExtSelect evaluates inputs

Selection
0 to 7 assigns the parallel interface inputs (see the Manual -- NCC System Controller) to the se-

lections SEL_0 to SEL_7. The entered values correspond to the digital inputs. A positive
value stands for a high-active digital input. A negative value stands for a low-active digital
input. The value 0 (zero) means that no digital input will be used

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements
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How to assign the selections SEL_0 to SEL_7 to External Select subtrees

1. Arrange every subtree beneath a Collect node (see section 5.31 Collect).

2. Arrange the Collect nodes beneath the External Select node.

3. Rename the Collect nodes.

The bit pattern within the first 8 characters of the node name is analyzed for the selection. The
first character within the bit pattern is the least significant bit. This bit corresponds to selection
SEL_0. The eighth character is themost significant bit. This bit corresponds to selection SEL_7. These
characters are allowed:

Character Description
0 inactive
1 active
other other characters than 0 (zero) and 1

will be ignored, but have to be allowed
within a node name

Particularities Momentarily there is no user interface to configure the ASE user inputs (see 3.36 ase
user io - USER Inputs and Outputs) or Laser Control HSIO (high speed I/Os at the LASER CONTROL con-
nector, see the documentation of the ASC controller) for ASC controllers for the Ext-Select function.
To be able to use this functionality, you have to use the Xplorer (see 8.5 Xplorer):

To assign signals to the ASE user I/O interface or Laser Control HSIO, create the External Select node
in the job tree. Then right click on the node and select "Xplore". Now enter the path ExtSelect (or
<name> of the ExtSelect node, if you changed its name)→ <unnamed> Set variable.

In this list you can select the ASE user or Laser Control HSIO port by clicking on the corresponding
"p_seln"-variables. You may also select each port number in the corresponding "i_seln"-variables.

Example
In this example selection SEL_0 is assigned to Input8 (see theManual -- NCC System Controller) and se-
lection SEL_1 is assigned to Input9.
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5.66. Framegrabber

That way up to 4 subtrees can be selected (in the following figure: ExtSelect_example1). Because
characters other than 0 (zero) and 1 are ignored, several subtrees can be selected by 1 bit pattern as
well (in the following figure: ExtSelect_example2). In this case the collectively selected subtrees will
be executed top down (in this case Collect nodes (see 5.31 Collect) with the needed functionality below
them are used as subtrees).

5.66. Framegrabber

This node allows to grab images with a video capture device.
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5. Job Nodes

5.66.1. Edit - Shared GUI Elements

Node Name see section 5.1 Shared GUI Elements

Action see section 5.1 Shared GUI Elements

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Restore see section 5.1 Shared GUI Elements

5.66.2. Edit - General

Purge if this check box is selected then all line data before the Framegrabber node will be output by
the scan head before executing the Framegrabber node

Move if this check box is selected then an image will be grabbed when the mirrors reach their
current position. Example: The Framegrabber node is child of a PosList node (see section 5.43
PosList). The position list defines where images have to be grabbed

Wait for completion if the check box is selected then the job will be paused until the image is
grabbed. If the check box is cleared then the job will be continued while grabbing
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5.66. Framegrabber

The check boxes Init grabber, Grab image and Deinit grabber can be used to optimize timing
when grabbing several images with the same video capture device. Example: A Framegrabber
node is child of a PosList node. The virtual grabbing is done by this node (Grab image selected).
The video capture device is initialized before the PosList node (Init grabber selected) and deini-
tialized after the PosList node (Deinit grabber selected).

NOTE

Trying to initialize an already initialized video capture device normally leads to an
error. In the example above this can happen if the job is aborted before it is deini-
tialized and restarted. Eithermanually deinitialize the video capture device or place
another Framegrabber node with Deinit grabber selected before the 1st Framegrabber
node with Init grabber selected. Use the latter method only if the video capture de-
vice is solely used by Framegrabber nodes and shall not to be available for other pro-
cesses.

Init grabber if this check box is selected then the video capture device in use will be locked for
other processes

Grab image if this check box is selected then the video capture device will grab an image when the
node is executed

Deinit grabber if this check box is selected then the video capture device in use will be unlocked
for other processes

Pre-Delay sets the time towait before grabbing an image. When e.g. switching between several not
externally synchronized cameras connected to 1 frame grabber, it takes time to synchronize
the frame grabber to the new analog signal and to stabilize the image

Post-Delay sets the time to wait before considering the grabbing as completed

Acquire manually grabs an image from the video capture device and saves it with the settings spec-
ified in the File-Settings tab

5.66.3. Edit - Grabber
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Select device opens the Select device window where a video capture device can be selected from a
list of available devices

Configure device opens the Configure device window where settings for the selected video capture
device can be done. Please refer to the video capture device documentation

5.66.4. Edit - File-Settings

Save-Mode selects how the file name is built

Single file the file name is built from Common and Format, e.g. Common=TESTandFormat=BMP
results in TEST.BMP

File counter the file name is composed of Common, the Counter with Digits length and the For-
mat, e.g. Common=IMAGE_, Counter=1, Digits=6 andFormat=TGA results in IMAGE_000001.TGA
for the 1st image

Date+Time the file name is composed of Common, the Format and the date (dd.mm.yyyy) and
time (hh.mm.ss.ms), e.g. Common=IMG_, Format=JPG and the image was grabbed at 5th
of December 2002 at 10:35:13 and 477 ms results in IMG_05.12.2002_10.35.13.477.JPG

File-Name

Common sets the common name of the file name

Counter sets the counter appended to the name beginning with the given value

Digits sets the number of Counter digits

Format selects the format the files are saved

BMP BMP format (Windows Bitmap)

JPG JPEG format (Joint Photographic Experts Group)

TGA TGA format (Truevision Targa)

Destination Directory selects the destination directory to save files to

opens the window Browse for Folder where a directory can be chosen to save the images in
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5.67. Select Font - Window

NOTE

Homonymous files will be replaced. Be careful selecting your filenames if you want
to keep the files.

5.67. Select Font - Window

Select the font to be used in this window.

Show InScript Fonts, TrueType Fonts, ROM Fonts, Raster Fonts, User Fonts

If the check box is selected then the corresponding fonts are displayed in the preview list

Preview-Text Font-Name; "The quick …"; User defined: …

selects, which text will be displayed in the preview list

Font Name the font name will be displayed

”The quick …” the sentence "The quick red fox jumps over the lazy brown dog.", which con-
tains all letters from a-z will be displayed

User defined a user defined text will be displayed

In the preview list in the left column the font names are displayed available from the font types
selected in the Show group. The names are preceded by a symbol indicating the font type. In
the right column the text defined in the Preview Text group is displayed in the corresponding
font

File Name shows the font name

File Path shows the path, where the font is located

OK see section 5.1 Shared GUI Elements

Cancel see section 5.1 Shared GUI Elements

Refresh refreshes the preview list of available fonts
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6. Job Control Window

The Job Controlwindow is the central control for executing jobs that are present in the Job Configuration
window.

6.1. How to Open the Window

� In the menu, click View→ Job Control.
— or —
Press the F9 key.
The Job Control window opens.

6.2. Description of the Window

Figure 14: Job Control window

ARGES logo the ARGES logo's beam will flash while the laser is processing

List with jobs selects a job for execution. Only jobs, from the Job Configuration window and with a
Job node as root node, are listed here

Preload if this checkbox is selected then processing –not the execution– of the job will be started
before clicking Job Start as far as the line buffer is sufficient. This may significantly speed up
execution time.

CAUTION

Wrong initialisation data

The controllerwill start calculating the job right away. So externally initialized vari-
ables, system time etc.may be wrongly or not initialized at all.

� Use this setting only if no dependencies on initialisation data exists.
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6.2. Description of the Window

Progress bar shows the interpolated progress of job execution. If the job execution time exceeds
the interpolated time the progress bar will flash until the job has ended. The execution time
will be interpolated from previous execution times of the job
Time to job end shows the estimated time until the job ends
Job duration shows the estimated job duration

Teach-in starts a teach-in. To use this button, a pen called pilot has to be created, see section
4.9.12 Teach-in pilot Pen and 3.3.4 Parametrize - Teach-In, that has a dist_xy pen section set,
where the Optical Path in the Common tab is set to e.g. Pointing Laser and in the sas pen section
under tab TeachIn the Use TeachIn checkbox is set. You may also press the F8 key instead

CAUTION

Visible and invisible laser radiation
If the pilot pen settings are set to a output range that is in a dangerous range, the
operator of the TeachIn is in hazard of injury!
We urgently recommend that the pilot pen settings are verifyed to be in a range that
is not dangerous.

TIP

Please be aware that if you execute TeachIn in standard configuration, only nodes
that are placed under Geometrical Operator nodes are output.

Job Start starts to process the selected job. You may also press the F5 key instead

Job Pause this button will replace the Job Start button if it is clicked. Momentarily Job Pause
is not implemented

Job Abort aborts the momentarily executed job immediately. You may also press the F7
key instead

Job Stop stop at the next Stop node, see section 5.45 Stop. You may also press the F6 key
instead

Safe State brings devices to a safe state. You may also use F9 for this functionality. Momen-
tarily Safe State is not implemented

Controller status shows the controller's status

Laser status shows the laser beam status: off or on
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Status text box shows the current system status: idle, ready, processing, failure, see section 8.8
System Status

6.3. Select Job for Execution

InScript can hold several jobs ready in the Job Configurationwindow. The root node of these jobs has to
be a Job node. To determine, which of these jobs shall be executed, it has to be selected for execution
first. Only one job may be selected at a time.

There are different, equally good possiblities to select a job for execution:

� In the Job Control window, select a job from the list.

NOTE

This is only possible with InScript v2.10.xx and higher. In previous versions of In-
Script this list was used to select an Execution Context — this feature is obsolete.

— or —
In the Job Configuration window in the Job node's context menu, click Select.
— or —
In the Job Configuration window, place the cursor on the Job node and press the Enter key.

The job will be loaded into the controller's line buffer. In the Job Configuration window the selected
job's icon will be framed with a red rectangle. For InScript v2.10.xx and higher a selected Job node
will be shown in the Job Control window in the list.

TIP

If you do the selection in the Job Configurationwindow then you may select the root node
of a job's subtree as well. This may save time when testing jobs. A selected subtree will
not be shown in the Job Control window in the list.

A selected job can be deselected in the same way. The job is deleted from the controller's line buffer
then.

6.4. Start (Execute) Job

Step 1 Select the job you want to execute, see section 6.3 Select Job for Execution.

Step 2 CAUTION

Visible and/or invisible laser radiation
The user is responsible for observing the laser safety regulations valid in his
country.
� Avoid eye or skin exposure to direct or scattered radiation.

To start the job, click .
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6.5. Abort Job Immediately

6.5. Abort Job Immediately

� To abort the job, click .

6.6. Stop Job at Next Stop Node

� To stop the job at the next Stop node, click .

NOTE

If there is no Stop node present in the job then the job will be executed to its end, see
section 5.45 Stop.

7. Vector Editor Window

The Vector Editor visualizes jobs and their output. The Vector Editor has 2 basic modes, the Editor and
the Preview mode. Both modes are described in the following sections.

7.1. Editor mode

In Editor mode the data is generated from the tree structure of the selected job or subtree in the Job
Configuration window. In Editor mode graphical objects can be directly added, edited and modified
in the Vector Editor window. Additional information like start points and direction arrows can be
shown.

Open the Vector Editor window in Editor mode as follows:
� In the menu, click View→ Editor→ Editor.

— or —
In the toolbar, click the small black triangle in and then click Editor.
The current mode is marked with a dot.
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7. Vector Editor Window

7.2. Preview mode

In Preview mode the actual line data rendered by the controller's DSP (Digital Signal Processor) is
shown in the exact order and scaled to the field size as the scan headwould output these lines. Editing
in the Vector Editor window is not possible in this mode, but arrows, head, jump and tail vector lines
can be shown as additional information, see section 3.10 How InScript handles lines in general.

Open the Vector Editor window in Preview mode as follows:

� In the menu, click View→ Editor→ Preview.
— or —
In the toolbar, click the small black triangle in and then click Preview.
The current mode is marked with a dot.

7.3. Fast Toggeling of Editor and Preview Mode

Requirement The Vector Editor window has to be open.

� In the Vector Editor's View toolbar (shown undocked in figure below), click Show Editor or
Show Preview .

↔

7.4. Toolbars

On the left side of Vector Editor its toolbars are initially docked.

472 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



7.4. Toolbars

Here is a description of the Vector Editor toolbars:

7.4.1. Mode

The Mode toolbar combines the following tools which can be applied in the Vector Editor window.

Modify Object(s) to open the Select toolbar, click for the time set in section 8.4.28 Sub Category
- User Interface Popup after theModify Object(s) symbol. This toolbar provides tools for selecting
objects and to edit them in the Vector Editor window

Handle Objects selects single graphical objects or groups of objects

Handle Elements Some nodes are composed of several graphical objects. Such nodes are
e.g. the nodes Mat2Off, PosList, RawLines and Tiling-Tiles. The Handle Elements tool selects
single graphical objects or groups of these objects within these nodes. This symbol is not
active until such a node has been selected with the Handle Objects tool
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Handle Points In some nodes graphical objects are defined by points. These are e.g. end
points of lines within the nodes RawLines and Tiling-Tiles. The Handle Points tool selects
single points or groups of points within these nodes. This symbol is not active until such
a node has been selected with the Handle Objects tool

Select all objects selects all objects in the Vector Editor window

Deselect all objects removes all selections from objects in the Vector Editor window

Select previous object selects the objectwhich precedes the actual object in the internal
list. In the internal list the objects are listed in the order they were created

Select next object selects the object which succeeds the actual object in the internal list.
In the internal list the objects are listed in the order they were created

Point operator these operators are only active if the ob-
ject selected inVector Editor is composed of points, like e.g. end points of lines in the nodes
RawLines and Tiling-Tiles and the Editor is in Handle Points mode:

Create Dot creates a single dot

Create line creates a line consisitng of 2 dots

Append line appends a line to a selected point

Split path splits a path of lines at a selected point

Join joins two selected points

Connect connects an end point (last point of a line path) and a start point (big rectangle
at the beginning of a line path) of a line path with a new line

Make path(s) first in list makes selected path(s) first in the RawLines list, see section
5.22 Raw Lines, so it is output first

Move path(s) up in list moves selected path(s) one position up in the RawLines list,
see section 5.22 Raw Lines, so it is output one position earlier

Move path(s) up in list moves selected path(s) one position down in the RawLines list,
see section 5.22 Raw Lines, so it is output one position later

Make path(s) last in list makes selected path(s) last in the RawLines list, see section
5.22 Raw Lines, so it is output last
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Reverse path(s) reverses the order of the selected path(s) last in the RawLines list, see
section 5.22 Raw Lines

Enter offset and add it to selected points opens the Enter Offset dialog and offsets
all selected points by the entered values after pressing OK

Create Object(s) to open the Create toolbar, click for the time set in section 8.4.28 Sub Category
- User Interface Popup after the Create Object(s) symbol. This toolbar provides tools to create
objects directly in the Vector Editor window

NOTE

In Preview modes of the Vector Editor this toolbar is not active.

Create HPGL File Link creates a HPGL-File-Link node, see section 5.12 File Link (HPGL)

Create Bitmap File Link creates a Bitmap-File-Link node, see section 5.13 Bitmap

Create Dot creates a Dot node, see section 5.14 Dot

Create Shape creates a Shape node, see section 5.15 Shape

Create Polygon creates a Polygon node, see section 5.16 Polygon

Create Concentric Circles creates a Concentric Circles node, see section 5.17 Concentric
Circles

Create Text creates a Text node, see section 5.18 Text

Create RoundText creates a Round Text node, see section 5.19 RoundText

Create Barcode creates a Barcode node, see section 5.20 Barcode

Create 2D-Barcode creates a 2D Barcode node, see section 5.21 Barcode 2D

Create RawLines creates a RawLines node, see section 5.22 Raw Lines

Create Spline creates a Spline node, see section 5.23 Spline

Create Spiro creates a Spiro node, see section 5.25 Spiral

Change Zoom State to open the Change Zoom toolbar, click for the time set in 8.4.28 Sub Cat-
egory - User Interface Popup after the Change Zoom State symbol. This toolbar provides tools to
increase and decrease the view zoom factor and to adapt the view in the Vector Editor window,
see also section 8.6 Birdview.

Scale view by window changes themouse pointer to amagnifying glasswith a cross hair
and lets you drag a bounding box over the area you want to zoom. Aspect ratio of the
zoomed part will be adjusted to the Vector Editor window
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Increase view scale zooms into the view. You can also achieve this effect by scrolling an
(optional) mouse wheel away from you

Decrease view scale zooms out of the view. You can also achieve this effect by scrolling
an (optional) mouse wheel toward you

Scale view to real size tries to scale the Vector Editor image closely to the real output
size. On many output devices, like e.g. CRT-monitors, the width and height can vary in a
wide range, therefor the view will often only approximate the real size

Scale view by factor opens a window where the zoom factor can be input

Scale view to current selection scales the view so that the selected object(s) fit(s) into
the view

Fit page to window scales the view so that the whole output area fits into the Vector
Editor window

Fit page height to window scales the view so that the output area height fits into the
Vector Editor window

Fit page width to window scales the view so that the output area width fits into the
Vector Editor window

Pan view pans a partial view in the Vector Editor window:

Step 1 Place themouse pointer on a point in theVector Editor view and hold the leftmouse
button pressed.
In that way you "grab" the drawing area.

Step 2 Drag theVector Editor viewmoving themouse pointer until thewanted partial view
can be seen.

Step 3 Release the mouse button.
You may eventually repeat this procedure until the view is adjusted.

Measure length and angle measures the distance and angle between objects in the Vector Ed-
itor window:

Step 1 Place themouse pointer on the start point inVector Editor, where youwant to begin
your measurement, and hold the left mouse button pressed.

Step 2 Move the mouse pointer to the wanted end point.
As long as you hold the leftmouse button pressed, a yellow rectanglewill be shown
at the left bottom edge of the Vector Editor window. In this rectangle the dis-
tance between start and end point and the angle between the line connecting these
points and the coordinate system's X-axis will be shown.

Step 3 Release the mouse button.
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7.4.2. Action

The Action toolbar combines possible user actions.

Refresh line data/Refresh DSP data refreshes the data shown in the Vector Editor window:

• In Editor mode: Refresh line data updates the line data calculated from the active job's tree
structure, see section 7.1 Editor mode

• In Preview mode: Refresh DSP data updates the DSP data calculated by the controller's DSP
(Digital Signal Processor), see section 7.2 Preview mode

After pressing , the button will change to until the refresh is done. While the refresh is
in progress, it can be canceled by clicking the symbol.

Incremental Paint of DSP-Data opens the Incremental View Of DSP-Data window. This func-
tion is only available in Preview mode and only shows all data if a detailed mode with Show
Arrows and Show Head / Jump / Tail is set, see section 7.4.3 View. Sequence, timing and other
data of the DSP line data can be stepped through and visualized in Vector Editor using this tool.
Use this tool for debugging or optimization.

NOTE

While a refresh is in progress, Incremental Paint of DSP-Data and some of the icons in
toolbar View will not be available, see section 7.4.3 View.

Line Data slider use this slider to step through all line data displayed in Vector Editor. The
stepping of the line data is reflected in the Vector Editor window while dragging the slider

First element jumps to the first element in the DSP line data

Previous line path jumps to the first line (head) of the previous line path

Previous element jumps to the previous element

Line Number input field you can enter a line number into this field. Up to this line the data
will be output and the slider will be set to this line
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Next element jumps to the next element

Next line path jumps to the first line (head) of the next line path

Last element jumps to the last element in the DSP line data

Redraw window refreshes the Vector Editor window

Show VectorEditor PenSettings Dialog opens the Editor Pen-Settingswindow, see section 8.4.14
Sub Category - Screen Styles / View Styles / Editor Mode Vector Editor Pen Settings

7.4.3. View

In the View toolbar you can configure the mode and style of the Vector Editor output.

Show Editor switches to Editor mode, see section 7.1 Editor mode. It toggles with

Show Preview switches to Preview mode, see section 7.2 Preview mode. It toggles with

Show StartPoints shows the start points of line paths. This symbol is not active in Preview
mode

Show Arrows shows processing direction arrows

Show Head / Jump / Tails shows head, jump and tail lines, see section 3.10 How InScript
handles lines in general. This symbol is not active in Editor mode

Show Customized shows lines with customized line colours, width and transparency, see sec-
tion 10.9 Visualize Stacked Objects in VE Edit and Preview Mode

7.5. Context Menu
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7.5. Context Menu

The Vector Editor context menu handles all kinds of object related tasks.

NOTE

The Vector Editor's context menu's contents depend on the selected objects and on the
current mode of the editor (handle objects, handle elements or handle points see 7.4.1
Mode). So not all of its entries are always available!

Edit Job Node open the Job editor of the node object beneath the cursor

Edit Transformation opens the parent Transformationnode of an object. This item is only available,
if the Vector Editor object has a Transform node as parent. This is automatically created if you
scale or move the object

Edit Size opens a Width and a Height dialog for the node object beneath the cursor. This item is
only working, if the Vector Editor object has a Transform node as parent. This is automatically
created if you scale or move the object

Delete Job Node deletes the node object beneath the cursor after a security dialog

Handle Objects see 7.4.1 Mode Handle Objects

Handle Elements see 7.4.1 Mode Handle Elements

Handle Points see 7.4.1 Mode Handle Points

Edit to edit Vector Editor nodes in element or point mode use the Edit submenu

Cut cut a selected element of the curent object in element mode to clipboard

Copy copy a selected element of the curent object in element mode to clipboard

Paste paste an element from clipboard to the current object in element mode

Delete delete a selected element or point in the current object in element or point mode

Select all select all elements or points in the current object in element or point mode

Deselect all deselect all selected elements or points in the current object in element or point
mode

Modify to Modify Vector Editor nodes in element or point mode use the Modify submenu. See 7.4.1
Mode Point operator

Auto Join Paths tries to automatically join paths at selected line end / line start point pairs that lie
on the same coordinates

Apply Apply all changes to the controller board

Refresh Refresh settings from controller board

Zoom to zoom in Vector Editor use the Zoom submenu (see also 7.4.1 Mode Change Zoom State)

Zoom In zooms into Vector Editor at the current cursor position

Zoom Out zooms out of Vector Editor at the current cursor position

Zoom To Object zoom near the object under the cursor
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Fit To Window scales the view so that the whole output area fits into the Vector Editor win-
dow

Xplore open the Xplorer at the object's variables that is under the cursor

Info gives Info data of the object under the cursor

Dump gives Dump data of the object under the cursor

Name To Clipboard copies the ful path of the object under the cursor to clipboard

7.6. Rulers

Lines that extend from themouse pointer show the actual position of themouse pointer on the rulers.

7.6.1. Set Origin

Step 1 In the point of intersection of both rulers position the mouse pointer on the symbol

Step 2 Hold the left mouse button pressed and drag the mouse pointer to the desired position
on the coordinate system

Step 3 Release the left mouse button.
The ruler origin is set to the actual position of the mouse pointer.

7.6.2. Center Origin

� To center the ruler origin in reference to the scan field, double click the symbol

7.7. Status Bar

The status bar contains following indicators (from the left to the right):

shows the status in form of
a color LED
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7.8. Coordinate System

red The computing power of the system is fully required by the Vector Editor or another
process. The Vector Editor is not ready and neither keyboard nor mouse input is possible

yellow Line data is still requested. The Vector Editor is conditionally ready

green The Vector Editor is ready

shows the zoom factor

shows the actual position (X,Y)
of the mouse pointer

shows the offset (dX, dY) dur-
ing moving, the scaling factor (sX, sY) during scaling, the angle (dA) during rotating as well as
the slant factor (slX, slY) during slanting of objects

shows a status text

shows thenumber of selected
objects

7.8. Coordinate System

The left figure shows how the coordinate system on the target beneath the scan head is oriented by
default. How to change this scan field orientation on the target can be found in the Manual -- Scan
Head.

NOTE

You will have to create a new scan field correction, if you do this. The right figure shows
how the coordinate system is oriented by default in Vector Editor. How to change the
page size and the orientation of the coordinate system in the Vector Editor can be seen
under 8.4.15 Sub Category - Screen Styles / Page.
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7.9. Manage Objects in Vector Editor

Graphical objects can be modified directly in Vector Editor if it is set to Editor mode (see 7.1 Editor
mode) and a Job is selected in Job Configurationwindow using the Show VectorEditor View in the context
menu.

You may create, select, offset, scale, rotate and slant an object. A corresponding Transformation node
(see 5.8 Transform) xf will be automatically placed above the object(s) you edit in the Job tree in the
Job Configuration window.

All these tranformations can also be achieved by making numerical inputs in parent Transform nodes
(see 5.8 Transform), Rotate nodes (see 5.4 Rotate), Scale nodes (see 5.5 Scale), Slant nodes (see 5.6 Slant)
or Offset nodes (see 5.7 Offset) of objects.

7.9.1. Add View of Node or Subtree from Job Configuration to Vector Editor

See also 4.6.27 Show VectorEditor View.

Step 1 Select the subtree root node you want to view in the Vector Editor view.

Step 2 In the context menu, click Add Vector Editor View.
The subtree lines are displayed in the Vector Editor view.

7.9.2. Remove View of Node or Subtree from Vector Editor

See also 4.6.28 Remove VectorEditor View.

Step 1 Select the subtree root node you want to remove from the Vector Editor view.

Step 2 In the context menu, click Remove Vector Editor View.
The subtree lines are removed from the Vector Editor view.

7.9.3. Create Objects

Youmay create anObject either in Job Configurationwindow (see 4 Job ConfigurationWindow) or using
the 7.4.1 Mode Create Object(s) tool bar.

7.9.4. Select Objects

To edit an object in Vector Editor, you can select it directly by clicking it with the mouse pointer (be
sure you click on a line of the object to select it unless you set Treat all objects as filled in 8.4.6 Category -
Vector Editor) or right click the node you want to edit in Job Configuration and select Select in VectorEd-
itor. this can be helpful if several objects are stacked. See also chapter 4.6.29 Select in VectorEditor.
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• Multiple objects can be selected by pressing Shift and sequentially click the objects
--or
click on a free space in the drawing area and open a dotted bounding box around all objects
you want to select

• to seelct all objects in Vector Editor use Select all objects in the Mode toolbar (see 7.4.1 Mode)
• If Objects are stacked on each other you can select themby pressing Alt and clicking the objects
until the wanted is selected.

7.9.5. Deselect Objects

To deselect a single object, hold the Shift key and click the object in Vector Editor or right click the
selected node you want deselect in Job Configuration and select Deselect in VectorEditor. this can be
helpful if several objects are stacked. If you want to deselect all selected objects, just click on a clear
space in the editor.

7.9.6. Offset (Move) Objects

To move objects, just click on the object a bounding box around the object with an X in the middle
wll be shown.

If you click and drag the X then the object will be moved.
The exact offset will be shown in the Vector Editor status bar (see 7.7 Status Bar).

7.9.7. Scale Objects

To scale objects, just click on the object a bounding box around the object with rectangles along the
side will be shown.
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• If you click and drag one of the rectangles on the corners of the bounding box, the object will
be scaled mainaining its aspect ratio

• If you click and drag one of the rectangles on the sides of the bounding box, the object will only
be scaled in the direction of the mouse movement loosing its aspect ratio

• If you additionally press Shift while scaling an object, it will be scaled expanding from its
center

• If you additionally press Control while scaling an object, it will be scaled in steps as defined
under 8.4.6 Category - Vector Editor Stepwidths for stepwise operations.

The exact scaling amount will be shown in the Vector Editor status bar (see 7.7 Status Bar).

7.9.8. Rotate Objects

To rotate objects, just slowly click twice on the object a bounding box around the object with rounded
arrows at the corners will be shown.
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• If you click and drag one of the rounded arrows on the corners of the bounding box, the object
will be rotated

• To move the rotation center, just click and drag the point and circle in the center of the object
to the desired position

• To modify the rotation center of the object right click the point and circle in the center of it. A
context menu with he following items is shown:

Set RotationCenter a Set rotation center window opens. Here you can enter the inates of the
rotation center in absolute or offset coordinates

Reset RotationCenter resets the rotation center to the center of the object

Reset X-Position only only resets the rotation center's x coordinate to the center of the
object

Reset Y-Position only only resets the rotation center's y coordinate to the center of the
object
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The exact rotation in degree will be shown in the Vector Editor status bar (see 7.7 Status Bar).

7.9.9. Slant Objects

To slant objects, just slowly click twice on the object a bounding box around the object with double
arrows at the sides will be shown.

• If you click and drag one of the double arrows on the side of the bounding box, the object will
be slanted

• If you additionally press Shift while slanting an object, it will be slanted around its center
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• If you additionally press Control while slanting an object, it will be slanted in steps as defined
under 8.4.6 Category - Vector Editor Stepwidths for stepwise operations.

The exact slant amount will be shown in the Vector Editor status bar (see 7.7 Status Bar).

7.9.10. Keyboard Shortcuts

While working with the Vector Editor some actions can be done using keyboard shortcuts instead of
using the mouse.

Shortcut Description
F5 redraws the window
Ctrl + A select all objects
ESC de-selects all objects
Tab selects next object,

if no or exactly one object is selected
Shift + Tab selects previous object,

if no or exactly one object is selected
Del deletes selected object(s)

after a confirmation
←, ↑, ↓ or→ moves the selected object left, up, down or right
Ctrl +←, ↑, ↓ or→ moves the selected object in small steps left, up, down or right
Shift +←, ↑, ↓ or→ moves the selected object in bigger steps left, up, down or right
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8. Toolbars, Menus and Other GUI Components

All remaining GUI components are described in this chapter. Most of them are accessible via InScript
Windows toolbar or using the InScript menu.

8.1. InScript Toolbars

Here is an overview of the InScript Window main toolbars.

8.1.1. Standard Toolbar

Here you can see the Standard toolbar undocked:

Open Job opens the Open file dialog. Here you can load a Job file (see 4.6.3 Open Job). You may
use Ctrl+O to access this function

Clear + Load Job opens the Open file dialog. After you choose a job file, and open it, all nodes
under Exec will be cleared and the selected job is loaded (see 4.6.9 Clear and Load Job)

Save Job if the cursor in Job Configuration opens the Save Job window. If the cursor in the Job
Configuration window window is on a job, you can save it clicking this icon (see 4.6.5 Save Job)

Show ProntOptions dialog, then print output on Form if the Vector Editor window is ac-
tive, clicking this icon opens the Print window
Source Tab in this tab the graphics area to print is defined
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Output Area selects the area, that shall be printed

As shown in Vector Editor prints the current Vector Editor view

Bounding box of all Objects prints all objects

Bounding box of selected Objects prints selected objects

Whole page prints the whole output area

User defined size prints a part of the output area, as defined in group User defined
sector size

User Defined Size

Unit selects the unit for all values in this group. Possible values are µm, mm, cm
and m

Left, Top, Right, Bottom size of the printed area with regard to the coordinate
system in the Vector Editor window

NOTE

Enter only valid coordinates, i.e. Left < Right, Top > Bottom.

Scale Output selects the scale the area shall be printed with

To best fit the print area is scaled that it fits best onto the paper (aspect ratio is
preserved)

By factor the area is scaled to the given factor

Mirror Output mirrors the output as specified

In horizontal direction if this check box is selected the output is mirrored in hor-
izontal direction (not implemented if grayed)

In vertical direction if this check box is selected the output is mirrored in vertical
direction (not implemented if grayed)

Miscellaneous tab more output options can be set in this tab
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Printer opens the category Global→ Printing→ Printer-Settings in preferences

Page opens the category Global→ Printing→ Page Margins in preferences

Style opens the category Editor→ Printer-Styles→ Common in preferences.

NOTE

Preferences categories View-Styles, Page and Grid also contain settings that affect
printing.

Print In

Color prints the lines in color on a color printer

NOTE

The used printer has to be configured for color printout.

Gray scale prints the lines in gray scales

Black and white prints in black and white

Descriptions

Node name if this check box is selected then the node namewill be printed in the upper
info area

File name if this check box is selected then the file name will be printed in the upper
info area

Date and time printed if this check box is selected then the current date/time will be
printed in the upper info area

Date and time created if this check box is selected then the file date/time will be
printed in the upper info area

Reproduction ruler if this checkbox is selected then a ruler and the scalewill be printed
in the lower info area

Reproduction factor if this check box is selected then the zoom factor will be printed
in the lower info area

Font

Name opens the Select Font window

Description size sets the info text size

Ruler label size sets the ruler label size

Show Warning

Output exceeds printable area if this check box is selected and the output area does
not fit to the printable area then a warning will be displayed

Print prints the defined graphics area

Cancel cancels printing
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8.1.2. Windows Toolbar

Here you can see the Windows toolbar undocked:

Close Job Editors close all job editors (see 8.2 Close Job Editors)

Show Xplorer opens an Xplorer window (see 8.5 Xplorer)

Show Job Configuration opens the Job Configurationwindow (see 4 Job ConfigurationWindow)
if it is not already open

Show Devices opens the Devices window (see 2 Devices Window) if it is not already open

Show Vector Editor opens the Vector Editor window (see 7 Vector Editor Window) if it is not
already open. If you click on the black triangle, you may choose the Vector Editor mode Editor
(see 7.1 Editor mode) or Preview (see 7.2 Preview mode)

Show Birdview opens the Birdview window (see 8.6 Birdview)

Show Quick Settings opens the Quick Settings window (see 8.7 Quick Settings)

Show System Status opens the System Status window (see 8.8 System Status)

Show Preferences Dialog opens the Preferences Dialog (see 8.4 Preferences). You may use
Ctrl+P to access this function

8.2. Close Job Editors

Sometimes Job Editors "get lost" behind the main InScript window. If you want to be sure that all of
these editors are closed use this functionality.

To close all open Job Editor windows click on Close Job Editors in InScript Windows toolbar or press
Shift + F4.

8.3. InScript Menu

Here is an overview of the main menu items of InScript.

8.3.1. File

New Job inserts a new Job node into the subtree Exec in Job Configuration window

Open Job opens a job file
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Load File opens a job or graphics file

Save Job saves a job. If several jobs are available then a menu is displayed where the job can be
selected

Save Job As saves a job under a new name. If several jobs are available then a menu is displayed
where the job can be selected

Save All User Files saves all subtrees which have a Job node as parent node

<File History> shows the recently opened jobs. You can select any dissplayed job to load it

Close Board closes the InScript window of the current controller. If the last InScript window is
closed then the InScript software is closed

Exit InScript exits InScript

8.3.2. Controller

Configure opens the Board Configuration window (only on NCC controller)

Save Devices and Default Pen (NVRam) saves thedevices and thedefault pen to the controller’s
NVRam (NCC) or to a file on the controller (ASC)

Flash opens the Openwindow, fromwhere the firmware or a backup can be loaded to the controller
(only on NCC controller)

Backup opens the Save Aswindow, where the firmware or a backup can be saved from the controller
(only on NCC controller)

Delete opens the Delete window, where to choose which data shall be deleted from the controller
(only on NCC controller)

Reset resets the controller after a confirmation (only on NCC controller)

Reconnect re-connects the controller after a confirmation (only on ASC controller)

8.3.3. View

Controllers if several controller boards are in one PC and/or remote controllers are connected (see
8.4.23 Sub Category - Startup formore information how to configuremultiple controllers) then
InScript windows for further controller boards can be opened from this list. youmay also open
windows for controllers that were newly added via 8.4.23 Sub Category - Startup

Job Control opens the correspondingwindow (6 Job ControlWindow). If themenu item is checked
then the window is already open

Job Configuration opens the corresponding window (4 Job Configuration Window). If the menu
item is checked then the window is already open

Birdview opens the corresponding window (8.6 Birdview). If the menu item is checked then the
window is already open
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Editor opens the Vector Editor window (7 Vector Editor Window). If the menu item is checked then
the window is already open. In a sub menu the Vector Editor modes Editor or Preview can be
toggled. A dot shows which of the VE modes is active

Quick Settings opens the corresponding window (8.7 Quick Settings). If the menu item is checked
then the window is already open

Devices opens the correspondingwindow (3 Devices). If themenu item is checked then thewindow
is already open

System-Status opens the corresponding window (8.8 System Status). If the menu item is checked
then the window is already open

Messages opens the corresponding window (8.10 Messages). If the menu item is checked then the
window is already open

Filesystem Browser very rudimentary controller file system browser. If the menu item is checked
then the window is already open

Node Inspector opens the correspondingwindow (8.9Node Inspector). If themenu item is checked
then the window is already open

Xplorer opens the corresponding window (8.5 Xplorer). If the menu item is checked then the win-
dow is already open. Multiple Xplorer may be opened

Load Layout loads a saved layout of windows (8.17.4 Save/Load Window Layout)

Save Layout saves the current layout of all windows and their state (8.17.4 Save/LoadWindow Lay-
out)

Mode in a sub menu you may toggle between Operator and Supervisor mode (9 Supervisor and
Operator Mode). A dot shows which of the modes is active

8.3.4. Service

Service Data opens the Edit Service-Information window, where service events of your laser can
be managed. To create a new entry in the Navigate list click the button Add. If you double click
on a list item in the Navigate list, the data for this entry is displayed and can be modified. This
dialog is laser specific
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Service Options opens the Edit Service-Options window, where service intervals that will be dis-
played automatically can be set. This dialog is laser specific and not available for all laser types.
The laser (e.g. CW200S, IDAR, SL902, Generic Laser, Lasag Laser, Haas Laser oder SL 4xx/8xx)
has to be active or in a failure state to have this menu option available

8.3.5. Extras

Beam Profiler opens the Beam Profiler window, where a beam profile can be analyzed (8.11 Beam
Profiler)

Video Capture Device opens a video capture device dialog (a video capture device is required see
8.12 Video Capture Device)

Align Target opens the Align Targetwindow, by which targeting tools (cross-hair or a target image)
can be positioned in the scan field (frame grabber required see 8.13 Align Target)

Convert Font to FDT opens the Select Font window. After selecting a font it can be saved in FDT
format that is supported by ARGES controler (8.14 Convert Font to FDT)

Create Support-Info opens the InScript Support-Info Wizard (8.16 Create Support Info)
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8.3.6. Options

Preferences opens the Preferences window to set all basic settings (8.4 Preferences

Administrator Password opens the Password window to set the password for toggling between
operator and administrator mode (9.1 Set and Edit Password)

Password active activates or deactivates the operator and administrator mode password. If the
menu item is checked then the password is active (9.2 Activate and Deactivate Password)

8.3.7. Windows

Close Job Editors closes all open job editor windows. Also hidden job editor windows (e.g. behind
the main window) are closed

<Window list> hiddenwindows (e.g. behind themain window or other windows) can be accessed
from this list and sent to the front. If a window is out of bounds (viz. its coordinates are outside
of the visible desktop coordinates) and you selcet it from the Windows menu, this window is
moved to visible coordinates and to the front

8.3.8. Help

Contents n/a

Index n/a

Find n/a

How n/a

About displays detailed information about ARGES, the software version and firmware version

8.4. Preferences

In the Preferences window the preferences for InScript are set. The possible settings are combined
in categories and presented in a hierarchical tree structure. This structure groups preferences in
related topics.
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The Preferences window is seperated in two parts. Te left part is a tree that is arranged in categories.
If you choose a topic on the left side of the window, then you will get the related parameters on the
right side of the dialog.

To open the Preferences window press Show Preferences dialog in InScript Windows toolbar, use
Options / Preferences in the main menu or press Ctrl + P simulataneously.

8.4.1. Category - Board nnnnnnnn or xxx.xxx.xxx.xxx

In category Board preferences are made for each individual controller board. NCC Controllers will be
represented by their number (nnnnnnnn) and ASC Controllers by their IP address (xxx.xxx.xxx.xxx).
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Start in selects, whether the Board window is opened in Supervisor mode or in Operator mode on
initial start (9 Supervisor and Operator Mode)

Supervisor mode all available information and settigns will be displayed in InScript

Operator mode only the information necessary for operation will be displayed in InScript

Clear + Load selects, how InScript will behave when you click the symbol in the Standard tool
bar

Select job if this check box is selected then the job automatically will be selected for execu-
tion

Execute flash reorganization if this check box is selected then the controller board flash
memory will be reorganized before loading a job

Bitmap upload warning Maximum size size of a bitmap file on the controller board abovewhich
a warning will be displayed and the file will not be uploaded. Enlarge this value to be able
to upload larger files to the controller.

NOTE

Do not enlarge this value too much (esp. on NCC controllers) because only a
limited amount of memory is available. Better use Streaming for bitmaps in that
case (see 5.13.1 Edit - General)!

If bitmap files are uploaded to the controller board then they are automatically converted
into bitmap files with a color depth of 8 Bit gray scales. A bitmap file, which has e.g. a
color depth of 24 Bit and a file size of 500 kByte, needs on the controller board approx.
170 kByte.
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8.4.2. Category - Auto Upload

Using the settings in Auto Upload you decide, if and when InScript automatically uploads files from
a local folder to the controller board.

Enable auto upload if this check box is selected then InScript searches in a defined folder on the
PC or on the network. The folder's contents will be uploaded to the controller board and even-
tually executed (see 8.4.3 Sub Category - Before Upload, 8.4.4 Sub Category - Upload and 8.4.5
Sub Category - After Upload)

Directory sets the folder in which InScript will search for auto load data

opens the Browse for Folderwindow, where you can select the folder in which InScript shall search

File filter sets the filter for filename(s) which shall be uploaded from Directory

8.4.3. Sub Category - Before Upload

Using the settings in Before Upload you define how InScript shall behave before files are automatically
uploaded from a folder to the controller board.

NOTE

Only if the check box Enable auto upload is selected in category Auto Upload then it is
possible to make any settings here.

498 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



8.4. Preferences

If board is marking

Abort running mark if a File filter file is present in the Auto Upload Directory then the running
job will be aborted

Wait for completion if a File filter file is present in the Auto Upload Directory then the running
job will be completed

Clear board before upload if this check box is selected then the user data (jobs, files, pens etc. )
will be deleted from the controller board before the sought-after file(s) will be uploaded

8.4.4. Sub Category - Upload

Using the settings in Upload you define, if the file shall be uploaded having a new name to the con-
troller board and which name the file shall get.

NOTE

It is only possible to make any settings here if the check box Enable auto upload is selected
in category Auto Upload.
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Substitute filename during upload if this check box is selected then the filewill be uploadedwith
the new name defined in Substituted filename to the controller board

Substituted filename sets the new name under which the file will be uploaded to the controller
board

8.4.5. Sub Category - After Upload

Using the settings in Upload you define, how InScript shall behave after files were automatically up-
loaded from a folder to the controller board.

NOTE

It is only possible to make any settings here if the check box Enable auto upload is selected
in category Auto Upload.
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Auto select if this check box is selected then the uploaded file will be automatically selected for
execution

Auto mark start if this check box is selected then the job will automatically be started as soon as
the file was uploaded

After execution selects, how the file shall be handled after the job was executed

Delete the file will be deleted from the file system

Move to archive the file will be moved to an archive folder (see Archives in this section)

Archives Directory sets the archive folder name, where the file will be moved to (see After exe-
cution in this section)

opens the Browse for Folder window, where you select the archive folder. The file will be
moved to a new sub folder in the archive folder

Max. archives sets the maximum number of sub folders in the archive folder that will be
created. If this number is exceeded then the oldest sub folder will be deleted and replaced
by the new sub folder

8.4.6. Category - Vector Editor

In this category the basic properties of the Vector Editor window are set.
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Haircross cursor if this check box is selected then a haircross cursor is displayed in addition to the
mouse pointer

Treat all objects as filled if this check box is selected then all objects will be handled like filled
objects. To select a "filled" object click on a place within the outline of the object. If the check
box is cleared then its outline has to be clicked to select the object

Snap cursor to grid if this check box is selected, the haircross cursor snaps to theVector Editor grid.
The grid properties can be defined in section 8.4.16 Sub Category - Screen Styles / Grids and
8.4.21 Sub Category - Printer Styles / Grids

Show objects during modification if this check box is selected and youmodify (e.g. move, rotate)
a object in Vector Editor then the object will be shown during modification. If the check box is
cleared then only a frame (bounding box) will be shown instead of the object. We recommend
to de-select the check box to speed up execution when objects have many lines

Stepwidths for stepwise operations this group combines settings for widths of stepwise opera-
tions in Vector Editor

Move, high/normal/low stepwidth sets 3 stepwidths formovingobjectswith the arrowkeys,
Alt-arrow keys and Shift-arrow keys in Vector Editor.

unit for the stepwith drop down

pixel the stepwidth is given in screen pixel

µm the stepwidth is given in µm

Rotate sets the rotation angle stepwidth used when objects are rotated by holding the Ctrl
key pressed at the same time

Scale and slant sets the scale and slant stepwidth used when objects are scaled or slanted
by holding the Ctrl key pressed at the same time
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8.4.7. Sub Category - Display

In this category the basic properties of the display are set.

Use graphics engine here you can set the Windows graphics engine that shall be used for Vector
Editor

Windows GDI Windows Graphics Device Interface

GDI plus Graphics Device Interface plus

Use antialiasing if this check box is selected then the lines will be antialiased in the Vector Editor

Line ends in Vector Editor lines are shownwith a width that can be set in section 8.4.13 Sub Category
- Screen Styles / View Styles / Preview Mode 8.4.14 Sub Category - Screen Styles / View Styles
/ Editor Mode. In the Line ends group you define, how the line ends look like. The result is
shown in the following figure. (The line with its end point is black and the line, how it can be
seen in the Vector Editor, is gray.)

Flat

Square

Round
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8.4.8. Sub Category - Rulers

Rulers

Show if this check box is selected then rulers are shown at the left and upper edge of the
Vector Editor drawing area

NOTE

To open this category automatically, double click the rulers in the Vector Editor
window.

Units sets the unit, the rulers are labeled with

List Items Description
meter, decimeter, centimeter, millimeter, possible units the rulers are labeled with
micrometer, yard, feet, inch, 1/10 inch,
1/100 inch, 1/1000 inch

8.4.9. Sub Category - Backdrop

The backdrop image is a special property of job nodes. Set the backdrop image as described in 4.6.30
Edit Backdrop Property.
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8.4.10. Sub Category - Screen Styles

In this category the object styles for the Vector Editor window are set.

8.4.11. Sub Category - Screen Styles / Common

Misc. appearances
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Minimal radius pixel sets the minimal radius Segment Start Points and single Points (Dots)
that are shown within the Vector Editor. This way small objects stay visible even if you
zoom out in Vector Editor

Show bitmap nodes as sets, how images of Bitmap File Link nodes or Bitmap nodes are shown

Simple Frame the image is shown as frame (bounding box)

Default Bitmap instead of the image the ARGES logo is shown

Original File the image is shown like it is in the original file, i.e. eventually in color

Gray Converted the image is shown in gray scale

8.4.12. Sub Category - Screen Styles / View Styles

In this category the graphical object properties are set for the Vector Editor view.

Select color for these settings select colors for Vector Editor objects

Selected objects sets the color used for objects selected in the Vector Editor

Subselected objects some nodes, like e.g. Mat2Off (see 5.36 Mat2Off), consist of several sub
nodes. Depending on the handlemode these nodes are handled as entire objects, elements
or points. Subselected objects sets the color for elements or points if this node is selected
in the Vector Editor

Inactive objects sets the color used for objects not selected in the Vector Editor view

Highlighted objects sets the color used for objects selected e.g. in the PosList node in the
Vector Editor view
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PosList alignment paths sets the color used for PosList nodeAlignment Paths (see 5.43 PosList)
in the Vector Editor view

PosList ramped points sets the color used for PosList node Ramped Points (see 5.43 PosList)
in the Vector Editor view

PosList repeated points sets the color used for PosList nodeRepeatedPoints (see 5.43 PosList)
in the Vector Editor view

Tiling Source sets the color used for the Tiling Source (see 5.47 Tiling), when theVector Editor
view is activated for a tile

Inactive Tiles sets the color used for tiles not selected in the Vector Editor view, when the
Vector Editor view is activated for a tile

Pen enlargement pixel enlarges the objects PosList repeated points and Tiling Source by the
set value. This makes the display of these objects more clear

8.4.13. Sub Category - Screen Styles / View Styles / Preview Mode

In this category the graphical object properties are set for the Vector Editor preview mode, cus-
tomized style. Some of these parameters affect the display of the line handling.

TheAppearance of data in previewmode group input boxes are combined in a table. The graphical objects
are arranged in rows. Their properties are arranged in columns.

Explanation of the rows. Settings can be made for the following graphical objects. These settings
affect only the preview mode with head, jump, tails and arrows:

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 507



8. Toolbars, Menus and Other GUI Components

Graph. object Description
Main Lines
Jump Jumps, i.e. scan head movements with the laser deactivated
Head Correction or "acceleration" lines at the beginning of lines
Tail Correction or "slow down" lines at the end of lines
Arrows Arrows at the end of lines

The line handling and thus head and tail are described in detail in device LINEPAR (line parameter)
in 3.10 linepar - Line Parameters.

Explanation of the columns. Settings can be made for the following graphical objects:

Parameter Description
Show If the check box is selected then the corresponding graphical

objects will be shown in preview mode
Head0 shows and sets the color of the corresponding graphical

objects for the first scan head
Head0 shows and sets the color of the corresponding graphical

objects for the second scan head
Size sets the line width of Main, Jump, Head and Tail and the

arrowhead length of Arrows respectively
Unit sets the unit for the value in Size. Pixel or µm can be

selected

8.4.14. Sub Category - Screen Styles / View Styles / Editor Mode

In this category the graphical object properties are set for the Vector Editor editor mode, customized
style. Some of these parameters affect the display of the line handling.
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Explanation of the rows. Settings can be made for the following graphical objects:

Graph. object Description
Path start pt’s Circle at the beginning of lines
Arrows Arrow at the end of lines
Def.pen, lines Lines in the Default Pen (Pen 1 Pen Settings)
Def.pen, dots Dots in the Default Pen (Pen 1 Pen Settings)

The line handling and thus head and tail are described in detail in device LINEPAR (line parameter)
in 3.10 linepar - Line Parameters.
Explanation of the columns. Settings can be made for the following graphical objects:

Parameter Description
Show If the check box is selected then the corresponding graphical

objects will be shown in editor mode
Color shows and sets the color of the corresponding graphical

objects
Size sets the line width of Def.pen, lines, the radius for Def.pen,

dots, and Segm.start pt’s and the arrowhead length of Arrows
Unit sets the unit for the value in Size. Pixel or µm can be

selected

Outline path start points if this check box is cleared then the Path start pt’s circles will be shown
filled

Outline dots if this check box is cleared then the Dots will be shown as filled circles
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Pen-Settings opens the Vector Editor Pen Settings window
Vector Editor Pen Settings Pen numbers can be assigned to pens (parameter sets) by the Pen Set

node (see 5.50 Pen Set). Pen numbers are used e.g. in HPGL files. That way pens can be selected
via the content of e.g. HPGL files during a job within a graphical object. In this window can be
set, how pens of such Pen Sets will be displayed in Vector Editor.

In this window the input boxes are combined in a table. The single pens are arranged in rows.
Their properties are arranged in columns.
Explanation of the columns. Settings can be made for the following parameters. These param-
eters can be set differently for lines and dots:

Parameter Description
Show If the check box is selected then the corresponding graphical

objects will be shown
Color shows and sets the color of the corresponding graphical

objects
Size sets the line width
Unit sets the unit for the value in Size. Pixel or µm can be

selected

Set Arges Default Colors sets all pens to ARGES standard colors
Set HPGL Default Colors sets all pens to HPGL standard colors
Enable All Pens selects all check boxes in the Show column
Disable All Pens clears all check boxes in the Show column

8.4.15. Sub Category - Screen Styles / Page

In this category the scan field properties regarding appearance in the Vector Editor are set.
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Size definition selects, how the page size shall be determined

Read from controller the page size will be determined from the settings in device dist_xy

User-defined the page size and coordinate system orientation in the Vector Editor will be de-
termined from the values set in the User defined size group

Enable / colors

Background shows and selects the background color of the area not belonging to the scan
field

Page shows and selects the background color of the page (whole scan field)

Page overlap shows and selects the color for page overlap. Such overlaps can occur with job
nodes like e.g. Dual Scan and Tiling

Axis shows and selects the color for the coordinate plane and the axes legend. If the check
box is selected then the coordinate plane and the axes legend will be shown

Move rect shows and selects the color for the rectangle, which encloses the area where the
scanner mirrors can move to. If the check box is selected then the Move rectangle will be
shown

Mark rect shows and selects the color for the rectangle, which encloses the area where the
laser beam is allowed to be on. If the check box is selected then the Mark rectangle will
be shown

Clip rect shows and selects the color for the rectangle, which encloses the output area. If the
check box is selected then the Clip rectangle will be shown

Beamclipping simulation if this check box is selected then in the page view the Vector Editor sim-
ulates shadowing effects within the scan head, e.g. page corners can be clipped
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User defined size settings for page size and coordinate system orientation in Vector Editor

Unit µm, mm, cm, m unit for the values Left, Top, Right, Bottom

Left, Top, Right, Bottom set the page size and coordinate system orientation in the Vector
Editor

NOTE

The page size and coordinate systemorientation inVector Editor are independent
from the scan field size and coordinate system orientation on the target. This
is useful, e.g. when transferring jobs from a scan head with a small scan field
to a scan head with a large scan field. Then the page size in Vector Editor can be
adjusted, that the graphical objects in a job can be seen properly even in viewing
the whole page.

8.4.16. Sub Category - Screen Styles / Grids

In this category the grid line properties are set.

Mode

Normal a fixed distance between the grid lineswill be used, as defined in theAppearance group
in the Size column

Dynamic a dynamic distance between the grid lines will be used, which will be adapted to
the zoom factor. The dynamic distance results from the setting in Units in category Rulers.
That way non-metrical distances between grid lines are possible

Show grid as

Lines the grid lines will be shown as lines
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Dots the grid lines will be shown as dotted lines

Appearance in thiswindow the input boxes are combined in a table. The distances between the grid
lines in X direction dx and Y direction dy are arranged in rows. Their properties are arranged
in columns.

Explanation of the column inscription. Settings can be made for the following parameters:

Parameter Description
Show If the check box is selected then the grid lines will be shown
Color shows and sets the grid line color
Size sets the distance between the grid lines
Unit sets the unit for the value in Size

8.4.17. Sub Category - Printer Styles

In this category the appearance of graphics on printed documents is set. In general the printer res-
olution is higher than the screen resolution. Compared to the Screen Style category therefore in the
Printer Style category higher values are necessary when entering parameters in pixel.

8.4.18. Sub Category - Printer Styles / Common

The settings correspond to the settings in 8.4.11 Sub Category - Screen Styles / Common.

8.4.19. Sub Category - Printer Styles / View Styles

The settings correspond to the settings in 8.4.12 Sub Category - Screen Styles / View Styles, 8.4.13
Sub Category - Screen Styles / View Styles / Preview Mode and 8.4.14 Sub Category - Screen Styles /
View Styles / Editor Mode.

8.4.20. Sub Category - Printer Styles / Page

The settings correspond to the settings in 8.4.15 Sub Category - Screen Styles / Page.

8.4.21. Sub Category - Printer Styles / Grids

The settings correspond to the settings in 8.4.16 Sub Category - Screen Styles / Grids.

8.4.22. Category - Global

In this category general inScript settings are made.
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8.4.23. Sub Category - Startup

In this category the InScript behavior at program start is set. This is one of the central settings to
determine which controller (ASC via IP or NCC on a PCI card in your computer) shall be loaded on
program start.

Run minimized if this check box is selected then InScript is started as a button in the task bar

Autostart InScript on Windows start if this check box is selected then InScript will be automat-
ically started when Windows is started

Connect Controllers

All local ISA Controllers if this check box is selected then InScript will connect to all local
ISA Controllers on startup

All local PCI Controllers if this check box is selected then InScript will connect to all local
PCI Controllers on startup

The following Remote Controllers if this check box is selected then InScrpt will connect
to the Remote Controllers in the list below this option

Controller list lists the Remote Controllers that InScript will connect to on startup

Add opens the Enter IP Connection window where the IP-address and the port for the Remote
Controller to be connected can be entered

Remove removes the selected Remote Controller from the Controller list above

View Controllers on Startup all connected Controllers (see Controller list above) are listed here.
To automatically open a Controller on InScript program start, select the corresponding check
box. If all check boxes are cleared then the first Controller in the list will be automatically
opened in InScript
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8.4.24. Sub Category - Shutdown

In this category the InScript behavior at program exit is set.

Save docking layout if this check box is selected and InScript is exited then the current Board
window layout will be saved to the file STANDARD.LAY in the InScript\bin folder

Save position and size of un-docked windows if this check box is selected then the un-docked
window position and size will be saved.

Confirm InScript shutdown if this check box is selected and InScript is exited the user will be
asked if he is sure to exit InScript

8.4.25. Sub Category - Message Handling

This category specifies, how InScript handles messages.
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Send MessageId to other applications if this check box is selected then MessageIds of the cor-
responding messages will be passed to other applications

Add entry to file ”message.log” if this check box is selected then themessages will be written to
the message.log file in the InScript\bin folder. This item is set by default and is not changeable
in the current version of InScript

Message list this list shows all possible messages and their IDs

8.4.26. Sub Category - File Handling

Here you can specify how InScript is storing recently used paths of file requestors
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Open/Save file dialogs open in

A fixed path all file requester will open using this path. The path that is set here will not be
modified by browsing to another folder in any file requester. The currently selected fixed
path will be shown in the Path list and can be modified as described below under Path list

Last used path all file requester will open using this path. The path will be modified, each
time you browse to another folder in any file requester. The currently active Last used
path will be shown in the Path list and can be modified as described below under Path list

Last used path all file requester will open using this path. The path will be modified, each
time you browse to another folder in any file requester. The currently active Last used
path will be shown in the Path list and can be modified as described below under Last used
path per file type file requester will open using the paths depending on the file type of a file
and each time you browse to another folder in a file type dependent file requester, this
path will be modified for the corresponding file type. Here are the currently supported
file types:

NOTE

<data folder> can be either the InScript installtion folder under operating sys-
tems≤Windows XP or the InScript Documents/InScript Application Data folder
(see InScript's Startmenu entries for these folders) on operating systems≥Win-
dows Vista.
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File type Description Standard Path XP|higher OS
Job *.job,*.tre <data folder>\Jobs|Jobs
Pen *.pen <data folder>\Pens|Pens
Font *.fdt,*.sfh <data folder>\Fonts|Fonts
Macro *.imc <data folder>\Macros|Macros
Rastergraphic BMP (*.bmp), JPEG (*.jpg,*.jpeg), <data folder>\Pics|RasterGraphics

TIFF (*.tif,*.tiff), PNG (*.png),
GIF (*.gif),
TARGA (*.tga,*.vst,*.icb,*.vda,*.win),
PCX (*.pcx,*.pcc,*.scr),
Photoshop (*.psd,*.pdd),
Portable Map (*.ppm,*.pgm,*.pbm),
SGI (*.bw,*.rgb,*.rgba*.sgi)

Vectorgraphic HPGL (*.hpgl,*.plt), <data folder>\HPGL|VectorGraphics
LG1 (*.lg1), IGES (*.igs),
Arges Rawline File (*.arl)
ACAD Draw. eXch. Format (*.dxf)
VeCAD Drawing (*.vec)

Distortion *.dst,*.aed <data folder>\Dist|Distortions
Layout *.lay*,*.bly*,*.tly* <data folder>\Config|Config
NCCFirmware *.fls,*.fb,*.ffb,*.fdb <data folder>\Firmware|Firmware
SaveAll Path for Save All User Files <data folder>\Temp|Temp

see 4.6.7 Save Multiple Jobs

All other file requester of less frequently used file types will open in the InScript instal-
lation path. The currently active Last used paths per file type will be shown in the Path list
and can be modified as described below under Path list

Path list corresponding to the settings in Open/Save file dialogs open in path entries are displayed in
the path list. If you click on a path entry in the list box, you can modify it in the Path edit box
or select a valid path by clicking on the browse button . If you click on Apply or OK, the new
path(s) will be used

Path selected entries of the Path list can be modified here

opens the Choose a directory dialog to browse for a valid path for the currently selected item of the
Path list

Default this button is only available, if Last used path per file type is selected. If this button is clicked,
then the standard folder in the InScript installation folder are preset

8.4.27. Sub Category - Job Creation

In this category the way is set, how job nodes are created.
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Insert job nodes as

first child if you add a new job node it will be inserted as first child to the current node (see
4.6.10 Create Node)

last child if you add a new job node it will be inserted as last child to the current node (see
4.6.10 Create Node)

8.4.28. Sub Category - User Interface

In this category the tool bar behavior, look and input filed sizes are set.
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Dialogs here the behaviour of Job Editor dialogs is set

Multiple Job Editors if this check box is selected then it is allowed to open Job Editor win-
dows (e.g. for a Shape and Text in Job Configuration ) for several Job Nodes in parallel. If this
check box is unchecked then opening a Job Editor while another is open will close this
first editor

Toolbars here the look of toolbars is set

Docked toolbars determines the look of docked toolbars

text only no icons, only text

small symbols only only small icons, no text

large symbols only only large icons, no text

large symbols, text beside large icons with text to the right

large symbols, text beneath large icons with text beneath

Floating toolbars determines the look of un-docked toolbars

text only no icons, only text

small symbols only only small icons, no text

large symbols only only large icons, no text

large symbols, text beside large icons with text to the right

large symbols, text beneath large icons with text beneath

Popup after determines the delay that Vector Editor toolbars with arrow (e.g. ) use
until their toolbar pops up. Below this delay the icon is selected (e.g. 250 ms = 1/4 second)
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Save toolbar positions if thsi check box is selected and InScript is exited then the tool bar
positions will be saved

Number formatting here the formats of numbers is set

Decimal places general sets the number of decimal places for real numbers except for
Xplorer

Decimal places Xplorer sets the number of decimal places for real numbers in Xplorer
(see 8.5 Xplorer)

8.4.29. Sub Category - Keyboard Shortcut

In this category buttons can be mapped to keyboard shortcuts. These settings can be activated or
deactivated.

NOTE

The keyboard shortcuts are only effective in job, pen and device windows.

Save changes and close dialog this key setting corresponds to the OK button

Enabled if this check box is selected then the keyboard shortcut is active.

Key input field set the cursor into this input field and type the key you want to use

Discard changes and close dialog this key setting corresponds to the Cancel button

Enabled if this check box is selected then the keyboard shortcut is active.

Key input field set the cursor into this input field and type the key you want to use

Restore settings in dialog this key setting corresponds to the Restore button
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Enabled if this check box is selected then the keyboard shortcut is active.

Key input field set the cursor into this input field and type the key you want to use

8.4.30. Category - Printing

In this category the properties for printing are set.

8.4.31. Sub Category - Printer Settings

In this category possible printer properties are set.

Printer Printer list select the printer you want to print on from the drop down list

Properties opens the standard Windows printer dialog. The dialog depends on the installed
printer driver

Paper

Size sets the paper size. The offered list items depend on the selected printer

Tray sets the paper tray. The offered list items depend on the selected printer

Format

Portrait the output will be printed in portrait format

Landscape the output will be printed in landscape format
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NOTE

Even in orientation Landscape captions will be positioned at the upper and lower
page border. On one hand this allows long captions (e.g. node or file names) on the
other hand printable area will not be utilized. Before printing major series do some
test prints to ensure the output matches your expectations.

Save settings as standard for selected printer sets theproperties as printer standard in InScript.
Other applications are not affected

NOTE

The settings of the standard Windows printer dialog are also included in these set-
tings. All settings are saved in thebinary file [printername].PRD in the InScript\PrinterData
folder. If you do not want to use these settings any more then define other ones or
delete the PRD file that has the printer's name youwant to discard. If you are using a
color printer and if the output is set to color in the standardWindows printer dialog
then the Vector Editor print function offers a convenient way to choose color, gray
or black and white printing.

8.4.32. Sub Category - Page Margins

In this category the page margins and the space reserved for description fields are set.

Page margins Left, Top, Right, Bottom using these fileds you can set the page margins

VE descr.field heights item[Top, Bottom] using these fields you can set the height of the top
and bottom description field
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Page preview field the preview on the right side shows the parameter’s effect.

The page areas are assigned as follows:

dashed black line printable area

continuous blue line page margins

dashed blue line lower/upper edge of the top/bottom description field

turquoise line parameter that is currently edited

8.4.33. Sub Category - Fonts

In this category the handling of TrueType fonts in InScript is set.

TTF-Conversion Flatness TrueType fonts including curves and arcs are converted to lines. Flat-
ness specifies the conversion quality. The smaller the value is the higher the quality, but
the more lines and data result from the conversion

Disable font preview in dialog ”Select Font” if this check box is selected then no preview of
InScript-, ROM- anduser fontswill be shown in the Select Fontwindow. Thepreviewof TrueType
fonts is not affected

8.4.34. Sub Category - Support Data

In this category, you can enter your contact info. This will be used e.g. in the InScript Support-Info
Wizard (menu Extras→ Create Support-Info). In addition the settings for request.log and autmation.log
files can be changed. These files record the communication between the controller hardware and In-
Script on PC side. The file may be useful for support requests.

524 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



8.4. Preferences

Contact info fields to fill in ct information. This information will be included in automatic support
requests

Request log
Enable if this check box is selected then the communication between controller board and

PC will be logged in the request.log file in the InScript\Log folder. This is useful for
testing and debugging

View shows the contents of the request.log file
Clear on startup if this check box is selected the request.log file will be cleared on InScript

startup
Limit file size if this check box is selected then the request.log file size will be limited to

the given size. If this size is reached then logging will be terminated
Automation log

Enable if this check box is selected then the communication between controller board and
PC will be logged in the automation.log file in the InScript\Log folder. This is useful for
testing and debugging

View shows the contents of the automation.log file
Clear on startup if this check box is selected the automation.log file will be cleared on In-

Script startup
Limit file size if this check box is selected then the automation.log file size will be limited

to the given size. If this size is reached then logging will be terminated

8.4.35. Sub Category - Mappings

In this category the editor properties for mappings are set, e.g. for power mapping.
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8.4.36. Sub Category - Mappings / Laser Power

In this category the editor properties for the power mapping in the laser device driver are set. If the
PowerMapping tab is present in your laser device driver then the powermapping editor can be opened
via this tab.

These settings are the same for Laser Power, Multi and TEM00.

Background shows and selects the background color

Cross cursor if this check box is selected then the mouse pointer is displayed as a haircross cursor.
The button shows and selects the haircross color

Picking region sets the mouse pointer sensitivity for selecting Excluding intervals

Excluding intervals shows and selects the boundary color of the excluding intervals

Excluding areas shows and selects the excluding area color

Laser power Cmd shows and selects the color for current nominal laser power

Linear Mapping shows and selects the linear mapping color

Working intervals shows and selects the working interval color

Sampling points shows and selects the sampling point color

8.4.37. Sub Category - Mappings / Bitmap Analog Mode

In this category the editor properties for the several mappings in the bitmap node analog modes are set. If
the Output Mode Settings or Lead In tab are present in the bitmap node editor then the power mapping
editor can be opened via this tab.
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These settings are the same for Analog, Pseudo Analog, Lead In and PWM Lead In.

Background shows and selects the background color

Cross cursor if this check box is selected then the mouse pointer is displayed as a haircross cursor.
The button shows and selects the haircross color

Picking region sets the mouse pointer sensitivity for selecting Selected points

Sampling points shows and selects the sampling point color

Selected points shows and selects the color of selected points

8.4.38. Restrict Permissions for Users

To restrict certain users from changing InScript settings you can limit access rights for these users to
theWindows system registry and/or relocate the InScript settings from the user registry to machine
registry. Here are instructions on how to do this:
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CAUTION

Data loss

Settings ofWindowsor InScriptmaybedamaged editingWindows registry or the InScript.ini
file

� UsingRegistry Editor incorrectly can cause serious, system-wideproblems thatmay
require you to re-install Windows to correct them. ARGES cannot guarantee that
any problems resulting from the use of Registry Editor can be solved. Use this tool
at your own risk.

� Editing the InScript.ini file can cause unwanted behaviour of InScript. Please
create a copy of this file usingWindows Explorer or similar tools to be able to revert
your changes to the original InScript.ini file.

To enable all users to save settings (This is the default setting)

1. Open the file InScript.INIwith a text editor. Youwill find this file in folder InScript\bin.

2. Search for section [Application].

3. If no entry RegistryRoot exists in section [Application] then create this entry.

4. Set the value of RegistryRoot to 1 (RegistryRoot=1). Now all settingswill be saved under
registry root-key HKEY_CURRENT_USER.

To enable only users with administrator permissions to save settings

1. Open the file InScript.INIwith a text editor. Youwill find this file in folder InScript\bin.

2. Search for section [Application].

3. Set the value of entry RegistryRoot to 2 (RegistryRoot=2)
--or--
Delete the RegistryRoot entry. Now all settings will be saved under registry root-key
HKEY_LOCAL_MACHINE.

4. Start InScript.

5. Configure InScript as wanted.

6. Exit InScript. Only if a user with administrator permissions closes InScript under his ac-
count the settings will be saved now. Assuming a standard configuration of Windows
2000/NT/XP all other users can read the settings now, but are not allowed to change them.

To enable selected users to save settings

1. Open the file InScript.INIwith a text editor. Youwill find this file in folder InScript\bin.

2. Search for section [Application].

3. Set the value of entry RegistryRoot to 2 (RegistryRoot=2)
--or--
Delete the RegistryRoot entry. Now all settings will be saved under registry root-key
HKEY_LOCAL_MACHINE.
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4. Start InScript.
5. Configure InScript as wanted.
6. Exit InScript. Only if a user with administrator permissions closes InScript the settings

will be saved now. Assuming a standard configuration of Windows 2000/NT/XP all other
users can read the settings now, but are not allowed to change them. Now you have to
grant permissions to selected users.

7. On the task bar click Start→ Execute. Window Execute opens.
8. In the Open box type the filename RegEdt32.exe.
9. Click OK. Window Registry Editor opens. Within this window further windows open.

10. Open the HKEY_LOCAL_MACHINE branch.
11. In the registry editor tree structure browse to SOFTWARE→ Arges→ InScript.
12. Select the registry-key.
13. Click Security→ Authorization in the menu. Further information on how to assign autho-

rizations to a registry-key and how to edit the authorization list (adding and deleting of
users and groups) take from documentation or online-help of the registry editor!

8.5. Xplorer

The fundamental configuration components are variables that are stored on the ARGES controller.
All components like Devices, Job Nodes or Jobs consist basically of a collection of these variables. Nor-
mally variables are combined intoNodes, Devices of other collections but sometimes it can be handy to
manipulate these variables directly. To do this the Xplorer can be used. Via Xplorer the hierarchical
tree of variables can be browsed and modified (see 8.5.2 Edit Variables in Xplorer) similar to the file
structure of Windows Explorer.

8.5.1. Xplorer Window

To open the Xplorer window press Show Explorer in InScript Windows toolbar. To open another
Xplorer window you can either click Show Explorer again or right click on almost any variable in In-
Script and choose Xplore or Explore here ... to open an Xplorer window for this variable.
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Xplorer Toolbar use the Xplorer toolbar to navigate directly to a variable or to browse to previous
variables.

browses to the previously viewed variable. If you click on the small arrow beside this but-
ton you will get a history of previously viewed variables

browses to the next variable that you viewed

creates a new variable at the current cursor position

Xplorer Path Input Bar here you can directly enter a variabe path e.g. usr.var.test that you
copied e.g. from a Job Node editor

Xplorer variable tree this window displays the variables in a tree structure on the left side. If a
node in this tree structure is selected then the node’s variables with all their properties are
displayed in the list on the right side

Xplorer variable list if a node in this tree structure is selected then the node’s variables with all
their properties are displayed in this list

Name name of the variable. Free to choose but has to be unique in its branch of the variable
tree

Value value of the variable depending on its Type

Unit unit of the variable. Only set on internal variables, not editable

Type type of the variable (possible are VAR: BIN (binary data you can type into a Hex Editor or
load via Load from binary file in Xplorer context menu), BOOLEAN (TRUE or FALSE), INT32
(32bit integer), INT64 (64bit integer), SELECT (dropdown with values), SET (collection of
variables), STRING (a sequence of characters), TEXT (a sequence of characters that can be
input using a multiline editor) or JOB: any Job Node)

Flags flags for the variables. The variables can be set by right clicking on the variable's Flags
column and choosing one or more of these flags:
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Flag Function Description
U user defined variable The user created the variable
W writable The user can change the variable's value
C controlled by device only for variables with o-flag. If the c-flag is

set then the variable is controlled by the owner
variable and adopts its value. If the c-flag is
cleared then the variable value can differ from
the owner variable's value

O owned by device Another variable owns the variable value. If the
value of the owner changes then this variable adopts
the value. Example: If the processing speed changes in
the default pen linepar pen section then the processing
speed also changes in the linepar device

T protected This variable is changeable but write-protected by
the t-flag

M modified only for variables with the n-flag. The variable was
changes since the last "Save To NVRAM" operation

N mirrored in NVRAM the variable value will be written into the NVRam at
the next "Save To NVRAM" operation

Q quick save to NVRAM only for variables with the n-flag. This means, with
every change the variable value will automatically be
saved to the NVRam

R override momentarily not used
F force momentarily not used
P pen-able This variable can be used in a pen
c consumable The variable is consumed after each job execution and

has to be re-set with a new value before it can be
accessed again

NOTE

Not all flags can be set manually in all places!

8.5.2. Edit Variables in Xplorer

NOTE

It is not possible to create or manipulate variables in all subtrees of the variable tree.
Normally users only manipulate variables that are located under usr viz. usr.var and
usr.job.

Create a new Variable place the cursor in Xplorer where you want to create a new variable and
select or use context menu New... The New Node window will open.
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Name enter a name for the variable

Type there are two types of variables that can be created:

Type VAR a Variable

Type JOB a Job with all its subnodes

Sub Type for Variables you may choose BIN (binary data you can type into a Hex Editor),
BOOLEAN (TRUE or FALSE), INT32 (32bit integer), INT64 (64bit integer), SELECT (drop-
down with values), SET (collection of variables), STRING (a sequence of characters) or
TEXT (a sequence of characters that can be input using amultiline editor) and for JOB you
can choose almost any Job Node from the dropdown (see 5 Job Nodes).

Index sets the index position at that the variable is inserted

Edit a Variable to edit an existant variable, just double click its Value column and edit the values.
On some variable type it is possible to in- or decrement or page the values by just placing the
cursor on the line and using Ctrl-cursor up / Ctrl-cursor down. If you are in a numerical edit
field (you double clicked the Value column of a variable) you can also use:

Key effect comment
crsr-up / crsr-dn in- / decrement value by 1
shift crsr-up / crsr-dn in- / decrement value by 10
ctrl crsr-up / crsr-dn in- / decrement value by 0.1 only on REAL
alt crsr-up / crsr-dn in- / decrement value by 0.01 only on REAL

Delete a Variable to delete a variable select it and press the Del key or select Delete from its context
menu

Rename a Variable to rename a variable select it and press the F2 key or select Rename from its
context menu

Context Menu the context menu can be opened by right clicking a variable in the Xplorer variable
list

New, Rename, Delete please refer to the descriptions above

Explore here... opens an Xplorer window at the selected variable

Add to Inspector opens inspector and adds the selected variable to it

Load from binary file ... only on BIN variables, Loads binary data to a BIN variable

Save to binary file ... only on BIN variables. Saves binary data to a .bin file

Value to Clipboard copies the value of a variable to clipboard

Nodename to Clipboard copies the name of a variable to clipboard

Fullpath to Clipboard copies the complete name and path of a variable to clipboard. This
is very handy for e.g. Scripting (see 5.44.2 Scripting Language). Be sure that you do not
forget to enclose the variable path and name in $$

Info shows the node info
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Dump dumps internal node data

Sorting enabled if this item is checked you can sort the Xplorer variable list by column (just
click on the column header taht you want to sort by)

8.6. Birdview

The Birdviewwindow shows a view of the whole scan field. If you view a zoomed area of the scan field
in Vector Editor window then the Birdview window shows the size and position of this area related to
the whole scan field as a red bounding box and provides a better overview.

8.6.1. Birdview Window

To open the Birdview window press Show Birdview in InScript Windows toolbar.

Scan Field the scan field is shown as a light blue square in the Birdview window

Zoom Area the zoomed area is shown as a red bounding box

8.6.2. Birdview Zooming

To change the zooming just drag the red Zoom Area bounding box to the size you want. The box will
then be adjusted to the aspect ratio of the current Vector Editor view. Seldom it is necessary to use
Alt-Tab to switch once from InScript to another window and back to make mouse input possible.

8.7. Quick Settings

In the Quick Settings window the most important parameters for line output and of the laser can be
set. The displayed parameters are always depending on the active laser device. You will find further
information about these parameters in section 3.10 linepar - Line Parameters.
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To open the Quick Settings window press Show Quick Settings in InScript Windows toolbar.

8.8. System Status

The System Status window displays the status of the system as color and text. It is possible to maxi-
mize thewindow. Thatway you canwatch the system status even if viewing the screen from a greater
distance.
The system status is shown as follows:
gray stands for "idle"

green stands for "ready"

flashing yellow/green stands for "processing"

yellow stands for "previewing"

red stands for "failure"
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To open the System Status window press Show System Status in InScript Windows toolbar.

8.9. Node Inspector

The InScript Node Inspector displays variables in a separate window and groups them in a list, e.g. to
monitor, edit or access them easily.

To open the Node Inspector window select View→ Node Inspector in the InScript menu (see 8.3.3 View)
or right click a variable you want to add to Inspector and select Add to Inspector in its context menu.

8.9.1. Add to Node Inspector

To access and edit variables frequently, they can be grouped in the Inspector view.

� Right click on a variable field of a Dialog (e.g. a Node Editor) and select the variable name. A
sub menu opens. Click Add to Inspector
--or--
Click Add to Inspector in the context menu of a variable in Xplorer window (see 8.5 Xplorer).
The Node Inspector window opens and the selected variable is added to the list of variables.

8.9.2. Node Inspector Context Menu

The Inspector has an own context menu:

<variable> click on this menu item to Xplore (see 8.5 Xplorer), get Info, get a Data Dump or copy
the name or value of the variable to the clipboard

Always on Top select this item to make the Inspector window a topmost window that can't be
covered by regular windows (except other topmost windows) or simultaneously press Ctrl+T

Remove From List remove the selected variable from the Inspector view (the variable is not deleted)

Info get an info summary of the selected variable

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 535



8. Toolbars, Menus and Other GUI Components

New User Variable lets you create a new user variable (see 8.5.2 Edit Variables in Xplorer). The
variable is added to the Inspector view, right away

Delete User Variable if a variable has the user flag 'U', it can be completely deleted from the In-
spector window

Save saves the current Inspector view. You will only be prompted if you want to save the view.
Only one view can be stored at a time

Load loads the Inspector view saved with Save. You will only be prompted if you want to load this
view

8.10. Messages

TheMessages window shows systemmessages. There are two different views formessages: messages
detail view (see 8.10.5 Messages Detail) and messages list view (see 8.10.6 Messages List).

To open theMessageswindow use InScriptMenu→View→Messages. If themenu item is checked then
the window is already open

8.10.1. Messages Types

There are three types of messages:

• Informational

• Warning

• Error

8.10.2. Messages Toolbar

Delete selected message deletes one selected message in list view or the current message in
detail view (see 8.10.3 Delete a selected Message)

Delete all messages deletes all current messages. This can be used to start a set of new mes-
sages that e.g. shall not be confused with older messages (see 8.10.4 Delete all Messages)

Show selected message details switches to the messages detail view (see 8.10.5 Messages De-
tail)

Show messages in a list switches to the messages list view (see 8.10.6 Messages List)

Always focus the last message always jumps to the last incomingmessage (see 8.10.7 Always
focus the last message)
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8.10.3. Delete a selected Message

To delete a single message in list view, select it with the list's cursor using the mouse or cursor keys
and click on . The selected message will be deleted.

If you are in detail view, the currently displayed message will be deleted.

8.10.4. Delete all Messages

To delete all messages click on . All message will be deleted. The messages window will show "No
messages available".

8.10.5. Messages Detail

Deatil information of the currently selected message is shown.

Click on to show the details.

Icon severity Informational, Warning or Error is shown

Previous message go to the previous message

Next message go to the next message

Messages box shows the text of the main message and its sub messages (if available)

8.10.6. Messages List

All current messages are shown in a list. Messages that have sub messages are grouped in treeviews
to view sub messages click on the '+' sign beside the message text. You may also use the mouse over
box of each list item to see complete messages.
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Click on to show the list. The list has the following columns:

Icon column a sign for Informational, Warning or Error is shown

Date date and time of occurance of the message

Message message text

Facility reporting system part e.g. InScript or controller firmware

ID Message ID

Severity Informational, Warning or Error

8.10.7. Always focus the last message

If this button set, the list or detail view will always show the last incoming message. If the button is
not set, then the list or detail view will remain on the currenty selected message.

8.11. Beam Profiler

The beam profiler visualizes basic information about the intensity distribution in a cross section of
the beam. The frame grabbing functions are available only if a supported frame grabber is installed
in the PC.
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To open the Beam Profiler window use InScript Menu→ Extras→ Beam Profiler.

8.11.1. Menu

File

New creates a new ARGES beam profile

Open opens an ARGES beam profile *.abp file

Import imports an image

Save saves an ARGES beam profile *.abp file

Save as saves an ARGES beam profile *.abp under a new name

Exit closes all openwindows belonging to the beam profiler. These windowswill be reopened
automatically next time opening the beam profiler

View

Show line cut 1 opens the window Line Cut 1

Show line cut 2 opens the window Line Cut 2

Show Profiles opens the window Beam profile

Show Histogram opens the window Histogram

2D profile opens the window 2D view

3D profile opens the window 3D view

Edit palette opens the window Palette editor
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Load Layout opens the window Load Beam Profiler Layout From File
Save Layout opens the window Save Beam Profiler Layout To File

Grab
Grab single image grabs a single image from the frame grabber
Grab continuous continuously grabs images from the frame grabber
Select device opens the window Select device
Configure device opens the window Configure device

8.11.2. Toolbar

Create new profile creates a new ARGES beam profile

Open beam profile opens an ARGES beam profile *.abp

Save profile saves an ARGES beam profile *.abp

Import beam image imports an image as a beam profile

Configure capture device opens the window Configure device

Capture single frame grabs a single image from the frame grabber

Capture a series continuously grabs images from the frame grabber

Show cut 1 opens the window Line Cut 1

Show cut 2 opens the window Line Cut 2

Open palette editor opens the window Palette editor

8.11.3. Window Line Cut 1 / 2
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Movement Free, Horizontal, Vertical creates a line cut in the preview on the left. The intensity
along this line is shown in the diagram below the preview. These types of can be created:

Free the line ends of the cut can be dragged to the desired position

Horizontal a vertical line cut can be moved horizontally

Vertical a horizontal line cut can be moved vertically

8.11.4. Window Beam profile

This window shows additional information which will be saved beside the image information in the
ARGES beam profile files.

Title sets the beam profile title

Date sets the date (in the format YYYY-MM-DD) the beam profile was captured

Time sets the time (in the format HH:MM:SS) the beam profile was captured

User sets the user who captured the beam profile

Description sets a description of the beam profile

8.11.5. Window Histogram

The window shows the weighting of intensity in the beam profile.

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 541



8. Toolbars, Menus and Other GUI Components

8.11.6. Window 2D view

The window shows the 2 dimensional top view of the beam profile.

To zoom the view

1. In the context menu click Zoom

2. Click the zoom factor you want to zoom to

8.11.7. Window 3D view

The window shows the 3 dimensional view of the beam profile.

Toolbar

Rotate Mode in this mode the left mouse button rotates the object and the right mouse
button moves the camera

542 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



8.11. Beam Profiler

Move Mode in this mode the left mouse button moves the camera and the right mouse
button rotates the object

Zoom out zooms out of the view
Zoom factor here you can enter a zoom factor in percent or choose from one of these

settings if you click on the black triangle:

Zoom in zooms into the view
Zoom in slider zooms in or out of the view using the slider

Reset camera view resets the camera view to top view

View Options lets you choose from one of these options:

Points shows the sample points of the profile
Lines shows the profile as lines
Solid shows the profile as a solid surface
Show axis shows x,y and z axis in the lower left corner
Show 2D cursor position shows the curser position of the window 2D View (see 8.11.6

Window 2D view) as a yellow vector

Z Elevation shows more or less z 3D elevation using a slider

Transparency shows more or less transparency using a slider

TIP

If you want to rotate/move the object/the camera exactly around/along one axis
then click and move the mouse within the colored areas at the side and bottom of
the window.

.
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8.11.8. Window Color Ramp

With the color ramp editor you can assign colors to laser beam intensity. Either use one of the pre-
defined color ramps or define one by yourself.

To define a power ramp, follow these steps:
There are 2 sliders on the color ramp preview. Their positions within the preview correspond to the
image intensity in percent as shown in the From/To boxes. The intensity range between these sliders
can be filled with a color ramp. That way it is possible to define own color ramps.

Step 1 Move the sliders to the desired positions or type the intensity [%] into the From/To boxes

Step 2 Double click a slider or click the corresponding color button.
The window Color opens

Step 3 Select a color

Step 4 Click OK
The intensity range between the 2 sliders will be filled with the color ramp shown on the
color buttons.

By repeating this procedure with different slider positions and colors it is possible to define your own
color ramps.

8.12. Video Capture Device

Using the functions of the window shown below, Video Capture Devices can be selected, configured and
used in InScript.

To open the Video Capture Device window use InScript Menu→ Extras→ Video Capture Device.
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8.12.1. Setup

Prerequisites

At least one Video Capture Device has to be installed in Windows, i.e. the hardware and its Windows
driver have to be installed. How to install a Video Capture Device in Windows should be described in
the Operator Manual of the respective Video Capture Device.

Initialization

Step 1 In InScript in the menu, click Extras→ Video Capture Device.
The Capture Window opens

Step 2 In the Capture Window’s menu, click Capture→ Select device.
The Select Video Capture Device windows opens.

Step 3 Select a Video Capture Device

Step 4 Click OK.
The Select Video Capture Device windows closes

Step 5 In the Capture Window’s menu, click Capture→ Configure device.
The Configure Video Capture Device window opens

Step 6 In the respective tabs, configure the Video Capture Device according to its documentation
provided by the manufacturer of the Video Capture Device.
Basically select the correct Color Format on tab Mode and the correct Type on tab Sensor.
The latter one is responsible if the captured image is shown in scale 1:1 or not, where the
camera pixel are equal to the pixel shown on the screen.

Step 7 Click OK.
The Configure Video Capture Device window closes

Step 8 In the Capture Window in the menu, click Capture→ Single image or Live image. The image
will be displayed in the Capture Window and the Video Capture Device is ready

8.12.2. Functions

How to capture a single or a live image

� In the menu, click Capture→ Single image or Live image

How to save an image

If the Video Capture Device is set to capture a live image, it will be reset to capture a single image as
soon you perform the next step. This single image will be saved.
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Step 1 In the menu, click File→ Save Image As.
The Save Image window opens

Step 2 Select a path and enter a file name to save the image to

Step 3 Click Save.
The Save Image window closes

How to print an image

If the Video Capture Device is set to capture a live image, a single image will captured and printed at
the time you perform the next step. If you want to print the image on a printer other than the default
printer, click File→ Print Setup and select a printer.

� In the menu click File→ Print Image

How to fit an image to the Capture Window

� In the menu, click Preview→ Fit to window

How to show crosshairs

� In the menu, click Preview→ Show crosshair

How to flip an image

� In the menu, click Preview→ Flip horizontal or Flip vertical

How to use the region of interest

A region of interest specifies a region, which can be enlarged to the CaptureWindow. Before a region
of interest can be used, it has to be specified in the first place.

Step 1 In the menu, click Preview→ Show region of interest.
A yellow frame marks the selected region of interest in the image:

• To move the region, place the mouse pointer on the region’s center, press and hold
left mouse button and move the mouse.

• To resize the region in 1 dimension, place the mouse pointer on the region’s edge,
press and hold left mouse button and move the mouse.

• To resize the region in 2 dimensions, place the mouse pointer on the region’s cor-
ner, press and hold the left mouse button and move the mouse.

Step 2 In the menu, click Preview→ Use region of interest.
The image will be clipped to the region of interest
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TIP

Fit the image to the Capture Window.

8.13. Align Target

This window is only available when a frame grabber is installed in the PC. In the Align Target window
one or more images of one or more video sources can be displayed in different resolutions. This is
helpful, if one or more targets have to be repeatedly aligned.

You can e.g. display a complete imagewith half video resolution and one ormore cut outs of the same
image in full video resolution. Several video sources and frame grabbers can be toggled.

To open the Align Target window use InScript Menu→ Extras→ Align Target.

To see captured video frames youhave to add a target view and show live images. Subsequently target
tools (cross hairs or target images) can be selected, configured and positioned.

Add Target View

Step 1 In the Target Align window menu, click Windows→ Add Target View.
— or —
In the Align Target window in the tool bar, click on Add a new TargetView window .
A new Target View window opens. The window will still be empty.

Step 2 In the context menu, click Select Video Source

8.14. Convert Font to FDT

To open the Convert Font to FDT window use InScript Menu→ Extras→ Convert Font to FDT.

Step 1 A Warning will be shown:
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If you are sure that your font is compliantwith the copyrightwarning, confirm the dialog
by pressing Yes.

Step 2 Now the Convert Font to FDT window is shown:

Show in this section you can choose the font file types that will be shown in the Fonts
list

NOTE

<data folder> can be either the InScript installtion folder under operating
systems ≤ Windows XP or the InScript Documents folder (see InScript's
Start menu entries for these folders) on operating systems ≥ Windows
Vista.

InScript Fonts if this check box is selected *.fdt fonts in <data folder>\Fonts will
be shown

TrueType Fonts if this checkbox is selected *.ttf fonts in <windows folder>\Fonts
will be shown

ROM Fonts if this check box is selected special vector fonts that are available
on all controllers will be shown

Raster Fonts if this check box is selected *.FON fonts in <windows folder>\Fonts
will be shown

User Fonts if this check box is selected User Fonts will be shown
Preview Text lets you choose a preview text for the Fonts list

Font Name if this check box is selected the font's name will be used as an exam-
ple

The quick red fox jumps over the lazy brown dog if this checkbox is selected
"The quick red fox jumps over the lazy brown dog" will be used as an example.
This sentence contains all English characters from a to z
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User defined if this check box is selected you can enter an own string that will
be used as an example

Fonts list shows a list of all availabel fonts that meet the conditions of Show
File Name shows the file name of the selected font
File Path shows the path to the selected font
OK if a font is selected the Choose Unicode Code Charts dialog opens (if a TTF font is

chosen for conversion) then the Save as dialog opens. You can save the font in FDT
format

Cancel cancels the conversion process
Refresh refreshes the Fonts list

Step 3 Click OK

Step 4 With TTF fonts, a list of Code Charts in the Choose Unicode Code Chartswindow opens. These
Code Charts represent different scripts (like European scripts, Asian scripts, even ancient
scripts and more). Each font can include different code charts! You may choose more
than one Code Chart for conversion. But please be aware that choosing lots of code charts
can lead to huge amounts of data that have to be converted. Normally it is better to
choose a small subset.

TIP

The Basic Latin code chart includes most of the common characters. If you
are unsure which Code Chart you shall choose, use Basic Latin if it is available.

Step 5 Click OK

Step 6 The Save asWindow opens and youmay select a path and filename for the converted FDT
font (normally the preset filename should be kept
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8.15. Convert IGES file to Jobstructure

To open the Convert IGES file to Jobstructure window use InScript Menu→ Extras→ Convert IGES file to
Jobstructure .... This menu item allows you to convert IGES 3D vector files to a InScript Job structure.

The conversion takes all curves and composite curves in the IGES file and creates a Job structure. The
curves and/or composite curves should have labels that are set up like this: name#penname (if no
labels are available, the curves or composite curves will be placed under an "Objectsn" Collect node
and as pen, the default pen will be used). This will assign names to curve or composite curve data and
also associate a pen (the pen has to exist on the system) with each curve or composite curve of the
given name.

The output job will look like this:

Description:
+Job node: Name = Name of IGES filename

+Scan3D node for all following nodes of the Job

+Transform3D node for all following nodes of the Job

+Collect node: Name = Label "name" of (composite) curve
(or "Objects(n)" if no label is used in the IGES file)

+Pen link node: Pen Label "penname" of (composite) curve
(or Default pen, if no label is used in the IGES file)

+Transform3D node

+Raw Lines node with the line data of the (composite) curve

+Collect node: Name = Label "name" of (composite) curve
(or "Objects(n)" if no label is used in the IGES file)

+Pen link node: Pen Label "penname" of (composite) curve
(or Default pen, if no label is used in the IGES file)

+Transform3D node

+Raw Lines node with the line data of the (composite) curve
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etc.

Step 1 Use the menu item Extras→ Convert IGES file to Jobstructure ...

Step 2 A dialog will be shown

Step 3 You can browse to your *.IGS IGES file by clicking on the ... button

Step 4 After the file is selected the dialog will look like this:

max. deviation from curve here you can set themaximumdeviationof curves. Curves
are approximated with lines, if this value is higher, less lines will be used for the
approximation

Start conversion if this button is pressed, the conversion of the IGES file to a Job struc-
ture starts

OK if this button is pressed, the dialog will be closed, no conversion will be done

Step 5 Click on the Start conversion button to start the conversion of the IGES file

Step 6 InScript will convert the IGES file into a Job structure in the Job Configuration window

Step 7 Now you may save the Job to an InScript Job file (see 4.6.5 Save Job)

Step 8 The conversion has ended. A message in the message window (see 8.10 Messages) shows
the status of the conversion (e.g. "Conversion from IGES-file to Jobstructure succeeded."
indicates that the conversion succeeded and "Conversion from IGES-file to Jobstructure
failed." indicates that the conversion failed).

8.16. Create Support Info

If you want to report a problem in InScript you can use the InScript Support-Info Wizard to create de-
tailed information of your system and the issue itself.

To open the InScript Support-Info Wizard window use InScript Menu→ Extras→ Create-Support-Info.

Follow these steps through the Wizard:

Step 1 Read the welcome screen.
Click on I Agree if you want to continue
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Step 2 To include all your contact information in the Support Info you have to fill in your Name,
Adress, Phone number, Fax number and eMail adress.

NOTE

If youwant to store this information for further requests click on Set as default.
Click on Next to continue.

Step 3 Describe the issue you want to report as exact as possible. To do this type a description
into the Edit field. Date and time of your report are shown at tthe bottom of the input
field.
Click on Next to continue.

Step 4 Choose the Range of information you want to report
Information Range sets predefined information ranges

Default selects a standard range of information
Minimal selects a minimal range of information
Maximal selects all information
User the wanted information can be selected under Information to embed

Information to embed the selected information will be included in the Support Info
System Status includes the current status of the system (hardware and soft-

ware versions etc.)
InScript Ini-File includes the current inscript.ini file
InScript Registry Path includes all current InScript registry entries
Current Job + Linked Files N/A
NCC Tree Snapshot includes a snapshot of the current variable tree
Flash Image includes an image of the current flash memory
Ram Image N/A

Click on Next to continue.

Step 5 While this screen is shown InScript collects the wanted information if you click on Start.
The current status and progress will be shown after you click Start. If the collection of
information is done the Next button will be available.
Click on Next to continue.

Step 6 Have a view of the collected information.
Click on Next to continue.

Step 7 Now all the Support Info is packed and you have several possibilities to proceed with it
Save to file save the compressed data to disk
Save splitted save the compressed data to disk but split it for different media
Mail to tries to open your standard windows mail client software. The compressed

data has to be attached manually as described in the requestor and in the mail's
text body

Delete Temp-Files On Finish if this check box is selected the created files will be
deleted after you click on Finish
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Click on Finish to exit the Wizard.

8.17. Arrange Windows and Tool Bars

In InScript the user can freely arrange windows and tool bars. If InScript is closed the layout will be
saved and restored with the next program start. Whether the layout of docked and/or un-docked
windows and tool bars will be saved, you can set in the preferences (see 8.4.24 Sub Category - Shut-
down).

8.17.1. Undocking

1. Place the mouse pointer on the window title bar or on the 2 parallel lines of the tool bar
2. Hold the left mouse button pressed and draw the window or tool bar to the desired position

--or--
Double click the window title bar or the 2 parallel lines of the tool bar.
The window or the tool bar un-docks, i.e. changes into a separate window.

8.17.2. Docking

Tool Bars 1. Place the mouse pointer on the title bar of the tool bar.
2. Hold the left mouse button pressed and draw the tool bar to the desired position

--or--
Double click the title bar.
The tool bar will be docked.

Windows 1. Place the mouse pointer on the window title bar.
2. Hold the left mouse button pressed and draw the window to the desired position. Frames

will show the position in which the window will be docked. Often it is good to place the
mouse pointer on title bars of other docked windows to achieve a desired position.
The window will be docked.

NOTE

If you double click the window title bar then the window will be maximized in-
stead of being docked. It behaves like any other window in Windows.

Pop-up Tool Bars in e.g.Vector Editor there are secondary tool bars that pop up after you press a
tool bar button for a longer time (as set in 8.4.28 Sub Category - User Interface Popup after).
These tool bar buttons are marked with a little triangle in the bottom right corner.

1. Undock pop-up tool bars from such a button by double clicking them.
The triangle is removed, the toolbar is floating and may be docked like other tool bars.

2. To re-attach the toolbar to such a button, just make it floating and press the [x] close
button of this tool bar window.
The little black triangle will be re-displayed
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8.17.3. Prevent Docking

Hold the Ctrl key pressed while drawing the window or tool bar respectively across the InScript win-
dow. The window will not dock at any position.

8.17.4. Save/Load Window Layout

NOTE

<data folder> can be either the InScript installtion folder under operating systems≤Win-
dows XP or the InScript Application Data folder (see InScript's Start menu entries for
these folders) on operating systems≥Windows Vista.

To save the current window layout to a file use InScript Menu→ View→ Load Layout and InScript
Menu→ View→ Save Layout (see 8.3.3 View). To save the standard layout that is loaded on start of
InScriptwrite over <data folder>\config\standard.lay. The file standard.lay is normallywritten
with the current window settings if you exit InScript but you may deactivate this behaviour under
InScript Menu → Global → Shutdown by unchecking Save docking layout and Save position and size of
undocked windows (see 8.4.24 Sub Category - Shutdown)

9. Supervisor and Operator Mode

What?

The Operator mode is intended e.g. for manufacturing, when persons shall execute jobs, set specific
parameters, but beside this are not allowed to change the configuration of InScript in no way.

Unlike Supervisor mode only a very limited set of dialog elements is available in the Operator mode
(see following figure).

554 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



9.1. Set and Edit Password

How?

Here you will learn, how to set, edit, activate, deactivate the password for Supervisor mode and how
to toggle between supervisor and operatormode. To enable the operator of setting a specific variable,
this variable has to be shared with the Operator mode.

9.1. Set and Edit Password

To prevent Operators from switching to InScript supervisor mode a password can be specified.

InScript has to be in Supervisor Mode

Step 1 Click Options→ Supervisor Password ... in InScript menu.
The Password window opens

Step 2 If a password already exists then type the password in the Password box. If you want to
specify a password and did not have a password before leave the Password box blank

Step 3 Type the new password in the New Password box and in the Repeat new Password box.

Step 4 Click OK.
The new password is set.
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9.2. Activate and Deactivate Password

InScript has to be in Supervisor Mode.

If you toggle from Operator to Supervisor mode and a password has to be entered you may deactivte
this temporarily.

� In the menu, click Options→ Password active.

A check mark shows if the password is active or not.

9.3. Enter a Password to Return from Operator Mode

InScript has to be in Operator Mode and a password has to be set and active (see 9.1 Set and Edit
Password and 9.2 Activate and Deactivate Password).

Step 1 If you are in Operator mode and a password is set and active, select View → Mode →
Supervisor from the main menu

Step 2 If a password is set and active, this dialog will be shown:

Step 3 enter the password you set (see 9.1 Set and Edit Password) to get back to InScript Super-
visor mode.
If you check the Ask again during this session checkbox the password will be requested
each time you want to switch from Operator to Supervisor mode. If you uncheck this
checkbox, you will not be asked to enter the password until InScript was restarted

Step 4 Click OK to switch to Supervisor mode

9.4. Toggle Supervisor and Operator Mode

Step 1 If you are in Supervisor mode click View→Mode→ Operator in InScript menu
— or —
If your are in Operator mode click View→Mode→ Supervisor in InScript menu.
A dot shows which mode is active.

Step 2 If you toggle fromOperator to Supervisormode and a password is active then thewindow
Enter Password opens.
Type the password in the Password box and click OK.
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9.5. Start in Supervisor or Operator Mode

Step 1 In the menu, click Options→ Preferences.
The Preferences window opens.

Step 2 In the tree structure, click Board.

Step 3 In the Start in group, click Operator mode or Supervisor mode.

Step 4 Click OK.
When InScript starts next time, it starts in the corresponding mode.

9.6. Make Variables Accessible in Operator Mode

InScript has to be in Supervisor Mode. The node with the variable has to be in a Job node subtree.

Step 1 Open the node containing the variable that you want to make visible in Operator mode or
browse to the variable in Xplorer.

Step 2 In the input box context menu of the variable (or the context menu in Xplorer) , click
[variable name]→ Add to Inspector.
The Node Inspector window opens and the variable is added to the list.

Step 3 In the Job Configuration window open the Job node in whose subtree the node with [vari-
able name] is located.

Step 4 Drag&Drop the variable from the list in the Node Inspector window to the list in the Job
Node Editor window.
The variable is added to the list in the Job Node Editor window.

Step 5 In the Job Node Editor window, click OK.

Step 6 Save the subtree (see 4.6.13 Save Subtree).
If you load the job inOperatormode the variables, you have added to the job, can be edited
and/or viewed.

10. Exercises and Examples

The following exercises and examples illustrate, how to work with InScript. The first and important
exercise (10.1 First and Important Steps) shows how to produce a simple output. Besides this you
will learn general procedures in working with InScript. Thus we strongly recommend to do the first
exercise.

In other exercises we assume that the concept of InScript and the previous chapters are known.
Therefore known steps will be described only briefly.

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 557



10. Exercises and Examples

NOTE

The settings shown only illustrate principles and depend on the connected hardware. To
prevent damage you have to be familiar with hardware properties of your devices before
starting a job and/or changing process parameters. ARGES does not assume liability for
consequential damage.

10.1. First and Important Steps

The goal of this exercise is to output the text "Hello world" within a frame and to get familiarized
with general connections in InScript, this includes working with jobs in Job Configuration and Vector
Editor window as well as the difference between Preview and Editor mode the Vector Editor.

Step 1 In the menu, click File→ New Job.
-- or --
In Job Configuration window, select the Exec node and then successively click the sym-
bols Organizers and Job .
In the Job Configurationwindow a new Job node is created as child of the Exec node.

Step 2 Select the Job node in the Job Configuration window and then successively click the
symbols Tools and Text .
In the Job Configurationwindow a new Text node is created as child of the Job node.

Step 3 Double click the Text node.
The Text Editor window opens.

Step 4 Click inside the text box on the left side of the editor.

Step 5 Type the text "Hello world". The text will be shown in the text box.

Step 6 Click Apply.

Step 7 Leave the Text Editor window open.

In this exercise the tree structure beneath the Exec node contains only one Job node. But there
can be several Job nodes. To determine that the controller board and Vector Editor "know" which
node to output, you have to "select" the node for output even if only one Job node is present:

Step 1 Select the root node of the subtree to be output in the Job Configuration window. In this
exercise this root node is the Job node.

NOTE

If the Job node already has a red rectangle around its name in the tree then
only Deselect will be available and you may continue with the next step. As an
exercise you could Deselect / Select the Job node.
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Step 2 In the context menu, click Select.
--or--
Press the Enter key.
A red square appears around the root node. The subtree is loaded to the controller board
line buffer.

To verify how the output would look like open the Vector Editor in Previewmode. This mode takes the
line data from the controller board and displays them as they would be output by the scan head:

Step 1 Click on the little arrow to the right of the symbol.
A menu opens.

Step 2 Click Preview.
The text "Hello world" is displayed in the Vector Editor window.
As the Previewmode takes the line data directly from the controller board, the line data
cannot be edited in this mode. The edit menu of the Vector Editor will be grayed.

Step 3 In the Text Editor window that we left open, change the value of Size (if the Editor was
covered up by the InScript main window you just have to double click the Text node
again).

Step 4 Press the Enter key.

NOTE

The character size does not change in Vector Editor. This is not an error but a property
of the Preview mode. Often a job contains complex objects with several thousand lines.
It would take a lot of time to update every change in the line data. Therefore the line
data is not automatically updated. You have to update the line data from the controller
board manually to display them:

Step 1 Click the (Update DSP-Data) symbol in Vector Editor Action toolbar,.
The text will be displayed with the new size.

Step 2 To display changes immediately in Vector Editor, click Add Vector-Editor View in the Job
node context menu.
This toggles Vector Editor to Editor mode. Furthermore the subtree that was selected in
this way is displayed in the Vector Editor and can be edited there. The edit menu of the
Vector Editor us ungrayed.

Step 3 In the Text Editor window, change the value of Size.
The character size now changes automatically in the Vector Editor window.

Step 4 Click OK.
The Text Editor window closes.

The next thing we want to do is to draw a frame around the text. As you already familiar with the
Text node you could create a Shape node this time and place it under an Offset or Transform node to
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move it to the desired position. But most of the graphical Tools operators (the Shape node is a part of
them) can also be created interactively using the Vector Editor's edit menu:

Step 1 In the Vector Editor window, click and hold on the symbol until a tool bar opens.

Step 2 Click the Create Shape symbol.

Step 3 In the Vector Editor window, open up a rectangle enclosing the Text "Hello world" by
clicking and dragging its outline.
As soon as you release themouse button, the red dashed draft line turns to a rectangle. At
the same time in the Job Configurationwindow2newnodes appear: a Transformnodewith
name "Shape" and a Shape node with name "Shape", which is a child of the Transform
node.
Accuracy is not relevant for this exercise, it only shows basic operation of InScript. You
do not have to align the rectangle exactly. But InScript could provide a lot of possibilities
to set exact numerical values instead of interactively move objects in Vector Editor. Just
double click any node in Job Configuration, place it under a Geometrical Operator node
and double click this node or right click any object in Vector Editor (if it is child of a trans-
formation node) and choose Edit Transformation, Edit Size or even Edit Job Node to set a lot
of possible values like size, offset etc. as exact values (see 5 Job Nodes for more informa-
tion).

Step 4 Before starting the process you have to check and set its parameters (e.g. laser power,
processing speed).

NOTE

The Job node you want to output already is selected for output. This is sym-
bolized by the red square around the node.

CAUTION

Visible and invisible laser radiation
The user is responsible for observing the laser safety regulations valid in his
country.
Avoid eye or skin exposure to direct or scattered radiation.

In the tool bar, click the symbol.
The job will be started.

Step 5 Save the job to use it as starting point for new exercises by right clicking it and choosing
Save Job from its context menu.

To find more information see 5 Job Nodes and 7 Vector Editor Window.
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10.2. Create an Arc

To create an Arc, you can use the Raw Lines node. This also ensures that the laser beam is not inter-
rupted (e.g. for welding) on subsequent objects after the arc was drawn.

Here is an example howto do this:

Step 1 Create a new Job via Organizers / Job . Rename it to e.g. Arc.

Step 2 Create a Vector view for this Job by right clicking it and selecting Show vectorEditor View.

Step 3 Insert a Raw Lines node under the Arc job node via Tools / Raw Lines .

Step 4 Insert a Shape node under the Arc job node via Tools / Shape and double-click the
Shape, set Type to ellipse, Width to 30.000 mm and Height also to 30.000 mm:

→

You may use different shapes for different purposes.

Step 5 Double-click the Raw Lines node and click Create rawlines from subnodes :
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→ all elements of the Shape are shown in the Raw Lines Editor

Step 6 Right click on the Shape in Vector Editor and choose Handle Points:

→ →
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Select all the points you do not need and delete them. Double-click the the start point
(the point with the enlarged square) to break the object. Create e.g. a line and Join it
with the Arc by selecting two points, right-click them and select "Modify / Join".

→

Step 7 You can also do this on the other End of the Arc, then switch to "Handle Objects":

→ →

Step 8 This could also be done on basis of a Rectangle with rounded corners. Please try to find a
scenario suiting your circumstances!
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→

10.3. Create Macros

Macros are small collections of nodes and instructions that can be re-used in one or more jobs on
different locations of this or these jobs. These macros can be handeled within the Job Configura-
tion window. Macros can only be created on ASC controllers from FW v2.5.0.264 and InScript v2.10.0
(ACME1928) and are not supported on NCC controllers!

Create and Save a Macro to create a macro, please follow these example steps:
� Create a macro from scratch

• Add a new „Macro“ node Under the „Macros“ section via Organizers / Macro .
Rename it to e.g. „MyMacro“.

• Add all functionality to you want to use to this macro. In this example e.g. a Shape
and a Polygon.

� Create a macro from an existing sub-tree under Exec via drag & drop
• For instance you got a Job with a collection of a Shape and a Polygon in the „Exec“

section in the Job Configuration window.
• Add a newMacro node Under theMacros section via Organizers /Macro . Rename it

to e.g. „MyMacro“.

564 Manual - InScript® Software - Graphical User Interface - as in repository revision 343



10.4. Create a Tiling Node

• Nowyou can just drag and drop the Collect node on the „MyMacro“ node. If you press
the Ctrl key, the Collect node and its sub-tree are copied. Elseway it will be moved.
If you copy it using Ctrl, the result will look like the example picture.

After you created a macro, you can save it for later use. Just right-click e.g. "MyMacro" and
choose Save Macro… from the context menu.

Use a Macro to use this macro, you only have to drag & drop it to the place in your Job where the
functionality of the nodes stored in the macro is needed. Here the macro is used once below a
transformation node and repeated five times and transformed under a Repeat node.

→

10.4. Create a Tiling Node

The Tiling node is meant to split the area of a workpiece that is bigger than the scan field into sections
that fit in the scanfield. After processing one section you canmove the workpiece to a different posi-
tion (e.g. by using an axis table) to continue processing in the area(s) that were outside the scanfield.

Step 1 A valid fieldsize of the scanfield has to be avialable.

CAUTION

Data loss
Your scanfield settingswill be lost if you execute this step in a fully configured
system.
Normally the filedsize should already be set correctly while doing the scan-
field correction and this should only be done for sheer testing purposes!

Only if no valid fieldsize of the scanfield exists you could set your fieldsize to e.g. 100×100
under Devices / dist-xy / [Expert mode] / Clipping
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Step 2 In this example the fieldsize is smaller that the actual workpiece that shall be processed,
so you have to use Tiling to cover the complete area of the workpiece.

Step 3 Create a new Job via Organizers / Job . Rename it to e.g. "Tiles".

Step 4 Create a Vector view for this Job by right clicking it and selecting Show vectorEditor View.

Step 5 Insert a Tiling node under the Tiles Job via Organizers / Tiling . InScript will create
a Source, Pre-Tile, Post-tile and a Tiles node under the new Tiling node (see 5.47 Tiling for
more information).

Step 6 Insert a Shape and/or a Polygon under Tiling / Source that should be processed on the
workpiece. This Shape should be bigger than the fieldsize you set (e.g. an ellipse with
width and height 200 an/or a star with Convex Radius 100 and Concave Radius 50).

Step 7 Double click the Tiling node and click on [Create Tiles] (this example shows, how to au-
tomatically create a Tiled output. If you want to distribute the output over pre-created
tiles in the Tiles subnode of a Tiling node, you can use the [Split] button).

Step 8 InScript will create several Rxxxxxxxxx nodes unter the Tiles node of the Tiling node.

Step 9 To do table translations between each tile, you can use the Pre-Tile and Post-tile nodes. In
this examplewewill only add an Info node via Dialogs / Info to Pre-Tile. Asmessage
we enter "Next Tile …" to the Info dialog by double clicking the Info node (you may use
almost all nodes in Pre-Tile and Post Tile).

The tiled objects and scanfield sections can be visualized in Vector Editor. There are some possibilities
to do this.
To visualize the tiles, right click the Tiles node and choose Show Vector Editor View or right click on
any of the created Rxxxxxxxxx nodes and choose Show Vector Editor View to view these tiles' areas. Or
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visualize the complete job with overlapping areas by selecting it.

→

10.5. Insert Date and Time in a Job

To insert date and/or time in a InScript job, you can use the controller variables stat.time.TimeStr
and stat.time.DateStr.

Step 1 Create a new Job via Organizers / Job . Rename it to e.g. DateTime.

Step 2 Insert a text node under the DateTime job node via Tools / Text :

Step 3 Double-click the text node and enter the following:
$stat.time.TimeStr$
$stat.time.DateStr$
Here you could also choose a different font or other output properties.

Step 4 Select the job by pressing the [Enter] key and create a vector editor view for this job by
right clicking the Job node and selcting Show VectorEditor View.

Step 5 Execute the job.
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If you want to format the output of date or time, you can use different stat.time.* controller variables
like stat.time.Year, stat.time.Month2 (e.g. "02" for February -most of these variables have a 2 digit
counterpart), stat.time.Month, stat.time.Day, stat.time.Hour, stat.time.Minute, stat.time.Second.
You can find these variables in Xplorer under path Root / stat / time and copy their variable nameswith
right click onvariable / Fullpath to Clipboard. You can e.g. useTime: $stat.time.Hour$:$stat.time.Minute2$:$
stat.time.Second2$ in a text node. You will get an output like "Time: 9:02:45".

10.6. Rolling Barcode Numbers

If you want to create a Barcode with rolling numbers, you can use the Counter node. A Counter node
is set to a specific number and then increments it for a certain amount. For this you need two Jobs in
this example. One Job to set the starting number and one Job to process barcodes.

Step 1 Create a new Job via Organizers / Job . Rename it to e.g. InitBarcode. With this job
we will set the initial number value of the barcode.

Step 2 Insert a Counter node under the RollingBarcode job node via Organizers / Counter
and double-click the Counter node:

Step 3 Name the node (e.g. SetCounter). Insert a variable name (e.g. BarcodeNum), set theValue
field to the needed start value of the barcode (e.g. 8000) and choose Set value as Mode.

If you start the job InitBarcode, the barcode's number will be initialized with 8000. You can use this
job to set a new start number.

Step 1 Create a second Job via Organizers / Job . Rename it to e.g. RollingBarcode.

Step 2 Insert a Repeat node via via Organizers / Repeat and double click the Repeat node:

→
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Step 3 Set the Count value to e.g. 6 (drawing barcodes needs a considerable amount of time, so
be sure that your pen linepar speed and jumps are high or this number is low).

Step 4 Insert a counter node via Organizers / Counter and double click this new Counter
node:

→
Insert the variable name used in the InitBarcode job's SetCounter (e.g. BarcodeNum) to
the Variable field, set the Value field to the increment you want to use for your rolling
barcode number (e.g. 1). Then choose Add value as Mode.

Step 5 Now insert a Barcode node under the Counter node via Tools / Barcode and double
click the Barcode node:

→
Insert the variable name in $$ signs ($BarcodeNum$) in the Content field (eventually ad-
just other barcode settings).

Step 6 Select the job by pressing the [Enter] key.

Step 7 Execute the job.
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To view a successive numbering in the preview window of InScript you can press Show Preview con-
secutively (the job will be rendered on the controller and that’s the reason why the counter node is
incrementing the bar code number).

10.7. Read Data From a TXT File

The Query node (see 5.56 Query) in connection with the Input node (see 5.54 Input) can be used to read
data from different data source (e.g. INI files, TXT files, Excel, MDB or DBF files). This example shows
how to read data from a Tab seperated TXT file.

The TXT file has to look like this (the '»' represent tabs):

Column 1» Column 2» Column 3
Value a1» Value b1» Value c1
Value a2» Value b2» Value c2
Value a3» Value b3» Value c3

Create this file with an ASCII editor (e.g. notepad.exe) and save it as Input.txt inthe same folder as
you will save your job. We will read the data of all three columns and output it using a Mat2Off and a
Text node.

Step 1 Create a new Job via Organizers / Job . Rename it to e.g. ReadTXT.

Step 2 Create a Vector view for this Job by right clicking it and selecting Show vectorEditor View.

Step 3 Create a Counter node via Organizers / Counter under the Job node ReadTXT and
double click it to set its parameters like this:

This initializes the line number counter to 0.

Step 4 Create a Mat2Off node via Organizers / Job and double click it to set its parameters
like this:
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This sets the initial positions of the output and sets the number of Columns andRows in the
TXT file. This numbers must match the TXT file's actual number of rows and columns
(3 columns and 1 row because the header is omitted and in each loop three values are
read).

Step 5 Under the Mat2Off node create another Counter node via Organizers / Counter and
double click it to set its parameters like that:

This increments the linenum variable by one on each Mat2Off loop.

Step 6 Place a Query node under theMat2Off node via IOs / Query and configure it like this:

This makes the data in the TXT file accessible for Input nodes under this Query node.
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Step 7 Place three Inputnodes under theQuerynode via Dialogs / Input and configure them
like this:

- -

Step 8 Place a Text node under theMat2Off node via Tools / Text and configure it like this:
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Step 9 The ReadTXT job should look like this:

Step 10 Select the Job ReadTXT for output using its context menu and click on Show Preview in
Vector Editor. The output will look like this:

NOTE

If you choose Show Editor in Vector Editor the output will not show the cor-
rect data because in this Vector Editor mode the processing of the external file
is not fully carried out.

10.8. Select Different Controller on Startup

InScript can be configured that only specific controller types are detected on start-up. To select this
you have to do these steps:

Step 1 Select Options / Preferences from the InScript menu:

Step 2 Under Global / Startup, you can set which controllers you want to detect during startup
of InScript.
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If you do not select any controller type, InScript will prompt you for a controller type
during startup.

Step 3 After you selected the type(s) of controller to find on startup, InScript will only scan for
this type of controller, which normally speeds up the start of InScript.

10.9. Visualize Stacked Objects in VE Edit and Preview Mode

To see if objects are stacked above other objects or even completely cover other objects you may
create a customized view for customized line sizes, colors and transparencies in VectorEditor. This
can be done independently for Edit and Preview mode. After setting this up (as described below) you
may switch on the customized view via Show Customized.

10.9.1. Visualize Stacked Objects in VE Edit Mode

Step 1 Use Show Vector Editor Pen Settings Dialog toolbar item.

Step 2 Set e.g. draw color No. 1 to 200 micrometer.

Step 3 Set Alpha channel to e.g. 33% (for up to 3 stacked lines: 3 * 33% uses almost 100%).
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Step 4 Activate Show Customized

Step 5 On intersections, you can see stacked lines by increasing darkness if you switch to VE
Edit Mode.

10.9.2. Visualize Stacked Objects in VE Preview Mode

Step 1 Use Options / Preferences / Vector Editor / Screen Styles / View Styles / Preview Mode.
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Step 2 Set Main to 200 micrometer.

Step 3 Set Alpha channel of e.g. Head 0 to e.g. 33% (for up to 3 stacked lines: 3 * 33% uses almost
100%).

Step 4 Activate Show Customized

Step 5 On intersections, you can see stacked lines by their different darkness if you switch to
VE Preview Mode.
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Appendices

A. Troubleshooting

This section gives some guidance on problems. If you can't find a solution here, please contact the
support department.

A.1. GiveIO Driver Problem

The GiveIO problem is a result of a driver for ISA controller cards, that may not be properly installed
or broken after installing and uninstalling a second InScript version.

Symptoms

InScript displays the following message:
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In case you are using Windows XP an Access Violation may occur. The exact error sympthoms are:

1. A dialog with "Error 2"

2. A dialog with "Could not use IO Driver, Could not start IO Driver, Could not install IO Driver"
(as shown above)

3. A dialog with "Error 0"

4. A dialog with an exception like: "An exception (C0000096) occured during DllEntryPoint or
DllMain in module: C:\...\NCCG32.DLL"

5. InScript starts but the ISA controller is not reachable

Possible Causes

NOTE

There is no ISA card support NCC cards ≤ 1703 for operating systems ≥Windows Vista
from InScript v2.10.2.1935 on. This error only happens with active ISA card support.

• If you have two parallel InScript installations and uninstall one of them, the GIVEIO.SYS is de-
installed and is not accessable on the next boot by the second InScript installation

• TheGIVEIO.SYS service could not be started because the old InScript Deinstaller did not remove
the GiveIO driver correctly. The driver is broken

• The GIVEIO.SYS service could not be started because Inscript was started without running the
install programm first (e.g. starting a copy of InScript.exewithout running the install program)

Resolution

Step 1 Un-install InScript via the Uninstall InScript entry in the Start menu

Step 2 Reboot

Step 3 Re-install InScript with the install program

Step 4 Start InScript and see if the error is fixed

If this does not work:

Step 1 Copy the folder <InScript folder>\Tools\GiveIOClean and all its contents in the InScript
folder on your hard disk to e.g. C:\GiveIOClean

Step 2 Uninstall InScript with the install program (to remove the GiveIO entries from the reg-
istry)
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Step 3 Check the Registry to see if all GiveIO entries are removed from the registry paths
HKEY_LOCAL_MACHINE/System/CurrentControlSet/Services/giveio
HKEY_LOCAL_MACHINE/SYSTEM/CurrentControlSet/Enum/Root/LEGACY_GIVEIO
and in the corresponding ControlSet00n paths

Step 4 If entries are still there execute the batch GiveIOClean.cmd from the copied folder
e.g. C:\GiveIOClean.
The registry will be cleard from all GiveIO entries

Step 5 Reboot→ Be sure that you do not omit this step, otherwise the old GiveIO driver may
persist!

Step 6 Re-install InScript using the setup program.

Step 7 Start InScript and see if the error is fixed

A.2. Another InScript process is already running

Only one InScript application may run at the same time. If you start InScript it checks if another
instance of this program is already loaded in Windows.

Symptoms

On startup, InScript displays the following dialog:

After clicking OK, the started InScript version does not start.

Possible Causes

• Another InScript instance is already running. The Winow of this InScript is visible, minimized
or hidden behind other windows

• A crashed InScript instance is running in the background without any visible window

Resolution

If another InScript is running and it is visible:

Step 1 Close the additional incstance of InScript by clicking OK on the dialog shown under A.2
Symptoms
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Step 2 Switch to the already running InScript instance by clicking on its icon in the Windows
task bar (normally this should also restore a minimized InScript window)

Step 3 Continue using this InScript instance

If there is no InScript visible, another InScript instancemay have crashed and it is still running in the
background. To stop this task, you can use the following steps:

Step 1 Open the Windows Task Manager by pressing the Ctrl, Shift and Esc keys simultane-
ously

Step 2 Change to tab Processes

Step 3 Find and select the InScript task:

Step 4 Click on End Process to stop the crashed InScript task

Step 5 Restart InScript

A.3. Flash Corruption Problem

If the Flash memory of the NCC controller is corrupted, data can't be read properly from it.

Symptoms

When starting InScript a sequence of messages appears on the screen with the text "VAR ’[variable-
name]’ get_var_from_blk=invalid".

Possible Causes

The controller board's flash is probably corrupted.
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Resolution

Reorganize the flash as follows:

Step 1 In InScript menu, click Controller→ Configure. The window Board Configuration opens.

Step 2 Click Details.
The window Flash Info opens

Step 3 In the meniu of window Flash Info click Enhanced Reorganization. As soon the flash is reor-
ganized the message "Enhanced reorganization successful!" appears

Step 4 Click OK

A.4. Settings seem to Disapear

All settings have to be saved to the controller. If you do not save them they will be lost after each
reset or restart of the controller (ASC), reset of the controller board (NCC) or the host PC (NCC).

Symptoms

With every reset of the ASC controller, NCC controller board or booting of the PC that contains the
NCC controller board, my settings disappear (e.g. device driver, default parameters etc.).

Possible Causes

The settings are not saved to the controller.

Resolution

� You have to save the settings to the NVRam of the controller board. In themenu click Controller
→ Save to NVRam (see also 2.7 Store Configuration).

A.5. InScript Search Paths Special Configuration

I want to configure the InScript Search Paths. These paths are automatically searched if InScript does
not find a file in the current path.

Description

If InScript does not find a file that is refernced in a Job, it searches in some additional locations. These
locations can be set in the InScript.ini configuration file.

NOTE

This feature is NOT supported on operating systems ≥ Windows Vista due to the more
restricted access rights in many system folders on these operating systems.
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Resolution

Step 1 Edit file <Path to InScript Home>\config\inscript.ini with an ASCII editor (e.g.Microsoft
Notepad)

Step 2 Find section [Search_Paths]

Step 3 Select the appropriate file-type/path pair, e.g. HPGL=<path> that you want to change or
extend item Change the path as desired, where:
More than 1 search path per file-type can be specified by using a semicolon ";" as delim-
iter. InScript goes through all specified paths in the given order using the first file that it
finds. The full stop "." equals the current job path The tilde "~" equals the InScript Home
folder.
Example "Pics in two local folders"
[Search_Paths]
Pics=C:\InScriptData\HPGL;C:\InScriptData\HPGL2,.plt

Example "HPGL on a network drive X:"
[Search_Paths]
HPGL=X:\InScriptData\HPGL,.plt

Example "Jobs on a network drive using UNC paths"
[Search_Paths]
Jobs=\\Goliath\Softdev,.plt

A.6. A Job has to be executed a second time to use current parameters

Symptoms

When a job is executed using Preview or Job Start, InScript ignores settings, changing variables or
external parameters until the job is executed a second time. Then these settings take effect.

Possible Causes

In the General tab of the sas device driver Preload is possibly set to always. This pre-executes the job
on the controller board and writes the line data to the digital signal processor (DSP) as soon as you
only select the job. If parameters are set after job selection then they will not take effect until the job
is loaded to the controller board once again.

Resolution

� Set Preload to never in the General tab of the sas device driver if this behaviour is not wanted.
— or —
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Click on Vector Editor Show Preview
This executes the changed job on the controller board for preview and loads the updated line
data to the digital signal processor (DSP). If you execute a Job Start after that then the controller
board outputs this updated line data from the line buffer.

For each parameter you can set in a pen there exists a corresponding parameter in the associated
device driver. In the device driver these parameters can be identified by the Controlled check box.
If the check box is de-activated (gray) then the parameter of the device driver is in effect. To take
the parameter of the pen in effect you have to activate (red) the check box. In the device driver,
which belongs to the pen, click the de-activated (gray) check boxes of the affected parameters. This
activates (red) the check boxes and takes the parameters of the pen in effect.

A.7. Pen Parameters seem to be Ignored

Symptoms

A parameter that was set in a pen seems to be ignored by InScript.

Possible Causes

For each parameter you can set in a pen there exists a corresponding parameter in the associated
device driver. In the device driver these parameters can be identified by the Controlled check box. If
the check box is de-activated (gray) then the parameter of the device driver is in effect.

Resolution

To take the parameter of the pen in effect you have to activate (red) the check box.

� In the device driver, which belongs to the pen, click the de-activated (gray) check boxes of the
affected parameters. This activates (red) the check boxes and takes the parameters of the pen
in effect.

A.8. Asynchroneous Execution Problem

Symptoms

During a job the connected devices are not running synchronously. E.g. the laser begins processing
while a linear axis yet stands still though the axis should move.

Possible Causes

The device driver sas has to be used to synchronize the connected and activated devices.
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Resolution

To enable the device driver sas of controlling devices they have to be child nodes of the sas device
driver in the Devices window (see 3 Devices).

� Drag & Drop the corresponding device driver(s) into the device driver sas.

A.9. Invisible PLT-File Line Data

Symptoms

PLT-files are not shown in the Vector Editor.

Possible Causes

You are using a version of InScript that is older than version 2.7.1 and there is no pen defined in your
PLT-file or your pen is set to pen 0. Older versions of InScript automatically used pen 0 if no pen was
defined in the PLT-file. But the color of pen 0 is preset to background color, whichmakes the graphic
invisible.

Resolution

� Change the color of pen 0 to another color than the background color.

A.10. Language Mix on Non-English Operating Systems

Symptoms

Some menus and dialogs in InScript are displayed in the language of the Operating System.

Possible Causes

These menus and dialogs are provided by theWindows Operating System and depend on the settings
there. National and international Windows versions exist. The international Windows version is
delivered with our industrial PCs.

Resolution

It is only possible to change the language in thesemenus and dialogs, if you are using an international
OS version. Be aware that such a change also extends to other programs where it is possibly not
wanted. To change the language to English in these menus and dialogs follow these steps:
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Step 1 In the Windows Start menu, click Settings→ Control Panel→ Regional Options.
The Regional Options window opens

Step 2 In the General tab of the Menus and dialogs list, select English

Step 3 Click OK

Manual - InScript® Software - Graphical User Interface - as in repository revision 343 585


	1 General Information
	1.1 Short Description
	1.2 Concept
	1.2.1 InScript - Controllers
	1.2.2 Summary
	1.2.3 Remarks

	1.3 Overview of Changes

	2 Devices Window
	2.1 Settings in Devices vs. Settings in Pens
	2.2 How to Open the Window
	2.3 Description of the Window
	2.4 Devices Tree Structure
	2.5 Context Menu in the Devices Window
	2.6 Manage Devices
	2.6.1 Basic Steps
	2.6.2 Create Device
	2.6.3 Configure
	2.6.4 Activate
	2.6.5 Edit (Parametrize)
	2.6.6 Synchronize with Other Devices
	2.6.7 Control Device Parameters During Job Execution
	2.6.8 Deactivate
	2.6.9 Delete

	2.7 Store Configuration

	3 Devices
	3.1 Shared GUI Elements
	3.1.1 When Configuring Inactive Devices
	3.1.2 When Editing (Parametrizing) Active Devices

	Controller Related Devices
	3.2 pio - Parallel Inputs and Outputs
	3.2.1 Configure
	3.2.2 Parametrize
	3.2.3 Parametrize - General
	3.2.4 Reading and Setting Parallel Inputs and Outputs

	3.3 sas - System Activity State
	3.3.1 Configure
	3.3.2 Parametrize
	3.3.3 Parametrize - General
	3.3.4 Parametrize - Teach-In
	3.3.5 Parametrize - Inputs/Outputs
	3.3.6 Parametrize - Breakout Pinout
	3.3.7 Parametrize - Connector Pinout
	3.3.8 Parametrize - Job Duration Measurement

	3.4 flash - Flash Memory
	3.4.1 Configure
	3.4.2 Parametrize

	3.5 dac_a/b - Digital Analog Converter a and b
	3.5.1 Configure
	3.5.2 Parametrize
	3.5.3 Parametrize - General

	3.6 dist_xy - Distortion
	3.6.1 Configure
	3.6.2 Parametrize
	3.6.3 Parametrize - Distortion
	3.6.4 Parametrize - Distortion - Testmark
	3.6.5 Parametrize - Distortion - Measured Values
	3.6.6 Parametrize - Correction
	3.6.7 Parametrize - Raytracing 8V
	3.6.8 Parametrize - Raytracing 8V - Testmark 1
	3.6.9 Parametrize - Raytracing 8V - Testmark 2
	3.6.10 Parametrize - Raytracing 8V - Raytracing NCC
	3.6.11 Parametrize - Raytracing 8V - Testmark 3
	3.6.12 Parametrize - Clipping

	3.7 dist_xy2 - Distortion
	Scan Head Related Devices
	3.8 head - Scan Head
	3.8.1 Configure
	3.8.2 Parametrize
	3.8.3 Parametrize - Wobble
	3.8.4 Parametrize - Offset
	3.8.5 Parametrize - Channels
	3.8.6 Parametrize - Target
	3.8.7 Parametrize - Home

	3.9 scanhead - Scan Head
	3.9.1 Prerequisites
	3.9.2 Prerequisites - Detection of the scan head over LPC
	3.9.3 Configure
	3.9.4 Parametrize
	3.9.5 Parametrize - status
	3.9.6 Parametrize - voltages
	3.9.7 Parametrize - adcValues
	3.9.8 Parametrize - temperatures
	3.9.9 Parametrize - trackingError
	3.9.10 Parametrize - trackingError - sfN
	3.9.11 Parametrize - trackingError - sfN - advanced
	3.9.12 Messages
	3.9.13 Messages - Failed to communicate with scan head
	3.9.14 Messages - Internal error in scan head
	3.9.15 Messages - Timeout while communicating with scan head
	3.9.16 Messages - Error during access to scan head via LPC
	3.9.17 Messages - Maximum allowed error limit exceeded for subframe N
	3.9.18 Messages - Number of axis is higher than the number of configured channels
	3.9.19 Messages - Tracking delay out of bounds for subframe N
	3.9.20 Mapping of axis names to subframe number

	3.10 linepar - Line Parameters
	3.10.1 Configure
	3.10.2 Parametrize
	3.10.3 Parametrize - Common
	3.10.4 Parametrize - Open End
	3.10.5 Parametrize - Joint 1
	3.10.6 Parametrize - Joint 2
	3.10.7 Parametrize - Dot
	3.10.8 Parametrize - Raster
	3.10.9 Parametrize - Ramping

	Laser Devices
	3.11 Coherent Avia
	3.11.1 Configure
	3.11.2 Parametrize
	3.11.3 Parametrize - Power
	3.11.4 Parametrize - Q-Switch
	3.11.5 Parametrize - Pulse Control
	3.11.6 Parametrize - Diodes
	3.11.7 Parametrize - Power Saver
	3.11.8 Parametrize - Interlock
	3.11.9 Parametrize - Configuration
	3.11.10 Parametrize - Temperature
	3.11.11 Parametrize - Status

	3.12 BP Aion / Coherent Prisma
	3.12.1 Configure
	3.12.2 Parametrize
	3.12.3 Parametrize - General
	3.12.4 Parametrize - Q-Switch
	3.12.5 Parametrize - Configuration
	3.12.6 Parametrize - Power Saver
	3.12.7 Parametrize - Power Meter
	3.12.8 Parametrize - Info

	3.13 configurable laser - Configurable Laser
	3.13.1 Configure
	3.13.2 Configure - Gate
	3.13.3 Configure - Osc/Frequency
	3.13.4 Configure - Osc/Internal
	3.13.5 Configure - Osc/External
	3.13.6 Configure - FPS
	3.13.7 Configure - Modulation
	3.13.8 Configure - Power
	3.13.9 Configure - Pointing Laser
	3.13.10 Configure - Shutter/Safety
	3.13.11 Configure - Shutter/Process
	3.13.12 Configure - Interlock - A-H
	3.13.13 Configure - Aux/DAC
	3.13.14 Configure - Aux/OUT
	3.13.15 Configure - Aux/IN
	3.13.16 Configure - GLA
	3.13.17 Configure - Comm
	3.13.18 Parametrize
	3.13.19 Parametrize - Control
	3.13.20 Parametrize - Osc
	3.13.21 Parametrize - FPS
	3.13.22 Parametrize - Ageing
	3.13.23 Parametrize - Stats
	3.13.24 Parametrize - Power Saver
	3.13.25 Parametrize - Start Conditions
	3.13.26 Parametrize - Fail Conditions
	3.13.27 Parametrize - GLA Status

	3.14 ipg ylp - Pulsed Ytterbium Fiber Laser by IPG
	3.14.1 Configure
	3.14.2 Parametrize
	3.14.3 Parametrize - Control

	3.15 Spectra-Physics Explorer
	3.15.1 Configure
	3.15.2 Parametrize
	3.15.3 Parametrize - Control
	3.15.4 Parametrize - Osc
	3.15.5 Parametrize - Power Saver
	3.15.6 Parametrize - Start Conditions
	3.15.7 Parametrize - Fail Conditions
	3.15.8 Parametrize - Status
	3.15.9 Parametrize - Explorer/General
	3.15.10 Parametrize - Explorer/Identification
	3.15.11 Parametrize - Explorer/Temperature
	3.15.12 Parametrize - Explorer/Diode 1
	3.15.13 Parametrize - Explorer/Q-Switch
	3.15.14 Parametrize - Explorer/Pulse Energy
	3.15.15 Parametrize - Explorer/Status

	3.16 sl4xx and sl8xx
	3.16.1 Configure
	3.16.2 Parametrize
	3.16.3 Parametrize - Control
	3.16.4 Parametrize - Power
	3.16.5 Parametrize - Ageing
	3.16.6 Parametrize - Timing
	3.16.7 Parametrize - Power Saver
	3.16.8 Parametrize - Conditions
	3.16.9 Parametrize - Stats
	3.16.10 Parametrize - Status
	3.16.11 Parametrize - ADC

	3.17 haas laser - HL-Series Laser by Coherent
	3.17.1 Configure
	3.17.2 Parametrize
	3.17.3 Parametrize - Control
	3.17.4 Parametrize - Interlock

	3.18 lasag laser 2 - RTPS and VCPS Controlled Lasers by LASAG
	3.18.1 Configure
	3.18.2 Parametrize
	3.18.3 Parametrize - Control
	3.18.4 Parametrize - Power Saver
	3.18.5 Parametrize - Messages
	3.18.6 Parametrize - Interlock

	3.19 cw200s
	3.19.1 Configure
	3.19.2 Parametrize
	3.19.3 Parametrize - Control
	3.19.4 Parametrize - Q-Switch
	3.19.5 Parametrize - Ageing
	3.19.6 Parametrize - Stats
	3.19.7 Parametrize - Interlock
	3.19.8 Parametrize - Power Saver
	3.19.9 Parametrize - Power Mapping

	3.20 idar
	3.20.1 Configure
	3.20.2 Parametrize
	3.20.3 Parametrize - Control
	3.20.4 Parametrize - Gate
	3.20.5 Parametrize - Ageing
	3.20.6 Parametrize - FPK
	3.20.7 Parametrize - Power Save
	3.20.8 Parametrize - Conditions
	3.20.9 Parametrize - Stats
	3.20.10 Parametrize - Status

	3.21 sl902
	3.21.1 Configure
	3.21.2 Parametrize
	3.21.3 Parametrize - Lamp
	3.21.4 Parametrize - OSC
	3.21.5 Parametrize - FPK
	3.21.6 Parametrize - Ageing
	3.21.7 Parametrize - Power Save
	3.21.8 Parametrize - Conditions
	3.21.9 Parametrize - Stats
	3.21.10 Parametrize - Status

	3.22 generic laser - Generic Laser
	3.22.1 Configure
	3.22.2 Parametrize
	3.22.3 Parametrize - Control
	3.22.4 Parametrize - Q-Switch
	3.22.5 Parametrize - Ageing
	3.22.6 Parametrize - Stats
	3.22.7 Parametrize - Power Saver
	3.22.8 Parametrize - Interlock

	Additional Laser Information
	3.23 Background to Modes of Operation
	3.24 Automatic Service Database Entry
	Motion Axes Devices
	3.25 isel - Universal Control for Motion Axes by ISEL
	3.25.1 Configure - General
	3.25.2 Configure - X / Y / Z / A
	3.25.3 Parametrize
	3.25.4 Parametrize - X / Y / Z / A
	3.25.5 Parametrize - I/O

	3.26 imc4 - IMC4 Motion Control
	3.26.1 Configure - General
	3.26.2 Configure - X / Y / Z / A
	3.26.3 Parametrize
	3.26.4 Parametrize - General
	3.26.5 Parametrize - X / Y / Z / A

	3.27 it116 - Control for Motion Axis IT116 by ISEL
	3.27.1 Configure - General
	3.27.2 Parametrize
	3.27.3 Parametrize - General

	3.28 ims - IMS Motion Control
	3.28.1 Configure - General
	3.28.2 Configure - A1 .. A8
	3.28.3 Parametrize
	3.28.4 Parametrize - A1 .. A8

	Miscellaneous Devices
	3.29 can0/1 - Controller Area Network
	3.29.1 Configure
	3.29.2 Parametrize
	3.29.3 Parametrize - Network Management

	3.30 udp_server - User Datagram Protocol Server
	3.30.1 Configure
	3.30.2 Parametrize
	3.30.3 Parametrize - General

	3.31 sew_movidrive
	3.31.1 Configure
	3.31.2 Parametrize
	3.31.3 Parametrize - General
	3.31.4 Parametrize - Status

	3.32 fume extraction - Fume Extraction
	3.32.1 Configure
	3.32.2 Parametrize
	3.32.3 Parametrize - General

	3.33 crossjet - Crossjet
	3.33.1 Configure
	3.33.2 Parametrize
	3.33.3 Parametrize - General

	3.34 hid - Human Interface Device
	3.35 profibus - Process Field Bus
	3.36 ase user io - USER Inputs and Outputs
	3.36.1 Configure
	3.36.2 Parametrize
	3.36.3 Parametrize - Inputs/Outputs
	3.36.4 Parametrize - Breakout Pinout
	3.36.5 Parametrize - Connector Pinout

	3.37 position encoder - Position Encoder
	3.37.1 Configure
	3.37.2 Parametrize
	3.37.3 Parametrize - General
	3.37.4 Parametrize - Measurement
	3.37.5 Processing-On-The-Fly

	3.38 disto - Distance Measurement Module
	3.38.1 Configure
	3.38.2 Parametrize
	3.38.3 Parametrize - General

	3.39 pwm - Pulse Width Modulation
	3.39.1 Configure
	3.39.2 Parametrize
	3.39.3 Parametrize - Wobble

	3.40 serial access - Serial Interface
	3.40.1 Configure
	3.40.2 Parametrize
	3.40.3 Parametrize - General
	3.40.4 Communication Examples

	3.41 out1 - Address Parallel Output Via Pens
	3.41.1 Configure
	3.41.2 Parametrize
	3.41.3 Parametrize - General


	4 Job Configuration Window
	4.1 How to Open the Window
	4.2 Description of the Window
	4.3 Job Configuration Tree Structure
	4.4 Context Menus for the Respective Branch in the Tree Structure
	4.4.1 Controller (root node)
	4.4.2 Exec
	4.4.3 Macros
	4.4.4 DefaultJob
	4.4.5 Pens
	4.4.6 Files
	4.4.7 Fonts
	4.4.8 Status

	4.5 Manage Controllers
	4.5.1 Basic Actions Managing a Controller
	4.5.2 ASC Web Interface

	4.6 Manage (Executable) Jobs
	4.6.1 Basic Steps
	4.6.2 Create Job
	4.6.3 Open Job
	4.6.4 Load File
	4.6.5 Save Job
	4.6.6 Save Job as
	4.6.7 Save Multiple Jobs
	4.6.8 Delete Job
	4.6.9 Clear and Load Job
	4.6.10 Create Node
	4.6.11 Drag and Drop Job Nodes
	4.6.12 Load Subtree
	4.6.13 Save Subtree
	4.6.14 Delete Node
	4.6.15 Delete Subtree
	4.6.16 Edit Node
	4.6.17 Rename Node
	4.6.18 Cut Subtree
	4.6.19 Copy Subtree
	4.6.20 Paste Subtree
	4.6.21 Expand Exec Tree
	4.6.22 Collapse Exec Tree
	4.6.23 Expand Subtree
	4.6.24 Collapse Subtree
	4.6.25 Arrange Subtree
	4.6.26 Arrange Node
	4.6.27 Show VectorEditor View
	4.6.28 Remove VectorEditor View
	4.6.29 Select in VectorEditor
	4.6.30 Edit Backdrop Property

	4.7 Manage Macros
	4.7.1 Create a new Macro
	4.7.2 Link a Macro to a Job
	4.7.3 Create a Macro Group
	4.7.4 Group Macros
	4.7.5 Save Macros
	4.7.6 Load Macros

	4.8 Manage Default Job
	4.8.1 Set Default Job
	4.8.2 Reset Default Job

	4.9 Manage Pens
	4.9.1 Control Device Parameters During Job Execution
	4.9.2 Create New Pen
	4.9.3 Edit Pen Section
	4.9.4 Load Pen
	4.9.5 Load Pen as
	4.9.6 Save Pen
	4.9.7 Save Pen as
	4.9.8 Delete Pen
	4.9.9 Delete Pen Section
	4.9.10 Assign Pens to "Line Colors" of a Vector Graphics File
	4.9.11 Force Execution of a Pen Link Node That Has No Child Nodes
	4.9.12 Teach-in pilot Pen

	4.10 Manage Files
	4.10.1 File Formats
	4.10.2 Scope
	4.10.3 Save
	4.10.4 Load - Creating Nodes Automatically
	4.10.5 Load - Creating Nodes Manually
	4.10.6 Examples

	4.11 Manage Fonts
	4.11.1 Font Formats
	4.11.2 Scope
	4.11.3 Use TTF Fonts without InScript
	4.11.4 Convert to FDT
	4.11.5 Example


	5 Job Nodes
	Common Information
	5.1 Shared GUI Elements
	5.2 Sequence of Transformations
	5.3 COM Ports in Job Nodes
	5.3.1 ASC Controller
	5.3.2 NCC Controller

	Geometrical Operators Group
	5.4 Rotate
	5.5 Scale
	5.6 Slant
	5.7 Offset
	5.8 Transform
	5.9 Rotate3D
	5.10 Offset3D
	5.11 Transform3D
	Tools Group
	5.12 File Link (HPGL)
	5.13 Bitmap
	5.13.1 Edit - General
	5.13.2 Edit - Render Server
	5.13.3 Edit - Geometry
	5.13.4 Edit - Grayscale Conversion
	5.13.5 Edit - Output Mode Settings
	5.13.6 Edit - Lead In
	5.13.7 Edit - Scanning
	5.13.8 Edit - Info
	5.13.9 Edit - Preview
	5.13.10 Edit - Mapping
	5.13.11 Edit - Position Encoder

	5.14 Dot
	5.15 Shape
	5.16 Polygon
	5.17 Concentric Circles
	5.18 Text
	5.19 RoundText
	5.19.1 Edit - Shared GUI Elements
	5.19.2 Edit - Text
	5.19.3 Edit - Characters
	5.19.4 Edit - Ellipse
	5.19.5 Edit - Angles

	5.20 Barcode
	5.21 Barcode 2D
	5.22 Raw Lines
	5.22.1 Vector Graphics Import Window
	 Zoom and Properties Context Menu and Mouse Usage
	 Edit Context Menu and Mouse Usage
	5.22.2 ARGES ARL File Preprocessor

	5.23 Spline
	5.23.1 How to create a spline curve
	5.23.2 How to handle points of a spline curve

	5.24 ARL P3D
	5.25 Spiral
	5.26 Split Text
	5.26.1 Edit - Shared GUI Elements
	5.26.2 Edit - Text
	5.26.3 Edit - Split

	5.27 TestPat
	5.28 Scan 3D
	5.29 Spiro 3D
	5.29.1 Edit - General
	5.29.2 Edit - Spiro Specification
	5.29.3 Edit - Spiro States
	5.29.4 Edit - Spiro Preview

	Organizers Group
	5.30 Job
	5.30.1 Edit - Shared GUI Elements
	5.30.2 Edit - General
	5.30.3 Edit - On Loaded
	5.30.4 Edit - On Selected
	5.30.5 Edit - About

	5.31 Collect
	5.32 Macro
	5.33 MacroGroup
	5.34 Repeat
	5.35 Link
	5.36 Mat2Off
	5.36.1 Edit - Shared GUI Elements
	5.36.2 Edit - General
	5.36.3 Edit - Offset Edit
	5.36.4 Edit - Rotation Edit
	5.36.5 Simple Edit

	5.37 Repeat X
	5.38 Repeat Y
	5.39 Conditional
	5.39.1 Edit - Expert Mode
	5.39.2 Edit - n of m

	5.40 Delay
	5.41 Clock
	5.42 Counter
	5.43 PosList
	5.43.1 Edit - PosList
	5.43.2 Conversion Options
	5.43.3 Using PosList
	5.43.4 Position Teach-In
	5.43.5 PosList "Old Style"

	5.44 Script
	5.44.1 Edit - Script
	5.44.2 Scripting Language
	 Data Objects
	 Operators
	 Functions
	 Control Flow
	 Scripting Examples

	5.45 Stop
	5.46 Flush
	5.47 Tiling
	5.47.1 Edit - Shared GUI Elements
	5.47.2 Edit - Working Area
	5.47.3 Edit - Tiles
	5.47.4 Edit - Current Tile

	5.48 Tile
	Modifiers Group
	5.49 Pen Link
	5.50 Pen Set
	5.51 Fill
	Dialogs Group
	5.52 Memo
	5.53 Info
	5.54 Input
	IOs Group
	5.55 Dual Scan
	5.55.1 Edit - Shared GUI Elements
	5.55.2 Edit - General
	5.55.3 Edit - Beam Dump
	5.55.4 Edit - Cache
	5.55.5 Edit - Target Area
	5.55.6 Example

	5.56 Query
	5.57 Head Offsets
	5.57.1 Edit - Head 1 to 4

	5.58 ExtRep
	5.59 ExtPos
	5.59.1 Edit - 1 to 8
	5.59.2 Edit - Teach in Realtime Control

	5.60 ExtMat2Off
	5.60.1 Edit - Shared GUI Elements
	5.60.2 Edit - Standard
	5.60.3 Edit - Offset Edit

	5.61 Cache
	5.62 ExtCmd
	5.63 Host Execute (or Execute Host Application)
	5.64 Split
	5.65 ExtSelect
	5.66 Framegrabber
	5.66.1 Edit - Shared GUI Elements
	5.66.2 Edit - General
	5.66.3 Edit - Grabber
	5.66.4 Edit - File-Settings

	5.67 Select Font - Window

	6 Job Control Window
	6.1 How to Open the Window
	6.2 Description of the Window
	6.3 Select Job for Execution
	6.4 Start (Execute) Job
	6.5 Abort Job Immediately
	6.6 Stop Job at Next Stop Node

	7 Vector Editor Window
	7.1 Editor mode
	7.2 Preview mode
	7.3 Fast Toggeling of Editor and Preview Mode
	7.4 Toolbars
	7.4.1 Mode
	7.4.2 Action
	7.4.3 View

	7.5 Context Menu
	7.6 Rulers
	7.6.1 Set Origin
	7.6.2 Center Origin

	7.7 Status Bar
	7.8 Coordinate System
	7.9 Manage Objects in Vector Editor
	7.9.1 Add View of Node or Subtree from Job Configuration to Vector Editor
	7.9.2 Remove View of Node or Subtree from Vector Editor
	7.9.3 Create Objects
	7.9.4 Select Objects
	7.9.5 Deselect Objects
	7.9.6 Offset (Move) Objects
	7.9.7 Scale Objects
	7.9.8 Rotate Objects
	7.9.9 Slant Objects
	7.9.10 Keyboard Shortcuts


	8 Toolbars, Menus and Other GUI Components
	8.1 InScript Toolbars
	8.1.1 Standard Toolbar
	8.1.2 Windows Toolbar

	8.2 Close Job Editors
	8.3 InScript Menu
	8.3.1 File
	8.3.2 Controller
	8.3.3 View
	8.3.4 Service
	8.3.5 Extras
	8.3.6 Options
	8.3.7 Windows
	8.3.8 Help

	8.4 Preferences
	8.4.1 Category - Board nnnnnnnn or xxx.xxx.xxx.xxx
	8.4.2 Category - Auto Upload
	8.4.3 Sub Category - Before Upload
	8.4.4 Sub Category - Upload
	8.4.5 Sub Category - After Upload
	8.4.6 Category - Vector Editor
	8.4.7 Sub Category - Display
	8.4.8 Sub Category - Rulers
	8.4.9 Sub Category - Backdrop
	8.4.10 Sub Category - Screen Styles
	8.4.11 Sub Category - Screen Styles / Common
	8.4.12 Sub Category - Screen Styles / View Styles
	8.4.13 Sub Category - Screen Styles / View Styles / Preview Mode
	8.4.14 Sub Category - Screen Styles / View Styles / Editor Mode
	8.4.15 Sub Category - Screen Styles / Page
	8.4.16 Sub Category - Screen Styles / Grids
	8.4.17 Sub Category - Printer Styles
	8.4.18 Sub Category - Printer Styles / Common
	8.4.19 Sub Category - Printer Styles / View Styles
	8.4.20 Sub Category - Printer Styles / Page
	8.4.21 Sub Category - Printer Styles / Grids
	8.4.22 Category - Global
	8.4.23 Sub Category - Startup
	8.4.24 Sub Category - Shutdown
	8.4.25 Sub Category - Message Handling
	8.4.26 Sub Category - File Handling
	8.4.27 Sub Category - Job Creation
	8.4.28 Sub Category - User Interface
	8.4.29 Sub Category - Keyboard Shortcut
	8.4.30 Category - Printing
	8.4.31 Sub Category - Printer Settings
	8.4.32 Sub Category - Page Margins
	8.4.33 Sub Category - Fonts
	8.4.34 Sub Category - Support Data
	8.4.35 Sub Category - Mappings
	8.4.36 Sub Category - Mappings / Laser Power
	8.4.37 Sub Category - Mappings / Bitmap Analog Mode
	8.4.38 Restrict Permissions for Users

	8.5 Xplorer
	8.5.1 Xplorer Window
	8.5.2 Edit Variables in Xplorer

	8.6 Birdview
	8.6.1 Birdview Window
	8.6.2 Birdview Zooming

	8.7 Quick Settings
	8.8 System Status
	8.9 Node Inspector
	8.9.1 Add to Node Inspector
	8.9.2 Node Inspector Context Menu

	8.10 Messages
	8.10.1 Messages Types
	8.10.2 Messages Toolbar
	8.10.3 Delete a selected Message
	8.10.4 Delete all Messages
	8.10.5 Messages Detail
	8.10.6 Messages List
	8.10.7 Always focus the last message

	8.11 Beam Profiler
	8.11.1 Menu
	8.11.2 Toolbar
	8.11.3 Window Line Cut 1 / 2
	8.11.4 Window Beam profile
	8.11.5 Window Histogram
	8.11.6 Window 2D view
	8.11.7 Window 3D view
	8.11.8 Window Color Ramp

	8.12 Video Capture Device
	8.12.1 Setup
	8.12.2 Functions

	8.13 Align Target
	8.14 Convert Font to FDT
	8.15 Convert IGES file to Jobstructure
	8.16 Create Support Info
	8.17 Arrange Windows and Tool Bars
	8.17.1 Undocking
	8.17.2 Docking
	8.17.3 Prevent Docking
	8.17.4 Save/Load Window Layout


	9 Supervisor and Operator Mode
	9.1 Set and Edit Password
	9.2 Activate and Deactivate Password
	9.3 Enter a Password to Return from Operator Mode
	9.4 Toggle Supervisor and Operator Mode
	9.5 Start in Supervisor or Operator Mode
	9.6 Make Variables Accessible in Operator Mode

	10 Exercises and Examples
	10.1 First and Important Steps
	10.2 Create an Arc
	10.3 Create Macros
	10.4 Create a Tiling Node
	10.5 Insert Date and Time in a Job
	10.6 Rolling Barcode Numbers
	10.7 Read Data From a TXT File
	10.8 Select Different Controller on Startup
	10.9 Visualize Stacked Objects in VE Edit and Preview Mode
	10.9.1 Visualize Stacked Objects in VE Edit Mode
	10.9.2 Visualize Stacked Objects in VE Preview Mode


	Appendices
	A Troubleshooting
	A.1 GiveIO Driver Problem
	A.2 Another InScript process is already running
	A.3 Flash Corruption Problem
	A.4 Settings seem to Disapear
	A.5 InScript Search Paths Special Configuration
	A.6 A Job has to be executed a second time to use current parameters
	A.7 Pen Parameters seem to be Ignored
	A.8 Asynchroneous Execution Problem
	A.9 Invisible PLT-File Line Data
	A.10 Language Mix on Non-English Operating Systems


